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Introduction

Welcome, and thank you for using Origin!

Origin is a powerful data analysis and publication-quality graphing software, tailored to the needs of scientists
and engineers. What sets Origin apart from other applications is the ease with which you can customize and
automate your data import, analysis, graphing and reporting tasks.

Customizations can range from simple modifications to a data plot, saved as a graph "template" for later use,
to customized data analyses which produce publication-quality reports, saved as an Analysis Template. Batch
plotting and analysis operations are also supported, wherein templates are used for repeat analysis of multiple
files or datasets.

We are confident that you will find Origin to be an effective tool for analyzing your data and presenting your
findings. And to help you get the most from Origin, we offer first-class customer and technical support,
training and consulting services.

In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro. OriginPro offers all the
features of Origin, plus extended analysis tools for Peak Fitting, Surface Fitting, Statistics, Signal Processing
and Image Handling.

The purpose of this guide is to try and present a broad overview of Origin's capabilities. We hope that new
users will find this to be a valuable orientation to the Origin workspace and its primary features. For those who
are already using Origin, we hope you will find useful information on new features and perhaps learn a thing or
two about Origin features that you had overlooked previously.

More detailed information is provided in the Origin Help file (Help:Origin from your Origin software’'s main
menu) and numerous other learning resources exist. For a complete listing of available resources, see the
Origin Resources chapter of this guide.

Some things to look for in this guide:

We have added short tutorials to numerous topics throughout this guide. These short
tutorials are intended to give you a quick introduction to a key Origin feature. These
tutorials will be marked with this icon.

Also, sprinkled throughout this guide, you'll find tips on using Origin. These tips are
marked with this icon.

e Features that are new to this version of Origin will be marked with this icon.

Important changes to key features and other critical information will be marked with
this icon.

We like to get feedback from our users on ways to improve and expand Origin's data analysis and graphing
capabilities. We would love to hear from you. You can find contact information in the Origin Resources chapter
of this guide.


http://www.originlab.com/doc/User-Guide/OriginPro
http://www.originlab.com/doc/User-Guide/Resources
http://www.originlab.com/doc/User-Guide/Resources




2 Installing and Updating Origin

2.1 Notes for Upgrade Users

e The Origin upgrade installs into a new program folder - it does not update a previous version. It is

therefore not necessary to install or uninstall a previous version of Origin before upgrading.

e |If you are upgrading from Origin 2018 or a later version, the process should be pretty painless. Origin
2018 and later versions share a common license file and User Files Folder. The first time you run Origin
2022b, it should be licensed and know where your User Files are located.

. If you are upgrading from Origin 2017, you will be prompted to pick a new User Files Folder (see
Selecting a User Files Folder, below). If you have custom Origin files from your previous version, you

can transfer them to your new User Files Folder. From the Preferences menu, select Transfer User

Eiles. Provided your Maintenance has not expired, you should not have to re-license your software. If
your Maintenance has expired, you will need to re-license your Origin 2022b software (See Reqistering
Origin, below).

. If you are upgrading from Origin 2016 or earlier, you will need to complete the license management
process. When your upgrade is launched for the first time, a license dialog will display asking for your
Product Key If you have custom Origin files from your previous version, you can transfer them to your

new User Files Folder. From the Preferences menu, select Transfer User Files.

e |If you have a dongle package, please update your dongle after the Maintenance renewal to make sure
your dongle is available for the latest version. Upgrade your dongle by entering a Product Key in the
License Activation dialog. Once done, you can use this dongle for Origin installed with the same serial

number on any other computers without re-activating the dongle.

Lastly, we want to point out that your Origin software has some great new features. For more information on
key features by version, see the originlab.com/VersionComparison page on our website.

2.2 Notes for Administrators of Multi-user Packages

Instructions for getting started with the multi-seat node-locked and concurrent network packages are
available on the OriginLab website (originlab.com/GetStarted).

In addition to the InstallShield setup that runs from the Product DVD, an MSI installer and sample transform
are available. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin
installation package for distribution. Information on the MSI installer and alternate deployment techniques can
be found on our website:

° MSI Installation
e Silent Install

(] Building an Installation Package

(] Installing Origin on a Remote Access Server such as Windows Terminal Server or Citrix.



http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/User-Guide/Installation-Startup
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
https://www.originlab.com/VersionComparison
https://www.originlab.com/getstarted
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/MSIInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/SilentInstall
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/BuildanInstallPackage
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/Multi-userDeployment/RemoteAccessServer
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2.3 Installing Origin

Origin is a Windows application. You can run Origin on an Intel-based Mac from Boot Camp or by running a
virtualization software. For more information, see the Running Origin on Mac using Virtualization
Software, on the OriginLab website.

There are three steps that must be completed to prepare Origin for use:

. Installation

(] Selecting a User Files Folder

o License management

Both the Origin upgrade and the newly-purchased products install into a new program folder. Origin does not
overwrite previous versions when upgrading, so your old version continues to function. Likewise, your original
version does not have to be installed when running the upgrade.

If you are installing from a DVD, the startup program that launches when you insert the Origin DVD, includes
an Origin installation button. If the startup program does not automatically run, you can browse the DVD to
launch the setup.exe.

Please note that Origin and OriginPro 2022b are only available as 64-bit versions.

2.3.1 How to Proceed if You Already Have the Origin Trial Version Installed

If you already have the trial version of Origin installed on your computer, you can convert it to the full product
or upgrade.

e |If you have purchased the Origin package with node-locked license management, run Origin and select
Help:Convert Trial to Product; or you can use Help: Activate License, click the “Or if you have
purchased already” radio button and choose Activate for this computer. In either case, you will be
asked to enter the Product Key that was generated when you registered your software purchase on
originlab.com.

e  For all other license management packages, run the Origin Add or Remove Files program located in the
Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator
permissions). When the Origin setup program starts, select the Modify option and then select Install

Product (requires serial number).

2.3.2 How to Correct or Change your Serial Number After you Complete an
Installation
If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or
Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a

log in account with administrator permissions). When the Origin setup program starts, select the Modify
option and then click Yes to change your serial number.

2.4 Selecting a User Files Folder

Each Windows login user must maintain a User Files Folder (UFF) for storing Origin user data:



https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/RunOriginonaMac
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter/Installation/DirectInstall
http://www.originlab.com/doc/License/Single-User-Node-Locked-Lic
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
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e |If you are upgrading from Origin 2018 or later versions, your User Files Folder (UFF) location is unchanged.

. If you are upgrading from Origin 2017 or earlier, you will be prompted to pick a location for a new UFF.
You must choose a different path from your old UFF.

e To transfer the contents of your old UFF and your toolbar and workspace configurations to the new UFF,
you can run the Origin software and selecting Preferences: Transfer User Files. For more information,

see Transfer User Files.

Consider these points in selecting your UFF:

. If you have a mobile computer, it is best to select a location on your computer rather than on your
network.

e  For non-mobile computers, you can select a location on the computer or on the network, as long as you
have stable access to the folder.

e Do not select the same UFF as other Origin users. To learn how to share custom files with other Origin

users, please see the chapter on Sharing Origin Files, later in this Guide.

Each time Origin starts, the program checks to see that your UFF is accessible. If Origin cannot connect to the
UFF, you will be prompted to select a new location for the UFF. Note that you can change the location of your
UFF at any time while running Origin. From the Preferences menu, select Options and then click the System
Path tab.

2.5 Licensing Origin

All Origin packages include license management. The type of license management provided with your package
is determined at the time of your Origin purchase.

2.5.1 Node-locked

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website by
entering a Product Key in the License Activation dialog when you start Origin. In-dialog instructions are
provided for computers with no internet access.

2.5.2 Concurrent Network

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin
administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains
a license for this server from the OriginLab website, and then sets up a license service. The license service
counts and restricts the number of Origin computers that can run concurrently. For more information, see the
Help Center on the OriginLab website (originlab.com/HelpCenter).

2.5.3 Dongle
A dongle (USB hardware key) is provided with the Origin dongle-license package and must be present in the
computer's USB port to run Origin. From Origin 2019, dongles are cross-version.

2.6 Registering Origin
Registering Origin is required to obtain product support from OriginLab and the team of Origin distributors.

Registration also activates Origin's Check for Updates menu command (Help: Check for Updates), allowing
you to obtain patch and help file updates directly from your Origin software. In addition, Origin's App Center


http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer
http://www.originlab.com/doc/User-Guide/Sharing-Files
https://www.originlab.com/index.aspx?go=Support/DocumentationAndHelpCenter
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and Template Center dialog, which provide direct access to Apps&Templates and their updates from your
Origin software, requires that your installation be registered.

For Node-locked licenses, registration is completed automatically when you enter a Product Key into the
License Activation dialog box that opens when you start Origin. To verify that you are registered, select About
Origin from the Help menu. The dialog should display the Registration ID that is assigned to your Origin
installation.

Serial Mumber: GF354-6089-1234567
Registration [D: ABC-12D-E3F

Computer Name:  MyComputerName

Maintenance Expiration (Y¥YYY/MM/DD):  12/31/2017
This copy of Origin is owned by:

Acme Corporation

For all other license management packages, open Origin, and then select Register on-line... from the Help
menu to open the Registration dialog box. Use the Registration dialog to register your Origin installation on
the Origin website. During this process, a Registration ID is issued. Enter or copy and paste this Registration
ID into the Registration dialog to complete the process. The About Origin dialog should now display your
Registration ID.

2.7 Maintenance

Most Origin packages are sold with the first year of Maintenance included. Maintenance provides you with free
Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting
services, and a home-use license.

Maintenance customers should receive notice of their eligibility for a free upgrade, when
choosing Help: Get Help Files/Check for Updates.

® To check if your Origin package includes Maintenance, select the Help menu and then select About
Origin. If your package includes Maintenance, the About Origin dialog will show your Maintenance

expiration date.

® To learn about the benefits of Maintenance, contact OriginLab or your local Origin distributor.

® As your maintenance expiration date approaches, Origin will display a maintenance expiration message
with a link to the OriginLab website to learn how to renew your maintenance. This reminder message

provides a check box to prevent showing in the future.

2.8 Service Releases

When called for, OriginLab publishes free service releases (patches). A service release typically provides bug
fixes and may include some minor improvements. All customers are encouraged to apply service releases to
ensure that your Origin software performs correctly. To check if a patch is available, select the Check for
Updates command from the Help menu. Patches are also available from the Support area of the OriginLab
website (originlab.com/Support).



https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=PURCHASE/Maintenance
https://www.originlab.com/index.aspx?go=SUPPORT
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2.9 Notification of Upgrade

OriginLab regularly releases new versions of Origin, adding features and feature improvements based on
customer input. Customers with maintenance are entitled - and encouraged - to use the most recent Origin
version. After a new version release, OriginLab and the team of Origin distributors notify maintenance
customers by email. However, to make sure you receive notification of a new version release, please create an
account on the OriginLab website (ariginlab.com) and select the check box in your user profile to receive
"product updates".

E-mail Subscriptions:

#| e-Newsletter: Tech Tips, User Stories, 6 issues per year

¥| Product Updates: Service Releases, New Version Motification

OriginLab will nat 32 or rent your personal contact information. See our privacy policy for details.

2.10Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland,
Austria, Liechtenstein, and China, may support running Origin with English display, or with Japanese, German
or Chinese display. To access this language control, select Change Language from the Help menu.

2.11system Transfers - Deactivating a License

2.11.1Node-locked Licenses (Computer I1D-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

(] If Origin can still be used on your computer:

Open Origin and then select Deactivate License from the Help menu. After successful deactivation, your
Computer ID will be removed from OriginLab’s server so that you can install and activate on another computer.

If your licensed Origin computer is no longer available:

Log into your portal at www.originlab.com.
Under Licensing, click the Manage my License(s) link.

Click on the Serial Number associated with the license that you want to deactivate.

A

Click the go link in the Deactivation column.

2.11.2Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not
required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "System Transfer Request Form" available
from the Support area of the OriginLab website.



https://www.originlab.com/
https://www.originlab.com/restricted/Login.aspx?ReturnUrl=%2frestricted%2fSystem_Transfer.aspx
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2.12 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder,
or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays
providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as
prompted.

The Remove program deletes all folders and files that were installed by the Origin setup program. It also
deletes folders and keys created by the installer in the Windows registry.



3 Origin Resources

The following tables list key Origin resources available to you. If you purchased Origin from a local distributor,

your Origin distributor may provide additional resources. Please contact your distributor to learn more.

3.1 Direct Support Resources for Origin

For Information On ...

Go Here

Technical Support .

Contact information for OriginLab

or your Origin Distributor
Report a bug

Suggest a feature

originlab.com/Support

Chat Online

Chat online with an OriginLab

representative

originlab.com

... and click
lower-right corner

User Forum

Share information with and get
help from the Origin user

community

originlab.com/Forum

Training and
Consulting

Making optimal use of OriginLab
products
Help in developing custom tools

for your particular application

originlab.com/Training
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3.2 Resources Installed with your Origin Software

For Information On ...

Go Here

Learning Center

Load graph samples and
analysis samples

Transfer User Files when
upgrading to the latest version
Learning Center for direct
access to Tutorials, Videos,
Origin Blog, User Forum and

social media pages.

Help: Learning Center (or press F11)

Help Files

Online or local (CHM) Help for
Origin (GUI, Programming)

Help: Check for Updates (to update

CHM files)

Context-sensitive
Help

Control-by-control explanation
of Origin dialog boxes

The dialog box must be open
Some dialogs have multiple
sections/tabs and you may
have to click on that

section/tab to set the focus

Press F1 when the dialog box is open

or

Click il in the upper-right corner of the

dialog box

10




Origin Resources

For Information On ...

Go Here

Recent files

Help with problems or
questions that arise while
using Origin

Direct access to Origin features

Press F1 when no dialog box is

open

or

the complex

Sf[art MenL_J and dialog boxes Click the Start menu icon at the
- Windows-like
Search Open or search for Apps bottom-left of the workspace.
relevant to a particular task E
_r':l
Location of Origin menu @ <« Start menu (F1)
commands for searched-for
features _ . . .
For additional information on using
this feature, see
The Origin Interface, Start Menu.
Step-by-step instructions on
performing many Origin
Tutorials operations, from the simple to Help: Origin : Tutorials

3.3 Online Resources for Origin

For Information On ...

Go Here

Online
Documentation

Product documentation

originlab.com/Doc

Help Center

Resources list

Installation and License

Documentation

Contact Info

originlab.com/HelpCenter

11


http://www.originlab.com/doc/User-Guide/Origin-Interface
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For Information On ...

Go Here

Video Tutorials

Help with a range of Origin
features including "tips and

tricks"

Available in playlists and

categories

Search Origin video or YouTube
pages by keyword
or type v <key phrase=> in the

Origin Start menu.

originlab.com/Videos
youtube.com/user/TheOriginlab

Live and recorded webinars

Webinars highlighting key features originlab.com/Webinars
Blog posts with plenty of
Origin Blog software tips and tricks blog.originlab.com

Case Studies

How others are using Origin in

their work

originlab.com/CaseStudies

Graph Gallery

Outstanding examples of Origin
graphs, many of them submitted

by the Origin community

originlab.com/GraphGallery

12

Information on key Origin features often can be found by just doing a quick web
search. Open a browser and search on phrases such as... "Origin shortcut keys",
"LabTalk graph legend", or "OriginC NAG functions".



http://www.originlab.com/doc/User-Guide/Origin-Interface

4 OriginPro

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis
tools and capabilities. If you don't know which product you have -- Origin or OriginPro -- look to the title bar.

@I(GriginProp022b - UNTITLED *

File Edit View Data Plot Column Worksheet Fo
DRk BM,- B2R @ EHEB
CELE SN

P Users of standard Origin will note that some menu commands are marked with (Pro),
; indicating that the feature is available only in OriginPro. If you own the standard version of
Origin, but find that you need features of OriginPro, you can upgrade by contacting your
Origin representative.

If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):

B Set Systemn Variables 7 >
Variable Value | Comment 2
RPM 1 Turns off menu display of (Pro) features
W
System Variables List
OK Cancel

4.1.1 Curve Fitting

In addition to Origin's linear and nonlinear curve fitting capabilities, OriginPro includes support for the
following:

Linear fitting with X error.

13
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e  Nonlinear fitting with X and Y errors (orthogonal regression).
e  Fitting with implicit functions (orthogonal distance regression).

e  Fitting Comparison: Fit and rank all functions in a category, compare two models to one dataset or two

datasets to one model.

e  Global fitting of multiple curves using different functions, with the option of sharing parameters.

For more information, see these web pages: Linear and Polynomial Fitting and Nonlinear Fitting.

4.1.2 Surface Fitting

With OriginPro, you can perform 3D Surface Fitting. Choose from 21 built-in surface fitting models including
Gauss2D, DoseResponse2D, Exponential2D, and Polynomial2D; or define your own function.

e  Fit worksheet data (XYZ) or matrix data (Z values).

e |ocate and fit multiple peaks using one of several peak identification methods.
e  Automatic peak parameter initialization.

®  Apply constraints and bounds to parameters and fix parameter values.

e  Output parameter and statistical results plus residual curves.

e  Find specific Z values along the fit surface and include them in your output.

e  Option for automatic recalculation of results and saving tool settings to a Theme file for repeat use.

For more information, see this web page: Surface Fitting.

4.1.3 Peak Fitting

OriginPro includes the Peak Analyzer tool with support for the following:

e Peak finding (Local Max, Window Search, 1st Derivative, 2nd Derivative, Residual after 1st Derivative).

e Detect and subtract baseline (Constant, Dataset, XPS, End Points Weighted, Straight Line, User-Defined,

None).
e  Fit Peaks with built-in or user-defined functions.
e  Fit individual peaks with different fitting functions.
e Fit Baseline as part of the peak fitting process (user-defined or built-in functions).

e  Control fit parameters (fix, share, set bounds).

For more information, see this web page: Peak Fitting.

4.1.4 Statistics

OriginPro includes support for advanced statistical analyses in these areas:

® Descriptive statistics (cross-tabulation, distribution fit, correlation coefficient, partial correlation

coefficient).

14


http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/LinearAndPolynomialFitting
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting/NonlinearFitting
http://www.originlab.com/doc/Origin-Help/Fitting-2DSurf
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/CurveFitting#Surface_Fitting_PRO
http://www.originlab.com/doc/Origin-Help/PeakAnalyzer
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/PeakAnalysis#Peak_Fitting_PRO
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e ANOVA (one-/two-way repeated measures, three-way).

e  Multivariate analysis (principal components, cluster, discriminant/canonical discriminant analyses; partial

least squares).

e  Survival analysis (Kaplan-Meier, Cox Proportional Hazards, Weibull Fit, test of equality of survival

functions)

e  Parametric hypothesis tests (two-/pair-sample t-Test on rows, one-/two-sample test for variance, one-

/two-sample proportion test).

® Nonparametric tests (one-/paired-sample Wilcoxon signed rank, paired-sample sign test, Mann-Whitney,
two-sample Kolmogorov-Smirnov, Kruskal-Wallis ANOVA, Mood's median test, Friedman ANOVA, support

for simultaneous tests).

e Power and sample size (one-/two-/paired-sample t-test, one-/two-proportion test, one-/two-variance test,
one-way ANOVA).

e ROC curve analysis.

For more information, see this web page: Statistics.

4.1.5 Signal Processing

In addition to Origin's standard suite of signal processing tools, the following are available in OriginPro:

e Signal transforms (short-time Fourier analysis, Hilbert transform, 2D FFT/2D IFFT).
e  Filtering (IIR filter design, 2D FFT filter).
e  Correlation (2D correlation).

e  Wavelet Analysis (continuous wavelet transform, discrete wavelet transform, inverse discrete wavelet
transform, multi-scale wavelet decomposition, smoothing, noise removal, 2D wavelet decomposition, 2D

wavelet reconstruction).
® Rise-time Gadget (linear search, histogram, largest triangle).
e Decimation (moving average, finite impulse response).
®  Coherence.

e Envelope curves (upper and/or lower, smooth during envelope detection).

For more information, see this web page: Signal Processing.

4.1.6 Gadgets

Origin Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. While there are
specific Gadgets for each analysis, all work by allowing you to graphically and interactively position a region-
of-interest (ROI) object around the data that you wish to analyze. OriginPro includes these additional Gadgets:

e Cluster Gadget (stats on points inside/outside the ROI; with support for masking, editing, copying and

deleting points).
e 2D Integration Gadget (integration on image plot or contour plot from matrix or worksheet data).

e Rise-time Gadget (analyze rise/fall time of stepped signals).

15


http://www.originlab.com/index.aspx?go=Products/Origin/Statistics
http://www.originlab.com/index.aspx?go=Products/Origin/DataAnalysis/SignalProcessing

UserGuide_2022b

For more information, see this web page: Exploratory Analysis.

4.1.7 Image Processing

Origin and OriginPro include a collection of easy-to-use image processing tools. OriginPro includes additional
tools in the following areas:

. Image adjustments (function lookup table, leveling).
e Image conversion (dynamic binary, threshold, RGB merge/split, image scale).
e  Spatial filters (user filter).

e Arithmetic transforms (alpha blend, extract to XYZ, image simple math, math function, morphological

filter, pixel logic, replace background, subtract background, subtract interpolated background).

For more information, see this web page: Image Processing.

4.1.8 Apps
Many add-on Apps are coded to integrate with an OriginPro feature and therefore, they require an OriginPro
license to run. OriginPro-only Apps will be listed in the Oriqgin File Exchange with a red symbol beside
them.

Here are some of our more popular OriginPro Apps:

. Redundancy Analysis

(] Speedy Fit
(] Correlation Plots

o Neural Network Regression

e  X-Ray Diffraction Analysis

e  Phylogenetic Tree
(] 2D Peak Analysis

(] Standard Curve Analysis

(] Linear Mixed Effects Model

° Rank Models

e  Peak Deconvolution

. Design of Experiments

(] 2D Confidence Ellipse

. Independent Component Analysis (Requires R software)

(] Logistic Regression

e  Sequential Fit
®  Piecewise Fit

®  Piecewise Smooth

(] Principal Component Analysis

(] Principal Component Analysis for Spectroscopy

16
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OriginPro

e  Slope Analyzer
(] Global Peak Fit
(] 3D Smoother

e Cyclic Voltammetry

[ Enzyme Kinetics

e  Polynomial Surface Fit

. Heat Map with Dendrogram

For general information on Apps visit www.originlab.com/apps.
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5 What's New in Origin 2022b

5.1 Origin 2022b New Feature Highlights

Visit www.originlab.com For Origin 2022b Feature Highlights, including a Highlights
video.

e Export Graphs and Layouts to SVG Image Format: Graphs and layouts can now be exported in SVG

format, allowing for easy editing of the exported file in applications such as Adobe Illustrator™.

e Workbook Buttons for New Sheet, Workbook Organizer: Buttons are added to workbook navigation

to add new sheets or to toggle the Workbook Organizer on and off.

e Arrange Windows with Custom Sorting and Snapping: New dialog to arrange/tile windows by Project

Explorer order, window name, window type, etc. Aligned windows can be "snapped" to a common edge by
dragging.

e Rich Text Support in Notes Windows: Applies to standalone Notes or Notes added as workbook sheet.

Use Format toolbar, apply document styles. Auto-wrapping.

e Rich Text Support for Worksheet Cell Notes: Use the Format toolbar and paragraph styles to style

text in both label row and data cells.

. Insert Images into Graphs and Notes: Insert linked images from data cells, image windows, files or

online, into labels in graphs or into Notes windows.

e Simplified Symbol Map Dialog: Open a smaller, tabbed dialog for inserting common symbols. Direct

access to "Advanced" dialog.

e Distance Annotation on Graphs. A new Distance Annotation tool (Tools toolbar) for labeling the

distance between to points on the graph.

(] Expanded Named Range Support for Label Rows and Fitting Dialogs: Use label row values in

calculations or placing reference lines. Use in fitting operations as parameters and bounds.

e Apps Gallery Improvements: Adjust icon spacing, plus dock the Gallery to top of workspace.

e New Graph Types: Bar Map, Circular Packing, and Right-Triangle Ternary.

[ New Apps:

5.2 Features by Category

5.2.1 Data Handling

. New Workbook Buttons to Add Sheet, Show/Hide Organizer

(] Column Label Row Support for Cell Comments
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. Improved Set Column Value "Column' Handling of Duplicate Long Name

e Column Label Row Support for Named Range

e Tolerance Factor Added to Split Worksheet

(] Improve ROI Support for Matrix Image Stack

. More Interpolation Options for Matrices incl. NetCDF Matrices

e Convert Project Links and Formulas to Raw Values

5.2.2 Notes

e Toolbar Support for Rich Text Editing of Notes Windows

(] Paragraph-style Support in Notes Window

. Font Size Control for Individual Notes Windows

(] Notes Window Support for Inserting Graphs, Images, Cell Values, LaTeX equations, etc.

. Insert Notes Window Content to Layout or Graph

(] Print Rich Text Content to PDF

. Notes Window Support for KaTeX

5.2.3 Graphing

(] Point-by-Point Legend improvements

. Data Highlighter Adds Support for Picking Rows in Multiple Sheets

° Insert Images into Graph Page Text Objects

e Simplified Symbol Map when Editing Legend or Text Object

(] Mini Toolbar Button for ""Add Label for Layers"

e Speed Improvement for Sankey Diagram

20


http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Matrix-Book-Matrix-Sheet-Matrix-Objects
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Worksheets-Columns
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Publishing-and-Export
http://www.originlab.com/doc/User-Guide/Origin-Interface
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Graphical-Exploration-of-Data
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/User-Guide/Graphing

5.2.3.1

What's New in Origin 2022b

Text Object Mini Toolbar Toggle for Link to Substitution

Longer Minus in Tick Labels, Active Indicator in Legend

Object Manager: Select Objects with Same Name

Mini Toolbar Support for Modifying Multiple Selected Legend Objects

Distance Annotation on Graphs

Box Charts: Add Percentile tab > Edge Thickness Control

Increment Line Style (dropdown)

Box Chart Connect Lines tab Support for Connection Types

Case Sensitive Sorting in Dialog Lists (e.q. Layer Contents)

Support Wrapping of Tick Labels When No Space Between Characters

Colormap Transparency for Image Plots

Mini Toolbar Toqgale for Speed Mode Banner Display

Auto Import of Linked Images

Better Batch Plotting Support for Multi-X Plots

Column Width Control, Data Point Tooltip

Alignment of Multi-line Data Labels

New Axis Option for Scientific Notation

Fit Page to Objects for Layout

New Graph Types

New Graph Type: Bar Map

New Graph Type: Circular Packing Graph
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5.2.4.2

5.2.4.3
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5.2.6
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New Graph Type: Right Angle Ternary

Analysis

General

Pause Auto Recalculate Hotkey

Batch Processing Improvements

New Normalization Methods for Worksheet Columns

Gadget

Customize ROI Label for Quick Fit Gadget

Fittin

Named Range Support For Fitting Operations

Support EMF/SVG for User-Defined Fitting Function Previews

Parameter Initial Formula Improvements

MT Button to Modify Displayed Digits in Result Table

Import and Export

Export Graph or Layout to SVG Image

Export Image Window Improvements

Import Web Image to Image Window, plus Hotkeys for Import

Excel Connector Improvement to Auto Detect Header

Support Display of Origin Import Filters (*.0if) on Data Menu

Image Analysis

Import GeoTIFF to Matrix Window

Import GeoTIFF to Image Window
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52.8

5.2.8.1

What's New in Origin 2022b

Import Multi-frame TIFF Control for Display of Thumbnail or Slider

NetCDF Import Improvements to Averaging and Handling of Numeric Year

Export NetCDF Analysis Results to .nc File

Miscellaneous

Disable Mini Toolbar Across Sessions

Flexible System for Arranging Windows

Resizing and Snapping of Windows in Workspace

Undo Delete Workbook

Control App Icon Spacing and Gallery Docking

Update LabVIEW VI Files to add ""Close References"

Project Explorer Shortcut Key Control of Preview

Adjust Window Size and Position For Display Resolution

Improved Notification of Upgrades via Check for Updates

Install Apps from the Origin Start Menu

Install Cloud Template from Origin Start Menu

Customize Behavior of Insert Object to Graph Button

Subpanel of Project Explorer Displays Size When Show Folders is Checked

Programming

LabTalk

Cell Notes LabTalk Access via Text Label/Legend Option @WN

LabTalk System Variable for Disabling Sparklines

Improve Notes Window Raw Text Editor
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For more information, see Programming in Origin > LabTalk.

5.2.8.2 Origin C

e Add Function to matrixbase Class for Importing ASCII string
e Add Function to Get DataRange from Named Range.

e  Add Function to Get List of Cells with Notes to Worksheet Class.

For more information, see Programming in Origin > Origin C.

5.2.8.3 Python

®  Support Calling Fitting Functions in Python.

e Specify Package Version When Running pip Command.

For more information, see Programming in Origin > Python.

5.2.9 New Apps for Origin 2022b

(] Zoom FET

(] Radiometric Geochronology Analysis

° Matrix Analysis

e NetCDF Data Analysis

(] Tangential Baseline

° Mann-Kendall Test

(] GeoTIFF Export

e Color Spectrum Plot

(] Hansen Solubility Parameter Plot

To find out more about Origin Apps, including where you can get the free add-on Apps listed above, see the
Apps for Origin chapter of this User Guide.
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6 The Origin Interface

6.1 The Origin Workspace

This chapter contains basic information on navigating the Origin workspace. Long-time Origin users can skim
this chapter.
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" For Origin 2022b, window size and position in the workspace, are automatically

- adjusted to accommodate different displays. This should make it easier for you to
switch between your laptop and a higher-resolution monitor, without having to
resize/reposition every window and dialog box. A system variable is added to control
rescaling behavior: @SRWS (0 = previous behavior; 1 = fit width, scale y; 2 = fit
height, scale x; 3 (default) = fit width and height).

—
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6.1.1 Windows File Explorer Previews

While not part of the Origin interface, you can use Windows File Explorer (previously "Windows Explorer") to

preview graphs in a project file.

(" Clickto Toggle or ALT + P}

kU= - o IEH|
Home Share Wiew ~ 8
L ||:| H:;rrwgnnell BB Edratarge icons | Largeicans | | | I [5] Group by = check boxes |g_"
lal | (L4 Details pane &[S Medium icons G =mall Cons 5 | = Add column W File name™dgnsions LA e
Mavigation e Sort Hide selected Options
pane~ i List by~ e all columns to fit ] Midden ibems tems -
.(-- * 1 |k « Local Disk (C:) » ProgramData » Originlab 95 » Origin » Central » Graphing | Search (ygphing »
> e (= il 3 C oA
W Favontes Hﬁw wl E i
5 i
B Desktop i - > P\i: (i)
" Dovminack 3D Scatter 3D Seatter 30 Seatter
# Recent places Ribban and Wall Ribbon and Wall Ribbon and Wall
& Google Drive Graphs - 3D Graphs - 3D Graphs - 3D
Ribbons.opju Scatter with Col.., Scatter with XY...
i OneDrive I { |
q " -\. "I \
& ‘ v & |
4 Homegroup e o i |
3D Scatter 3D Scatter 3D Scatter
188 This PC Ribbon and Wall Ribbon and Wall Ribbon and Wall
i Desktop Graphs - 3D ﬂ_iraphs = 3_0 Graphs - sq Xy
E Documents Stacked Walls.o... Trajectory with ...  Wall.opju |
: ¥ 4 L —
& Downloads -= T
& Music A .
E Pictures : : Scroll to View all
R i Wi Ll L& Graphs in Project
b v N Crabbar AN S atbar AN Cufara Dinte . ¥
186 tems 1 tem selected 1.85 MB

e Windows Explorer's Large or Extra large icons views (right-click in File Explorer and choose View:

Large Icons or Extra Large Icons or select from the Explorer View menu) will show an image of the

6.1.2
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last active graph before the project file was saved.
Open the Preview Pane (ALT + P) and scroll through all graphs in the project file.

If you do NOT wish to save graph previews into the file (either in icon view or in the Explorer Preview

Pane), you can set LabTalk system variable @PESS=0 or =-1. For information on changing the value of a

system variable, see FAQ-708 How do | permanently change the value of a system variable?

Origin Menus and Menu Commands

Context-sensitivity of menu bar and menus: The menu bar and menu commands are context-
sensitive; they change as you change window type (from worksheet to graph to matrix, for instance).
Only menus pertinent to the active window will display.

Menu bitmaps, toolbar buttons and shortcut keys: Some menu commands also have bitmaps that
display to the left of the command. Additionally, you may see a shortcut key combination listed to the
right of a menu command. The button bitmap and the shortcut keys indicate alternate ways to access the

same functionality.
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®  Shortcut menu commands: Many commands are available from shortcut menus. To open a shortcut
menu, right-click on an Origin object (worksheet window, graph axis, text object, etc.). Only pertinent

menu commands will show.

e Collapsible menus: By default, main and shortcut menus in Origin are “collapsed", meaning they display
an abbreviated set of commands. When you use a menu item which isn't included, it is added to the menu.
If you prefer to always see full menus, click Preferences: Options > Miscellaneous tab and clear the

Enable Collapsible Menus box.

e Most frequently used analysis menu commands: Most-recently used menu commands will appear at
the bottom of the analysis menus (Worksheet, Analysis, Statistics, Image, etc.). This gives you quick
access to tools when performing repeat operations.

e Custom Menu Organizer: Since Origin 8.1, Origin users have been able to use the Custom Menu
Organizer to add or remove menu items. To learn more, see the chapter Customizing Origin, later in this
Guide.

6.1.3 Origin Toolbars

Use the Customize Toolbar dialog box (View: Toolbars) to control toolbar display and reset or reinitialize
toolbars.

e Customize toolbar button appearance: Use controls on the Options tab of the Customize Toolbars

dialog box to modify button and toolbar appearance.

e Dock/Float a toolbar: Toolbars can be undocked and made to float on the workspace. To float a toolbar,
hover over the left-end of the toolbar. When the pointer becomes a four-headed arrow, drag the toolbar
off of the toolbar space. To return the toolbar to its former docked position, double-click the toolbar title

bar.

e Hide/Show a toolbar: Clicking the Close button on a toolbar removes the toolbar from view. To restore
a hidden toolbar, open the Customize Toolbars dialog box and select the toolbar.

e Hide/Show a button: Clicking the tiny arrow at the end of toolbar to turn on/off some buttons on a
toolbar.

e Move button location: Alt+drag a button to move it to a new location within or among toolbars.
Alt+drag to blank workspace to create a new toolbar. Alt+drag a button to child window til X shows to

remove a button.

6.1.4 Mini Toolbars

OriginLab continues to add Mini Toolbar support for common objects and tasks. These toolbars appear when
the user selects an object or when the user clicks in certain key areas inside the page. Available controls
depend on context (selected object, window type, etc).
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Available tools depend on context — window type, selected
object, where you have clicked on the page, etc.

Before using Mini Toolbars, make sure there is a checkmark beside View: Mini Toolbars (default).
To display the toolbar, select an object such as a data plot, a text label, or a worksheet cell.
In addition, there are toolbars for more-general page- and layer-level customizations and these toolbars

are displayed by hovering near the margins of the window. When you see your mouse cursor change to

something like this , this is your cue that clicking in this spot will display a Mini Toolbar of relevant

tools.
(X5) JIY5) /]
015 2015

Most Mini Toolbars have a Properties button I:I that gives access to more complex settings (e.g. a

graph window's Plot Details dialog box).

If you move away or you do not act quickly enough, a Mini Toolbar will fade away. To restore a Mini
Toolbar after it has faded, press the SHIFT key.

To add or remove buttons from a Mini Toolbar, click on the three dots at the bottom center of the toolbar.

This opens the Customize Mini Toolbar dialog box where you can enable or disable buttons as needed.




The Origin Interface

A ° Customize Mini Toolbar

Group  Single
[ Select All
600 - | Y e
222 . B % Line Color
400 — | == Increase Line Thickness,Decrease Line Thickness Line Thickness
| e v — AT A [F Fat
|03 ARG B4 =" Show DataLabels
Tax |
i | Bl 58 CopyPlot
Al |\ | I'. = {: Change Plot to
04 — — E E Ungroup
| - | | r 1 -E} Open Plot Details
0 2 4 ] 8
[ Hide. Te show again, press SHIFT.

Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
sessions (i.e. if turned off in the current session, they would be restored on Origin
restart). Now, this setting is remembered across sessions (alternately, you can control

Mini Toolbar display by setting system

6.1.5 Start Menu

Cancel

variable @DMT (ON=0; OFF=1)).

Enter keywords and phrases into the Find box to return relevant Menu entries, Apps, FAQs, Videos and X-
Functions. Open recently-opened Files, Menus and Apps.

Open the Start Menu by (1) pressing F1 (when no other dialogs are open), (2) by clicking the magnifying-
glass icon at the bottom left corner of the Origin workspace, or (3) by clicking Help: Activate Start Menu

(main menu).

t for Batch Processine

Projects
Batch Processing Multipk

File: Save Proj
Sharteut Menus
Wi ray are

filke including fitting furx

Find o poss % (0

@ << Start Menu (F1)
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To narrow your search, type the following letters in front of the search term(s):

m = search only Menu entries
a = search only Apps

search only Help + FAQ
search only Videos

search only X-Functions
search your recent projects
search sample projects
search Menus + Apps + X-Functions (only executable)

h
v
X
p
s
e

Alternately ...

Click the "gear" icon beside the search field to open the Settings box. Here you can restrict search results and
tweak other search settings.
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Il 2D Peak Analysis

[| Onset for Peaks
Iubal Peak Fit %

v

S — . . B . .
- Fit multiple peaks in multiple datasets with parameter sharing.
W Ger muoiscuian weigne anaryzer

Find |peak fit

& << Start Menu [F1)

d
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6.1.6 Learning Center

Learning Center is a "startup” dialog that gives quick access to graphing and analysis examples, plus
learning resources (tutorials, videos, the OriginLab blog, etc.).

1. To open the dialog, choose Help: Learning Center or press F11.

2. Check or clear the Show on Startup box to show or hide this dialog each time Origin starts.

l Filter by Plot Type l l Search by Plot Type
X
Q ~

B Learning Center

Box Charts
Graph Samples

Analysis Samples R

Wi

Learning Resources . &

.l ;[ BHEt
g | HTEEN
// P TEsAmARTENES

TTTTT

Learning
Center

Version
Number

Transfer User Files

Opens
Transfer User Files
Dialog Box

Double-click on a panel Show or Hide

to open Learning Center
Sample Data and Plots on Startup

e View and load sample graphs, including sample data and notes on re-creating the graph.
® Load analysis samples with data.

®  Browse the Learning Resources tab for tutorials and videos and links to the Origin Blog, User Forum and

Origin social media pages.

e  Move files from your previous User Files Folder to your new User Files Folder.

31


http://www.originlab.com/doc/Origin-Help/FileShare-UserFileTransfer

UserGuide_2022b

To see new graphs in Origin 2022b, open the Learning Center, click the Graph
Samples tab, set the plot filter drop-down to All Plot Types and search on 2022b.

6.1.7 Project Explorer

Project Explorer (PE) is a tool to help you organize the contents of your Origin project files (OPJ).
] Menu for Float, Dock,
Title Bar

Autohide, etc. x‘
Project Explorer [6) \‘ » O W Pin/Autohide
P

[[3 2D and Contour Graphs Toggle
... 2D Parametric Fuction Plot

> Area
»- 1 Col B i
- Column, Bar 4 Primary Panel
4 1 Contour
i [ Contour Plot with Vector Overlay
1 Heat Map
1 Polar Contour
E "'; Profile
- Ternary Contour
L X¥YZ Contour
A i sl Cnvimm s | e
MName Camments -+ Long Name Shart Name Type d————— Column header,
Contour Profile Contour Profile  ContourProfile Graph Details View
%F‘rnfileData _ ProfileData ProfileData2 Workbook Sub-panel showing
< -
@Nntes Motes Motes35_E Motes contents of
] MBook1C MBooklC Matrix highlighted folder

Project Explorer (PE) is split into two panels. The primary panel shows the OPJ folder structure. The sub-panel
shows windows contained in the folder that is highlighted in the primary panel.

Using Project Explorer to manage your projects:

e  Right-click the PE title bar or click the drop-down menu to display the panels stacked (Vertical

Alignment) or side-by-side (Horizontal Alignment).

e  Context menus in both panels provide options to delete, hide, print, etc. Menu options vary depending on

what is selected or where you have right-clicked.

e  Multiple-selection of windows in the sub-panel is supported (press Shift or Ctrl while clicking with your

mouse).

®  The sub-panel supports differing views of windows: Details (default), List, Small Icons, Large Icons,

Extra Large Icons.

e In any view, mousing over a window icon shows a popup preview of the graph, worksheet, matrix or

layout window. Notes window content is shown in a tooltip.
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£ Test_ OGWU_Preview Layout1
[ Folderl & Notes
E Function Plots - 20 Functil =] Scatter with Mﬁn Connected
lﬁ Line and Symbaol Graphs - B Stocks.dat
B Line and Symbol Graphs - - g S Manily Paromance n 2012
ﬁ Line and Symbaol Graphs - t T
£ > :fli.;.+§f++_+.%_;.

Project Explorer Improvements, Origin 2022b:

e  Control display of popup previews by right-clicking in the subpanel and placing a check
mark beside Hold Ctrl Key for Preview Popup. Henceforth, popups will only appear

as you press CTRL.

e  When subpanel's Show Folders is checked, folders now show folder Size.

4 v¥aterrall

o Wind Rose
Find... F3
<
Wiew 3
Mame - |5ize
Show Folders
L3 Symbol Plot with Size and... [230KB )
Hold Ctrl Key for Preview Popup
3 Ternary Contour 16KB
[ Three Panel graph with In... |259KB Arrange lcons r
[ Two-Level Grouped Box C... [307KB Reset Slide Indices
[ Unbalanced Grouped Box... |23KB
[ Variable Column Width 35KB New Window v
[ Waterfall G96KB Mew Folder
[d'Wind Rose 29KB
(— Refresh F5
Select All Windows Cirl=A
Send Graphs to PowerPoint...
Slide Show of Graphs...

e  When displaying windows as Extra Large lIcons, the PE sub-panel displays a thumbnail of graphs, layout

windows, workbooks and matrixbooks. Notes window content is shown in a tooltip.
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Project Explorer (5} >~ Ox
_ Test_OGWU_Preview
(3 Folderl g [—
{4 Function Plots - 3D Functs
[ Line and Symbel Graphs - i laEagEBaLs ;
{5 Line and Symbol Graphs - =
{4 Line and Symbal Graphs - :

. N Layout] w Scatter with Mean Connected Stocks.dat

(Border indicates Active Window

Prior to 2018, the PE sub-panel listed sub-folders in the folder selected in the top panel.
To restore this display mode, set the value of system variable @PEF = 1.

| You can right-click on PE folder (upper panel) and choose Copy -- or select the folder
/ and do a CTRL + C and CTRL + V -- to copy and paste the folder structure and content
to (a) another folder in the current project or (b) another project running in a second
Origin session. To copy a single workbook window, right-click on the window (lower
panel) and copy and then paste the window to (a) another folder in the same project,
or (b) to a new project running in a second Origin session.

1. Select Help: Open Folder: Program Folder, click the Samples subfolder, then drag

the file Tutorial Data.opj to your Origin workspace.

2. By default, Project Explorer is docked to the left side of the Origin workspace in

auto-hide mode. Mouse over the Project Explorer tab to show the PE window.

7= | Project Explorer (71) - 4@ x
Tg' - Map Combining Line and Contour Plots ~ E(Y) FiY
m | -3 Multi-Level Filter
% - Multi-line-plot with Special Position Annotation Line Cow Clos
z - Multiple Axis Breaks e
=i | -~ Multiple Fill Area
| - Multiple Layers with Step Plot

|| [ Multiple Surfaces in Same Layer 5
—| = Eper?-Higlh':Lon:I-CInse-‘-fnlume Stock Chart v gg 131f

3. Click on the "push pin" icon on the PE title bar to pin the window in the docked

position.

Project Explorer [71) VEX
~

A _lim el bl Smemial BacEFimm & mmetatiom | e

4. By default the sub-panel is in Details view. In this view, window metadata such as
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Name, Size and Comments show below these column headings. Try dragging

column headers to reorder them.

Mame Long Mame Short Name Comments ~ < e Commgnts =
eastcali3... eastcali3033 Workbook Mormal 282KE 9/23/2014 17:30
EMBocks MBookd Matrix MNormal  193KB 10/25/2013 11:39
@Notes Motes Motes7_E Motes Mormal 537 bytes  12/18/2017 15:52
5. Right-click on the column headings and show or hide any of the headings by
checking or unchecking the box beside each.
MName Long Mame  Short Name Comment2Z& AlhLglumns to Fi;. Size Madified Slide
%eastcalal)ﬂ eastcaliBDS@ [v] Hame | 28ZKB 9/23/2014 17:30
& Notes Notes Notes7_E \ Long Name 537 bytes  12/19/2017 10:33
@MBDDM MBookd T 193KB 10/25/2013 11:39
Type
Wiew
Size
Modified
Created
Dependents
Comments
[v] slide

Show All

6. To add a comment in the Comments field, click once, pause briefly and click a
second time. This puts you into edit mode. Enter a comment.
MName Long Mame Short Mame Comments ~ Type View Size Modified
B eastcali3... eastcali3053  [Typeyour comments here..| |Normal 282KB  9/23/2014 17:30
@Notes Motes Notes7_E Motes MNormal 537 bytes  12/18/2017 15:52
@MBDDkﬂ- MBookd Matrix Nermal  193KB 10/25/2013 11:39
7. To change the Name of a window, right-click in the row and choose Rename. By
default, the Name field displays the window Short Name; or if a window Long
Name exists, the window Long Name (all windows must have a Short Name but
Long Names are optional). Click the SN or LN button to the right-side of the
editable Name field to edit the Short Name or Long Name. If the Long Name does
not exist, you can enter one.
Mame Long Mame Short Mame Comments =+ Type View Size Madified
eastcali3053 Typeyour.. Workbook MNormal 282KB 12/18/2017 16...
Motes? E Motes Hidden 5337 bytes 12/18/2017 16:27
£ MBookd Short Name Matrix Hidden 193KB 10/25/2013 11:39

8.

Click to switch to editing Long Mame

J

In the top panel of Project Explorer, scroll to the folder 3D Surface with Point

Label and click on it. The sub-panel shows that there are three windows in the

folder. Note that the worksheet window eastcali3053 is bold indicating that it is
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the "active" window - the window that is being acted upon as well as the window
that determines what operations are available. There is also a Notes window, and

a matrix window named MBook4.

1__1 3D Scatter with Line Projections
w45 30 Surface with Point Label
: 1 3N Ternars Surfare

Mame Long Name  Short Mame Comments ~ Type WView Size

ﬁ eastcali3053 eastcali3053 Workbook MNormal 282KB
@Nntes Motes Motes7_E Motes Mormal 337 bytes
@MBDDk‘l MBookd Matrix Maormal  193KB

9. In the sub-panel, double-click on MBook4 and note that it is now bold and has a
magenta "halo”, indicating that it is the active window. You will also see that the
whole window(in the workspace) displays with a halo which can be customized in

color with the system variable @AWC-- another indicator that this is the "active"

window. Double-click on this MBook4 icon again and note that the icon is now
dimmed. Note also that the actual window disappears from the workspace. This is
because MBook4 is now hidden. Double-click the MBook4 icon again and the

window is restored and made active.
§m m e e e
iw{ 1 3D Scatter with Line Projections
1.5 3D Surface with Point Label
L. 3N Ternars Suface

Icon is dimmed indicating that the
window is hidden in the workspace

Mame Lang Mame ort Name Comments « Type View Size Madified

| eastcali3053 eastcali3053 Workbook Normal 282KB 9/23/2014 17:
MotesT_E Motes Normal 537 bytes  12/19/2017 11:03
MBookd Matrix Hidden 193KB 10/25/2013 11:39

10. With MBook4 active, click Plot = 3D: Surface: 3D Colormap. This creates a 3D
colormap surface graph (close the attention message). Note also that a new window --

Graphl -- has been added to the sub-panel of Project Explorer.

11. Right-click in an empty portion of the sub-panel and choose View: Extra Large

Icons. Note that Graphl now displays a graph thumbnail.

:...,.,‘..._,......'(... p I

eastealizlEd Graghl MBookd MNotes
12. Right-click again and choose View: Large Icons. Note that windows are now

represented by icons but if you hover on them, you can see the window contents

as a pop-up.
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EREDEA

i3

P To disable PE previews, open the Script Window (Window: Script Window) and type
' one or both of the following, then highlight the text and press Enter:

@PESS=-1; //turn off window preview in PE, show window comments

as tooltip
@PESH=0; //turn off window comments tooltip

When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.8 Apps Center and App Gallery

Apps are add-on applications for Origin that perform specific graphing and/or analysis tasks. A small number
of Apps that are broadly applicable to science and engineering fields are pre-installed with your Origin software.

Apps - 0 X
T Peak Fitting with Peak Analyzer [E=B[EeR[~>=
LaTeX 1

< !
® LaTak Eguaton fdac -

Equsson

P(x) = “frac{lH{“sigms “sqrt {p1 } He"{{{ Lef
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Use the App Center dialog for browsing, updating or downloading Origin Apps. This new dialog gives you
direct access to all of the Apps on the OriginLab File Exchange without you having to open a browser and
navigate there.

F| Spectral Broadening m Allan Variance
o Origanlab i . Origanlab «
Min. Versior: OngnPro 2017 SRD Min. Version: OngnPro 2017 SRO
A% Maps online (D) P q Impaort Files from a Folder
‘ Originlab L) OriginLab J-
Min, Version: Or i M7 SR2 Min. Version: On qin 017 SRO

To launch the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery, docked at
the right-side of your Origin workspace. If you do not see the Apps Gallery, click View: Apps (or ALT + 9) and
verify that there is a check mark beside Apps.

v

e |nstalled and Up-to-date Apps will appear in the App Center with a green check mark beside them

&

e Installed Apps for which there is a newer version will appear with an Update icon beside them

£ 3

e Those not installed will appear with a clickable Download and Install icon beside them

Origin's Statistics, Analysis: Fitting and Analysis: Peaks and Baseline menus include a Find Apps entry.
Clicking Find Apps opens the App Center to show only Apps that relate to the current menu (e.g. Statistics).
You can download or update Apps directly from the App Center.

Use the Apps Gallery to organize and access your installed Apps.

New For Origin 2022b:

e Adjust App Gallery icon spacing using a slider control.

e Dock the Gallery in a horizontal configuration, at the top of the workspace.

New Apps and App updates are are continually made available to Origin and OriginPro
users. Be sure to open your App Center occasionally (press F10) and if it displays the
red Download Now button, click to get the latest list of available Apps.

MNew App
Information
Is Available

Download
Now

For more information on Apps, please visit www.originlab.com/Zapps.
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6.1.9 Object Manager

The Object Manager is a dockable panel that opens to the right side of the workspace, by default. Use the
Object Manager for quick manipulation of the active graph or workbook window.

Graph Windows

e  Select an element (layer, plot group, data plot or special point) in the Object Manager to select the
corresponding element in the graph window and vice versa. Selection also (a) dims all other plots in the

graph layer and (b) selects the source data in the worksheet.

& = [@]1[&
a0 | em | cm [om | Em |-

_/\:}/\_A
a 2 4 ] L 10 a 2 4 ] L 10

e Object Manager can show a "Graph Objects" view and a "Plots" view of graph windows. To toggle
between the two views right-click in an empty portion of the Object Manager and choose Show
Plots/Show Graph Objects; or press Ctrl + Shift + S.

Graph2 * EI

1

Object Manager w 0 X

2 erl
| —O—V

I-V Curve for Single Electron Transistor |

eg.

1000

800 -

600

Object Manager

B&: Graph

=1+ Layerl
T x Ais Title (¥B)
[T ' Axis Title {YR)
T % Ass Tile (XT)
T Auis Title (YL)
T Text
/ Line
Line1

L)

V(uv)

400 |

200 +
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Hide or show plots or graph objects by clearing or checking the corresponding box in the Object Manager.

1an JTATE 5 : [+ Layer2 ]

G000 4

4000

(cm®iem)

2000 H

Cumulative Drain Discharge

At the graph level, change Object Manager list order (Drawing Order or its reverse -- Order of
Appearance ).

At the layer level, change layer order.
At the plot level, show labels, show or hide plots, reorder plots or create plot groups.

Within a plot group (labeled as gN), ungroup plots, re-order plots by dragging or by shortcut menu
command, change plot type.

Remove a plot (permanently) from the graph window.
Access the Plot Details, Layer Contents and Plot Setup dialog boxes.

Right-click on the layer icon and Reverse Plot Order.

Workbook or Matrix Windows

The Object Manager also supports certain actions for workbooks and matrices:

40

List all sheets in the active workbook or matrix.
Quickly select multiple sheets by pressing CTRL + Up/Down arrow.
Click a sheet in Object Manager to activate the corresponding sheet in the workbook or matrix.

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,
Move, Copy, and Duplicate.

Right-click on a matrix or virtual matrix in Object Manager to Rename.
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\-\____,f”/

Layout Windows

Y
25 Peaks Insent
Drelete
Add
B(Y1) Add Graph &% Sheet: [PanelGraph] — Raman Spectrum
Peak Fit of Sheet1 B
Add Matiia &5 Sheet
Long Mam [ Baseline . Sheet...
Units F“"‘H'“E‘“T Right-click on
I sheet in Object
Sheet
L4CK OR 812.91663  0.22654 Manhagr[ar :D o D
i - - d SNOMCuUl menu  hout Data
":‘,_;E?t T 82583326 022654
jec 3874989 0.22654 o]
Manager to 851 66651 022654 8 Move Befare "
activate sheet 864 58314 0.22654 ] Mowe to Begin
(]| InWOrkDOOK [GfSheetiB ) FitPeakCurvel { PeakProg ~ MeveteEne
S, x

Hame and Comments...
Exciude from Plotting Dialogs

Exciude from Excel Export

Mawigate.

When a Layout Page is active, the Object Manager lists and allows arrangement of objects via shortcut
menu commands.

All objects, including added graphs, tables and text objects, list in the Object Manager.

Hide or show objects by clearing or checking the adjacent box.

Select multiple objects in Object Manager, then right-click and align or distribute them using shortcut

menu commands.

6.1.100rigin Child Windows

Active windows -- the window that will be acted upon by graphing and analysis
operations -- display a colored frame to make the active window more obvious. You can

customize the active window indicator properties (frame color, where the frame shows,
frame line style) with "@ System Variables" @AWC (color) and @AWI (style).

pibEEINET Y

"Halo" indicating
Active Window
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Workbooks: The Origin workbook provides a framework for importing, organizing, analyzing,
transforming, and plotting your data. The tabbed workbook contains between 1 and 1,024 sheets. Each
sheet may contain more millions of rows and more than 65,000 columns of data. In addition to your data,
workbook windows may also store graphs, annotations, column-based functions, scripts and
programmable button objects, LabTalk variables and import filters.

Matrixbooks: Like the worksheet, a matrixsheet is a grid of cells, arranged in rows and columns. The
primary difference is that in the worksheet, each column is a dataset and each dataset can be configured
to contain various types of data (text, text & numeric, numeric (double), numeric (int), etc). In contrast,
the matrix is a single, numerical dataset of Z values, related in the XY plane by row (Y) and column (X)
index numbers. The matrixbook contains between 1 and 1,024 sheets. Each sheet can contain multiple
matrix objects (up to 65,504).

Graphs: The graph window is the primary container for your data plots. Origin supports over 100 chart
types, chosen specifically for their applications in various technical fields. Each chart is created using a
built-in, user-modifiable graph template that can be saved with your custom settings. In addition to data
plots, the graph may also contain annotations (text and drawing objects) or button objects that, when
triggered, perform some custom graphing or analysis task. Graph windows can be inserted into worksheet

cells or "floated" on worksheets (outside the grid) in a workbook window.

Images: The image window is a window for importing, viewing and editing raster images and videos
(.avi, .mov, .mp4).

Function Graphs: The function graph is a specialized graph window that displays a curve described by a
function. The function graph differs from other Origin graphs in that it is not produced from a dataset of
discreet values (though you can generate data after plotting).

Layout Pages: The layout window allows you to combine and arrange graph and worksheet windows and
various annotations onto a single "display panel." It is used primarily for creating presentations.

Excel workbooks. Excel workbooks can be opened or created in Origin. Workbooks can be saved

separately or as part of your Origin project file.

Notes: The Notes window supports plain text, Rich Text, HTML and Markdown. Use it for simple tasks
such as recording analysis procedures, making notes to students and colleagues, and cutting and pasting
text from other applications; or use it for rendering highly formatted text, including HTML reports and

mathematical expressions (see next).

The Notes window now supports both LaTeX and KaTeX, allowing you to render
highly-formatted mathematical expressions.
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Note: For more information on Origin's child windows, see

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Creating a
Child Window

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Basic Child

Window Operations

To save an Origin child window independently of the Origin project file:

® Select File: Save Window As... to save active window. File extensions OGW(U), OGG(U), OGM(U) are for

Origin Workbook, Graph and Matrix windows, respectively.

e  Right-click any window title bar and choose Save as... context menu.

Note: To save an Excel window as an external Excel file, right-click the Excel window title in Origin and choose
Save Workbook as... context menu.

| Origin 2018 added Unicode (UTF-8) support for Origin projects, child windows and
' templates. When you save a window file, you will have the option of saving a file with
or without a "u" appended to the file type (*.opj or *.opju). If you intend to use the file
only in the latest version of Origin, you should choose the Unicode-compliant
(appended "u") option as it offers some performance advantages.

To open a worksheet, graph, matrix, or notes window that was saved to a file:

_ . = : .
e Select File: Open or click the Open button J on the Standard toolbar to open window files.
e Select File: Recent Books, File: Recent Graphs to open recently saved workbook and graph window

files.
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Note: Origin supports window Short Name, Long Name and Comments and the Short Name must be
unique in the Origin project. The window Short Name will be renamed if such a name has already exists in the
project. If you open window file in the current project, then save the project, the window will be included in
the project.

To open an Excel workbook file:

If you are intending to work with Excel files in Origin, please see this section of the
Origin Help file before proceeding.

e Select File: Open Excel menu to open a external Excel file. Or, you can click Import Excel button in the
Standard toolbar or select Data: Import from File: Excel (XLS, XLSX, XLSM)... from the main menu

to import the Excel file.

Note: If you choose Open Excel, the Excel file is opened as an Excel workbook, in an Excel session that runs
inside Origin. In this mode, you have only limited access to Origin features. If you choose Data: Connect to
Eile: Excel or Data: Import From File: Excel, the Excel file is imported into an Origin workbook and all
Origin features are available.

6.1.10.1 Arranging Child Windows

Origin 2022b adds some new window arranging tools that go beyond the basic Tile
“ME) and Cascade functionality. Users in industry and research who work with high
s {¥ds resolution monitors and many windows should find the tools helpful.

6.1.10.1.1 Arrange Windows Dialog

Central to using these tools is the Arrange Windows (winarrange) dialog (Window: Arrange Windows).

B Arrange Windows: winarrange — x
il

Dialog Theme =

Arrange windows in a certain sequence.

Columns
Sorting Order

Window Name

First by Window Type
Direction

Overlap Each Column

3

Auto

By Window Mame Ascending

Short Name

O

@ Horizontal First

() Vertical First

L

Offset (Title Bar Height=10) | 10

Restore

Apply

Cancel
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Use the dialog to sort and arrange windows in the Origin workspace.

e Divide windows into how many columns?
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e  Sort by order of activation, Project Explorer order, or window name (ascending, descending).

e  Sort within window type.

e  Horizontal (left to right) or vertical direction (top to bottom).

e  OQverlap each column (cascade) by user-defined Offset.

®  Save settings as a Dialog Theme.

6.1.10.1.2 Snapping Windows

Windows that are arranged in rows and columns can be "snapped"; that is, dragged and resized along a
common edge. The visual cue for engaging the snap is a green bar.

1. Toggle this feature off or on using Window: Snap Windows (Ctrl+F12).

Sparkjlnes /Jm.: 1 J P
L[ v [+]v]\T305K T T T

H EE=]

(=3 AQ)

Long Mame | Wavelength
Units nim
Comments
Fix)=
Sparklines

[« [» [+[v]yT325K

Long Mame | Wavelength
Units nm

Comments

Fix=

Amplitude

mYy

e To resize a single window without snapping, press SHIFT while dragging window border.

e  Swap two window positions by pressing ALT while dragging the window title bar.

e To snap a window into an empty space, press SHIFT while dragging.

6.1.11The Command Window and Script Window

The Command Window can be used to issue LabTalk commands to Origin, to do simple mathematical
calculations, or to check the value of LabTalk variables. The Command Window maintains a time-stamped
command history that can be carried over from session to session, and intellisense which provides auto-
completion features when writing X-function commands.
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The Command Window is dockable and has two panels. The left-hand panel displays the command history,
while the right-hand panel provides the command line.

The Script Window provides some of the same functionality as the Command Window. It lacks some of the
Command Window's features (no intellisense, no command prompt, no command history) but it is handy for
running simple LabTalk commands (e.g. changing the value of a LabTalk system variable). The window's Tools
menu also opens the LabTalk Variables and Functions dialog box where you can view a list of Origin
variables, functions, macros, loose datasets, etc.

To open the Command Window:

® Click the Command Window button on the Standard toolbar. Alternately, select Window:

Command Window menu or press ALT+3.

To open the Script Window:

®  Select Window: Script Window menu or press SHIFT+ALT+3.

6.1.12The Formula Bar

The Formula Bar is similar to formula bars in OpenOffice and Excel. While it is not necessary to use the
Formula Bar to enter cell expressions, it does offer the advantages of function search, interactive range
selection and improved visibility of expressions, particularly of long expressions that exceed cell width.

TLED *

Currently-
selected

Plot  Column Worksheet Format Analysis  Statistics |mage Tools Preferences Comnedivity Wind
gl sEEE o+ BERE BESE & AWEDe 6.
m @y . & Ua@ . wooeautadal - 9 B I U = =
a /o = (B1:

c b 4 < fx stddev(B1:810) N\

| o oo o owr o e -

2 o fx =stddev(B1:B10)

Expression/Text,
Current Cell

-
=

Function Lookup

Al
Drag Edge to Resize

1. With a workbook active, toggle the Formula Bar on or off by clicking View: Formula Bar on the main
menu.

2. To change font size, change the value of LabTalk system variable @FBFS (default is “130").

For more information, see the Workbooks, Worksheets and Columns chapter.

i e The Search Functions dialog that is opened from the Function menu in certain

dialogs (e.g. Set Column Values) can be opened by clicking Tools: Search

Functions.
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6.1.13The Status Bar

\“& Cell Formula: =stddev(B1:B10) 3 Average=0.35958 Sum=0.35958 Count=1 AlU: ON 1: [Book1]Sheet1!3[1:1] Radian

The Status Bar is located at the bottom of the Origin workspace. It reports multiple parameters, including:

e Help messages and tool descriptions.

e  Statistics on the current workbook, matrix or graph selection.
®  Whether the AutoUpdate analysis feature is turned on.

® The name of the System Theme, if any.

. Information pertinent to the active window.

e  Angular unit (radians, degrees, or gradians).

e  Tool tips for functions listed in the Set Values F(x) menu.

e Notifications from OriginLab, represented by a small red flag to the right side of the Status Bar.

Average=0 Sum=0 Count=0 ™} All: ON 1: [Bookl1]5hes

1 Motifications from OriginLab n
 Dismiss All|
Origin Central Update v2 X

Graphing and Analysis samples updated’added

- Line and Symbaol Graphs - Colermapped Line Series opju

- Column and Bar Charts - Evenly Spaced Column Plot with Numeric X opju
- Line and Symbaol Graphs - B&W Line Plot.opju

- Multi-Panel Graphs - Treat Each Source Graph as a Unit and Add

Labals opiju

- Batch Processing opju

Customize and Copy Status Bar Data

® You can select what shows in the Status Bar by right-clicking on the Bar and selecting (or clearing) items

from the context menu.

e Copy displayed statistical values by selecting Copy Statistics from the context menu. The copied data are

TAB separated between quantity and values, with each key value pair separated by a CRLF delimiter.

6.1.14Smart Hints and the Smart Hint Log

Smart Hints are triggered by user actions and are intended to give the user help with current task. These
hints may appear briefly inside a dialog box, as in this example.
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Symbol | Drop Lines | Label | Color List |

e Size CollC): "Mass’ v Scaling Factor 216116 = _
In-Dialog
O E Edge Thickness  Defaut il Smart Hint
Edge Color Index:Col{D): "Ty... w /
Fill Calor

Go to Color List tab to further customize the colors
Transparency |_,} [ Do not show this message in the future Ib

Alternately, Smart Hints may appear in the lower left corner of the Origin workspace, as in this example.
[ x]
You can press Shift key and dick on the menu to open the
dialog with theme loaded,
[ Do not show this message in the future %

Unless you hover over a Hint, it will quickly fade. You can prevent display of individual Smart Hints by checking
the "Do not show this message in the future" box at the bottom of a Smart Hint.

Hints are logged for the current Origin session and can be reviewed by clicking the Smart Hint Log tab,
docked at the edge of the Origin workspace (Note that in-dialog Hints are not logged).

[ YL AL L ULUYL L s SLULLFLALLF 11U

Origin menu for quick analysis.

[B7/14/72813 16:89:86 2325
Select Gadgets: Quick Fit from
Origin menu for quick analysis.

£7 B0 JUIH PewWS

To open (and close) the Smart Hint Log window:

1. From the Origin menu, select View: Smart Hint Log or press ALT+7.

To prevent a particular Smart Hint from displaying again in the current session, right-click on the hint in the
Smart Hint Log window and check Do not show this hint again from the context menu. A message asks you
to confirm that you do not want to show or log this message.

To turn off all Smart Hint display in the session, open the Script Window and type the following:

@SHS = 0;
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To turn on Smart Hint display (including those were individually hidden), type @SHS = 1, and click Help:
Reactivate All Hints.

When you set the value of a system variable using the Script Window, you are altering
Origin's behavior for the current session only. To set the value of a system variable
across sessions, see this FAQ.

6.1.15Code Builder

Origin integrated development environment (IDE) is called Code Builder. Code Builder provides tools for
writing, compiling, and debugging your Origin C functions. Additionally, it can be used for running and
debugging Python code.

To open Code Builder:

A
1. From the Origin menu, select View: Code Builder or click the Code Builder button G on the Standard
toolbar or press ALT+4.
2. Code Builder can also be opened by clicking Connectivity: Open untitled.py. In this mode, you can

paste and run Python code by pressing CTRL + F5.

6.1.16Messages Log

The Messages Log window shows messages about operations including Output Information, Results and
Errors. It displays messages that are not sent to the Script Window or the Command Window.

To open (and close) the Messages Log window:

1. From the Origin menu, select View: Messages Log or press ALT+6.

6.1.17Results Log

Origin automatically types many analysis and fitting results to the Results Log. Each entry in the Results Log
includes a date/time stamp, a window name, a nhumeric stamp which is the Julian day (see Dates below), the
type of analysis performed, and the results.

In most cases, when results are reported to the Results Log, it opens automatically. Manually open (or close)
the Results Log by doing one of the following:

) == o
1. Click the Results Log button on the Standard toolbar. Alternately, from the Origin menu, select

View: Results Log or press ALT+2.

Right-click in the Results Log to open a shortcut menu with commands to Copy, Print, Clear..., and View
Results.

6.1.18Float, Dock and Auto-Hide Windows

There are several Origin windows, which can be floated, docked, auto-hidden, or hidden. These windows
include Project Explorer, Results Log, Command Window and Messages Log. This allows you to
customize your Origin workspace so as to maximize utility and save screen space.
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6.2 Numbers in Origin
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Displayed vs. Actual Cell Value: When you import or type your data into a workbook or matrixbook,
Origin uses a combination of user-specified settings to determine how to display the data in each cell.
What displays is a visual representation of the data value. The actual data values are stored with the full
precision allowed by the dataset's Data Type (see table below). When you perform calculations, it is the
actual data values that are used and not the displayed values.

When Contents Exceed Cell Width: Prior to Origin 2020b, if the sequence of characters in a sheet cell
exceeded what could be displayed at the current cell (column) width, Origin represented cell contents as a

series of pound signs (######). This has changed to mimic MS Excel's worksheet behavior:

e  Text strings will not trigger display of pound signs ###### regardless of column width. To
view the full string, you must increase column width.

e Numeric values that exceed column width will first be rounded to the nearest decimal and
only if that is not sufficient to display the full integer value, will pound signs ####HH+#
display in place of the numeric value.

e  This rounding of numeric values affects the displayed value only. The internally-stored value

does not change.

e To restore the old behavior of displaying pound signs #####+# whenever cell contents were
not fully displayed, set system variable @WPE = 1. For information on changing the value of
a system variable, see this FAQ.

Missing Values in the Worksheet: When spreadsheet programs first appeared it was recognized that
there was a need for a special number that was "not a number" which would - when used in a calculation -
generate itself. Origin has such a number and its internal value is -1.23456789E-300. Because Origin
recognizes this value as a special value, it can be used to enter a missing value into a worksheet or matrix
and it can be used in calculations or scripts (for instance, to return a missing value unless some condition
is met). Origin displays missing values in a worksheet or matrixsheet as "--". However, you shouldn't

confuse this display (output) with what you enter as a missing value (input).

Decimal, Scientific and Engineering Notation: You can display workbook or matrixbook data in
Decimal:1000, Scientific:1E3, Engineering:1k, and Decimal:1,000 notations. You can manually
choose from these data display options but you can also pre-define thresholds for automatic display of

scientific notation. By default, these thresholds are set to 6 (upper) and -3 (lower).

Dates and Times in Origin: Origin's long-time mathematical system for dates and time is based on
Astronomical Julian Day Numbers, with a 12 hour offset. This system defines January 1, -4712 (January 1,
4713 BCE), 12 hours Greenwich Mean Time as zero. Recently, two alternate time systems were added: (1)
a true Julian Date value (O is at noon instead of the following midnight) and (2) a "2018" system in which
0 is defined as 00:00 on January 1, 2018. The 2018 system supports greater precision when, for instance,
importing data with the Import Wizard (e.g. Custom Date Format supports "MM'/'dd'/'yyyy
HH':'mm':'ss'.'"###H###"). Previously, precision was limited to 0.0001 seconds. For more information, see

Dates and Times in Origin.
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Note: For more information on numbers, see

Help: Origin: Origin Help > Origin Basics > Elements of the Origin Workspace > Numbers in
Origin

Origin workbooks and matrixbooks support the following Data Types:

Workbook Matrixbook Bytes Range of Values
double double 8 +1.7E+308 (15 digits)
real float 4 +3.4E+38 (7 digits)
short short 2 -32,768 to 32,767
long int 4 -2,147,483,648 to 2,147,483,647
char char 1 -128 to 127
byte char, unsigned 1 0 to 255
ushort short, unsigned 2 0 to 65,535
ulong int, unsigned 4 0 to 4,294,967,295
complex complex 16 +1.7E+308 (15 digits), each 8 bytes

6.3 Topics for Further Reading

(] Project Explorer

(] Customizing Toolbars

(] Mini Toolbars

e The Object Manager

e Finding Data in your Origin Project

. Basic Child Window Operations

(] Numbers in Origin

(] Dates and Times in Origin

e FAQ: How do I turn off the collapsible menus and show full menus?

e  Customizing Toolbars

e  Setting Your Preferences
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e The Numeric Format Tab of Preferences: Options
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7 Origin File Types

7.1 Roundup of Origin File Types

A series of Unicode-compliant (UTF-8) file types was added for Origin 2018. Upgrade
users may recognize that some of the old familiar file types now have a Unicode
counterpart, denoted by an appended ‘u* (e.g. *.opj => *.opju). Origin versions 2018
and later will read and write the older, non-Unicode file types. As the default is to save
to the newer Unicode-type files, be sure to set the Save as type drop-down if you

need to save to an older file type.

File Type

File Extension

Used As

Origin Project
Files

*.opj(u)

A container for all data.

Child Window
Files

*.ogw(u);*.ogg(u);*.ogm(u);*.txt

The child windows for workbooks (.ogw(u)), graph
(.ogg(u)), matrix(.ogm(u)), notes (.txt).

Template Files

*.otp(u);*.otw(u);*.otm(u)

A stored customizable suite of data-handling and
format options: graphs(.otp(u)), worksheets
(-otw(u)), matrix(.otm(u)).

Import Filter * oif An external file which handles basic import file

Files ’ parsing and data extraction.

Fitting Function | 4 A fitting function definition file.

Files

Region of One or more sets of XY coordinates that define the

Intgrest Files *.roi position of one or more regions-of-interest (ROI)
within a given matrixsheet or Image Window.

:;ﬁte);—alk Script *.00s A text file organized in sections of LabTalk script.

Origin C Files *.c;*.cpp;*.h;.etc A file used for developing Origin C programs.

X-Function An Origin tool with a flexible mechanism for

Files *.oxf;*.xfc; performing a wide variety of data manipulation

tasks.
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Origin Package — A package file created for distributing custom
Files -op applications.
A file that contains Origin menu information. An
Origin Menu * yml*ome: * xml can be edited outside of Origin for menu
Files o ’ customization purposes. An *.omc file contains the
configuration of customized menus.
Initialization % ini A file that controls the configuration of some Origin
Files ) features on startup.
IC:ticl)enSflguratlon *.cnf A text file that contains LabTalk script commands.
Custom Plot - A binary file that holds the bitmap images of custom
origin.uds
Symbols symbols.

7.2 Topics for Further Reading

®  Opening, Closing and Backing Up the Origin Project File

(] Protecting Origin Projects

(] Origin Template

Files

e The Theme Organizer

e System Themes

. Import Wizard, Save Filters Page

e  Origin Fitting Functions, the Fitting Function Organizer and the Fitting Function Builder

(] OGS Files and Getting Started with LabTalk

(] Running LabTalk Script from OGS Files

L] Using X-Functions in LabTalk

(] Packaging Multiple Files as an OPX File
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8 Import Data

For data import tasks, click the Data menu or toolbar button

we g (Dot Ju G

Data menu ... Data menu...

Connect to File
> G5V Excel, HTML, JSON, ORJU, etc.

Import From File
> ASCIl, Image, 3rd party
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Solumn  Warshert Ryt

B A o

Copy & Paste
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Import Wizard

Connectto Web
> SV, Excel, HTML, JSON, ORJU, etc.

Connectto File
> Origin, HDF, Matlab, etc.

Connect to Database
> 50L data

Connect to Web
> Origin, HDF, Matlab, etc.

Import From File
> ASCII, Excel, many 3rd party

> Import Wizard (ASCII, Binary, U-def) : ; P
de
Data menu__ Drag & Drop Import E ﬁ"wf'
Import Wizard > Connectors (limited types) 5 i
> ASCII, Binary > Import Filters {builtn) ' e
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A new generalized data import mechanism we call Data Connectors was added in Origin 2019b. As the name
implies, Data Connectors create a link between your project and an external source file. The source file may be
local, it can be on a company network; it can even be on a web-server. Data Connectors support options for
excluding imported data when saving the project (smaller files, plus, maintain a live link to source data) and
for protection of data against accidental alteration or deletion. Data Connectors also make possible import of
previously-unavailable data sources, including HTML Tables and JavaScript Object Notation (JSON). Data
Connectors support drag-and-drop and Auto Import on Project Open. In addition, OriginLab continues to
expand Connector support to new data formats. In Origin 2021b, for instance, we have improved Connectors
for National Instruments TDMS and NetCDF files; plus we've added a new Thermo Fisher Scientific
MSRawfFile Connector.

Other supported import mechanisms:

e  OriginLab continues support for Origin's long-standing X-Function + filter-based routines for ASCII,
CSV, Excel, binary files, and many third-party formats, including MATLAB, pClamp, NI TDM and NetCDF. If
you are a long-time user and you have import filters and Themes that you have long relied on, they
should still work as they always have.

e Copy-paste for quick import of simply-structured data (mostly useful for quickly adding data to
worksheets).

e  For complex ASCII, binary or User-defined file types, you can use the graphical interface of the Import
Wizard to parse your file and save settings to an import filter file. The Import Wizard supports power
features such as saving file metadata to variables and use of custom Origin C functions for data
processing and import.

e |If you work with SQL databases, you can use Origin's Database Connector and SQL Editor interface to

create connection strings and SQL queries.
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8.1 A Note to Upgrade Users

Longtime Origin users who are upgrading from older versions should note that import routines have moved
from the File menu to a new Data menu. Here, you will also find Origin's newest data-import tool: Data
Connectors.

@ OriginPro 2022b - UNTITLED *
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Data Connectors are a general mechanism for importing data to your Origin projects from local or from web-
based files and pages. Data Connectors differ from older Origin import methods primarily in two default (but
modifiable) behaviors:

e Data imported via Connector is locked to editing. This helps ensure data integrity.

e Data imported via Connector is not saved with the project. This helps to keep your project files smaller.

Data Connectors support a number of common data formats, including:

e Text/CSV

e Excel

(] MATLAB

e  Origin File (project, workbook, matrix)
e HTML Table

e JavaScript Object Notation (JSON)

e HDF

e TDMS

e NetCDF
e N42

. Import Filter (use a custom import filter with the Data Connector mechanism)

To connect to SQL database, see Database.

To import data with a Data Connector:

1. With your workbook active, click the Data menu.

. If you are connecting to a local or network file, click Connect to File and pick a file type.
e To connect to multiple files, click Connect Multiple Files.

. If you are connecting to web data, click Connect to Web and enter a URL.

8.2.1 Things to Know about Data Connectors

e By default, when import data file size exceeds 500kB, the imported data and graphs made from that data
are NOT saved with the Origin file (see LabTalk system variable @FSE). All analysis output resulting from
imported data ARE saved with the Origin file. Not saving raw data with your project file can significantly
reduce file size and improve performance when working with large projects.

(] IMPORTANT: Since, by default, connector-imported data (> 500kB) is not saved with the project file,
users should always ask themselves whether they need to preserve imported data. This could be an issue

when the data source is web-based and stored in a place beyond your control. If you prefer to save all
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data imported via a Data Connector, with your Origin file, click the Data Connector icon and clear the
check mark beside Exclude Imported When Saving prior to saving your file'. Note that each Data
Connector-containing book will have its own Exclude... check mark. Alternately, if you decide the Data
Connectors are not needed, you can click the Data Connector icon and choose Remove Data Connector

(from this book) or Remove Data Connectors from All Books (in the project).

Data can be re-imported at any time by clicking the Data Connector icon (% or %) in the upper left
corner of the worksheet and choosing Import (Ctrl+4) or Import All.

By default, imported via a Data Connector is locked from editing. You can graph it and analyze it but you
cannot modify it. While this ensures against accidental modification, some users may find this too
restrictive. Unlock sheet data by clicking the Connector icon and choosing Unlock Imported Data. See
this FAQ for more information on removing editing restrictions from Connector-imported data.

A workbook can have only one type of Connector (e.g. Text/CSV). For files with a simple structure such as
Text/CSV, you can have multiple sheets with each connecting to a separate file, as long as they share the
same Connector. For files with more complex structures such as Excel or MATALAB, you will initially
connect to one sheet/variable, then use the Data Navigator's Add and Connect Sheet(s) shortcut menu
command to add other sheets/variables in the book, as needed. You can only connect a single Excel or
MATLAB file to a single Origin workbook or matrixbook.

In books containing files with a simple structure (e.g. CSV), when you right-clicking on a sheet tab and

add a new sheet, the sheet is added with an empty Connector. The unconnected state is denoted by a

pale-yellow Connector icon % (see Connector states, below). Click on the Connector icon to open a

shortcut menu where you can connect the sheet to a data source.

[ S|
| A
Import
Import All Sheets
Impaort All Books
Auto Import 4
Unlock Imported Data
———— Disconnect Sheet B8
IElF Remove Data Connector... < ? |r

Remove Connectors from All Books...

Exclude Imported When 5aving
Common Data Path (Undefined]...
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e Data Connectors that you do not use can be hidden by choosing Data: Connect to File: Customize...

and clearing the checkbox next to unused Connectors.

e Data Connectors for file formats not shipped with Origin, are available by clicking Data: Connect to File:

Add New.... New Data Connectors are added to the Data menu.

Data | Plot Column Worksheet Fo

Connect to File - JSON
i‘" Connect to Web... Crigin File
Connect to Database L4 HTMIL Table
[ Connect Multiple Files... Impart Filter
BY Clone Import AT
'Eg ;E-Impnrt Dirlvlalctly Ctrl=4 nor
Excel
Hi Rempott.. NetCDF
ﬂ';_‘ Import All Connected Data Text/CSV
Import From File * e Customize...
e A d Mew..,

TOrigin caches data imported by Data: Connect to Web, for a period of time
determined by LabTalk system variable @CFDT, plus file size. By default, a 10MB file
will use cached data for ~24 hrs. In other words, if you re-import (i.e. reconnect to the
web file) within 24 hrs, you will be using data that was cached on first import. If you
re-import to this 10MB file after 24 hrs passes, the cache is cleared and the data are
freshly imported. To learn how to control this caching behavior see, these topics:

e | abTalk system variable @CFDT.

e The LabTalk delete -web command.

8.2.2 Data Source File Path

A Data Connector icon appears in one of five states:

e  When the data source is connected, the icon looks like this: !—"

e  When data in the sheet are unlocked to editing (either by the Connector menu or @1PDC=0), the icon

looks like this: %

e  When a data source import is pending, the icon looks like this: %

® When a new sheet is added to a connected book, an empty Connector is added to the sheet and the icon

looks like this: %
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e  When the data source is no longer viable (e.g. the data source has been moved), the icon looks like this:

2

Regardless of the state of the connection, you can click the Connector icon, then use the Data Source File
Path and Common Data Path to help you maintain the connection between your Origin files and your source
data.

8’ Data Source File Path ? x

You can click the radio choice to switch to relative file path

®) Relative 1o Project path )
[ s ata path

File path Origin2019b\Samples\Batch Processing\T273K.csv
Seledt...
Import Project Path E\Project_Data\(Origin 20196 Project Data
| | Import All Common Data Path  E:\Project_Data\Crigin 20196 Project Data'Origin20196'Samples\Batch Processing),

Disconnect Shee I oK | Cancel

— Remave Data Connecdtar...

B Exclude Imported When Saving

B Common Data Path (Undefined)...

]
1g B Common Data Path ? x
4 [ [\ T275K 4 T285K 4 1

E:\Project_Data'Origin 2019b\Project Data\Origin20136\Samples\Batch Processing', | El

This path is saved into the project for connectors in all the books to share

0K Cancel

e Relative to Project Path: If your data are stored in folders under the project file, you could set Data
Source File Path to Relative to Project path. You can then move the project and data sources together,
and their relative paths are preserved. No path corrections are then needed when re-opening the project

file from a different location on your network.

e Relative to Common Data Path: If data sources are under some common path, you could set Data
Source File Path to Relative to Common Data Path. If the files are subsequently moved, you can re-

establish the Common Data Path and then Import All Books.

8.2.3 Data Navigator

The Data Navigator is a collapsible panel that is automatically added to the workbook when you connect to
multi-page/multi-variable files such as Excel, MATLAB or Origin Projects.
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8.2.4

There

Import Data

Hide Mavigator, Restare by clicking B and choosing
Data Show Data Navigator

Navigator | x |»| «—————— Collapse or expand
Excel Sheets MNavigator panel
Gil
Natural Gas «—————— Right-click on a sheet name:
Coal Add and Connect Sheet(s) Add dimmed sheets
Total Primary Eneray Delete Connected Origin Sheet(s) Delete connected sheets
= [ ]
B A) | B0 | cw) [ om [~
Lang Mame Year Crude Ol Production | Estimated Petroleum MNet Exparts Ol Consumption
ol Units 1K BamelsDay 1K Barrels/Day 1K BamrelsDay
aan Commenis || = Enerq.l'lramwﬂon .:dmumstrahﬂ.l
alra Fixe
1 2013 7441 4904 -6618.3613 189461,1285
2 2012 6496 6967 TIT15197 18480.2136
3 201 B§44.7918 -B753 8067 18882.0725
4 2010 B481.8712 -Bad4 537 19180.126
5 20049 5349.8328 -0641.315 187714 | ¥
[«T+T\oa f 1K e

Origin will import data from the first sheet and list other sheets in dimmed type.

Right-click on a dimmed sheet -- or press CTRL or SHIFT and select multiple sheets -- then choose Add

and Connect Sheets.

The file name is assigned to the book Long Name and sheets are the original sheet name is assigned to

sheet Name.

Connected sheets can be deleted from the current Origin workbook.

Data Connectors and Drag-and-Drop

is drag-and-drop support for the file types listed under Data: Connect to File:

For files with a simple header information (e.g. only column name and units), a Data Connector is added
and the file is properly parsed with no need for an import filter.
For files that are not properly parsed (i.e. header information ends up in the data portion of the

worksheet), consider making an Origin Import Filter (*.0if) file using the Import Wizard.

Import filters can be saved to the data file folder, the User Files\Filters folder or in the current window. If
you intend to use a template for your data import, you can save the filter to the window; otherwise the

filter file (*.0if) should be placed either in the data file folder or in \User Files\Filters.

8.3 Connecting to Text/CSV

You can use a Data Connector to import local or web-stored text files (TXT, DAT, CSV). Data Connector
methods work well for these file types, simplifying and in some cases eliminating, some of the problems
associated with Origin's older X-Function-based import routines. For instance, import of date-time data always
required manual configuration of date-time columns. With Connectors, if your date-time data are of a standard,
easily-recognized format, that configuration is done for you automatically.
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To connect to a file on a local or LAN drive:

With the workbook active, choose Data: Connect to File: Text/CSV.

Browse to and select your file.

Set your CSV Import Options. In many cases, you can simply accept defaults and your file will be

cleanly imported, so as a test, try importing data without modifying defaults. If the results are

unsatisfactory, rerun the import and modify the default settings.

In this mini-tutorial, we use the Text/CSV Connector to import a text file with a date-
time component. While older Origin import methods treated the date-time data as text,
requiring the user to manually set the date-time column to Date after import, the Text/CSV
Connector is able to automatically configure the worksheet column on import.

Click the New Workbook button

Hland choose Data: Connect to File: Text/CSV.

2. Browse to the <Origin Program=>\Samples\Import and Export\ folder and open Date

with higher precision.dat.

3. In the CSV Import Options dialog, accept default settings and click OK. Data are

imported to the workbook.

4. Click on the column A header to select the column, then right-click and choose

Properties. Note that Format has been automatically set to Date, Display has been

set to Custom Display and a custom format shows in Custom Display.

@ Book1 *

=

Long Name |

[ ][® =]
A,J‘J\HAA\AN,.\/\,J“\L_\& /

Comments T

B width
Column Width 158
Applyto all M
E options
Flat Designation X W
Format Date w
Display Custom Display £
Custom Display MM/ aNyYYY HH:mm: 55 =82 o

Apply to all columns to
the right (.

In this mini-tutorial, we use a Data Connector to import multiple files. These identically-
structured files have multiple rows of metadata that we want to preserve. So, you will
make use of an import filter file that has been developed using the Import Wizard, to
import the files and write file metadata out to multiple column label rows in each
worksheet. In so doing, you will see (a) how to import multiple files using a Data
Connector and (b) how you can use an import filter file (*.0if) developed with an earlier
version of Origin, to import files using Origin's newer Data Connector technology.

1. Start a new project and with the workbook active, choose Data: Connect Multiple
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Files.
2. In the files2dc dialog box, set the following:
O Data Connector = Import Filter
O Source = Specified Files
O File Names = <Origin Program=>\Samples\Import and Export\S15-125-
03.dat, S21-235-07.dat and S32-014-04.dat
O Same Book = enabled (checking the box will bring all files into one book)
3. Click OK and in the dialog that opens, set Import Filter = Data Folder:
VarsFromFileNameAndHeader.oif

4. Click OK and the three files are imported as separate sheets in the workbook.

To connect to a file on the Web:

1. Choose Data: Connect to Web.
2. If you have a file URL, enter it in the URL box. Otherwise, set File Type to Text/CSV (optional but helps
to filter Recent URLS), then click directly on Recent URLs and pick from the list.

8" Connect to Web O X

Recent URLs 4-——--.\1 File Type -+ Auto Detect E‘

® Basic ) Advanced

URL
... or Paste a URL here

You can use the CSV Import Options dialog to specify a partial import of web-stored
files just as you can for locally-stored files. Check the Partial Import box for guidance
on the syntax used to define Column and Row import.

Note: To learn more about working with the Text/CSV Connector, see the Origin Help:

Help: Origin: Origin Help > Text/CSV _Connector

8.4 Connecting to MATLAB Files

While Origin continues to support older X-Function based MAT file import, Data Connectors offer some distinct
advantages for import of both locally-stored and web-stored MATLAB files:

e Connecting to a MATLAB file at the root level will add all variables as Origin matrix objects in the
matrixsheet.
® Aslider is added so that you can flip through Origin matrix objects in the sheet. You can toggle between

slider and thumbnails using the Slider or Thumbnails Mini Toolbar button.
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e  The Connector also adds a collapsible

as individual sheets, you can right-click on the Data Navigator list and add them.

/ e

E MEBookd - IMG18v73.mat:1/18 d1 ™

IMG18v73.mat
= MATLAB

d1(25

d1(0
d11

ST

Slider or Thumbnails

Data Navigator panel to the window. If you wish to add variables

7 MBookd N&ﬂ"i mat:1/18d1~

o] & s

» [\, MATLAB f [< =

MG 18v73 mat
=/ MATLAB
d1 (2 2
d10
di1

To connect to a MATLAB file:

1. With a workbook or matrixbook active, click Data: Connect to File: MATLAB or Data: Connect to Web

and enter a URL to your .mat file.

2. Select the variables that you want to import (add them to the Browser's bottom panel) and click OK.

Help: Origin: Origin Help > JSON/MATLAB

Note: To learn more about working with the JSON/MATLAB Connector, see the Origin Help:
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8.5 Connecting to NetCDF and Shapefiles

The NetCDF file format is used for sharing multi-dimensional scientific data. The format is widely used in
climate science. Shapefiles are commonly used to store geographic boundaries and other geo-spatial data.

8 Data Connecter Browses =

Comtents [Double-chck to select)

Data Type float
...... Dimension hames tirnel ] * bat{ 120] * lon{300]
Bunensionaity 3
Units mm/day
Descript Mantriy Average of Daily Accumulated Precipiaticn
=5 Precipstation, Manthly Average {mm/day). 1953 =
B 1
4
Cats Range .
Mook Tiprecrp! Mab{™ 1 969-01-01 0000 : 1968-01-01 D2:007) f
[MiBsck Tjprcra! Mat{"1965-01-01 0000  1365-02-01 D2:00") -
[MiBook Tjprecin! Mat{™ 196500 &1 0000 - 19650301 D5:0é")

[MBksok Tipreeip! Mat ™ 1065-00.81 00400 - 1968-04-01 D000}
[MBook Tiprecp! Mat{™1 365-06-01 0000 - 1365-05-01 00-007)
Mook TrmciniMabl™1365-05-01 0000 - 13650601 D0.007)
[MSksck Tiprmeip] Mat{1965-06.81 0040 - 1968-07-01 006"}
[MBook Tiprecin! Mat{™1965-07-01 0000 - 1363-06-01 D2-D0")
MiBiooh Tiprecy! Mat ™1 365-08-07 G000 - 1365-05-01 D2-087)
(Mol Tiprmaip| Mat{1965-00.01 0000 - 13681001 D0-007
{1 9651001 0000 - 19681101 DI

g

..f

Wenihly o verage conmecediveiy 19891181 0008 - 1889-12-01 0004

@008 $803 1000 1500 000 2500 3800 3580

To connect to a NetCDF file:

1. With a workbook or matrixbook active, click Data: Connect to File: NetCDF; or Data: Connect to Web

and enter a URL to your .nc file.

Select the variables that you want to import by adding them to the Browser's bottom panel.
Adjust Import Options (“pencil” button) as needed and and click OK twice.

If a workbook is active but the variable requires a matrixbook, you will be prompted to add a new

matrixbook or an embedded matrixbook in the active workook.

Origin 2022b improves .nc file import:

fq,i-q'w..'.;:.'-
W e  Support for executing Time Axis Skipping first, then applying Averaging

e  Support Across Years for non-Julian numeric year (e.g. 1900).

To connect to a Shapefile:

1. With a workbook or matrixbook active, click Data: Connect to File: Shapefile and browse to and choose

your .shp file.
2. Specify whether to Load Attributes and (optionally) encoding, and click OK.

Origin 2022b improves export of NetCDF data. Now, you can export matrix analysis
results (e.g. Linear Fit of Matrix Stack) to .nc files that can be used in Origin or in

D
JEW' other software. For more information on importing and analyzing NetCDF data and on
using shapefiles, see the Origin Help File. In addition, check out these OriginLab blog
posts:
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® An Introduction to NetCDF Matrix-Based Features in Origin 2021b

e Adding Maps to Graphs with Built-In and Imported Shapefiles

Note: To learn more about working with the NetCDF Connector, see the Origin Help:

Help: Origin: Origin Help > NetCDF Connector

8.6 Connecting to a Cloud Drive

You can connect to Origin, MS Excel and ASCI I files stored on MS OneDrive or Google Drive. Once you've
established your account credentials, connecting to cloud files is similar to connecting to local files:

1. With a workbook active, click Data: Connect to Cloud. This opens the browser for picking files.

2. Use the browser's drop-down controls to switch cloud services or accounts, if needed.

B’ Onelrve - OriginUser2022@0utlook.com x
< OneDrive Refresh fOriginlabyTest_Connect_2022
Type Size| Descrip
Batch Peak Analysis.opj Origin Project 224 KB
ColorScale_in_image_Plot.opju Origin Project 10 ME
Connected _xlsx_csv.opju Ongin Project 61 KB
E| Experimentl.xlss MS Excel 11EB
H Fl.dat octet-stream 9372 Byte
L pulse_indexed.xt text/plain £25 Byte
Sensor Analysis.ogw Origin Window 221 KB
2] T2T5Kecev octet-stream GEE
£ >

o) Cancel

3. Pick a file and click Open.

Note that the first time you connect to a cloud account, you'll be asked to verify that account. OriginLab will
only access and transfer data between your cloud account and your local computer using a temporary file. No
other communication of information occurs.

8.7 Working with Excel Data

There are several ways to work with MS Excel data in Origin:

®  You can copy Excel data to the Clipboard and paste or paste link that data into Origin.
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You can use a Data Connector to import a local Excel file by (1) clicking Data: Connect to File: Excel,

(2) clicking the ﬁ button on the Standard toolbar, or (3) dropping your Excel file onto the Origin
workspace.

You can use a Data Connector to import Excel data from the web by clicking Data: Connect to Web:
Excel (see below).

You can use Origin's older X-Function-based routines to import a local Excel file by clicking Data: Import
From File. This option was recently hidden to accommodate the Excel Connector but if you prefer to use

this method, see this section of the Origin Help file.

Things to know:

Origin imports files of type .xls, .xIsx or .xlsm.

If you are importing data using the Excel Connector, you can refresh your Origin-side data at any time by

clicking the Connector icon @—" and choosing Import; or re-import your Excel data at the time that you
open the Excel-connected Origin project.

If you are using the older (X-Function based) impMSExcel import routine: Certain file import information is
saved to the workbook on import. Having once imported an Excel file to an Origin workbook, you can use
the Re-import button on the Standard toolbar to re-import an updated Excel file -- including those that
contains multiple sheets -- to your Origin workbook.

Origin does not support dynamically linking one Excel workbook with another Excel workbook, nor does it

recognize or translate Excel formulas.

Note: To learn more about working with Excel data, see the Origin Help:

Help: Origin: Origin Help > Working with Microsoft Excel and Connecting to File > Excel

Both the Excel Connector and impMSExcel routines support partial import of Excel
data. For more information, see the Origin Help file topic Partial Importing and Re-

importing.

8.7.1 Connecting to Excel Files

Origin 2022b auto detection of import file header info (i.e. column names, units and
other file header information) is improved for Data: Connect to File: Excel.

L

Origin's Data Connectors create a live link between your external data files and your Origin project.
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8.8

To connect to a local file, click Data: Connect to File or click the @ button located on the Standard

toolbar.

To connect to a web-stored file, click Data: Connect to Web.

You can connect one Excel file per Origin workbook.

If the file is a multi-sheet file, you must first connect to a single sheet. This opens the the Data
Navigator panel (described above) where you can connect to additional pages, as needed.

When all sheets are identically structured, ensuring that the first sheet is properly parsed (e.g. the header

information is correctly handled) will allow you to connect additional sheets without making adjustments.

A B C D E E G
Source: U.S. Energy Information Administration B Excel Import Options ? >
<http:waw.eia.Eov.fcoun'trieg,ﬂ'countw—data.cfm?fips:US#

United States Energy (1980-2013) xls

Estimated

Crude Qil  Petrolenm Oil Excel Sheet il ~
< Year Production et Exporis—Censumption (| proin header lines [ Auto

\%IK 1K IK E Column Labels
glsDay BarrelsDay BatrelsDay Ba

o1

L M
2013 74414904 -6618.3613 189611265 ryrh v
2012 6496.6967 -7371.5197 18490.2136 Uniits

m| =] &
<<«

2011 5644.7918 -8753.6067 18882.0725
2010 5481.8712 -9434.537 19180.126
2009 5349.8329 -9641.315 18771.4

Comments From | <none=

Comments To <nonesx

Partial Import ]

1. Click the New Workbook button to create a new workbook, then choose
Data: Connect to File: Excel.

2. Browse to and open <Origin Program=>\Samples\Import and Export\United States
Energy (1980-2013).xls.

3. In the Excel Import Options dialog that opens, accept default settings and click
OK.

4. In the Data Navigator panel that opens to the left side of the workbook, hold the
CTRL key and select the other three (dimmed) sheets, right-click and choose Add
and Connect Sheet(s). The remaining sheets -- Natural Gas, Coal and Total
Primary Energy -- are imported into the workbook. Note that if the unconnected

sheets are large in size, you can opt to connect to them one-at-a-time, as needed.

Import from File

The import routines listed under Data: Import From File pre-date Data Connectors. While the Import From
File routines are no longer being developed, they are still supported.
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Note, also, that Connectors may not exist for some of the file types listed in this table. If no Data Connector
exists, you should use the Data: Import From File methods.

1y
The Standard toolbar Import Single ASCII EH putton now calls the Data: Connect
to Files: Text/CSV routine. For the impASC routine, see the next section.

8.8.1 Importing ASCII Files with impASC

1l
e The Data: Import From File: Multiple ASCII... (E?E ) method is generally satisfactory for importing

text files having a simple structure (works for single or multi-file import). This routine will typically handle
files with commonly-used delimiters and a simple header structure, without adjustments.

. If the file import needs adjustments, select the Show Options Dialog checkbox when selecting your
file(s) in the ASCI I dialog. This will open the impASC dialog box prior to file import, allowing you to

tweak the way that the files are handled.

Columnz

Bl Header Lines
Murber of Main Header Lines [exclude subheader lines) 1 -
Auta Determine Subheader Lines [l
Lire Murnber Start frorm Battarn
Murnber of Subheader Lines & -
Extract Long Mames and Unitz from Same Line [l
Short Mames 1 -
Lokg Marmes 2 -

I b= 2 -

Note: To learn more about working with the ASCII Import using the impASC dialog, see the Origin
Help:

Help: Origin: Origin Help > Customizing the ASCII Import Options

8.8.2 Saving Import Settings

Once you've adjusted impASC dialog import settings, you can save them in one of two ways:

e  With the worksheet template.

e As a Theme file from within the impASC dialog box (including saving for drag-and-drop).
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Saving import settings with the worksheet template offers portability (e.g. templates are easily shared with
colleagues). Saving import settings as a Theme offers the advantage of being able to recall any humber of
import options combinations (Themes) when importing via the impASC dialog box.

For more information on Themes and templates, see the Customizing Origin chapter later in this User Guide.
Additionally, see topics listed under "Topics for Further Reading", below.

|, You can quickly load your custom import theme from the list at the bottom of the Data
menu. You can also use the Data: Import from File: Add/Remove File Types ...
menu to open the Import Menu Customization dialog box where you can select and
add User Themes to the Data: Import From File menu.

8.8.3 Third Party Formats

If a Data Connector does not exist for a certain third-party format, you can still use Origin's older X-
Function-based import routines. These include many widely-used formats, including pClamp, NI TDM, and
NetCDF. As with all X-Function-based routines, you can customize third-party file import options and save your
settings with the worksheet template or as a dialog Theme for later use. As with other supported file types,
you can import third party files by drag-and-drop.

To Learn More, see

File Type Method Help: Origin: Origin Help > Importing

and Exporting Data

Thermo (SPC, CGM)
pCLAMP (ABF, DAT, AB?)
Princeton Instruments (SPE)
Sound (WAV)

NetCDF (NC)

CDF (CDF)

HDF5 (H5, HE, HDF5)

NI DIAdem (DAT)

Famos (DAT, RAW)

ETAS INCA MDF (DAT, MDF)
IgorPro (PXP, IBW)

Prism (PZFX, XML)

MATLAB (Mat)

Minitab (MTW, MPJ)
KaleidaGraph (QDA : . i i
SigmaPlot ?JNI(B) ) Rit:: ;Weeort > Importing Third Party Files
MZXML(mzData, mzXML,
mzML, imzML)

EarthProbe (EPA)

EDF (EDF, BDF, REC, HYP)
Somat SIE (SIE)

JCAMP-DX (DX, DX1, JDX,
JCM)

HEKA (DAT)

SPSS (SAV)

BRUKER OPUS

SAS (sas7bdat)

Tektronix (ISF)

Data Translation (DCF, HPF)
Binary 2D Array (IMG, B2D)
Image
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Note: Some of these 3rd party file formats are hidden by default. To add, choose Data: Import From
File: Add/Remove File Types.... This opens the Import Menu Customization dialog box where you
can choose which file types to show in the Import From File menu. To insert a separator after a menu
command, right-click on the command in the right-hand panel and choose Add Separator. To remove a

separator, double-click on it in the right-hand panel.

L If no Data Connector exists for a given file type (i.e. those listed in the table above),
then drag-and-drop support is managed by file extension, using the Filter Manager
dialog. From the main menu, click Preferences: Import Filters Manager....

Note: To learn more about working with the Third-party Formats, see the Origin Help:

Help: Origin: Origin Help > Importing Third Party Files

8.9 The Import Wizard

For import of complex ASCII files -- those not satisfactorily handled by the methods previously discussed --
you can use the interactive Import Wizard. Files with an optional header section followed by a sequential
binary structure, can also be imported using the Import Wizard:

Another advantage to using the Import Wizard to your ASCII data is that you can create import filters that are
targeted to a group of similarly-named data files. This is especially helpful when those files contain metadata
that that needs to be handled in a certain way. The filter can then be used for drag-and-drop import
operations and it can be added to the Data: Import From File menu.

A couple of improvements to Origin Import Filters (*.0if) for Origin 2022b:

Gand i ®  You can add your import filter file to the Data: Import From File menu.
Subsequently, when you pick your filter from the menu, the Open dialog will only

show files that match your filter.

Uzer Defined 2 2022 3:11 Ph e folde

| 515-125-03.dat 11/1/2018 5:06 PM DAT File
Mj 521-235-07.dat 11/1,/2018 5:06 P DAT File
| 532-014-04.dat 11/1/2018 5:06 PM DAT File

y | §*-** dat .

Open as read-only Cancel
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. In prior versions, the default was to apply a filter to all files with .dat, .txt or .asc
extensions. Henceforth, the default will be to name the filter as the current Wizard file
and to only apply the filter to files of the same name. As was the case in earlier
versions, the user can still modify the Applicable File name, and using wildcards,

expand the list of files to which the import filter (.oif) applies.

To run the Import Wizard:

=
Choose Data: Import From File: Import Wizard... or click the @ button located on the Standard

toolbar.

Develop Origin import filter files (*.oif) for import of ASCII files not handled satisfactorily by the Text/CSV

Connector.

Import data from the web pages using the Clipboard (see below).
Extract variables from the import file name and header.

Specify custom delimiters and date formats to parse your data.

The ability to post-process your imported data using a custom LabTalk script.

Note: For more information, view the help topic:

Help: Origin: Origin Help > Importing and Exporting Data > The Import Wizard

8.10Copy/Paste the Clipboard Data

One obvious way to get data into Origin is simply to copy data to the Clipboard and paste it into Origin. This
can be as easy as selecting a block of data in an Excel workbook and pasting it into an Origin workbook.
However, Clipboard data may not be formatted, arrayed or delimited in a way that makes it easy to paste your
data into Origin. Here are some things you should know:
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Data copied from Excel and pasted to Origin will be brought over with full precision, regardless of the
number of displayed decimal digits in Excel.

When working with Excel files with header information, paste the Clipboard data into data row 1 in Origin
(not into the column label rows), then select a row and use the (right-click) shortcut key commands Set

as Long Name, Set as Units, Set as Comment, etc. to tag your header information.

Data copied from the web can be formatted in various ways. You may have to experiment a bit to find a
method that brings the data over cleanly. If a simple copy and paste doesn't work, try using the Import
Wizard. The Import Wizard provides an interactive interface for parsing Clipboard data, with the added

benefit that you can save your procedure to an import filter file (.oif) for reuse with identically formatted

data. For more information, see the tutorial Using the Import Wizard to Import Clipboard Data.
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8.11 Selectively Import Data by Querying an Origin File

You can selectively import columns of data from an external Origin file by specifying an SQL-like Query in the
Data Connector Browser prior to import.

B Data Connecto

Contents (Double-click to select)
1 ]
= (uerykx Folder
=l Folder1 Folder
= Book2 - 521-23 _.
T 7 Select Query by
Trial Run 2
= MyBook - §15-| e __—— ——
Trial Run 1< |Select Column from Project where Liar li]ia_"'ii‘.@

73



UserGuide_2022b

To selectively query Origin files using the Origin Connector:

1. With the worksheet active, choose Data: Connect to File or Connect to Web.

2. Browse to your Origin file and click Open. This opens the Data Connector Browser.

W

Click the Select Query button

J

Enter your Query in the Select Query dialog, then click OK.

Data will be selectively imported into the active workbook as specified by your query.

Common Keywords:

Keyword Description
_SName short name, e.g. _SName, Sheet_SName
_LName long name, e.g. _LName, Book_LName
Comments comments, e.g. _Comments,
- Sheet_Comments
Column_D1 column user-defined parameter, where 1

is the parameter index

Column_[Name]

column user-defined parameter, where
[Name] is a parameter name containing

spaces
Examples:

Select Column from Project where _SName == "A";

Select Column from Project where _Comments like ""S*3";

Select Column from Project where (Column_P1 like "*y*" and Column_D1 > 3);
Select Column from Project where Sheet_SName like "Trial*";

Select Column from Project where (Book_SName like ""Book*" or Book_LName like

UEFITETY)

For more information, see Examples of using SQL query condition in Origin Connector.
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8.12 Database

Origin supports connecting to databases by ODBC and OLE DB. Additionally, Origin includes a simple SQL
Editor to add connection strings and generate SQL queries within Origin.

To import SQL data, start with the Data: Connect to Database menu command:

® Open lets you browse for and open a saved connection (ODS) or query (ODQ) file.

® New opens the Database Connector dialog.

® | Databaze Connector ? >

El What would you like to use to make the connection?
() Connection string
(®) ODBC data source

() ODBC driver
OWindnws's ‘Data Link Properties” dialog

|:| Encrypt Connection Credentials

QK Cancel

e Connection string: Select this if you already have a text-based connection string for a

given data source (ODBC or OLE DB).

e ODBC data source: Select this if you have defined an ODBC data source via the Windows

ODBC Data Source Administrator applet.

e ODBC driver: Select this if you have an ODBC driver and want to create a data source
applicable to this data connector instance.

e Windows Data Link Properties dialog: Select this if you are using an OLE DB-based data

source such as some SQL Server or Access client libraries.

Other things to note:

e Use the LabTalk system variable @IPDB to control protection of imported range (0O = no protection, 1 =
protected but allow reorder, 2 = protected).

e  Similar to other Connectors, you can opt to Exclude Imported (data) When Saving as OPJU/OGWU.
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Note: For more information, see the Origin Help

Help: Origin: Origin Help > Importing and Exporting Data > Importing Data from a Database

8.13Digitizer

At times, you may only have a graphic representation of some data that you would like to explore further. Use
the Digitizer to import an image file, then digitize the plots, converting your image to numeric data that you
can study and re-plot using Origin's analysis and graphing tools.
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e |Import most common image formats.

® Rotate the imported image, remove noise and calibrate scales by picking start and end values.
®  Pick points on curves manually or automatically.

e  Manually add curve inflection points, as needed.

o Interactively remove points that you do not want digitized.

e  Support for Cartesian, polar and ternary coordinate systems.

To open the Digitizer:

1. Click the Digitize Image Eﬁ button on the Standard toolbar or choose Tools: Digitizer... from the

main menu.

8.14 Saving Origin Files without Imported Data

Users have long had the option of saving Origin files without data. Save Template As..., Save Workbook As
Analysis Template and Save Project without Data, were three options for saving Origin files without data
while preserving settings and operations with the file.

Users now have the option to save Origin files without imported data. This is a particularly attractive option for
those who work with large data files, where saving of that data with the file would hinder performance or
waste disk space.

e By default, data imported using a Data Connector, will not be saved with the book when the import file

size exceeds 500kB. Each book has its own Exclude Imported When Saving check mark and clearing

the check mark on any page in the book will cause all imported data to be saved with the book.

ALK) B(Y) CY) D(Y)
Long ¥ Data Source... L, Area D
(kmz2)
Select...
Comr import
Import All H:I 710
8 143998
Disconnect Sheet -T 36193
Remove Data Connector... 19 10452
. T 99538
E— . Exclude Imported When 5aving ;? 26338

[ T MNetherlands 1.73E7 41526

® Any book in the project -- not only those with Data Connectors -- can be configured to exclude imported
data by right-clicking on the window title bar, selecting Properties, then checking the Exclude imported

data when saving project box at the bottom of the dialog.
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col(4), and Al instead of col(A)[1] in F(x).

Indicate unused cells with a shaded background

Exclude imported data when sav@

The act of excluding data when saving differs from saving a template file in a couple of important
ways:

When you exclude imported data, you are still saving all output resulting from analysis operations on
imported data -- fitting results, statistical analyses, Set Values calculations, etc. -- you just don't save
imported data or graphs of that imported data.

Books which you have saved without imported data retain a "live" link to the original data source. For
Data Connector-containing books, click the Data Connector icon and click Import (active sheet) or
Import All (all sheets in book). For books used for standard file import, activate the empty book and click

Data: Re-import Directly; or click the Re-Import no dialog button on the Import toolbar (see next).

8.15Re-Importing Data Files

There are two import commands in the Data menu that are specifically intended for repeat import of the
same file (i.e. the file path and name must be the same):

Re-Import Directly. When you import a file into an Origin worksheet or matrixsheet, by default a
number of parameters, including file path and name, are saved in the sheet. If you have an external data
file that is periodically updated or you want to reload a standard file into the worksheet, you can re-import

directly without opening an import dialog.

Re-Import.... This menu command opens the corresponding X-Function import dialog box for the file

type so that you can adjust your import options before re-importing.

Notes:

e  Only one file can be re-imported at a time. When you use either of these two menu commands,
only the file associated with the active worksheet or matrixsheet, will be imported. If the selected
data are imported from multiple files, re-importing will fail.

. If you import an ASCII file via the Import Wizard and select Data: Re-Import..., the impASC
dialog will open instead of the Import Wizard.

(] Re-import does not work for Binary or User Defined data types brought in using the Import
Wizard.
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8.16Clone Import

Clone import works by "modeling" an import -- and optionally, an associated analysis operation -- and then
applying what was done to the initial file, to a series of similar files. As long as the active book contains
imported data and associated operations, it can be cloned. In this sense, cloning is similar to creation of an
Analysis Template but is somewhat more limited in power (e.g cannot be used with the Batch Process tool).

Clone import is supported by both Data Connector and X-Function-based import methods. A brief tutorial
will show you the basics of cloning import and analysis operations.

=

Click the New Workbook
Using Window's File Explorer, browse to your <Origin Program>\Samples\Curve

button to open a new workbook.

N

Fitting folder and find a file called SensorOl.dat. Drag-and-drop the file onto the new

workbook. The .dat file is imported using the Text/CSV Connector.

3. Click the column B header to select the column, then click the Scatter button to
create a scatter plot.

4. Click on the X or Y graph axis scale and in the Axis dialog box that opens, click the
Scale tab, then press Ctrl and select both Horizontal and Vertical axis icons in the
left panel. Set Rescale to Auto and click OK.

5. With the graph active, click Analysis: Fitting: Linear Fit and open the dialog box.
Set Recalculate = Auto, accept other default settings and click OK. Answer No to the

Reminder Message and click OK.

6. Right-click on one of your workbook tabs and click Add Graph as Sheet. This will

add your scatter plot with the linear fit results, as a page in your workbook.

1] 4]
| IIEI\SE e Citlinaarl 4 Eiblinearinal & ||
Insert —

Delete
Add

Add Graph as Sheet: [Graph1]

Add Matrix as Shee

7. Make sure the sheet with data imported from SensorO1.dat is active and click the

B3
Clone Import B putton on the Import toolbar.

8. Browse, once again, to your <Origin Program=>\Samples\Curve Fitting folder,
press Ctrl or Shift and select files Sensor02.dat - Sensor07.dat. Click Add Files
and then click OK. What you should see is that using the original book as a model
for import and analysis operations, the Sensor files are imported using the
Text/CSV Connector and, one-by-one, they are processed (it may take a few

seconds for all operations to go to completion).
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8.17 Topics for Further Reading
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Data Connectors

Importing Simple ASCII Data Files

Customizing the ASCII Import Options

Updating Excel Data in Origin.

Video: Use Clone Import to Batch Process More Data Files

Tutorial: Importing Multiple Files into Workbooks Cloned from Active Workbook

Importing Third Party Files

Importing Data by Drag-and-Drop

Tutorial: Updating Graphs by Re-importing Data from a Database

Tutorial: Connect to Web Data by Copy Link Address

Importing Data from a Database

Drawing or Deleting Data Points

Tutorial: The Digitizer
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9 Workbooks Worksheets Columns

Formula
Row far
Math
Operations

Column Label

D tOI'I { Rows for
alasets o Display of File-
Long Name Wavelangth Intens ity Wavelength Intensity or Columa-
Units nm arb. unit am b, unll sqjlcorﬂcrgiaf
Comments Date: 03-27-2013, 11:25:03 (yellow rows)
Integration Time (mseck 200
User-defined 1mn: Nmeagnfrm
Parameter Numbser of Pixels in File: 2048
Row X Cofr- 5.30
Y Corr. -152 68
~ Fixe A+ ncf B + ycf
I Comsction Facior 5.30 -152 68
Peak Value 85494 4095 85024 | =
»__ Gparkding —_ | e L}
189.41 0 184,71 182
189.77 15588 195.07 32
190.13 156.44 195.43 376 User-defined
[ 19049 157 68 195.79 5
190.85 1574 106.15 an2 Earar;wefter
Sparklines - 19121 16052 196,51 784 0w DeIng
Thumbnail 19157 161.08 106.87 8.4 Used for
S 19193 160.8 197.23 8.12 CellHevel
"
Graphic View of 19220 16424 197.59 11.56 — Calculation
Column Data Batch No. 1 {Batch No. 2 A Batch No. 3 ) Batch No. 4 ) Batch No. 5 A Batch Ng | < [

Multiple Sheets in Book
(up to 1024 w/ Unicode File Types)

9.1 Workbook, Worksheet and Column Basics

The Origin workbook is a nameable, moveable, sizeable window that provides a framework for importing,
organizing, analyzing, transforming, plotting and presenting your data.

e Each workbook is a collection of one or more worksheets (up to 1024).

e  Each worksheet contains a collection of columns (up to 65,500) and each column contains rows of cells
(up to 90,000,000).

e  Each column has a Short Name (e.g. "A") that uniquely identifies it within the worksheet and a Column
Designation (e.g. "(X)" which determines how it is handled, by default, in plotting and analysis
operations.

e Each worksheet, and each worksheet column, has data-containing cells identified by row (index) number;

and a preceding metadata containing area ("header™) comprised of optional label rows, including Long

Name, Units, Comments, etc.

81



UserGuide_2022b

For Origin 2022b, two convenient buttons are added to the workbook window: Add
Sheet and Show/Hide Organizer.

Salalll ) 1
. 5 121
A+ [ANRLARZLR
| ..r"'f \\ = .
Add Sheet | Show/Hide Organizer |

9.1.1 Some Workbook, Worksheet and Column Limits

Object Maximum Number
Worksheets in a workbook 1024t
Rows in a worksheet, 1 column 90,000,000
Rows in a worksheet, 5 columns 90,000,000
Rows in a worksheet, 32 columns 90,000,000
Columns in a worksheet, 1 row 65,500
Columns in a worksheet, 100 rows 65,500
Columns in a worksheet, 1000 rows 65,500

T = 255 sheets requires saving file to Unicode-compliant (e.g. *.opju) file format. Unicode formats not
compatible with Origin versions prior to Origin 2018.
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9.1.2 Naming Workbooks, Worksheets and Columns

Workbook
Short Name Column Short Name

and
Long Name

Plot Designation (XY, Z, Er, Label, etc)

SN

s
@ BookShortMame - - Workbook Lon Tame (spaces, numbers and special characters allowed) EI@
AK) | B(Y) | cv | bm In
Lang Name Time Delta Temperature  Magnetic Field  Position L4
Units (sec) (=K (Qe) (mm)
Comments
Fix)= \
Sparklines —
1 .01 40 Bl.6 T071.¢
2 0.02 405 13 100.9 Column Label Rows
3 0.03 40.2 §1.9 100.3 (optional)
4 0.04 40.1 B62.5 100.8
5 0.05 40.2 53.1 100.8
& 0.06 396 63.7 101.7
7 0.07 39.7 64.3 100.8
8 0.08 399 G54.8 102
g 0.09 39.9 65.4 101.2
10 01 39.4 65.9 101.1
11 011 39.3 6G.5 101.2 -

v [+]v] 515-135:03 £521-235-07 £532-014-04 f ] T} am

Baclkward
Forward
Add Sheet
Show/Hide Crganizer

e A Workbook has a Short Name and an optional Long Name and Comments.
Origin uses the Short Name for internal operations.

e Short Name must be unique within the project file, can contain only alpha-
numeric characters (letters and numbers), must begin with a letter and are
limited to 13 characters.

e A Workbook Long Name is optional, need not be unique within the project

Workbooks file, can use any characters in any order and has a limit of 5,506 characters

(including spaces).

To name a workbook, right-click on the window title bar and choose
Properties. Here you can edit Long name, Short name and Comments. Use
the Window Title drop-down to control which name(s) show on the window

title bar.
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Worksheets

A Worksheet has a Name and optional Label and Comments.

The Name must be unique within a workbook.

A Worksheet Name has a 64 character limit, including spaces. These special
characters are not allowed: {}|"<=>Q![].

Worksheet Label and Comment are optional. They need not be unique within
the project file, can use any characters in any order, and can be of any
practical length.

To name a worksheet, double-click on the sheet tab, or right-click on the tab
and choose Name and Comments. More details are listed under

Worksheets, below.

Columns

A Column has a Short Name and an optional Long Name.
The Short Name must be unique within the worksheet. When spreadsheet
cell notation is enabled (default setting), you cannot edit the column Short

Name (see Column Short Name Restriction). When cell notation is disabled,

you can edit the column Short Name. When editing Short Names note that
they must use only alphanumeric characters (no special characters), must
begin with a letter or number, and cannot exceed 18 characters.

A Column Long Name is optional, need not be unique within the project file,
can use any characters in any order and has a limit of 30,000 characters. The
Long Name can be edited directly by clicking in the Long Name cell or by
right-clicking on the column header and choosing Properties from the
shortcut menu.

Dialog box and Status Bar references to data range will use Long Names,
provided that (1) Long Name exists and (2) you have selected Use Long
Names when available (Preferences: Options: Miscellaneous).

Otherwise, Short Names are used.

9.1.3 Workbooks

Origin workbooks are highly customizable and can be saved with data (e.g. Workbook File) or without data
(e.q. Workbook Template). Since they can be configured for many different applications, there is a good

chance that you will collect a number of custom files over time. The New Book dialog is useful for organizing
and choosing these files for use.
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9.1.3.1 New Book and Book Templates

Browse to Select and "Manage"” Mode: B Workbook Templste
Add Templates Delete/Show/HIde User Templates ; 5
Analysis Template

\ // Matrcbook File
: Matricbook Template R
B MNeéw Book -
List Template in
\Q File: New: Fiter | Resat

Workbook/Matrix Menu

’ Workbook File

Scan User Files Folder to
Add Templates

—

Sort by Name, Book Type, All Categories . Friuinded
Category or Location il
Siats by Groupng Column | i - Stabstes ided
nght-click =
All Categories b Moremal wenced
UserDefined e Open Template |+
Statistics e Center
i Set as Default
Hover for Preview s e Mathematics Brtended
Regresuan Clustenng Fitting Statrstes Extended
[
[0 Y ._'"f—“. LR with Resichual Analysis Signal Processing Fittng Estended A
OneXManyY
Miscellaneous
1 X column and B Y columns Open Close
Chlsersymike\AppData\Local OrigenLabh Templates | /
s l .. or Double-click on Name I

To open the New Book dialog:

1. Click File: New: Workbook: Browse or press Ctrl + N.

For Origin 2022, an Open Template Center button &was added to the New Book
dialog. Click the button to browse for additional workbook templates that you can
download and add to your template list.

e The dialog lists both add-on (Extended) and User-defined (User) files.

e  Files can be sorted by Name, Book Type, Category or Location.

e A file preview shows when you hover on the o icon.

e  Right-click on a template name and Edit metadata or Set as Default (e.g. New Workbook button).

Also, right-click to Clear Default.
e Enable Show in Menu to list a window in the New: Workbook or New: Matrix menus.
e  Filter windows by category using the "All Categories" menu.
e  Filter windows by type using the Book Type drop-down menu. Reset to show all.

e Right-click on a template to Set as Default or Edit metadata.
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Enable/disable Show on startup and new project.

Each window's Properties dialog has a Comments box for entering text. These
comments are included in the New Book dialog previews and the Project Explorer
previews. In addition, comments are searchable from the Edit: Find in Project tool.

9.1.3.2 Spreadsheet Cell Notation (SCN)

Origin workbooks support Spreadsheet Cell Notation (SCN). Spreadsheet Cell Notation allows the sort of
cell-level calculations that are familiar to users of spreadsheets (more details below).

By default, SCN is ON for all new workbooks.

A-Z
In Origin 2017 - 2019, when SCN was enabled in the workbook, you saw this icon HH| in the upper-left

corner of the worksheet.

Beginning with Origin 2019b, the SCN icon is hidden (by default) but SCN remains enabled (also by

default) to make room on the workbook window for the Data Connector icon.

Most users will want to leave SCN enabled but in rare cases (e.g. you need to customize the column Short

Name), you may want to turn SCN off. To disable SCN, right-click on the workbook title bar and choose

Properties. Look for the Spreadsheet Cell Notation check box about half-way down the page.

When SCN is turned off, users of all versions will see this icon in the upper-left corner of the

workbook.

If you open a project or workbook window in Origin and SCN is turned OFF in a particular workbook, the

SCN OFF button will display in the upper-left corner. This includes projects or workbooks that were
created prior to Origin 2017. To enable SCN, right-click on the book title bar, choose Properties and
check the Spreadsheet Cell Notation check box.

9.1.3.3 What Types of Data Can | Store in the Workbook?

The workbook serves as a flexible container for all of your work-related data -- not just text and numeric data.
You can add graphs, matrices, images, notes; and store calculations, scripts and variables, text objects and
programmable buttons, and create live links to other project data. Beyond its role as a flexible data container,
the workbook can also serve as a medium for batch analysis and reporting.
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Workbooks Worksheets Columns
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This table summarizes the kinds of objects that can be saved in the workbook window at the workbook,
worksheet and worksheet cell levels, and how to access them.

Element Workbook Worksheet Worksheet Cell
Right-click on the sheet Right-click in the gray P
Graphs tab > Add Graph as area beyond the last E'gg:tcg(;l; ot? the cell >
Sheet column > Add Graph NS oraph

Right-click on the sheet

Matrices tab > Add Matrix as -- --
Sheet

Right-click on the cell >

Images -- -- Insert Images from
Files

Right-click on workbook Click the workbook's Click on the cell and

Notes titlge bar > Properties > Show/Hide Organizer Insert Note with the
p T T————
button > Data Sheets > Mini Toolbar (see
Comments —_—
E— enter notes in box below).
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Element Workbook Worksheet Worksheet Cell
Click the workbook's
Show/Hide Organizer
button > page.info,
Imported Files, User
Tree, etc.
e  The Insert Right-click on the
Variable Dialo worksheet cell and
Variables Added text objects Insert Variables; or

Box (Used with

linked to data/variables

Worksheets)

e The Insert
Variable Dialog
Box (Used with
Text Labels)

select a cell and Define

Name using Mini
Toolbar.

Functions and
Formulas

Right-click in the gray
area to the right of last

column > Show Script
Panel

Select a column, right-
click and Set Column
Values. Alternately,
enter formula in F(x)=
cell.

Click on a cell and use
the Formula Bar or
direct cell entry, to
create cell formula.

Scripts

Right-click in the gray
area to the right of last

column > Show Script
Panel

e  Right-click the
selected
column > Set
Column

Values
e Added

text/drawing

objects and
associated

scripts

File Metadata

Click the Show/Hide
Organizer button on the
workbook toolbar

Links

Enter cell-level links to
URLSs, other worksheet
ranges/cells, project
graphs, matrices and
image files.
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Element Workbook Worksheet Worksheet Cell

Add Programmable
Buttons and Text

-- Labels and Drawing --

Text and Drawing

Objects Objects to the
worksheet.
Arrows - n Right-click and Insert

Arrow

9.1.4 Worksheets

Prior to Origin 2018, an Origin workbook could contain a maximum of 255 worksheets. That number is now
increased to 1024. When you have more than 255 sheets in a book, you will need to save your file to one of
the Unicode-compliant formats (opju, oggu, otwu).

To add worksheets to the workbook, right-click on a worksheet's tab and choose one of the following:

® Insert. Inserts a single worksheet ahead of the active sheet.
e Add. Appends a single worksheet.
e Duplicate Without Data. Duplicates the active worksheet without duplicating the data.

e Duplicate. Duplicates the active sheet, including the data.

I Each sheet in a workbook can have its own set of customizations. When you Insert or
' Add a worksheet, the new sheet is based on the ORIGIN.otwu file, specifically the
version of ORIGIN.otwu that is saved to your User Files Folder (found in UFF if you
have customized this file). To add a sheet that is based on another sheet in the
workbook (including number of columns and special formatting), you would use the
Duplicate or Duplicate Without Data shortcut command.

A sheet has a single Name which can contain spaces and special characters. Optionally, you can add a Label
and/or a Comment.

To edit the sheet Name

1. Double-click on the sheet tab and enter a Name. Alternately, right-click on the sheet tab, choose Name

and Comments and edit the Name field.

System variable @SSL can be used to modify sheet naming behavior. Look for @SSL in the LabTalk System
Variable List.

When mousing over the worksheet tab, Name, Label and Comments appear as a
tooltip.
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9.1.4.1 Worksheet Properties

To open the Worksheet Properties dialog

Right-click in the gray area to the right of the worksheet grid (but inside the workbook window) and

choose Properties.

You can use the Worksheet Properties dialog box to customize properties of the sheet, including...

Display of row labels, header labels and grid lines (View tab).

The number or rows and columns and other sheet dimensions such as column or row header height (Size
tab).

Enabling of rich text, text wrap, how to display truncated cell content, sheet font and color (Format tab).
Auto add rows, ignore hidden rows in plotting and analysis, cell resizing (Miscellaneous tab).
Printing/exporting of grid lines, headers and footers, background color (Print/Export tab).

Script to run after import or upon data change (Script tab).

Display and edit a user tree (e.g. the user adds some configuration info for use in the template) (User

Tree tab).

Note that many of the sheet customizations can be applied at the cell level by right-clicking on a selected cell
and choosing Format Cells.

For more information, see The Worksheet Properties dialog box.

9.1.4.2 Manipulating Sheets with Object Manager

Use the Object Manager's shortcut menu commands to manipulate display of workbook content:

90

List all sheets in the active workbook.
Click a sheet in Object Manager to activate the corresponding sheet in the workbook.

Right-click in Object Manager for access to common worksheet operations, including Delete, Insert, Add,

Move, Copy, and Rename.
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Insert

Creiete
(=i Do Add
Eﬁn” 1 Add Graph &% Sheet: [PanelGraph) — Raman Spectrum
Peak Fit of Sheet1 B
Add Mattio &1 Dhast
Long Nam | Baseline Sheet...
Units F*”"“”D*’“T Right-click on
BaselneData sheet in Object
L-8CK On B12.91663 | 022654 Manha?'ter :0 oper [+
i . a shorcut menu  hout Dats
?E}et 't” 82583326 0.22654
Jec 838.74989  0.22654 )
Manager to 851 66651 0.22654 8 Mave Befare ,
activate sheet 864 58314 | 022654 8 Mave to Begin
'l | b | in workbook of Sheet] B j.Fﬂ_'Pﬂlchu;;;i ;E PeakProp Move to End

N
\“-.._____..-"“../. Hame and Comments-..
Exciwde from Plotting Dialogs

Exciwde from Excel Export

Hamgate

9.1.5 Worksheet Columns

e To add a new column to the right end of an existing worksheet, right-click in the gray area to the right

of the worksheet columns and choose Add New Column or Click the Add New Column +E button on

the Standard toolbar.

e To add multiple columns to the worksheet, make the worksheet active then choose Column: Add New
Columns... from the main menu. Specify the number of columns to add in the Add New Columns dialog
box and click OK; or use the Format: Worksheet... menu item or the F4 hot key to open the

Worksheet Properties dialog, then set the desired value for Column Number in the Size tab.

® To insert a column into the worksheet, highlight a column, then right-click and choose Insert. A column

is inserted ahead of the selected column and column Short Names are adjusted accordingly.

Worksheet columns can be renamed by:

e  Double-clicking on the column heading opens the Column Properties dialog box. Enter/edit Short Name

and/or Long Name.

e Type a Long Name directly into the worksheet header cell by double-clicking in the cell.

e Import a data file and specify that the workbooks, worksheets, and columns be named upon import.

e Use the Enumerate Labels tab of the Worksheet Properties dialog to enumerate or duplicate column
names and labels.

e Type names into a few columns (e.g. Peak 1 and Peak 2), then highlight the cells and drag the bottom-
right corner of the selection to auto fill and enumerate the names for other columns. This also works for

other column label rows such as Comments. See the above table for rules on worksheet column naming.
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9.1.5.1 Column Designations

As mentioned, worksheet Column Designations (aka "Plot Designations™) generally determine how data are
handled during analysis and plotting operations. For instance, you might select an X column + three Y columns
to perform a simultaneous linear fitting of each Y dataset against a common set of X values. Or you might
select the same columns to graph 3 line plots against a common set of X values. In addition, there are
designations for Z values, for error data, for labels, etc. (for more information, see Column Designation in the
Origin Help file).

Disregard
ar
X Y Z X Error Y Error Label Group  Subject None
=N =R
AR | B(Y) ‘ c@) |D(}{Er¢}‘ E(yEri}‘ F(L) | c(G) ‘ H(S) | |O‘ ~
Lang Mame
Units
Commenis
Flx}=
L [~
[ I\Sheett / | < >

While there are a number of places in the user-interface where you can designate columns during some
analysis or plotting operation, at a basic level, they are set in the worksheet by (1) clicking on the column
header to select a column, then (2) doing one of the following:

® Choose an option from the column-level Mini Toolbar.

e  Click a button on the Column toolbar.

®  Right-click on the column and choose Set As and choose an option from the shortcut menu.

®  Right-click on the column, choose Properties and set Plot Designation.

9.1.5.2 The Column Properties Dialog Box

The Column Properties dialog box is used to customize properties of the column including...

. Long Name, Short Name, Units, Comments, etc.

(] Format (Numeric, Text, Time, Date, etc.).

° Plot Designation.

To open the "'Column Properties™ dialog box:

1. Double-click on the column header.

2. Right-click the selected column(s) and choose Properties....

Use the Properties tab to edit the column Short Name, if desired. Other properties -- Long Name, Units
and Comments -- can be edited here or entered directly into the column label row cells.
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9.1.5.3 Formatting Column Data

Data in the Origin worksheet is treated as either text or numeric data. While the display of text data in the
worksheet is fairly straightforward, the display of humeric data is more complicated.

Unless otherwise specified, all numbers in the worksheet are stored internally as floating point, double
precision (Double(8)) numbers. This includes date and time, data which is formatted to display in degrees-
minutes-seconds or numbers that are formatted to display a fixed number of decimal digits.

When dealing with numeric data, understand that what you see in the worksheet is a representation of a
number that is stored internally. This is important for two reasons:

®  Calculations involving worksheet values are always done on the double-precision number that is stored

internally, not the value that is displayed in the worksheet.

® You can apply various Format and Display options to change the way that this stored number displays in

the worksheet.

I While the central place for formatting worksheet data is the Properties dialog, as
’ described above, keep in mind that there are quick-access Mini Toolbar buttons for
changing the Display of numeric and date-time data. Note that the Eormat of selected
columns must first be set as Date or Numeric/Text & Numeric for these buttons to be

visible.

_@ﬁlﬂﬂqwm o & fi i Qo v ED i o
XY Z | el == | = XY Z ey

i A LA dd.MM.yyyy HH:mm:ss. &4 l} i — E/Auto ]

MM/dd/yyyy HH:mm:ss #&#88#
MM/dd/yyyy hhimm:ss ###EE8

0

.

M/dAyyy 2 %

yyyy-MM-dd . . 3

S Date-time Displayed a

1 Format Digits G
-d-yyyy

@

9.1.5.3.1  Numeric Display Formats

Double-click on a column heading to open the Column Properties dialog.
Click the Properties tab, then set Format = Numeric.
3. Set Display to Decimal: 1000, Scientific: 1E3, Engineering: 1K, Decimal: 1,000 or Custom (see

below).

9.1.5.3.2 Date and Time Formats

By default, Origin stores date-time data as a modified Julian Day value and it uses this number for date-time

calculations. Typically, however, you will prefer to display this Julian Day value in a more meaningful date-time
format:

1. Double-click on a column heading to open the Column Properties dialog.
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Click the Properties tab, then set Format = Time, Date, Month or Day of Week.
Set the Display list to one of the listed options.
If none of the listed options are appropriate you can choose Custom Display and construct your own

custom date-time string using these date-time format specifiers.

| When importing date-time data into the worksheet, Origin will sometimes treat this data
' as text (Origin's CSV _Connector generally does a better job of recognizing date-time
data). If your date-time data are left-aligned in the worksheet cell, Origin "sees" it as text.
You will need to open the Column Properties dialog box and choose your Format and
Display options. When you see that your date-time data are right-aligned in the cell, you
know that Origin "sees" the data as numeric data, displaying in a date-time format.

H imported Date and Time.dat * == ] H imported Date and Time.dat * o |- S
A [ s [~ A0 [ 8w [~
Long Mame Time Signal Long Name Time Signal
Units Units
Comments | Text | Comments | Numieric Formatted as Date |
Fix= / Fix)=
Sparklines VWW Sparklines \ M{V‘N
125.01.2004 09:38:59.50 8555 7 25.01.2004 09:39:20.50 5.4
225.01.2004 09:39:04.50 B5.55 B 25.01.2004 09:39:34 .50 8545
3125.01.2004 09:30:09.50 85.55 25.01,2004 09:39:39.50 354
4 |25.01.2004 09:38:14.50 B5.6 1 25.01.2004 09:39:44.50 85.35
5125.01.2004 09:39:19.50 B5.5 1 25.01.2004 09:39:49.50 8525
6 |25.01.2004 09:38:24.50 8555 ¥ 12 25.01.2004 09:39:54 50 8535 ¥
Ezl\tnslnm Date and Time} "( 3 |r Ilzr\ﬁ.lstam Date and T'lnef |¢ )lr

9.1.5.3.3 Color Format

Origin 2021 introduced a new column and cell Format -- Color.

[ Seurce: https://www.wischools.com/colors/colors_names.asp * m?‘@
AX) | B(Y) cn [ owm | EM | Fo) @) A
Long Name HTML Color Name Hex Value R G B color| ) function
0= color(C,D.E)

1|Black 0 0 0

2| Navy 0 0 128 Save As Increment List

3| Dark Blue 0 0 139

4 | Medium Blue 0 0 205

5|Blue 0 0 255

6 |Dark Green 0 100 0

7|Green 0 128 0

8| Teal 0 0 128

9| Dark Cyan 0 0 130

10 | Deep Sky Blue #00BFFF )

e  Supports direct entry of HTML color codes into the worksheet cell to set cell background color, with the
option to display or hide the HTML codes in the Color cell.

e  Use the color() function to calculate hex values and set colors from RGB values in other data columns
using Set Column Values or cell formula (e.g. color(A,B,C) sets color using RGB values in columns A, B
and C).
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e Select a column in which Format = Color and use a Mini Toolbar button to Save as Increment List

(color list) for use in your graphs.

e  Alternately, from the Custom colors menu in the Color Chooser, choose Create Color List from

Column and pick a Color worksheet column from the flyout.

EEEETE T EEEEEEeE
O O |

Meore Colors: Systemn Color List -

> [Bookl]colsplitB(Y) : Hex Value
[Bookl]colsplit!F(Y) : color( ) function

| Create Color List from Column...
ENEEENEEEEE o
AEEEEEEEEEEn
Customn: test_color_custormn_add - Open Increment Editor...
B BER-+ Last Custom Colors
Recent colors

| |

9.1.5.3.4  Other Custom Display Formats

Origin can display numeric values in the worksheet in a variety of custom formats. This illustration shows
various formats applied to the same set of numeric values (column A(X)).

AR) | B(Y) | C(Y) | DY) |
default T&N *2 8.3 E.2

055737 0.56 5.57T4E-01 557.3Tm
097082 0.97 9.703E-01 970.82m
065931 0.66 6.593E-01 659.31m
0.8495 0.85 8 495E-01 849 50m
0.82661 0.83 8 266E-01 826.61m
0.80481 0.80 8 046E-01 804.61m
0.66641 0.67 6.664E-01 666.41m
0.65464 0.65 6.546E-01 G54.64m
0.74152 0.74 7.415E-01 741.52m
0.62085 0.62 6.208E-01 620.85m

Column Properties > Properties tab

1. Select the column.
2_Right-click and choose Properties.
3. Click on the Properties tab.

G(Y) | H(Y)
# HHHH DM S
3461 =33z
3334 0=5815"
60/91 0=39°34”
79/93 0°50°58"
B2/75 0°49°36"
7087 0=4817"
213 0=3959”
36/55 =37
G6/29 0°44°29”
d8/20 ——

Text & Mumeric w |

Do not convert text to D
numeric during data entry

Display

Custom w

Custom Display |¥.DD% i

Apply to all columns to the D

right

The following is a sample listing of some supported custom format options (this just happens to be the pre-
populated list that ships with Origin 2019). Note that you can enter custom formats directly into the Custom

Display list and they will be saved to this list.

There are many other format options. For more information, see Custom Numeric Formats.

o Example
eliuf Description if cell value = 123.456
*n Display n significant digits. *3 displays 123
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o Example
Format Description if cell value = 123.456
.n Display n decimal places. .4 displays 123.4560
Sn Display n decimal places, in scientific notation of the S.4 displays
' form 1E3. 1.23456E+02
E.n Display n decimal places, in engineering format. E.2 displays 123.46
* i Display a number as a decimal, followed by the *"pi" displays
symbol 1. 39.297271
. Display a number as a fraction of 1, with a Wi A
#4 "pi denominator of "4". #/4 "pi" displays 157m/4
#1# "pi" Display a number as a fraction of . #/# " pi" displays 2751/7
S Dlsplgy.a number as tyvo dlglt.s, a "+" separator, then s+ displays 01+23
two digits (e.g. surveying stations).
S M Dlsplgy_a number as one 9Iglllt, a "+" separator, then #+##M displays 1+23M
two digits, plus a suffix of "M".
#n Dlsp_lay a number as an integer of n digits, pad with 45 displays 00123
leading zeros as needed.
#% Display a number as a percentage. #% displays 12346%
# #H1H#H# Display a number as proper fraction. g:/tgé## displays 123
# #/n Display a number as proper fraction, in nths. # #/8 displays 123 4/8
DMS Display a number in Degree® Minute' Second"”, where DMS displays
1 degree = 60 minutes, and 1 minute = 60 seconds. 123°27'22"
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o Example
Aol LA Ad if cell value = 123.456
Display a number in Degrees and Decimal Minutes.
D MDn EW ii al ol o |
(longitude) Pgrameter n specifies decimal p aces. Positive values D MD3 EW displays
will have "E" or "N" appended, Negative values will o
D MDn NS r e i 123° 27.360 E
(latitude) have _W or "S" appended. If you wish to preserve
negative values do not append "EW" or "NS".
Display a number in Degrees and Decimal Minutes.
D MDn EWB Parameter n specifies decimal places. Letter "B"
(longitude) ("before") specifies that positive values should have D MD3 EWB displays E
D MDn NSB "E" or "N" prefixed, negative values will have "W" or 123° 27.360
(latitude) "S" prefixed. If you wish to preserve negative values
do not append "EWB" or "NSB".
Display a number as a 32-bit hexadecimal (max 8 .
0, 0,
/oi#x hexdigits). The "#" symbol specifies "Ox" prefix. /6féx displays 0x7b
Display a number as a 32-bit hexadecimal (max 8
%#0Nnx hexdigits) notation, as an n-character string, pad with %#06x returns 0x007b
leading 0 as needed.
Display a number as a 64-bit hexadecimal notation o
%#0n164X (max 13 hexdigits, 15 total including #="0x"), as an n- %##014164X returns
; : - 0X00000000007B
character string, pad with leading 0 as needed.

9.1.6 Column Label Rows

Origin 2022b adds cell Notes support to column label rows, including the F(x)= column
formula row. Select a cell and on the Mini Toolbar, click the Insert Note button.

Insert Mote

5 alkares
- o B s ey == ey e T : e = 2

Wama] Tame | g “— A CAS Registry Number is a numeric identifier that can contain up to 10 digits, divided by hyphens into three parts

Uinils. * The right-rost digit is a check digit used to verify the validity and uniqueness of the entire number.
fijCihane. | Fd-ad-0 G2 For example, 58-D8-2 is the CAS Registry Number for caffeine.
7| Hopfare | 142-82.8  C7r Source: hitpsy//www.cas.org/support/documentation/chemical-substances/fags
3| Hexana 110-54.3 CEL..,
4|isabutane | 75-28-5 C4H1O 58.12 Colorless gas 1596 AT X ol

Column label rows store metadata -- data that is used to describe other data. Typically, this metadata may be
brought in as header information in imported files, or it may be manually entered. Display of column label rows
is optional and the user can selectively show them or hide them, as needed.
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Column label row information is often used in plotting operations (e.g. worksheet Long Names used as graph
legend text or Axis titles). The F(X)= row is used in performing math operations on columns of data (see
below). Data stored in User-defined Parameter rows might be used in labeling or grouping of datasets in

plotting, data manipulation, statistical analysis or math operations (see Tutorial 2, below).

i=2 Book1 - automobile. dat

A BiL) YY) By Eiv) i)
Long Mame 0~G0 . Gas Engine
Manth Make Fovver miph Weight Mileage Displacemen
b SEC ko rmpg Lo
Comments
Sparklines fﬂ,ﬂ “l Mwl || /"’H.’M
Cec Buick 132 2238 arv36.5
Dec Acura 154 12 2324 11 212
Dec GMC 148 13 1631 10 a900.4
Cec Chrysler 132 10 20848 12 B277.4
Cec kia 121 12 1202 12 a736.5
Cec Suzuki 106 10 1417 14 a736.5
Cec Yoo 45 14 166G 13 a0y
Dec Mercedes 132 14 2208 12 573645 _
\autnmnhllef ﬂ 1 | | LH

You can copy a selected subrange of worksheet cells and include associated column
label row information with the copy-paste operation. To copy label rows with data cells,
right click on your subrange selection and choose Copy (including label rows).

9.1.6.1 Managing Display of Column Label Rows

Display (showing or hiding) of column label rows is controlled by shortcut menu commands:

-

BH 51512503 - 515-125-03.dat * 1 (=@ ]|[=]
A00 | BYY | cm DM | 4
Long Mame Time Delta Temperature  Magnetic Field = Position
LInits (sec) (K) (Oe) (mm})
ents
Sparklines / k [—
1 0.01 60.6 101.7
2 0.02 40.5 61.3 100.9
3 0.03 40.2 51.9 100.3
4 0.04 401 §2.5 100.8
5 0.05 40.2 631 100.8
6 0.06 306 63.7 101.7
7 0.07 397 64.3 1008 —
4]r 451512503 f |« e v [
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Right-click here and choose View from the shortcut menu.
Right-click here and choose Edit Column Label Rows or other label row command.
3. Right-click here to control worksheet elements (display Row Label, Column Header, etc) or select a cell in

this area, then right-click to Set Comments Style.

There is also a worksheet column label row Mini Toolbar for managing label rows. Use it to do such things as
hide selected label rows, enable Rich Text or change label row order.

Long MName Time Delta Temperature  Magnetic Fielo
LInits (sec) (KD (Oe)
Cor S = no 515-125-03 515-125-03

IE P. £} | Rich Text

ezt S~ |/
) B 2.1 21

Sample fBCO milled  YBCO milled YBCO milled
Measured o [ 12/01/2004 12/01/2004 1210112004
Time: [03:20:39 AM 03:20:29 AM 03:20:39 AM

Run Type: | Trial Run 1 Trial Run 1 Trial Run 1

9.1.6.2 Column List View

Origin 2019 introduced a new view mode for the worksheet called Column List View that is a transposed
view of the column label row metadata. This view is potentially useful if your worksheets have many rows of
metadata and you want to focus on some particular aspect of that metadata. With the worksheet active,
choose View: Column List View or press Ctrl + W.

S Rch Sompies - |
L acy [ en [ em [ oo [ e [ em [ e WFZ) W) wom | wm [ wm |-
Lang Nims Time Dol Temmetsly MagradiFisid Paslan Tim Ouhs Tareeili  Nagnelic F isid Pralion Tima el Tamgesvihl Wighalic Fiei [y
e [T =) o peT [ane ) " i ) =i 0 ey
FHORSTS | gutrssd) | SSS00  SIBIED) | SN0 | ENAOT | EDEDT | S3aNa) SR004  BIREAL  BXROMAME  SIO0Md |
o T R TN et e S e g A
werion 21 21 2 21 21 13 X 35 15
s of paanes a0 1300 004 ] o0 840 880 88 a5
Hampls| TECOmAs | YBCOmise  YECOrsiet | RGO miied | TBOO mied THED miiing B0 miwo-5qu 00 miied-s cuaBCE milled seusBCD mied-su
Maasared on 13017004 12004 122004 RO 1IN ST004 1IN RI00E 130V00 125007004 APL-A s ) 120%700H
[ Tew| 0I30WAM | DX309AN XM A 10NN | 030830PN a0 P DUDGOd AN GADUOAAN D20 04 A (el 20004 A
e Topw | T i 1 g 3 = = e
SaaeiD © 515 ol Bekeh Sermples *
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Jt' B(Y1) | Detts Tempesters () FIES00 S~ 21 1008 VBCO mid 1DO12008 DIIEIHAN  TralFun 1 S15 125 3]
A CIr1) | Mageats Faig o) BB T 21 Won YECO miled 1D0VR00M OIPUI9 AN TralFum 1 B15 125 [:%]
Lol v O{r1] | Posiion immmj sieEmn N 31 ] VECD miled 10V 03203 AH  Trial Aun 1 515 s L]
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Further, you can apply a data filter to metadata in Column List View. When you return to the standard
worksheet view (clear the mark beside View: Column List View), only data associated with the filtered
metadata will show in the worksheet.
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I Column List View displays column index number ahead of column short name (+ column
' designation). In addition, you can hover on the left edge of column long name and a
tooltip reports dataset size. To disable the display of column index, set @DSI=1.

Column Toaoltip reports dataset size on hover
index _ Long Name\ | Units |Comments|

1 1) e (sec) S15-125-0
1) erature (K S15-125-0
3 C(Y1) | 1,000]ic Field (Oe) 515-125-0
4D(¥1) [l201 n (mm) 515-125-0
S5EM2) | 202 (sec) S521-235-0
6F(Y2) | 203 emperature (K) 821-235-0
TGN2) |l204 dcField [Oe) 521-235-0
_8BHNZ) [l2z05 n (mm) 521-235-0
9I(X3) |[Time (sec) S32-014-0

10 1(Y23) |Delta Temperature (K) S532-014

9.1.6.3 Sparklines

Numeric data stored in a column will graphically display in the column header in a special label row called
Sparklines. A sparkline is, by default, a small inset line plot of the data in a column, plotted as the dependent
variable (Y) against the row number or the associated X column as independent variable (X). When importing
data, Origin displays sparklines by default when the number of columns is less than 50.

ALK) B{Y) CY) DY)
Long Mame Time Delta Temperature  Magnetic Field Position
LInits (sec) 9] (Oe) (mm)
Comments
Flx)=
Sparklines 7
T \H\“‘“-—h-q_._ / N
1 0.01 40 60.6 101.7
2 0.0z 40.5 61.3 100.9
3 0.03 402 61.9 100.3
4 0.04 40.1 G625 100.8
5 0.05 40.2 G631 100.8
] 0.06 39.6 637 101.7

To Show or Hide Sparklines:
e  Show Sparklines by clicking Column: Add or Update Sparklines. This opens the sparklines dialog.

Show Sparklines for selected columns by clicking the Add Sparklines button ﬂon the Column toolbar.

Right-click on the worksheet's Sparklines column label row and choose Add or Update Sparklines.

Delete sparklines by right-clicking the Sparklines column label row and pressing the Delete key.
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e In addition to the default line plot, Sparklines can display as Histogram or Box Charts. Highlight one or

more columns by clicking on the column header, then choose Column: Add or Update Sparklines. In

the dialog box that opens, set the Plot Type to Histogram or Box.

con | om e | AX) 8(Y) oY)
Long Name Power 0~60 mph | Weight | Gas Mileage  Engine Displacement Long Mame | Sepal Length | Sepal Width Petal Length  Petal Width
Units few 58C kg Units cm cm cm
Comments Comments
Fix)= Fix)=
Sparklines Sparklines I ; ,—L| r___
1 132 14 2238 11 5736.5 11 54 37 15 0.2
2 154 12 2324 11 5212 12 43 34 16 0.2
3 158 13 1531 10 5000.4 13 4.3 3 14 0.1
4 132 10 2088 12 6277.4 14 43 3 11 01
5 121 12 1202 12 57365 15 58 4 12 0.2
6 106 10 1417 14 5736.5 16 57 44 15 04
7 95 14 1661 13 5031.7 17 5.4 39 13 0.4
] 132 14 2208 12 5736.5 18 5.1 35 14 0.3
a 128 13 1412 12 5736.5 19 a7 38 1.7 0.3
10 124 17 1518 13 5800.4 20 5.1 38 15 0.3
11 110 1n 1R1N 11 R212 24 EA 24 47 N

e  Sparkline plot properties can be customized. Double-clicking on a sparkline pops open a graph window.

Double-clicking on the pop-up window opens the Plot Details dialog box where you can customize the plot.

When you close the pop-up window, your customizations are applied to sparkline.

9.1.7 The Workbook Organizer

As mentioned, the workbook commonly stores metadata, some of which is visible in the column label rows.
Other metadata may be hidden in the workbook. Such hidden metadata might include things like import file

path and name, date and time of data import, file header information not written to the column label rows,
variable names and values, etc. This hidden metadata can be viewed in the Workbook Organizer panel.

To show (or hide) a workbook's Organizer panel:

e  Click the Show/Hide Organizer button on the workbook button bar.

e  Right-click on the workbook title bar and select Show Organizer.
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] F3-Fadat” | [ | [
ALK} B(Y) C(Y) A
Long Mame | Experiment Data: 09/01/07
Lnits | Temperature: 372
Comments -
ime
ser Sample Error
Fix)=
Sparklines

LGN N A

0
26
52
78
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0.32975
0.33097
0.32563
0.33003
0.33067

0.00163
0.00232
0.00188
0.00219
0.00208

B F3

= Data Sheets

]

_—— 1324 0 29asd 0 00908
[ e LA i ARIRE / I<

First sample set. Readings taken after 24 hr treatment with Na25204,

iy

B F2
B F3

= page irfo

SYSTEM.IMPC
SYSTEM.PLOT

= Imported Files

£ Fldst v

Right-click on the nede to edit

Bl layerinfo
Ma Info.

B user Tree
Mo Info.

=1 =]
i

Starting with Origin 2022b, you can add separate plain-text Notes to each sheet by
highlighting a sheet under Data Sheets in the Organizer panel.

9.1.8 Managing Workbooks with Mini Toolbars

A number of common book-, sheet-, column and cell-level properties can be set or toggled ON/OFF with a
Mini Toolbar button.
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% Book2
kT i —
i ‘ B(Y) | L1 DwEri} @ ffft lnﬂ Q plef: % tﬂI @ Setas ¥ Err |
Long Name Area Months Y1961 Y1967 e g TTIUo
Units (=C) Y Z H—|NDNE -.‘|__-: | (*C)
Comments Temperatu|g .s U| Standard O
Fix=
Filter |  Africa
Antarctica Miit:ﬁ.r:é?g
Asia e

e To see which tools are available, make a worksheet selection and then hover on your selection.

e  Page-level formatting options are shown by hovering in the upper-left corner of the sheet or near the

window margins in the gray area to the right of the worksheet columns.

®  Go here for a full list of worksheet Mini Toolbars.

Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
sessions (i.e. if turned off in the current session, they would be restored on Origin

, HE] b restart). Now, this setting is remembered across sessions (alternately, you can control
L ] Mini Toolbar display by setting system variable @DMT (ON=0; OFF=1)).

9.1.9 Find and Replace in Worksheets

& i V(R o MY ER & @8 [
XY Z = ¢# HDHEE-E}

L

e Clicking Find opens a small dialog for searching the current worksheet selection.
e Small dialog supports string or numeric, forward and backwards search.

e  While the dialog is minimized, you can edit within the selection or press CTRL + Page Up/Page Down to
search backwards or forwards; or change the worksheet selection and restore the dialog to perform a new

search.

®  Click the ellipsis button (...) to open Origin's larger Find and Replace dialog.
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i’ Find and Replace ) >
i [Bookd]"Custom D.. — X Find  Replace
Data Type:  ® Mumeric () String
Find l@ Condition: Find what (Enter -- for missing value):
Minimize or Win+Down to work in worksheet = - |35'5 V‘ﬂ
. Look in:
Ctrl + Page Up/Diown to search previcus/next.
Active Worksheet

Skip linked cells

Find/Replace in selected range
[ Use absolute value

[]5earch up

Tolerance: le-8

Origin has another "Replace" tool that can be scripted: wreplace. To open a Ul dialog,
open the Script Window (Window: Script Window) and type wreplace -d. To learn
about scripting options, see X-Function documentation for wreplace.

9.2 Simple Utilities for Filling Columns with Data

Origin provides several utilities for filling a worksheet range or column, with data. The simplest of these use a
menu command to fill a worksheet column with either row index numbers, uniform random numbers or

normal random numbers. This is useful for generating quick datasets to test and try out other Origin
features.

These simple procedures create a dataset in a pre-selected worksheet range or column(s):

Action Toolbar Button Menu Command

e Column:Fill Column With:Row

Numbers

or
Fill a range or column with row .,dﬂ]

numbers . . .
® Right-click and select Fill

Range/Column(s) With Row

Numbers
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Action

Toolbar Button

Menu Command

Fill a column with uniformly
distributed random numbers between
Oand 1

or

Column:Fill Column
With:Uniform Random

Numbers

Right-click and select Fill
Range/Column(s) With

Uniform Random Numbers

Fill a column with normally distributed
random numbers

or

Column:Fill Column

With:Normal Random Numbers

Right-click and select Fill
Range/Column(s) With Normal

Random Numbers

Fill a column with a patterned or
random set of numbers

Right-click and select Fill
Range/Column(s) With A set

of Numbers...

Fill a column with a patterned or
random set of Date/Time Values

Right-click and select Fill
Range/Column(s) With A set

of Date/Time Values...

Fill a column with arbitrary set of
Text&Numeric values

Right-click and select Fill
Range/Column(s) With
Arbitrary set of Text&Numeric

values...

The auto fill feature can be used in filling column label rows and the worksheet data cells:

To use auto fill to extend a pattern in the data across a range of cells (numeric data only):

1. Select a contiguous block of cells and move the mouse cursor to the bottom right corner of the selection.

2. When the cursor becomes a "+", hold down the ALT key and drag the mouse to the bottom or the right.
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To use auto fill to repeat a pattern in the data across a range of cells (text or numeric data):

1. Select a contiguous block of cells and move the cursor to the bottom right corner of the selection.
2.  When the cursor become a "+", hold down the CTRL key and drag the mouse toward the bottom or to the
right.

Datasets can also be generated quickly using LabTalk script. As an example:

1. With a new worksheet active, open the Script Window from the Windows menu, and copy-paste the

following lines of script code into that window:

col (1)={0:0.01:4*pi};

col(2)=sin(col(1));

2. Highlight the two lines and press ENTER to execute them. The first two columns of the worksheet will be

filled with data.

9.3 Setting Column Values

I Access to Origin's built-in functions has been improved in recent versions:

® The Set Values dialog and the F(x)= cell get Auto Complete support. Begin

typing to see a list of possible functions.

® The Search Functions dialog that is opened from the Function menu in the Set
Values dialog can now be opened directly from the Tools menu (Tools: Search

Functions).

The Set Values dialog box is used to set up a mathematical expression that creates or transforms one or
more columns of worksheet data. The dialog box includes a menu bar, a control used to define output range, a
tool for searching and inserting LabTalk functions into your expression, a column formula box used to define a
one-line mathematical expressions, a Before Formula Scripts panel (usage optional) intended for data pre-
processing and defining of variables used in your one-line expression and for Python users, a Python
Function tab for defining and using Python functions which can also be used in your expressions.

106


http://www.originlab.com/doc/User-Guide/Programming-in-Origin
http://www.originlab.com/doc/Origin-Help/Wks-SetColVal-QuickStart

Workbooks Worksheets Columns

] Set Values - [Bookl]Sheetl!Col(D)

Forrnula weol{l) Col(A) Function Variables Options

I
(g
£d

Faow [i] From <auto: To <autox k
Menu commands

Search and insert functions

CallD] = Save formula —3 | [iJ ﬁ|

rpeak - rbase * dnorm

Put column formula here

£ () () (o)

Before Formula Scripts = Python Function

S/ Point to spectrum, baseline, and ocutput column P
range rpeak = 2, rbase = 3, raubk = wcol(j)s ‘

1L

S/ Compute normalization factor using lst data point
double dnorm = rpeak[l] / rkase[l]; \ —

LabTalk script to be executed before applying formula ™

Since Origin 2017, the column formula box (the upper box) in Set Values has supported a simplified
spreadsheet cell notation like is used in MS Excel and Google Sheets. A cell is addressed using column

Short Name + row index number (e.g. the first cell in column A -- formerly represented as "col(A)[1]" -- is
now simply "Al1").

In new workbooks, spreadsheet cell notation is enabled by default. Spreadsheet cell notation can only be used
in defining the column formula. It cannot be used in the Before Formula Scripts panel of Set Values, nor can
it be used in your LabTalk scripts. Note that the "old" column and cell notation will work in spreadsheet mode,
so if you are an experienced user and you prefer to use the old notation, you may enter it as you always have.
For an introduction to the spreadsheet cell notation syntax as well as a contrast with the "old" methods, see
Column Formula Examples.

To open the Set Values dialog box for a single column:

1. Select a worksheet column or a range of cells in a worksheet column.

2.  From the menu, choose Column: Set Column Values... or right-click on the worksheet column and

choose Set Column Values... from the shortcut menu.

To open the Set Values dialog box for multiple columns:

1. Select multiple, contiguous worksheet columns (skip no columns) or the entire worksheet.
2.  From the menu, choose Column: Set Multiple Column Values... or right-click on the worksheet column

and choose Set Multiple Column Values... from the shortcut menu.
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P

1] Set Values - Multiple Columns =]l @ 5]

Forrnula  weel(l) Col(A) Function Variables Options

Faow [i] From <auto: To <autox )
_ Specify the range of
Col (i) Fram 3 To 8 columns by column index

weolfj] = Efi\l l<| [<<| [22] {221

wool({j-3) * 3

j refers to the index of current column

[ (Goms) (o8]

Before Formula 5cripts  Python Fundion

Note: Other controls and panels are similar
to the Set Values dialog for single column

9.3.1 Set Values Menu Commands

Because Long Names need not be unique within the worksheet, Origin 2022b now
displgys both Long Name and Short Name in the formula box.

b
L W Bl o i
AR B €I ) Eiv} Fi . -
[CLomiame| wawvengh  Ampfode | Wovmngn | Ampkse | Wweengn Am B3 Set Values - [TI63KITI6SKICal(L) X
[—_.tnis] m my nm my m i

ﬁ Formula  weol(l) Col(d) Function Variables Options
> = = S A by 1
e Jq\_-?\m L A i J"- Row (i) From | <auto> To | <auto>

3 B A amz au I = I K 1 << | lwd! B
81 (15} ar DL a8 {‘{U} E L& !
1] 2

1 H

col (c"Wavelength™)
N

am i M
ant LEE] axn
am 8223 a\
am D a3

k| a4
A Lo T+ [l Task

Recalculate [Auto, v ﬂ ok | [ cancel | [Appy| [
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e Formula: Load a saved formula into the column formula box. Formulas are
saved using Formula: Save or Formula: Save As....

e wecol(1): Use the menu to include worksheet columns in either your column
formula or your Before Formula Scripts (column reference is inserted at the
cursor). A Column Browser is available to help in selecting the correct

columns. Columns are listed by column index.

e Col(A): Similar to wcol(1) menu functionality but columns are listed by

column name (including Long Name, if it exists).

e Function: Add LabTalk functions to your expressions (function name is
Menu

inserted at the cursor). Note that when you hover over a function in the menu
Commands

list, the function description will be shown in the Status Bar. When a function
is selected, its description will be displayed in a pop-up Smart Hint.

e Variables: Add a variable or a constant to Column Formula or Before
Formula Scripts; Add range variables (including by selection) or file
metadata, to Before Formula Scripts.

e Options: Allow direct editing of column formula in worksheet Formula row;
add a comment about the column formula; or preserve text in Set Values

columns (do not treat as text as missing values).

e Add a single line expression for generating data. Functions, conditional

Column Formula operators and variables can be used.

e labTalk scripts to be executed before the expression in the column formula
Before Formula

i box is executed.
Scripts

e Define and use Python functions in your expression.
Python Function

I When you mouse over one of the functions listed in the Function menu in Set Values
' dialog, a one-line tooltip is displayed in the Status Bar. If you select the function, a
Smart Hint appears with a more detailed explanation and a link to the full function
description, syntax, examples, etc.

Additionally, you can click the Search and Insert Functions M button to search for
available functions by keyword and, once found, insert the function into your
expression.

To learn more, see Set Column Values - Quick Start

9.3.2 The "F(X)="" Worksheet Column Label Row

For simple expressions, you can use the F(x)= row to set column values. Any expression you enter here is
directly entered into the Set Values dialog and vice versa. Note that the simplified spreadsheet cell notation
that works in the formula box in Set Values also works in F(xX)=:
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1. Double-click in a cell in the F(xX)= column label row.

2. Enter an expression to enter output in the data column below.

AX) B(Y) cry) @& DY) &
Long Mame Wavelength Intensity Wavelength Intensity
LInits nm arb. unit nm arb. unit
Fix)= A+ucf | B +ycf
Correction Factor 530 -152.68
1 189.41 0 18471 -152.68
18877 16588 185.07 32
3 18013 166 44 18543 376

| Note that there is "Auto Complete" support for Functions and Named Ranges in the
; Formula Bar, cell formulas (begin typing with "="), the F(x)= cell and the Set Values
dialog. Hints are linked to function documentation (Functions) or data ranges (Named
Ranges).

3.5.2.30 Movrms

Contents

| cm | o |[ES
ay1 Decay2 Decay3

a.u. a.u. Description
mov The functicn returns & veclor to calculate the oot mean square(ms) of adiscent Fanges [i-nb, i+
&k \\ Ly The roct mean square of adjacent ranges at point | & ghven by
= Mmovavg e
— s Py
5 7 91E § LT naow == L
3 ! 147 -'g Movavg Tons =\ Qb+ nf+1
1 :]] g LTZ Maoveoef where ryfy is the backwarnd offset and r f is the forward offset

LT b
?g = Movrms Movrms(vd.back[.forward])
70 "Tz Movslope

545 Takes a vector vd and returns the root mean square(RMS) of
6074 adjacent ranges [1-back, i+forward], for a point 1 (1 = the current
54 55 row number). example:

* col (B)=movrms(col(k),0, 2);: fills COI(B) with RMS at
each point for data within the window [1, 1+2]).

If you prefer not to use Auto Complete, you can disable it by setting system variable

@FAC=0.

9.3.3 Set Column Values Tutorials

Tutorial 1: A Quick Units Conversion using F(xX)=

Start with a new workbook and import the file \Samples\Graphing\WIND.DAT.

2.  We will assume that column B contains Speed values in miles per hour (MPH). Click
on the column heading for column C, then right-click and choose Insert. Origin
inserts a new column C and moves Power values to column D.

3. Now, we'll convert the MPH values in column B to kilometers per hour (KPH).
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Double-click in the F(x)= cell of column C and enter

B*1.6
and press Enter. Column C is filled with values in units of KPH.

Tutorial 2 : Computing Moving Average and Moving Standard Deviation
1. Import the file Samples\Signal Processing\fftfilter1.DAT.

e + A

Add two more columns to the worksheet by clicking the E twice.

Click on the header of the 3rd column to select it, then right-click and select Set
Column Values... from the context menu.

4. In the Set Values dialog, enter the following in the upper panel:

movavg(B,5,5)

and press Apply. Column 3 is filled with an 11-point moving average of the data
from column B (note that you can insert functions such as movavg from the

Function menu of the Set Values dialog box).

Click the >=> button above the edit box to switch to the 4th column.

In the edit box for the 4th column, enter the formula:

movrms(B,5,5)

and press OK. This 4th column will be filled with root-mean-square (RMS) values,
using a window size of 11 at each point.

Tutorial 3: Set Values for Multiple Columns

1. Create a new project by clicking the New Project D button on the Standard
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toolbar.

FLEEN
Click the Import Multiple ASCII = button to import the files F1l.dat and F2.dat

in the <Origin Folder=>\Samples\Import and Export\ path. In the impASC dialog,
set Multi_File (except 1st) Import Mode to Start New Books and click OK.

Two workbooks are created, named as F1 and F2. Click the New Workbook

button on the Standard toolbar to create another workbook.

. . . +

With the 3rd workbook active, click the Add New Columns E button to add a
column. Highlight all columns and select Column: Set Multiple Columns Values
from the main menu or right-click the columns and select Set Multiple Columns

Values from the shortcut menu to open the Set Values dialog box.

et
Expand the bottom panel by clicking the Show Scripts button. Enter this

script in the Before Formula Scripts edit box,

range ril=[F1]F1lwcol(J); //"j" is the column index.

range r2=[F2]F21wcol(j);

Enter (r1+r2)/2 in the Column Formula edit box

Select Options: Direct Edit Formula Cell to clear this option.

Select Options: Formula Text... and enter (F1+F2)/2 in the Formula Text
dialog, then click OK.

Click the OK button in the Set Values dialog box. You will see the results in the
worksheet, and (F1+F2)/2 will display in the F(x)= column label row instead of the

formula.

9.4 Setting Cell Values

Origin supports cell-level expressions similar to those used by spreadsheet programs. Cell-level expressions
which return a single value (numeric, string or date/time) can be entered into any worksheet data cell or into
cells in a User-Defined Parameter row of the column label row area. When Edit Mode (Edit: Edit Mode) is

toggled on, cell formulas display. When Edit Mode is toggled off, the formula result is displayed. Cell content
can be edited regardless of Edit Mode state.
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400 () v | om | ag | v | em | om |
Long Mame Morning Evening Stats Long Mame Moming Evening Stats
Units (=F) Units (=F}
Comments Meming Evenin Commenis Mgining i
Count User Parameter =couniid, 1) :munt[ﬁ?ﬂ Count | = User Parameter 49 55
Fix)= Fix)=
1 §7.08375 §7.06043  =meaniA) =mean(B) 1] 57.09975 §7.08043 58 23458 5815735 |
2 972 4700407 =StdDeviA) =StdDew(B) 2 a7.2 97.09497 04952297 0.50379
3 07.20991 97 46701 3 97.20991 97 46701
4 97.40002 97.53114 4 97.40002 97.53114
5 - 97.51223 5 - 97.61223
1] - 97.40801 6| 47 40901
[ - 97.65766 7 - 97.65766
8 - 97 53376 8 - 9763378
9 - 97.44921 g - 97.44921
10 - 97.52057 10 - 97.52057
11 47.60003 97.71328 1) 97.60003 a7.71328
12 97.50993 97 58163 12 97.59993 97.58163
Edit Mode ON § Edit Mode OFF

e To use cell formulas, Spreadsheet Cell Notation must be enabled (it is by default).
e  Cell formulas begin with an equal sign (e.g. =B1 - C1).
e  Cell formulas can return a numeric, a string or a date-time value.

e Cell formulas can incorporate cell references, variables, operators, LabTalk-supported functions and

constants.
(] Cell formulas can reference values in other sheets or books.

e  Cell formulas can be extended to other cells by dragging with your mouse.

To learn more, see Using a Formula to Set Cell Values.

9.4.1 The Formula Bar

When creating cell formulas, or column formulas using F(xX)=, the Formula Bar makes it easier to find and
insert functions, select cell ranges and view and edit expressions, particularly long expressions that exceed cell
width.

TLED *

Currently-

SEIECtEd Plot  Column ‘Worksheet Format Analysis Statistics |mage Tools Preferences Copnedivity ‘Window
Cell ERR sEHER 4 o - SERFE BSE & alcFEMe 6.

o T @ I - ¥ Ua @ wpoodaut st - 8 » B I U % =-m- A

c1 /" R o fx =stddev(B1:810) ~
Cancel 3 o fx =stddev(B1:B10)
OK Expression/Text,

Current Cell =al

Function Lookup Drag Edge to Resize

To enter an expression into a cell (data cell or F(x)=), click on the cell, then:

1. Enter an "=" and type your expression; or click the fx button to open the Search and Insert
Functions dialog.

2. Search for the desired function then double-click on it to insert it into your Formula Bar expression.
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3. Interactively select your data range going to the worksheet and (a) clicking on a column heading or (b)

dragging to select a range of cells.

4. When your expression is complete, click the button or press Enter.

Note that you can drag the edge of the Formula Bar to resize it. You can also change
the default font size by changing the value of LabTalk system variable @FBFS (default
is "130").

9.4.2 Set Cell Values Tutorials

Tutorial 1: Extending a cell formula to other cells

1. Click the New Workbook button to open a new book.
2. Click on the column A heading to select, then right-click and choose Fill Column

with Row Numbers.

3. Click on cell B1 and enter:

=A1+A$1

Press ENTER. This adds the value in Al to the value in Al.
5. With the cell still selected, hover on the selection handle in the lower-right corner
of the cell and when it looks like a "+", double-click to extend the cell formula to

the bottom of the column.

6. Click the Add New Columns button +E to add column C.

7. Click on the Cell in C1 but this time enter (omitting the "$"):

=Al+A1

Press ENTER. This adds the value in Al to the value in Al.

With the cell still selected, hover on the selection handle in the lower-right corner
of the cell and when it looks like a "+", double-click to extend the cell formula to

the bottom of the column. Note that this time, the resulting values are different.

10. Click Edit: Edit Mode to display the underlying cell formulas. Note that the "$" in
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column B "locked" the second cell Al reference so that it didn't change but that the
Al reference in column C changed with the row index number as we extended the

cell calculation to other cells.

=AT+AGT | =AT+AT
—A2+AS1 | =A2+A2
=AI+AS1 | =A3+A3
—AA+AS1 | =Ad+Ad
—AS+AS1 | =AS+AS

:'_:34-'_5:1 =ME+A

Tutorial 2: Quickly finding maximum values in multiple columns of data using
special keyword "This"

The only place where you can use cell formulas in the worksheet column label rows
(worksheet header rows), is in a User Parameter row.

1. Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2. With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3. In the dialog box that opens, enter "MaxValue" and click OK.

4. In column A(X), in the MaxValue cell, enter:

=Max(This)

Click outside the cell and cell should now display "10".

Click back on this cell, then grab the selection handle in the lower right corner of
the cell and drag to the right to extend the cell formula to MaxValue cells in
columns B(Y), C(Y) and D(Y). All MaxValue cells should now display the

maximum values in their respective columns.

Tutorial 3: Use a column label row value in a cell calculation

All data in the worksheet column label rows, including User Parameter rows, is stored
as string data. To use a "number" stored in a column label row in a cell calculation, you
must convert the string to a numeric value. In the following example, we use the
LabTalk value() function to convert column label row data to a numeric so that it can
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be used in a cell calculation:

1. Create a new workbook and then choose Data: Import From File: Single ASCII
and import the file \Samples\Import and Export\S15-125-03.dat.

2. With your mouse, hover just to the left of the F(X)= row label and when the
pointer becomes an arrow, right-click and Add User Parameters.

3. In the dialog box that opens, enter "Correction” and click OK.

In column D, enter the value "0.2" into the Correction cell.

5. Click the Add New Columns button +E to add column E.

6. Incell E1, enter:

=D1+value(D[Correction]$)

7. Press ENTER. This converts the Correction value to a numeric and adds the

numeric to the value in cell D1. The cell should display 101.9.

NOTE: The "$" in the above expression does not function to create an absolute cell
reference as in the first example above. In this context, the "$" syntax is used to
express a string variable stored in a user-parameter cell, before converting that string
to a numeric value.

9.4.2.1 Naming Data Ranges

Origin 2022b adds support for named ranges to column label rows. Use, for example,
to incorporate a label row parameter value in your Set Column Values calculations.

You can assign a name to a worksheet data range and use the name in cell formulas or column formulas and
to define Reference Lines in graphs.
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To create a named range:

B Mew Mame >
Refers to [Bookl]Sheet1!D
Name | myMameRange |
Scope Project W
Define as Function s

Bo ck k
X Column
Comment
2]
QK Cancel

Highlight a cell or a range of cells and choose Data: Define Name.

In the New Name dialog box, enter a Name for the selected (Refers to) range.

Assign a Scope to your named range.
Optionally: if you wish to use the named range to return interpolated values, enable Define as Function

P w NP

and/or add a Comment.

To manage named ranges:

1. With the worksheet active, choose Data: Name Manager.

2. Use the dialog to modify name, scope, range and comments.

B’ MNamed Range Manager x
Mame Scope Refers To Comment
Duspl Book [Book3]Sheet1!'B[1:1] Sensor displacement in mm
LeftPts  Project [Book2] Step Signal with Randorm Moise™!D[1:1]  Moving average left window
RightPts  Project H [Book2] Step Signal with Random Moise™!D[2:2]  Moving average right window
Tired Sheet [Bookllabrasion_rawl& Tire 4" Abrazion Tire &
TireB Sheet IEl [Book!]abrasion_raw!B Tire B Abrasion Tire B
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9.5 Remove FormulaZLinks

Beginning with Origin 2022b, you can use a small dialog to remove formulas and links
"MNE! from the current selection, the active sheet, the active book or the entire project. This
L il converts formulas and links to raw numbers.

Removing formulas and links can make it easier to share project data with colleagues without having to share
such things as externally-linked (DDE) Excel files; or to significantly reduce project size before archiving data.

® | Remove Formula/Links ? 4

Replace formula, links with their current values

Remowve Links in Project e

Cell Formula and Links
Column Formula
Excel(DDE) Links

QK Cancel

Things you can convert to raw numbers:

(] Cell formulas
e  Column formulas

e Linked cell values (e.g. values copied a report sheet and paste-linked to other worksheet cells in the

project).

e DDE links (e.g. paste-linked values from an external Excel sheet).

9.6 Cell Notes

Any worksheet cell -- data row or column label row -- can contain a cell note; even those that contain data or
other objects such as images or embedded graphs.

For Origin 2022b, worksheet cell Notes get Rich Text support, meaning you can now
style text using Origin. In addition, you can add images and graphs, and link to
Wi worksheet cell values, report table values, etc. See Notes Windows for Reporting.

1. To add a Note, select the worksheet cell and click the Mini Toolbar Add Note button .
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o | #n S0 ||

Fitted Curv | 0% Q@ Insert Nate — Fited Cunv
SON's 1 rson's i

39587 7 ==
' -]

2. Enter your text. If adding more than brief, simple text, click the Mini Toolbar Open in Notes
Window button. Rich Text is enabled by default.
(Y) | H 3
Fitted Curv| &% @ X Open in Notes Window

30M's T
19587

3. While editing cell notes, use Format toolbar buttons (a) to format your text. To see your note in
"Render" mode (b), press CTRL + M (Notes: Render Mode). To insert the finished Note into the

worksheet cell, click the Close button (c).

Fp Default: Arial = 22 - B I U x, x{afA &« E-1l- A -

) Notes1

This is \bibold) text. ?

This is \i(italicized) text. o

This is (ST text. Render Mode (CTRL + M)

This is subscript text.

This is Greek text.

This is larger text. El 9
~

4. The reinserted Note can be seen by hovering on the worksheet cell.
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T Default: Arial U 2 ~ - & .

+" This is bold text.

This is italicized text.
This is red text.
This is ¢ pscripted text.

This is Tpeek text.
This is larger text.

| . . .
4 For text that is not assigned a paragraph style (see next section), you can use the Font
Size control on the Format toolbar, to control text size. Font Size can be set for each
window but all Notes windows must share a common Font (e.g. Segoe Ul).

A

Origin 2022b supports "substituting” cell Notes in graph legend and text objects using
@WN (e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source
worksheet).

9.6.1 Text Styles Manager

' In addition to styling text with the Format toolbar, you can apply a simple set of styles
to each line/paragraph. Manage styles with the Text Styles Manager dialog box.

1. With a worksheet active, choose Tools: Text Styles Manager.

2. Select a Style to Modify and Apply or Close.
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8 Modify Text Style 7 x
Style to Modily Body Text sl
Font Face T Default: Anal wr |
Size Factor (%) 100 w
Color . Auto -
[ Justification
2 Font Style
Bola O
ttalic |
Underline O

= spacing
Extra Line Spacing (%) o o |
Before Paragraph (pts) o W |
After Paragraph (pts) 3 w |

Indentation (3 of font size)
List HNone W

Delete Cloze

Apply

To apply a paragraph style to Notes window text:

Open the cell note in a Notes window.

Workbooks Worksheets Columns

Note that you can add styles by selecting <new=> from the Styles to Modify drop-down list; or select a style
and Delete.

With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph

Styles and choose a style from the popup menu.

To check results, press CTRL + M (Render Mode).

9.7 Processing Worksheet Data

Origin provides a number of utilities for manipulating worksheet data. Most of these are found on the
Worksheet menu while some are on the Edit, Column or Analysis menus (note that a worksheet must be
active). Some utilities are available from a shortcut menu: select your data and right-click.

Utility

Menu Access

e  Sorting Data

Worksheet:

Sort Range

Worksheet:

Sort Columns

Worksheet:

Sort Worksheet

Worksheet:

Sort Columns by Label
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Utility

Menu Access

Find
Replace

Go To (sheet row/column)

Edit: Find in Project Edit: Find in

Sheets

Edit: Replace

Edit: Go To

Hide Column

Hide Rows

Column: Hide/Unhide Columns

Hide/Unhide Rows (shortcut menu only)

Move Columns

Swap Columns

Column: Move Columns or Column

toolbar.

Column: Swap Columns

Query Worksheet Data

Worksheet:

Worksheet Query

Copy Columns to (new locations)

Worksheet:

Copy Columns to

Append Worksheet

Worksheet:

Append Worksheet

Join Worksheets Worksheet: Join Worksheets by
Column
Worksheet: Join Worksheets by Label

Split Columns

Split Worksheet

Split Workbooks .
Worksheet: Split Columns
Worksheet: Split Worksheet

Split Worksheets by Worksheet: Split Workbooks

numeric column(s) adds

g HENY user-specified
Tolerance
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Utility Menu Access

No menu access. To open the dialog box:

1. Click Window: Script Window.
2. At the cursor, type text2cols -d

Split Cell Strings to Multiple Columns
and press Enter.

For more information, see this link

Stack Multiple Columns into One with

Grouping Worksheet: Stack Columns

Unstack Grouped Data into Multiple Columns
Worksheet: Unstack Columns

Stack Columns Common to Multiple Sheets

by Label

Worksheet: Stack Worksheets

Summarize Data with Pivot Table i
Worksheet: Pivot Table

Filter data by defining conditions on one or Column: Filter menu, or Worksheet

Data toolbar
more columns -

See Also: Data Masking

Worksheet: Remove/Combine
Duplicated Rows

Worksheet: Reduce Columns
Worksheet: Reduce Rows

Data Reduction Analysis: Data Manipulation: Reduce
Duplicate X Data

Analysis: Data Manipulation: Reduce

by Group
Analysis: Data Manipulation: Reduce to
Evenly Spaced X

Worksheet Transpose
Worksheet: Transpose

Convert Worksheet Data i
Convert to XYZ Convert to Matrix
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Utility Menu Access

Worksheet: Conditional Formatting:

e Apply Conditional Formatting to Worksheet Highlight
Worksheet: Conditional Formatting:

Cells Heatmap
Worksheet: Conditional Formatting:

Duplicates

e Reverse Order
Column: Reverse Order

9.8 Conditional Formatting of Worksheet Data

In addition to the above worksheet data utilities, the Origin worksheet supports Conditional Formatting.
Conditional Formatting has three modes:

e Highlight mode opens a dialog box with controls to apply color to worksheet cells based on one or more
conditions (e.g. "equal to", "not equal to", "text that contains"”, etc).

e Duplicates mode opens a dialog box with controls to apply to worksheet cells that contain duplicate
values.

e Heat Map mode opens a dialog box with controls to apply a color map to cells based on worksheet values.
The worksheet Heat Map is zoomable and scrollable, making it easy to get a "big picture" overview of data

variation in three dimensions.
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" B g e g o Lol Annual Average Temperature
1 HALEPELL NT| 1143 #52 MR =43 577 Bas sz Ext I 128
2 [} NT 1064 Lk o2 5 5
3 SPOMAME, Wh| 1174 &LT 620 A - - - »
] CREATFALLE NT| 1113 475 6.2 LS - 4
[ FARGO ND | 960 e 708 - 'P
0 HEMARCK ND | 1008 =E e - : e W, %
il CARBOU VE -8B #E 856 - . 4
(] YAKIMA WA 1204 e LLE] - £
§|  SAULTSTE NAREMI 844 1 538
0 ASTORMA OR | 1238 | 452 801 ¥
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15 SHERIDW WY 10T wus 68 ok @3@3
i BURLINGTOR, T 733 s 06 proLy .
17 NT WASHRGTON. NH 7168 3 48T
8 AOCHESTER, MH| 425 i T
] EUGENE OR 1311 | el [LF] o
+ [+ 1y S Mhean Tempesature ¢ -

Manage conditional formatting in the active sheet using the Conditional Format Manager.

When using 3-Color Limited Mixing to apply color to worksheet heatmaps, you can now
precisely control where the middle color falls. Specify by Percentile, by Percent or by
Value.
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9.9 Workbooks for Analysis and Reporting

Apart from text and numeric data, the workbook can contain various other types of information -- images,
graphs, notes and matrices; links to cell values in other books, project variables, documents or web pages;
plus, import file metadata, variables and scripts -- making the workbook a flexible medium for collecting
research data or for creating custom reports.

Further, as we will see, the workbook can "store" a complex sequence of analysis operations -- for instance,
the application of a data filter, plus a fitting operation on the filtered data, combined with a customized plot of
the results -- into something that we call an Analysis Template. The Analysis Template makes it possible to
automatically generate a custom report of results, simply by supplying new input data.

5] 51512503 - S15-125-00.dat [Fo [ ]
'.I"iﬂ:l‘ll el ]
Tuesday, September 18, 2012
] lull 1 BNl Bl ¥ P '
| FRCD miled 1 | 515 1
Measured On | L] | Batch Rumber | 125 |
+ Positon (mm) | Vales | Siaadard Eiver
. . [ v | woss 00231
_Gaus!-Fl_EMSIS-]lE-DJD 5 Y XE 00 50005
203 = W 1,40 0.0011
[ LLE] 0.9a07
—ﬁ— [ 0.000%5
= 174 1.85 00013
E I \ 0007 T
5 145
H ]
O gy \
-—j e
l:l.l':l 2.9 5.8 ar
Time {sec) i
4 [+ [\ 51512503 JFmiL [ FiNLCurves] ) Custom Report f E 3.

One attractive option for generating reports (there are others -- see the tip at the bottom of this section) is to
export data to a custom MS Word template, and optionally, a PDF file. This is done by running an output-
generating analysis in Origin, then associating key results with bookmarks in a Word template, and, finally,
saving the workbook as an Analysis Template. To generate your report, you open the Batch Processing tool,
point to both your Analysis Template and your Word template, run the batch process and generate your
reports.

e  For information on generating custom reports using an MS Word Template, see the tutorial

Batch Processing with Word Template for Reporting.

e  For information on batch analysis and generating custom reports, see the Batch Analysis

section of the "How to Handle Repetitive Tasks" chapter of this Guide.
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r Another option for generating reports is to create HTML reports using Origin's Notes

' window. A Notes window can link to graphs, worksheet cells, etc., either directly or
using a placeholder sheet. For more information, see HTML Reports from Notes
Windows.

9.10Topics for Further Reading

(] The User Files Folder

®  Origin Template Files

e What is Saved with the Workbook Template?

e The New Workbook Dialog

e  Arranging the Worksheet
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Displaying Supporting Data in the Worksheet Header Rows

Controlling How Numeric Data Display

Dates and Times in the Worksheet

Generating Simple Worksheet Datasets

Column Short Name Restriction

Using Formulae to Set or Transform Worksheet Column Values

Using a Formula to Set Cell Values

Simple Manipulation of Worksheet Datasets

Inserting Graphs, Images and other Objects into Worksheet Cells

Inserting Links into Worksheet Cells

Inserting Variables into Worksheets

Conditional Formatting of Worksheet Cells

Analysis Report Sheets and Columns

Workbooks Worksheets Columns

127


http://www.originlab.com/doc/Origin-Help/WksHeaderRow-DataSupportDisplay
http://www.originlab.com/doc/Origin-Help/Wks-Col
http://www.originlab.com/doc/Origin-Help/WksCol-DateTime
http://www.originlab.com/doc/Origin-Help/Wks-GenerateDataset
http://www.originlab.com/doc/Origin-Help/Column-Short-Names-Restrict
http://www.originlab.com/doc/Origin-Help/Wks-Set-Column-Values
http://www.originlab.com/doc/Origin-Help/Using-Formulae-to-Set-Cell-Values
http://www.originlab.com/doc/Origin-Help/Wks-Manipulate-Datasets
http://www.originlab.com/doc/Origin-Help/InsObject-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsLink-to-WksCell
http://www.originlab.com/doc/Origin-Help/InsVariable-Dialog
http://www.originlab.com/doc/Origin-Help/conditional-format
http://www.originlab.com/doc/Origin-Help/Analysis-Rep-Wks-Cols




10 Matrix Book Matrix Sheet Matrix Objects

Show XY

Display Book Short Mame and/or Long Mame,
plus active objectftotal matrix objects

ar
Show —
Col/Row -m.imuﬁnw‘m* o = -]
Index Y 557813 | 557853.118( 557893.23| 557933.35] 557973.47| 558013.59] 556053.71] 558093.83
079| 444358 0098748 -5096581 198.2151 557 4458 | 536.8206 5440881 5494019 |
1080 | -086174 21915 1406350 | 837.7456 | 0103503 0356158 0440705 0525883
51080 | -13.54047 -3.00889  198.3013 | 8352455 D00 4708 | D24 8105 0360904 9453353
51081 -13.56136 | -3.01364 | 199.8415 | 943.9602 | 904.7725| 9241335 | 938.7389 | 951.9407
51081 |-13.60308  -3.02311 2006620 0528624 | 007.4351 0185458 0370830 0575286
51081 | -13.72035 -3.05319 2027375 | 865.0512  919.7008 | B23.1581 036.7444 9559837
51082 | -13.89543  -3.08787 2050240 0O76.1607 | 038.8082 0420627 0387186 9546320
51082| 1406051  -3.12656 | 2075130 | 0862426 | 0529808 | 0571997 0514242 957.4f o tf
51083 | 1423889 -3.16416 2000687 | D96.2024 0DE0.0429 | 0704652 0670438 0633 uppaort ror
51083 | -14.41634 | -3.20378 | 2124347 | 1004578 | 066.7511 | 9817135 9767313 066.9 Math on
51083 | -145776  -3.23971 2147021 1012553 9720591 9891984 0987.9827 9784 Matrices and
51084 | -14.681 -3.25173 | 217.1823 | 1020.144 977.768 | D96.9862 9990008 983.4
51084 | 1504002 | -3.37374 | 2158201 1027.076 | 084.0202 1005262 1010528 997 Auto _
51085 24899 -34338 | 2157352 1031076 | 985254 1007469 1020155 1013\ Recalculation
51 0.08324 1.95785 | 3759120 | 1020.805 992 3148 | 1011053 1016692 1007.
85| 58.50061 225077 984.1144 | O76.8622 | 1003.061| 1011154 1019.890 1014.246
Z 51086 | 5490721 21.21116 | 9453394 | 9707631 | 1005558 | 1015789 1025500 1019.033 _
ValUES 51086 | 55.81547 | 2152259 | 053.3359 | O7B.1679 | 1008266 | 1017127 1025772 1017.124 —
1 rI\EImamWnn A Soil  Habitation f | ER! b

10.1 Matrixbooks, Matrixsheets and Matrix Objects

__-_'_'_-—_

Up to 1,024 Matrixsheets

with Multiple (Up to 65,527) Matrix Objects per Sheet

A matrix is a dataset of Z values arranged as an array of columns and rows which are linearly mapped to X
and Y values. The following table summarizes some important matrixbook limits:

Maximum Number of... 32Bit OS 64Bit OS
Matrixsheets in a matrixbook 1024+t 1024+t
Matrix objects in a matrixsheet 65,527 65,527
Cells in a matrix (Note) 90,000,000 90,000,000

T > 255 sheets requires saving file to Unicode (e.g. *.opju) file format. Unicode formats not compatible with
Origin versions prior to Origin 2018 SRO.

Note: The product of any combination of rows and columns must not be greater than 90,000,000.
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10.1.1Naming Matrixbooks, Matrixsheets and Matrix Objects

% MBookl - Mt. 5t. Helens before and after eruption 1,2 Eefu% E@

_ Matrix Book Mame
Thumbnail of Short Name - Long Name: active object/total objects
imported image

_ Columns mapped to M3 trisc
Befare fifter r—. linearly spaced X values Window

c|2|3'|4|5";4 Menu

T)\ 444364  0.98748 -50.96561 198.2151 5574458 5368206 5440881 £~
2 : 837.7456  919.3603 9356158 944.0795 ¢ |
3 9352455 0004708 9248105 9360004 ¢
4 Rows mapped to 94309693 9047725 9241335 9387389 ¢
5 linearly spaced 952 8624 907.4351 013.5458 937.9830 ¢
5 965.0512 9197008 9231581 0367444 ¢
7 . 942 0627 9387186 ¢
3 20? 51 - yalues - 9571997 9514242 ¢
9 216416 | 200969 \iow of Image in |0 9704652 967.0428 | ¢

10|L14.41634 320378 212434 "Dats Mode" |1 9817135 976.7313 ¢

1 || 145776 -3.23971 214703 1 9891984 987.9827 ¢

12 |[1466156  -3.25173  217.182 8 0969863 9999008 ¢

C

V13 [-15.04802 0 -3.37374 | 2158201 1027.076 | 984.0202 1005262 1010.528
-15.24899 -3.42338 985254 1007469 1020155

15 0.0894 1.4 9923148 1011.053 1016.692 -

16| 58.59061 22 1003.061  1011.154  1019.990 -

17| 54907210 212 1005558 1015789 1025500 -

18| 55. 8‘154T 1008.266 1017127 1025772 -

) 4 95-4‘1593 9?9 3904 1007.114 ‘1[]‘13 837 | 1021393 | —

Al | R ~ [

e The matrixbook has a Short Name whether you display it or not. Origin uses

the Short Name for internal operations.

e Short Names must be unique within the project file, cannot contain spaces,
must begin with a letter, consist only of alphanumeric characters (A to Z and 0
to 9), and limited to 13 characters. You can use lowercase characters and the

Matrixbook text will appear as such, but upper and lower case are not unique characters.
(You cannot name one matrix MBOOK1 and another mbook1.)

e Long Names are optional, need not be unique within the project file, can
contain spaces, can begin with a letter, a number or a special character, and

the length cannot exceed 520 characters, including spaces.
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Matrixsheets

The sheet Name must be unique within the matrixbook and is limited to 32

characters.

Can contain spaces and numbers.

Can contain special characters except ~ 196" | Q[{3}<>.
Can begin with a letter, number or allowed special character.

Optionally, sheet can have Label and Comments.

Matrix Objects

By default, Origin assigns a matrix object index number to each object, as it is

created. This index number cannot be changed.
You can add a name to the object by clicking on the yellow object icon - or

a data matrix or or an image matrix - in the upper right corner of the
matrixsheet and choosing Rename from the menu. Alternately, you can
double-click on the matrix object number/name below the thumbnail and enter

a name.

10.1.2Different Views of the Matrix

In the worksheet, a dataset is contained in a single column and the dataset may consist of X,Y,Z, Error, or
Label data. In the Origin matrix, a dataset is arranged in a specified dimension of rows and columns. The
matrix contains a single dataset of Z values.

e  Matrix columns are mapped to linearly-spaced X values.

®  Matrix rows are mapped to linearly-spaced Y values.

Note that the matrix window has two column and row heading view modes:

e By default, matrix row and column headings display as row and column index numbers (View: Show

Column/Row from the menu or press Ctrl+Shift+C).

®  You can opt to view matrix row and column as X and Y values by choosing View: Show X/Y from the

Origin menu (or press Ctrl+Shift+X). The displayed X and Y values are the X and Y coordinate values,

calculated by linear interpolation of the axes From and To values by the number of columns and rows.
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In addition to the two row and column heading view modes, there are two matrix display modes:
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In Data Mode (View: Data Mode from the menu or press Ctrl+Shift+D), the matrix object displays as

raw numbers.

In Image Mode (View: Image Mode from the menu or press Ctri+Shift+1), the matrix object displays

as either a gray scale image or a color image, depending upon the type of data in the matrix. A matrix of

real numbers or complex numbers displays as a gray-scale image while RGB values will display as a color

image.
- . ..‘-..I ! ﬁh S Tuﬂ‘ E @'J-.- ~teM
1t [ 2 | 3 | & [« A

1 85 a3 91 83 & =
2 85 82 a2 90
3 95 93 92 92
4 94 93 93 80
5 04 g4 92 94
] 94 91 94 92
T L LVl 92

B Vi . 90

g lm iew: Data Mode 23

10 ox 75 o5 95

1 92 92 91 83

12 94 83 96 04

13 93 95 92 04

14 95 94 92 93

15 93 95 85 85

16 95 93 o4 94

17 94 96 a7 L]

18 94 94 97 93 w
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Note: If the matrix object is an image, the object icon will display as whether you are viewing the
matrix object in Image Mode (View: Image Mode) or Data Mode (View: Data Mode). Similarly, when

you import numeric data into the matrix, the object icon will display as regardless of View mode.

10.1.3Matrixbooks

Like the workbook window, the matrixbook window is created from a customizable template (.otmu file). The
matrix template stores such things as number of sheets in the book, the nhames of the matrixsheets, matrix
dimensions, data type, math functions, data import handling instructions as well as various style and format
options.

When you create a new matrixbook, the book is named MBookN, with N reflecting the order of window creation.
Appended to the book name, you will see something like ":1/3" where the first integer denotes the active
matrix object and the second denotes the number of matrix objects in the active matrixsheet. Following the
above example, if you click the yellow object icon to the right side of the matrix, the menu shows three matrix
objects with the first being the active one - the one with a check mark placed beside it (note that in our
illustration, the objects are empty).

[

[ MBookt 173 =)
1 2 3 | 4 | 5 |B Insert
1 _ _ _ _ .
- . ~ ~ - ] Add
3 = - - - - Rename
4 - - - - -
g - —- — - ] Delete
E - - - - 7 .
7 _ _ _ _ ol Properties
<[ » [\ MSheet1 }MSheet2 f || « | M N
2
3

I You can right-click on a worksheet tab and Add Matrix as Sheet and insert a
/ matrixbook into a workbook. This is useful when building Analysis Templates that
involve matrix-based operations such as 3D surface fitting or 3D plotting operations.
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Insert

Delete

Add

Add Graph as Sheet...

Add Matrix as Sheet...

Add Motes as Sheet

10.1.4Matrixsheets

|, Prior to Origin 2018, an Origin matrixbook could have a maximum of 255 sheets. That
number is now increased to 1024. When you have more than 255 sheets in a book, you
will need to save the file using one of the new Unicode-compliant formats (opju, ogmu,
etc).

A matrixbook can have up to 1024 matrixsheets. The default matrixbook template - ORIGIN.otmu - has a
single matrixsheet containing 32 rows and 32 columns. Each matrixsheet can differ in dimensions(number of
rows and columns and X & Y range).

To specify the dimensions of the matrixsheet:

1. Click on a tab to activate the sheet and choose Matrix:Set Dimensions/Labels. This opens the Matrix
Dimensions and Labels dialog box.
Specify a number of columns (X dimension) and rows (Y dimension).

Specify a From and To value for X (columns) and Y (rows).

Note: The X and Y coordinates of the matrix are evenly spaced. The first X is mapped to the first matrix
column and the last X is mapped to the last matrix column. The X coordinates of other columns are
interpolated. Matrix rows are similarly mapped using the From Y and To Y values. When plotting or
analyzing matrix data, the position of a point in 3D space is determined by the column X and row Y
coordinate values (not column or row index) and the Z value contained in the cell intersected by the row

and column.

10.1.5Matrix Objects

A matrixsheet can contain up to 65,504 matrix objects, though the actual limit is likely to be far less
(determined by system resources). Objects in a sheet share the same X/Y dimensions and column (X) and row
(Y) headers, but every object can have its own Z header. Other matrix object properties include internal data
type and numeric display options.

Matrix object properties are set in the user interface via the Matrix Properties dialog box. To open the dialog
box:

1. Make sure that the matrix object is active (check mark shows beside it in the object menu).
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2. Choose Matrix:Set Properties... from the main menu.

| You can set properties for multiple matrix objects without closing the Matrix Properties
' dialog box by clicking the << Previous or Next >> buttons at the top of the dialog

box.

<< Previous

Mext ==

19%
B

Properties

B " Matrix Properties - [A3D5urfaceCon]"3D 5. —

=

Long Name

Units

Digits

Data Type

| 30 Surface & Contour

AT File irminnrt

Default Decimal Digits

Double(g) e

QK

Cancel

Apply

10.1.6Import Image to Matrix

Origin has two structures for importing multi-frame images -- the matrix window and the Image window. The
matrix window is better-suited to performing data analysis tasks (e.g. surface fitting, statistics, mathematic
transformations of data, etc.) and some graphing operations, but take note of the following:

Mode" (View Data Mode) and "Image Mode" (View: Image Mode).

second window in the sequence below.

When you import an image to the matrix, you can -- as with other matrix data -- switch between "Data
However, until converted to data, matrices contain RGB values (regardless of View mode), as seen in the

Performing certain analysis or graphing tasks requires that the matrix first be converted to Z values (e.g.

Nonlinear Matrix Fit or creating an Image Plot) by choosing Image: Conversion: Convert to Data.
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Image in
"Data Mode"

180 207 18 1812101

184 207 18 1912081

186 20519 | 194 207 1

197 208 19 192 2071

18621019 196 2101

6| 19521019 | 196 2101

18521013 194 2091

187 206 19| 194 207 1
9020519 198 2071
198 202 19 199 2081

201 206 19| 200 208 1

12| 20120819 2002112
13| 200 20719 1992081
14| 204 206 19 204 208 1

18] 205 204 19 204 2071
16] 204 207 19 200 2091

For more information, see Image Conversion

a5
g

pree
B
e
LS

Ly

in the Origin Help File.

To import an image or image stack to the matrix window:

1. With the matrix active, choose Data: Import From File: Image to Matrix.
2. This opens the Image to Matrix (implmage) dialog. Note that there are are controls for Import

Grayscale GeoTIFF as Data, Show Image Thumbnails and multi-file import-handling.

Dialeg Theme

Import image file inte a new Matrix wandow

Import Grayscale GeoTIFF as Data

= import Options
Show Image Thumbnails

(%]

< E:\Project_Data\Origin 2021b\Test_Data\pt : F
= File Info
10542 .81t File S5@ze 138,19 MB

[Only it Multiple |

15t File Import Mode Replace Existing Data
Multi-File (sxcept 15t) Impart Mode Start New Objects |
[ [RejMaming Matrix Sheet and Mattix Book
Output | [MBook1]Mheeti!] D
Cancel |
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10.1.6.1 Image Thumbnails and Image Slider

When importing multi-frame TIF files, thumbnail/slider display is controlled by system

variable @MSS (default value =10):

Matrix Book Matrix Sheet Matrix Objects

e |f the sheet contains a single frame, don't show thumbnail/slider.

e For 1 < frames < 10, show thumbnail

e  For frames > 10, show slider

When the sheet contains multiple objects, you can display those objects as a series of thumbnails in a spacer
at the top of the matrix window.

1.

Right-click on the matrix window title bar and place a check mark beside Show Image Thumbnails.

1H MBock :2/100 0001 *

0000

0002

Show Organizer
Show Script Panel
Show Column/Row

Showe X5

— e

Ctrl+5hift+C
Chrl=Shift+%

show Image Thumbnails

I} Ctrl+5hift+MN

1|2

| 3 | 4 | s

RANNE

| | o En

0.00968 0.00968
0.00968 0.00968
0.00968 0.00968
0.00968 0.00963
0.00968 0.00968

0.00968 0.00968

0.00968 0.00968  0.009
0.00968 0.00968  0.009

0.00968 0.00963  0.009
0.00968 0.00968 | 0.009¢
0. EIEIEIIJS 0.00968  0.009§

0.0094

Save As..

Hide

Print...

Add Shortcut to Favorites

Ctrl+P

L] [

At
et

i68
At
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0.0~
0.0
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0.0
0.0
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Alternately, you can use a slider control to view these objects in the active matrixsheet.

7] MBook1 :53/100 0052 * = e
———
7
o]
W
£ >

If you are seeing thumbnail images in the spacer at the top of the window, you can switch to the slider by

doing the following:
Hover in the space between the thumbnails and when the cursor changes to a grid icon B2/ click to show

1.
the page Mini Toolbar (you can also click in the gray area to the right of your matrix image).

2. Toggle the Slider or Thumbnails button to show slider or thumbnails.

Likewise, you can turn off both thumbnails and slider by clicking the Image Selector button. Click the

3.
View Image button to toggle between Data Mode and Image Mode.
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Image Selector

View Image l Slider or Thumbnails
Cal —+
& a4} s o Image-related
il « En £ Toggles

10.1.6.2 Naming Matrix Objects

You can assign a name to a matrix object:

1. With the matrix object active, choose Data: Define Name.

2. Give the matrix a Name, set Scope and, optionally, add a Comment.

Named ranges can be used in Matrix: Set Values (e.g. to perform math operations on other matrix objects of
the same dimensions).

10.1.6.3 Import GeoTIFF to Matrix

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file
i and which has applications in mapping. Starting with Origin 2022b, Origin supports
import of GeoTIFF files to both matrices and Image windows.

i
e

To import a GeoTIFF file to the active matrix:

1. Click Data: Import From File: Image to Matrix.

2. In the Image to Matrix dialog (implmage), check the Import Grayscale GeoTIFF as Data box and click

OK.

= File Info
u.,.lI.u.luuﬂuuq.lluu [RE T TERTET IS TR I L ER T LELLRT 1 F||E Si:E: 211.,_5 r-,'18
Import Grayscale GeoTIFF as Data |

Import Options

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.

10.2 Extracting Information from the Matrixsheet or Object

When viewing matrixsheets or matrix objects in Image Mode (View: Image Mode), you can extract
information from the matrix using the Region-of-Interest (ROI) tools:

1. Go to Tools: Region of Interest Tools and verify that there is a check mark beside the menu item. If

not, click on this item or press CTRL + SHIFT + T to enable the ROI tools.
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Click on the displayed ROI tool (e.g. Rectangle Tool ?{é‘) on the Tools toolbar and choose an ROI shape
from the flyout menu (rectangle, circle, polygon, region).
Using your mouse, drag out an area on the image and double-click to set your selection. Once the
selection is set, additional clicks allow rotating, stretching, or skewing the ROI.
To add multiple ROI to a matrix, you must give each ROl a hame that is unique within the matrixsheet.
Double-click on the ROI to open a small dialog with access to the object name.
Right-click on your ROI and choose an option from the shortcut menu. To discard the ROI, press Delete:

O Crop: Crop the image to the minimum rectangular area that will contain the ROI. By default,

values outside the ROI will show black (zero values in Data Mode).

O Copy: Rectangle only. Creates an image from the ROI.

O Copy Positions: Copy the position of the selected ROI.

O Paste Positions: Paste the position of the selected ROl to another ROI (width, height...all).

O Export ROI: Save the ROI object(s).

O Import ROI: Replace the object(s) with those in a saved .ROI file (hint: create a "dummy" ROI
to import).

O Create New: Use the mroi2mat tool to generate a new matrix from the ROI.

O Extract as XYZ: Use the mroi2xyz tool to generate a new worksheet of XYZ values.

O Intensity Profile: Use the mroiprofile tool to generate a statistics for the ROI.

Crop
Copy

Copy Positions

Paste Positions

Export ROI...

Import RO,

Create New
Extract as XYZ
Intensity Profile
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ROI stats are automatically reported to the Status Bar. Right-click on the Status Bar to

hide or show statistics.

Average=133.76614 Count=198616 Min=69 Max=487 | AU: ON A10482(10241024) U2 1: [A

John Murray (University of Pennsylvanial, Ke Hu (indiana University, Bloomingten) (2011) CiL:10542,
Toxoplasma gondii RH. CIL. Dataset. hitps:/doi. org/doi: 10.7295WICIL 10542 (Public Domain Image. )

10.3 Image Plot

Data in a matrix can be plotted as an Image Plot. Axis scales are determined by the matrix XY coordinates
(when the matrix is active, choose View: Show X/Y).

Note that if you import an image to the matrix (Data: Import From File: Image to Matrix) you must first
convert the image to data (Image: Conversion: Convert to Data) before creating your Image Plot (Plot:
Contour: Image Plot).

1. Activate a matrix window and choose Plot: Contour: Image Plot.

Z] Grapht [ & ]

1
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By default, the image plot will use the same colormap, Z scale range and missing value color, as matrix image
mode (View: Image Mode). See Matrix: Apply Palette to Color Map, below.

For Origin 2022b, a Transparency control is added to the Plot Details Colormap tab
of Image Plots created from matrix data.

10.4 Image Window

The Image Plot described above is used to plot values in a single matrix object. The Image Window can be
used to:

e  Open an image file for basic manipulation (flip, rotate, convert to gray-scale) using the Image Window's
Mini Toolbar.

e Edit an image inserted into a worksheet cell or graph window (double-click on the inserted image).
e Import an image set such as the common "TIFF stack™".

. Import multiple discrete image files as an image stack.

® Open and play a movie (.avi, .mov, .mp4) file.

(] Define one or more regions-of-interest (ROI) for which you can Copy Positions, Paste Positions (from
another ROI), and Export or Import position information saved to an Origin *.ROI file (a text file with

position information on each ROI on the image).

® Open and operate on images inserted to worksheets or graphs: crop, copy, export ROI, etc.

Image window import improvements:

(] Content can be exported to one of several raster formats: BMP, GIF, JPG, PNG,

TIF. For Origin 2022b, you can adjust DP1 in the exported file.
e Import GeoTIFF files, with negative numbers treated as missing values.

e Import multiple GeoTIFF files of same dimensions into an Image window and

enable a slider.

10.4.11mage and Video Import

1. Choose File: New Image, then choose an option from the flyout menu.

e Empty Window: You can later add a file by right-clicking and choosing Import or Import

from Web. Alternately, click the New Image button @ on the Standard toolbar.
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Right-click to choose an image

e Image/Video (CTRL + ALT + 1): Use the file type drop-down to specify an image or video

file format.

E7 image1 - 34517_web.mp4 * = =R
202x206 pixels; 143/144 x=193, y=5; RGB(0,0,0)

|[<= EL = =3 -

Paula Bubulya, David Spector (2011) CIL:34517, Homo sapisns, cervical
carcinoma. CiL. Datasel. hitps.Ydoi org/doi: 10. 7295 WICIL34517
Public domain image: htlp.Acellimagelibrary.org/images/34517
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e  Multiple Image Files (CTRL + ALT + T): Specify which files to import as a stack, including

GeoTIFF. Note that the resulting stack will show an image slider, by default.

[ image3 - myocytel tif...myocyted.tif * = ] !.
myocyted: 1024x1024 pucels; 4/8; (386,5) ,value =111 |

[ image6 - 2001 8..2020.6F * =N Hom ==

e Web Image (CTRL + ALT + L): Enter a URL in the dialog to link to a web-stored image. Hint:
to grab an image URL, right-click on the web image and choose Copy image link or Copy

image address.

[® " Enter Image URL 7 %

Image Link | https://www.originlab.com/images/header_logo.png e

For example: https:/fwww.originlab.com/images/header_logo.png

Right-click on a web image and choose "Copy image link" or "Copy image address"

Cancel
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10.4.1.1 Import GeoTIFF as Image

GeoTIFF is a public-domain image format that stores spatial information in a TIFF file
“ME ) and which has applications in mapping. Starting with Origin 2022b, Origin supports
[T import of GeoTIFF files to both matrices and Image windows.

To import a GeoTIFF file as an image:

1. Click File: New: Image: Image/Video and choose the GeoTIFF image.

To import multiple GeoTIFF files as image:

1. Click File: New: Image: Multiple Image Files and choose your images. Images are imported to the

active Image window and a slider is added to scroll images.

£ image - 2001.tif...2020.tif * = EEE ==

2010: 7T20x360 pixels; 10/20; (667,60) x=152.82425, y=59.91644, value=13.69; z(0,315.52001)

- | >

e All Images must be the same size.
e Negative numbers (e.g. -999) are treated as missing values.
e The Image window Mini Toolbar has a button for setting Missing Value Color

e Convert an Image window containing multiple GeoTIFF files to matrix using Image: Convert

to Matrix. Each image in the stack becomes an object in the output matrix.

Click inside the window, somewhere near the top, to show the Mini Toolbar.

For more information, see the Origin Help file page for GeoTIFF Importing and Processing.
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10.4.1.2 Image Import Notes

e To help control Origin project file size, right-click on an Image Window image and enable Linked File.
This saves a link to the image file into the window but excludes the image from the saved project. When
you reopen the saved project, the window will appear empty; at this point, you can decide whether you
need to re-import the image (CTRL + 4 or Import from the window shortcut menu).

e Actual Size Mode is turned on by default for images of max width or height of less than 800 pixels. The

size threshold can be adjusted using system variable @IWP (see this FAQ for info on changing the value

of a system variable).

10.4.21mage Window Navigation

Display of image information and navigation controls is enabled or disabled via the the View menu and/or the
Image Window Mini Toolbar (None, Thumbnails, Video or Slider).

View 2 S |
Toolbars... Ctrl+T

Status Bar

Command Window Alt=3 . )

r (’ D' 7' ' , I, E Image - myocytel tif...myocyted.tif * E\

myocytel: 1024x1024 pixels; 1/8; (53,2) ,value =93 ‘ Ll

Messages Log =
Smart Hint Log Alt=,

Show Information

Show MNavigation

The same Mini Toolbar button is shown for GeoTIFF images:

£ image1 - 2001.if...2020.4 * o |[= ][ =3
2008: T20x 360 pixels; 8/20; (358,10) x=-1.24688, y=84.77 I:I 111 |rl'-! & _-"3_ ' Stk Navigabon |

I E]* ﬁ Mone

Thumbnails

Video

Slider
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Additional Keyboard control for Video navigation

®  Pressing the left/right arrow keys will move the frame by 1.
e  Shift + arrow key will move the frame by 5.

e  Shift + Ctrl + arrow key will move the frame by 20.

10.4.3Image Resize

To resize the image by one of several interpolative methods:

With the Image Window active, choose Image: Resize.

2. Choose options including your Interpolation Method (Nearest Neighbor, Bilinear, Bicubic, Pixel Area

Relation, Lanczos) and click OK.

Resize..: cvResize ? >

Dialog Theme b

Resize an image

Keep Aspect Ratio

Width | 500 |

Height |375 |
By a Factor | 1 |
Interpolation Method | Bilinear W

QK Cancel

10.4.4Define ROIs

For Origin 2022b, you can add multiple ROl without stopping to rename each (see 2.,
below). To speed operations, Add ROl is added to the matrix image shortcut menu.

& s
.

You can define a region-of-interest using one of the ROI tools (e.g. Rectangle Tool i:::I) on the Tools toolbar.

1. Select the tool and drag out an ROI. Once added, fine adjustments can be made by dragging the blue

handles.
2. To add multiple ROIs to an image, (a) click an ROI tool (Rectangle/Circle/Polygon/Region) and drag out
your ROI or (b) right-click on the matrix image and choose Add ROI. Repeat as needed. Objects will be

named as "ROIxx" as they are added.
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B ROl Position

MName ROIT

B Enter new coordinates for the ROE

From To
| 50 | {115 |
| 25 | | 150 |
Apply OK Cancel

change the outline color of the ROI.

10.4.5Mini Toolbars for Image Window

&
When the ROl is selected, use the Style toolbar Line/Border Color button A to

Mini Toolbar buttons are available for performing simple image manipulation, including rotating, flipping or

converting to grayscale.

E Image - Car.bmp * @

B Imaged - Car.bmp *

=)

‘ 500375 pixels; 1/1; (492,2) value =198

| 500x375 pixels; 1/1; x=497, y=113; RGB(193,210,196)

You can apply a color palette to a grayscale image using the Palette button @ on the

Style toolbar. Click More Palettes to open the Color Manager dialog box and add

more palettes.
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Data in a matrix can be viewed in profile -- either in the X, Y or arbitrary cross-section.

1. Activate the matrix object and choose Plot > 2D: Profile: Image Profiles from the main menu.

This creates an image plot and opens the Image/Contour Profile dialog box. Use the dialog box to specify X

and/or Y profile plots and the location and appearance of the cross-sectional lines. Note that this dialog box is
interactive. You can make adjustments to your image profile -- move the cross-sectional lines or change the
configuration or the appearance of the plots -- without closing the dialog box. After closed the dialog box, a

button Profiles...will appear at the right-top corner of graph window, which can be used to reopen the

Image/Contour Profiles dialog.

P

Contour Profile *

(o= ]|[=

J2]3]a

Profile. ..

L 500
Lo

L 2500
L 2000
L1500 ]
L1000 ]

G0o G50

1258

7oa

70

7733

a0o

100 200 300 400

1300 4

1200 4

1100 4

1000 4

005 1
0ao 4
005 |4
000z
00524

Y

10.6 Setting Matrix Values

The Set Values dialog box is used to generate or transform data in a matrix object.
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You can assign a name to a matrix object and use the name Set Values (e.g. to
perform math operations on other matrix objects of the same dimensions).

To open the Set Values dialog box, make sure that the matrix object is active, then:

1. From the menu, choose Matrix: Set Values.

or

1.

Select the matrix by clicking in the upper-left corner (in the empty header cell just below the matrix

icon/name), then right-click on the matrix and choose Set Matrix Values from the shortcut menu.

P

Formula Mat(l) Mat{d) Function Vanables

X

Faw [i] Fram |1 To |32
Col [j] From 1 To |32

insert functions

] Set Values - [MBook2]MSheet] IMat(1) = | B || 2

Menu commands

Celllij] = Search and —'}ﬁ le<| <2 32

=

mat(2) + mat {3)\

Type in formula here

Recalculate ﬁ [ ak. ] [Eancel] [.-’-'-.ppl_l,l]

Before Formula Scripts |

// Prepare twWo eXtra cbjects in the matrix sheet
wk3.nmats = 3;

msetvalue im:i=mat({2) formula:="X";

msetvalue im:=mat(3) formula:="vy";

Script to be executed before applying formula ™

| »

1L
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Menu
Commands

e Formula: Load a saved formula into the matrix formula box. Formula are
saved using Formula: Save or Formula: Save As....

e Mat(1): Use the menu to include matrix objects in either your matrix formula
or your Before Formula Scripts (matrix object reference is inserted at the
cursor). A Matrix Browser is available to help in selecting the correct objects.
Objects are listed by object index.

e Mat(A): Similar to Mat(1) menu functionality but matrix objects are listed by
object Long Name, if one exists.

® Function: Add LabTalk functions to your expressions (function name is
inserted at the cursor).

e Variables: Add a variable or a constant to Matrix Formula or Before
Formula Scripts; Add range variables (including by selection) or file

metadata, to Before Formula Scripts.

Matrix Formula

® Add a single line expression for generating data. Functions, conditional

operators and variables can be used.

Before Formula
Scripts

e Enter one or more lines of LabTalk script to be executed before the expression

in the Matrix formula box is executed.

Use the Before Formula Scripts panel at the bottom of the Set Values dialog box to
define variables or LabTalk functions that you wish to use in your matrix formula.

Click the Search and Insert Functions button Elto search for built-in LabTalk
functions.

10.7 Manipulation of Matrix Data

Utility Menu Access

(multiple

®  For an XY coordinate pair picked
with the Screen Reader, output Z

values for for the matrix stack

worksheet.

. . Matrix: Pixel Extraction
matrix objects) to a
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Utility Menu Access

e  Flip or Rotate a matrix. Matrix: Rotate90
Matrix: Flip: Vertical

Matrix: Flip: Horizontal

Matrix: Resize

®  Resize a matrix using one of four The msresize dialog adds
methods (Expand, Shrink, ; more control and flexibility for
y MEWY Origin 2022b. Those working
Interpolate and Pad). e with NetCDF data will find new

interpolation options: Random
Kriging and Inverse Distance
Weighted.

e Transpose a matrix. .
Matrix: Transpose

®  Generate a 3-dimensional

dataset by transforming XYZ . )
Matrix: Generate Grid
values by formula.

e Expand the matrix by scaling in

the X and Y directions. Matrix: Expand

®  Shrink the matrix by some

row/column factor, using one of ) )
) Matrix: Shrink
several shrink methods.

e Use a palette file to transform a
matrix in Image Mode. Set a
system variable to apply a color
palette (Style toolbar, Palettes )

. . Matrix: Apply Palette to Color Map

button) to all matrix objects

(@MAP=0, default) or only the

active matrix object (@MAP=1).
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Utility Menu Access

(] Convert a matrix of values to

worksheet columns (see next

. Matrix: Convert to Worksheet
section).

10.8Changing the Color Scheme of a Matrix

You can use the Palette Q( button and the Missing Value Color & button in the Mini Toolbar to customize
the color of the matrix window.

The selected palettes and missing value color will apply to all matrix objects in the
active matrix sheet, but will not change the palettes and missing value colors of objects
in other matrix sheets in the same matrix window.

10.9Converting Matrixes to Worksheets

To convert a matrix to worksheet:
1. With a matrix active, choose Matrix: Convert to Worksheet: Open Dialog.

There are two methods for converting matrix data to worksheet data -- Direct and XYZ Columns. Starting,
for instance, with the following arrangement:

] MBookl :1/1 * [ 3]
X1 | 3= 5.5 775 | 10|

[

Y 1
1.1Z
1.24
1.36
1.435
1.6

<[> \ESheet1 / | =y

m

L ) I S T R L R
L= Ry I 5 R L
L=y I R wS
L ) I S 7 R LS R
L=y I R wS

10.9.1Direct

This copies the Z values in the matrix to a worksheet with no reordering. If the matrix consists of M rows by N
columns of Z values, this method produces a worksheet which has M rows and N columns. By default, the X
and Y coordinates of the matrix Z values are not copied to the worksheet. You can opt to copy X coordinates to
the 1st worksheet row or a parameter row and the Y coordinates to the 1st worksheet column.
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B Bookl * o= ][]
AY) B(Y) C(Y) D{Y) E(Y) Fe) |-
Long Mame
Units f‘ X Coordinates L
Comments
Parameters 1 3.25 55 T.75 10 |
1 1 1 1 1 1 1
2 112 2 2 2 2 5
3 124 3 3 3 3 3
4 1.36 4 4 4 4 4
5 148 5 5 5 5 5
B 16 B & B & 6T
L+ [ » I\ Data1 Y Coordinates || « m V[

10.9.2XYZ Columns

When there is a single matrix object, this method produces a worksheet with three columns: X,Y, and Z, with
X and Y columns containing the X and Y coordinate values and the Z column containing the matrix Z value at
each XY coordinate.

.

£ Book2 = = =
AG) B(Y) c@) .
Long Mame
Inits
Comments
1 1 1 1 =
2 1 1.12 2
3 1 1.24 3
4 1 1.36 4
i} 1 1.48 5
i 1 1.6 i
7 3.25 1 1
a 3.25 1.12 2
g 3.25 1.24 3
10 3.25 1.36 4
11 3.25 1.48 5
12 3.25 1.6 i
13 5.5 1 1
14 5.5 1.12 2
15 5.5 1.24 3
|« ] » |\ Sheet1 / || « G v |

In addition, this method:

e  Saves matrix object Long Name, Units and Comments to the Z column label rows.

e |If the converted matrix contains a color image, the resulting Z column will display a Color column of HTML

colors for each matrix cell.
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o

o

[ Car - Caromp :1/1 Car.bmp * o - e | & Bookz* =N EcE <=
[ ax) B By @ c@) @~
& Long Mame Carbmp
Units
Comments
FlaE
34805 a2 =04 [HASE0SE!
34806 82 305
34B07 92 306 m
34808 92 307
34808 g2
309
34811 a2z 310
34812 82 311 v
[ ]+ ]\ Car £ || < >[N /£ || < [

When converting multiple matrix objects:

When there are N matrix objects, you can set Convert On = All Objects and output columns as X, Y and Z x

N (i.e. XYZ2ZZ...).

Convert to Worksheet: m2w ? >
Dialog Theme >
Convert the Matrix data into a Worksheet

Recalculate Fanual

Input Matrix [MBook1]MS5heetl | p

Method X¥Z Columns w

Convert on All Objects e

Option ¥ Const 1st e

Trim Missing Values [_|

Output Worksheet | [Bookd]MSheet1!1:6 E b
(0] Cancel

10.10Converting Worksheets to Matrixes

1. With the worksheet active, choose Worksheet: Convert to Matrix and choose one of the following

methods:
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Method Conversion Type Notes
Ideal for spreadsheet data that
conforms to the following:

e X data values in the 1st
column, Y data values in the
1st row and Z values in

e X across columns columns 2 to N and rows 2 to

) ® Y across columns M.
Direct .

e NoXandyY ® Y data values in the 1st
column, X data values in the
1st row and Z values in
columns 2 to N and rows 2 to
M.

Note: See Virtual Matrix,

below.
Some ASCII files have an upper limit
for characters allowed on a single line.
Use this method when your file breaks
a single line of data across multiple
lines.

e Expand by Row: specifies

e Row the number of ASCII file

Expand e Column rows comprising one matrix

row.

Expand by Column:
specifies the number of
ASCII file columns
comprising one matrix

column.
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Method Conversion Type Notes
Conv_ersion Type depends upon XY
spacing:
® Choose Regular applied for
* Regular data that are regularly
® Sparse spaced in XY.
¢ Random (Renka Cline) ® Choose Sparse when you
XYZ e Random (Shepard) have missing values.
Gridding e Random (Thin Plate Spline) ® Choose Renka-Cline,
e Random (Kriging Correlation) Shepard, TPS, Kriging or
e Random (Weighted Average) Weighted Average
methods for data that are
irregularly spaced in XY.
Option for No Extrapolation
outside Boundary.
Gridding | Methods same as XYZ Gridding and Y. then performs XvZ Gridding.

10.11Virtual Matrix

Data arranged in a block of worksheet cells can be treated as a "virtual matrix". As is the case with regular
matrix data, virtual matrix data can be used to create 3D plots, such as color mapped surfaces or contour plots.
The data can include a column or label row with the X or Y values. Unlike a regular matrix which only supports
a linear spacing in the X and Y dimensions, a virtual matrix supports irregular spacing of X and Y coordinate

values (provided those values are in ascending or descending order).

( '. 3
30 Surface Created from & Viftual Mt = ]
g ol ]

B & Wistual Matrin weith Monlingar Spacing of X aned ¥ Values EEER
| cm -
AN NJI:“n: X eaoningte Irreqular spacing in X and ¥
Commenis
¥ Cogrdnale - 39 1172 19.53 2734
i fﬁh Tear LE L m riE:)
2 no12 413 0.oay 003 -0.006
3 o225 014 034 -0.26 -0.484
4 0.037 -0.058 -0.628 -0.455 076
] 005 -1 -1.784 -0.588 -0.B27
] k062 -0.264 -0.623 -0.632 -0LTv
T 0075 -0.284 076 -0.6 -0.452
] oAy -0L.257 061 -0.483 -0.055
] 0088 -1191 -0.38 1315 0.453
10 k112 -0.093 -0.113 -0L0ET 1.048
11 124 002 204 247 1.7
12 137 172 0545 0626 2414
13 0149 326 D87 1.067 314
14 162 485 1.242 1.566 3264
15 0174 e 1.568 2123 4565 =
- A J e i
[T D watertans 5 Ik im

_:—'_'_'_'_'_
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Note: You can create 3D plots from XYZ columns of worksheet data in which data are irregularly spaced in

the X and Y dimensions. This is not considered a "virtual matrix."

10.12Topics for Further Reading

° Matrixbooks, Matrixsheets and Matrix Objects

(] Matrixbook and Matrixsheet Operations

e What is Saved with the Matrix Template?

. Matrix Dimensions and XY Coordinates

(] Matrix Object Data Properties

(] Setting Matrix Values

(] Matrix Conversion and Gridding

e Creating 3D and Contour Graphs from a Virtual Matrix

e  Viewing and Profiling Matrix Data
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11 Graphing

11.1Creating a Graph

Graphs can be created from both hard data and from mathematical functions. With Origin, you can create over
100 graph types using Origin's built-in graph templates. Each of these graphs has been specifically chosen for
its applications in various technical fields.

All graph types are accessible from the Plot menu. Note that while most graph types also have a
corresponding 2D Graphs or 3D and Contour Graphs toolbar button, some do not. Until you've had time to
familiarize yourself with available toolbar buttons, the Plot menu should be your "go to" place for creating
graphs.

Creating most graphs involves just two steps.

1. Select your data.

2. Select the plot type.

Some Origin graph types have very specific data requirements. Other graphs can be created from multiple
data arrangements. See the Origin Graph Types section for specific requirements.

11.1.1Creating Graphs from Worksheet Data

Origin's most generic graph types -- line, column/bar, pie -- plus a lot of the more specialized types, are
created from worksheet data. The following quick tutorial demonstrates importing an ASCII data file and
creating a simple graph.

Tutorial: One click to create graph with selected data

1. Open a new workbook and select Data: Import from File: Single ASCII... from
the main menu.

Choose the file Samples/Curve Fitting/Multiple Gaussians.dat and click Open.

3. Now highlight columns B(Y), C(Y), D(Y) and E(Y) by clicking and dragging across
the four column headings.

4. Click Plot = Basic 2D: Line & Symbol: Line & Symbol. A graph window is
created with four line and symbol plots. Note that the plots differ by line color and
by symbol type.

Return to the worksheet, and again select columns B(Y), C(Y), D(Y) and E(Y).
This time, select the Plot > Multi-Panel/Axis: 4 Panel menu item. Note that a

very different plot is created using the same datasets.

We were able to quickly create two different graphs using the same data. The chapter Customizing Graphs
discusses customizing graphs and saving templates in more depth.

We are also able to create 3D plot types from worksheet data. The following tutorial demonstrates creating a
3D surface plot, then overlaying it with a 3D scatter plot.
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Tutorial: 3D Surface Plot from XYZ Data

10.

Create a new, empty workbook window and import the file \Samples\Matrix
Conversion and Gridding\XYZ Random Gaussian.dat.

Highlight column C and right click. Select Set As: Z from the fly-out menu.

Select Plot > 3D: 3D Colormap Surface to create a 3D Colormap Surface plot.
Select the Graph: Layer Contents... menu item or right click the layer icon on the

left-top of the graph to open the Layer Contents dialog. In this dialog, click on

drop-down next to the ﬂbutton and select 3D Scatter/Trajectory/Vector

from the fly-out menu.

Select column C from the left panel and click on the Add Plot ﬂbutton to add
the 3D scatter plot to the graph. Click OK to close the dialog.

Double-click on the plot to open the Plot Details dialog. In the left panel, expand
the Layerl node and then expand the 2nd node which represents the scatter plot.
Click and select the branch named Original. Be sure to leave the node-level check
box selected, otherwise this plot will be hidden.

In the Symbol tab on the right side, set Shape to Ball, Size to 12 and Color to
Color Mapping: Col(C).

In the Drop Lines tab, clear the Parallel to Z Axis check box.

Select Layerl from the left panel of the Plot Details dialog. In the Lighting tab,
under Mode, select Directional. Click OK to close the dialog.

Click on the scatter plot in the graph to select this plot, then in the Style toolbar,

click on the @ button and select the Rainbow palette.

Your graph should look like this:

1115
1012
5080
B.0s0
7030
§.000
4470
3840
230
1880
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You can hold down the R key on your keyboard and use the mouse to freely rotate the
3D surface. With the pointer tool active, click on the layer for additional controls to
move, stretch and rotate the surface.

11.1.1.1 Worksheet Column Plot Designations

The labels (X), (Y), (2), etc. in column headings are referred to as the Column Plot Designation. Columns
can also be designated as Label, Disregard, Y Error or X Error. Each plot type has certain data
requirements (e.g. a simple line plot requires one X and one Y dataset) and column plot designations work in
concert with settings saved in the graph template, to allow you to quickly create a graph.

To set the Column Plot Designation, select a column or multiple columns, then from the menu choose Column:
Set as:<option>; or right-click and choose an option from the Set As: context menu.

In the 1st tutorial above, we plotted 2D graphs, which require Y data from one or more worksheet columns.
The Y data were automatically plotted against the X column data to their left. In 2nd tutorial, we plotted a 3D
graph using Z data. The Z data were plotted against X and Y data columns to the left of the Z data column.

Note: For more information on Column Plot Designations and how they affect plotting behavior, see Plot

Designation, in documentation for the Column Properties Dialog Box.

11.1.1.2 Selecting Worksheet Data

Various ways to select data for plotting:

e Single column: Click on the column heading, e.g. B(Y)

e  Multiple columns: To select a small number of contiguous columns, click on the first column heading and
drag the pointer to the last column heading. To select a large number of contiguous columns, click on the
first column heading, use the scroll bar at the bottom of the worksheet to locate the last column, then
press the SHIFT key and click on the last column heading. To select non-contiguous columns, press the

CTRL key while clicking on the desired column heading.
e A range in a column: Click on the first cell of the range and drag to the last cell of the range.

e Multiple ranges within a column: Select one range. Press the CTRL key while selecting each range.

When plotting, each range will be treated as a separate data plot in a plot group.

e Ranges across multiple columns: If cells are contiguous, click on the first cell and drag to the last cell.
If cells are not contiguous, press the CTRL key while selecting each range. Each range selection will be
treated as a separate data plot in a plot group.

e Range(s) across all columns: Click on the first row heading and drag to the last row heading, to select
multiple rows. This will select data in all columns in the worksheet. Press the CTRL key while selecting row
headings for non-contiguous rows. Each range selection will be treated as a separate data plot in a plot

roup.

e Entire worksheet: Press CTRL+A to select the entire worksheet; or mouse over the bottom-right corner
of the blank cell in the upper-left corner of the worksheet. When the pointer becomes a downward-

pointing arrow, click to select the entire worksheet.

e Specific columns: To select columns by data in column label rows (header rows); or to select columns

using a pattern, choose Edit: Select.
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i As noted in the Worksheet Column Plot Designations section just above, if you select Y
; or Z columns, Origin defaults to plotting the Y column against the nearest X column to the
left; or to plot the Z column against the nearest Y and X columns to the left. But if you In
the case of simple XY 2D plots (line, line+symbol, etc.), you can ignore this rule and plot
with selected XY columns not matter the selected X is on the left or right side of VY.

ensors01_07.dat *

AT i
Long Mame | Displacement
Units mim
Comments
Fix)=

Sparklines /
1

11.1.2Creating a Graph from Matrix Data

As discussed in the Matrixbook, Matrixsheets and Matrix Objects chapter, a matrix is a dataset of Z values
arranged as an array of columns and rows which are linearly mapped to X (column) and Y (row) values. Matrix
data is used to create 3D, contour and heatmap graphs -- all of which require require "3D" data. In earlier
versions of Origin you had to have your data in a matrix to create such plot types but this is no longer the case
(see discussion of the Virtual Matrix below). A few graph types such as a color-filled surface with error bars
still require matrix data.

There are still many situations in which you will be creating 3D plots from matrix data. If data are stored in a
worksheet and for one reason or another, you need to convert it into a matrix form, see Converting
Worksheets to Matrixes.

Once your data are in a matrix form, plotting matrix data is simple: activate the matrix window then select
your plot type using a Plot menu command or corresponding 3D and Contour Graphs toolbar button. Since
you cannot plot only a portion of the matrix, data selection isn't necessary. You can, however, choose a subset
of the data plot to display once the graph is created. See Editing Plot Range, below.

11.1.2.1 The Virtual Matrix

The Virtual Matrix concept was covered in the Matrixbook, Matrixsheet and Matrix Object chapter of this Guide.
To recap, a virtual matrix is a block of worksheet cells which contain Z values, with X and Y coordinates in the
first row or column label row, and first column. X and Y coordinates don't have to be evenly spaced and can
even contain text or date/time data.

When selecting and plotting virtual matrix data to 3D, Contour and Heatmap graph types, the worksheet's
Column Plot Designations are ignored. Instead, a dialog box is opened where you designate your X and Y
coordinates. The intersecting data points are then treated as Z values.

Tutorial: Contour Plot from Virtual Matrix

1. With a new workbook active, use the Data: Import from File: Import Wizard...
menu to open the Import Wizard dialog.

2. Press the browse button in the dialog and select the file Waterfall.dat from the
Samples\Graphing subfolder.

3. This file has an import filter already associated with it. Press the Finish button to
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import the file.

With the workbook active, press CTRL+A to select the entire sheet.

Now select the Plot = Contour: Contour - Color Fill menu item. The plotvm
dialog will open.

In the dialog, set the Y Values in drop-down to Column Label, and then set the
Column Label drop-down to Excitation Wavelength(nm).

Set the X Values in drop-down to 1st column in selection, then press OK to
close this dialog.

The contour plot will be created.

Use the Graph: Speed Mode... menu item, then in the dialog that opens, set the
Speed Mode drop-down to Off and press OK. This will turn off speed mode so that
all data points are plotted (see the discussion of Speed Mode, below).

Click on the contour plot to select this data plot, then from the Style toolbar, click

the Palette button @ and then select the Pumpkin Patch palette. Your graph

should look similar to the image below:

=] Grap2 [

1

BOD

oo

Excitation Wavelangth (nm)

L]

400 1000 1100 1200 1300
Emission Wavelength (nm)

Once you customize your contour levels and colors, you can save your settings as a
Theme, or simply copy-paste your customizations from one graph to another. To save a
Theme, right-click on the graph and choose Save Format as Theme; or use the
Colormap Theme controls on the Colormap/Contours tab of the Plot Details dialog

box.
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11.1.32D and 3D Function Plots

Unlike plots from worksheet data or plots from matrix data, parametric plots are not plots of actual data.
Instead, they are plots of mathematical functions.

To create function plots and parametric function plots, select File: New: Function Plot menu. There are four
options to choose from:

Type Function Form
2D Function Plot y =f(x)
2D Parametric Function x = f1(t)
Plot y =f2(t)
3D Function Plot z =1(x, y)
3D Parametric Function X f f1(u, v)
Plot y =f2(u,v)
z = f3(u, v)

These plot types are also accessible from the function plot buttons on the Standard toolbar.

£ |
F+/ New 2D Plot
£~ New 2D Parametric Plot

§2 New 3D Plot
;.5‘29 Mew 30 Parametric Plot

Tutorial: 3D Function and 3D Parametric Function in Same Layer

1. From the menu, choose File: New: Function Plot: 3D Parametric Function
Plot...

2. In the dialog that opens, click on the arrow button at the top right side of the
dialog, and from the fly-out menu select the built-in example Partial Torus
(System) and press OK to close the dialog. The function plot will be created.

3. With the function plot window active, invoke the menu File: New: Function Plot:
3D Function Plot....

4. In the dialog that opens, enter -5 and 5 for the From and To edit boxes for x and
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y scale.
In the Z(x,y) edit box, enter O.
Set the drop-down at the bottom left corner of the dialog to Add to Active Graph
and press OK to close dialog.

7. The Z=0 plane will be added to the graph, and the plane will properly intersect the
parametric surface plot. You can hold down the R key and use the mouse to freely

rotate the plot.

e [E=S o~

e  Some function plot dialogs provide sample formulas. Click the arrow button beside Theme at the top of

the dialog box to access them. You can download more examples at http://originlab.com/3dfunctions.

e  For 2D parametric, 3D, and 3D parametric function plots, data is generated when the function plot is
created. To create data for 2D function plots, right-click the plot and choose Make dataset copy of
Function or if on the Function tab in Plot Details, click the Workbook button.

e Besides function plots, you can also create graphs with all built-in and user-defined nonlinear curve-fitting
or surface-fitting functions. From the menu, choose Analysis: Fitting: Simulate Curve... or Simulate

Surface.... You can even add noise to the plot. Corresponding data is created as well.

11.1.3.1 Adding Function Plots to Existing Graphs

You can add function plots to existing graph windows containing other plot types. See FAQ-171, specifically
the section entitled Add Function Plot to an Existing Graph.

11.2Plotting without Using Column Plot Designations

While worksheet Column Plot Designations are always used when creating graphs from the Plot menu or one
of the graph toolbars, the Plot Setup dialog box does not make use of them. With Plot Setup, you assign
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column designations on an ad hoc basis, allowing you to overcome some of the restrictions of template-based
plotting.

However, to make use of the Plot Setup dialog box, you need to have some familiarity with the hierarchy of
objects contained in the Origin graph window.

11.2.1Pages, Layers, Plots and the Active Plot

Each Origin graph window is comprised of a single, editable graph page. The graph page is defined by the
white area inside the graph window. Anything that lies outside the page is not printed or exported. By default,
the dimensions of the graph page are defined by the printable area of your default printer driver; without
adjusting settings, a printed graph should fill the printed page.

Active Layer

Teon Layer The Page Graph
Icons (the white area including the Legend
| s araph}
amaaa‘ﬁ\r-wmpharmmcharmiu / / =s 5 el &
Jalalel 3rd Y
Characteristics of Samples Grown Under Different C Axes wf
) ) ¥ Dffset
i 1% L2 1.1} 4
- h . . —
at 4 A Grown
& L] Annealed
= & — AT
B —
The i - 1
Layers E " '\.‘ |
{Including £ N i A }
data £ o 1T
plots) = - ) [
I T -
;! N
T T T * T Commaen
L2 L1 54 L+ x Axil;
Tranitisn Tempaiabure |F)

/7

This Area is inside the Graph Window
but is NOT part of the page

The Layer
Frame

e The graph page must contain at least one, and may contain as many as 1024, graph layers.

e  Each graph layer generally contains one or more data plots (graphical depictions of datasets). Note that
the graph in the image above contains three graph layers, represented by the three non-printing layer
icons in the upper-left corner of the graph page. Note that there is one layer icon which is highlighted,
indicating that this is the active layer.

e Just as there is only one active layer, there is only one active plot in a graph. Usually, the active plot is
the first plot in the active layer. To verify which plot is active, click on the Data menu while the graph is

active. The active plot will have a check mark beside it.

166



Graphing
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The hierarchical structure of the graph page can be seen in these places:

e The Plot Details Dialog Box (Format: Page ...)
e The Object Manager (View: Object Manager)
e The Plot Setup Dialog Box (Graph: Plot Setup...)

F

8 ' Plot Details - Plot Properties Object Manager 87 Plot Setup: Configure Data Plots in Layer
=iy GraphB
# | GraphB #| Layerl Plok List: Dirag enines in st column to rsarder of bo s
o [\ Lagert L= H |
| 18 " (e 1 6] [1727F 7] Layer? o
4 —— Hogt L Loyer1

(w147 MSheelll “w [me 1]

=41 Layer 2
s, [WORET147|Sheet1 DML CRAL "Time"Tx]

11.2.2The Plot Setup Dialog Box

The Plot Setup dialog box is a flexible all-in-one plotting tool for creating graphs and manipulating the data
plots in an existing graph.

e Creating graphs without regard to Column Plot Designations
e Creating graphs from a combination of data sources: multiple worksheets, workbooks, matrixbooks, loose

datasets, etc.
e Creating graphs combining multiple plot types.
e Adding, removing, replacing data plots.
e  Grouping or ungrouping data plots.

e  Reordering data plots in a layer or moving data plots to another layer.
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To create a graph with the Plot Setup dialog, make sure no data is selected in the active worksheet and
choose the plot type that you want to create (from the Plot menu or by clicking on a toolbar button).

To open the Plot Setup dialog for an existing graph window, right-click on any layer icon in the upper left
corner of the graph window and select Plot Setup..., or choose menu Graph: Plot Setup....

Tutorial: Creating a Simple Line Plot with the Plot Setup Dialog Box
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Click the New Workbook button on the Standard toolbar.

Click Data: Import From File: Single ASCII, browse to the Origin installation folder
and import the file \Samples\Curve Fitting\Step01.dat. Starting from column B, columns
are actually paired - X data and Y data -- but by default all columns are assigned a "Y"
Column Plot Designation on import.

Without selecting any data, click Plot > Basic 2D: Line. This opens the Plot Setup
dialog box.

Click the two "double-arrow" buttons to show all three dialog box panels.

In the middle panel, select the "X" box for Column B (Sensor Ax) and the "Y" box for
Column C (Sensor Ay), then click the Add button to add the plot to Layer 1 in the
bottom panel.

Select the "X" box for column D (Sensor Bx) and the "Y" box for Column E (Sensor By),
then click Add.

Select the "X" box for column F (Sensor Cx) and the "Y" box for Column G (Sensor Cy),

then click Add. Three plots are added to Layer 1.



8.
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Press CTRL and click on each plot in the bottom panel to select all three, then right-click
and choose Group.

Click OK to create a grouped line plot.

# ° Plot Setup: Configure Data Plots in Layer

Plot List: Drag entries i 13t column to reorder or bo move between lapers. Right click for ather options.

Filat Range Show
= Laver1 [ Rescale v

= () Group

[Step, dat)Stepn | “Sensor A »"f<). ' =28 04X <592, 00105 <Y < 011768

epll. dat)Stepll! "Sensor B & =38 02 << 594 001679 < ¥ < 0.26044

[Stepl, datfStepll] "Sensor C "< "Sensor C ') 5 D¢y < 051117

Tutorial: Creating a Graph with Data from Multiple Worksheets

=

Click the New Workbook button on the Standard toolbar.

Click Data: Import From File: Multiple ASCII, browse to the Origin installation
folder and select SensorO1l.dat, SensorO2.dat and Sensor03.dat under \Samples\Curve
Fitting\ to import. After Import, 3 workbooks are created.

Without selecting any data, click Plot > Basic 2D: Line+Symbol. This opens the Plot
Setup dialog box.

Expand the top panel if it is hidden. From the Available Data list, choose
Worksheets in Folder.

Select Sensor01, Sensor02 and Sensor03 sheets in the top panel.

In the middle panel, select the "X" box for Column A (Displacement) and the "Y" box
for Column B (Sensor Output), then click the Add button.

Click OK to create a grouped Line+Symbol plot using Sensor Output columns from 3

worksheets.
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®  The Plot Setup middle panel only allows choosing one X column at a time.

e If your worksheet is set up with the correct Column Plot Designations (e.g. XYXY) but you only want
columns with same Long Name, click the toggle in the upper-right corner of middle panel so that only
plottable columns show (e.g. for 2D plot types, X columns are not shown). Then you can sort the columns
and select all columns with same Long Name and plot them together. The Y columns will be plotted
against corresponding X columns.

e To change a data plot's type, choose the corresponding plot in bottom panel. Corresponding X and Y
columns will show in middle panel. Choose a new plot type in middle panel and click the Replace button.

e All data plots in a group share the same plot type. If you want to change the plot type of a single plot in a
group, right-click the Group node in bottom panel and Ungroup first.

e Drag and drop data plots in the bottom panel to move them to different layers.

e If the bottom panel is hidden and you have selected columns in the middle panel, you can directly click
the OK button to create your graph.

11.3Manipulating Data Plots

The following sections discuss higher level modifications to existing graphs such as changing plot type, adding
or removing plots from the layer and controlling the density of plotted points (Speed Mode). For more detailed
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plot customizations, including those involving such things as changing plot symbols, colors, and legend
customizations, see the Customizing Graphs chapter.

11.3.1Changing Plot Type

Some Origin plot types (e.g. scatter, line, line+symbol) allow you to interchange the plot type of an existing
plot with a few other select plot types. Some examples:

e  Scatter, line, line+symbol, column/bar are interchangeable.

e 3D scatter/trajectory/vector, 3D bars, 3D surface are interchangeable.

To change the plot type of an existing plot:

e Right-click on the data plot and choose Change Plot to: Graph Type from the shortcut menu.

e  Click on the data plot and choose Format: Plot... and in Plot Details choose from the Plot Type drop-

down list.

e Click on the data plot, then click one of the supported graph toolbar buttons.

Note that if you switch plot types and the selected plot is part of a plot group, all plots in the group are
switched.

A word of caution: This is an old Origin feature, and for a quick change of common plot
types in a single-layer graph it works well. Changing plot types in a multi-panel, multi-

layer graph can lead to unwanted outcomes. When working with more complex graphs,
it is better to create a graph directly using the specified Plot menu command or toolbar
button .

11.3.2Exchanging Data Plots

You can quickly change the data source (X, Y, or worksheet) of a plot using these context menu commands.
Right-click on a data plot, then select one of these options:

e Change X/Y/Z. These menu items allow you to swap the current X,Y or Z data with data from any column

in the project.

e Select Columns. This opens the Column Browser where you can select another column in the Current

Folder, in the Current Folder (recursive) (includes subfolders) or in Current Project.

e Change Worksheet. This menu item allows you to replace both X and Y with data from another
worksheet. The selected worksheet must have the same Short Names, the same Column Plot Designations

and the same row index range as the current worksheet.

Tutorial: Changing X and Y assignment of a data plot

1. Start with a new workbook and import the file automobile.dat from the

Samples\Statistics sub-folder of the Origin installation folder.
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2. Select the Gas Mileage column and select the Plot: Basic 2D: Scatter menu
item. The Gas Mileage column is plotted against the default X column Year.
3. Right-click on the data plot and select Change X: Engine Displacement. The

Gas Mileage column is now plotted against Engine Displacement.

Note: If new data is significantly outside of the current range for X or Y axes, you will be asked if the
graph should be rescaled. If data are not significantly different, you may want to manually rescale the
graph (Hot key: CTRL+R).

If you have performed some analysis on the data plot (e.g. linear regression with
Recalculate set to Auto), the fit results will automatically update when you change
X/Y or the worksheet.

11.3.3Adding, Removing and Hiding Data Plots
Use the following methods to add or remove data plots from a graph.

11.3.3.1 Adding Data by Drag and Drop

You can add data to a graph by drag and drop. When using this method, Origin relies on worksheet Column
Plot Designations to create the plot.

Select the worksheet data (one or more columns or a range of one or more columns).

2. Move the mouse over the left or right edge of the selected range.

I
3. When the pointer looks like this , hold down the left mouse button and drag the data to the graph
window. Release the mouse.

4. If there are multiple layers in the graph, drag the data to the desired layer, then release the mouse.

Usually the current plot type is used when plotting by drag-and-drop. To change the
global plot type to use when drag and drop, choose Preferences: Options... from the
main menu. Go to the Graph tab and change the Drag and drop plot type.

11.3.3.2 Adding Data with Insert: Plot to Layer

Use the Insert menu to insert some types of plots to the active graph layer. Choice of plot type depends on
the active graph window and the last-activated data source (worksheet or matrix). For instance, if you create a
2D graph, select data in a workbook window, then return to graph window and click Insert: Plot to Layer,
your insert choices will be Line, Scatter, Line + Symbol, Column..., Area and Contour....

To use the Insert menu command, you should have an existing graph window:

1. Go to the worksheet or matrix window and select your dataset(s).
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2. Return to the graph window, make sure that the target layer is active layer, then choose Insert: Plot to
Layer: Plot Type.

11.3.3.3 Adding and Removing Data with the Layer Contents Dialog Box

Open the Layer Contents dialog box by double-clicking or right-clicking on the layer icon(s) in the top left
corner of the graph page. Controls in the left panel can be used to filter and list available datasets. The right
panel lists datasets that are plotted in the active layer.

Filter source data.

Click arrow to Click to switch Group or
choose Plot layers (existing) or ungroup plots.
Type or accept to add a new layer.
A (auto). ] | Reorder
B ° Layer Contents: Add, Rzmaw%mup Older\huu—nur:n—\ ‘—/ 'h( p|0t5 in the
| Workshests in Folder - layer.
¥] Inchude Shortcut
Book Na.n'a . Sheat .ng Mame | Short Mama ;l Short Heme | Lomg Mo | Ngerd | Flarge Pl Type
sutomobile. dat automabie Make BIY) = 1 L= —
automabile. dat automobie Powen  CIY) E :g; zﬂ . :L}:;: ::::::
automobile. dat auitomobile 060 mph DY) - .
asulombile, dat automabie weight  E[Y) e B[] Weight [1°-112%] Scatter
sutomobile. dat automabie Gas Mileage FiY) o
sutormickile, 22t autamobie Ergine Disp GIY) Opt to rescale graph
19921995 |Weight B0V | axes when plots are
added or removed.
.
. i | | | Layer Propesties...| [Pl Setup...| ool | Close | [ Canced
L' Y

Move selected
data into or out of
the layer.

1. Choose data
from this pool ...

2. ..then add it to
the graph layer.

Controls in the center of the dialog box allow you to add or remove plots from the active graph layer. When
adding data to the graph, click the list button (downward-pointing arrow) to pre-select the plot type before
adding data to the layer. Use controls in the right panel to group or ungroup plots, or re-order plots in the
layer.

. . In Origin 2022b, a new LabTalk system variable @SCCS modifies Layer Contents
HEW sort behavior: @SCCS = 0 (default) sorts as Bookl > Book2 > Book10; @SCCS = 1
sorts as Bookl > Book10 > Book2.

11.3.3.4 Adding, Removing, Replacing or Hiding Data Plots with the Plot Setup Dialog Box

Among other things, the Plot Setup dialog box can be used to add or remove data plots from the graph.

1. To add plots to the graph, use the top panel of Plot Setup to identify your source data.

2. Use the controls in the middle panel to specify the plot type and how the data selection should be treated
(as X, Y, yError or Label).

3. In the bottom panel, choose the Layer to which you want to add plots, then click the Add button.
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To remove a plot from the layer, select the plot in the bottom panel, then right-click and choose Remove.
To hide a plot, uncheck the Show check box for the plot.
To replace a plot, select the plot in bottom panel, then change the X and Y selection and plot type in

middle panel and click the Replace button.

Plot Range Show  Plot Type
=i Layer1 Rescale vl
=l [z Group
E [Step0 dat]Step01! “Senzor & B [}y‘ <832, -0M05 <Y < 011768 Line + Symb
w, [Stepll dat]Step01! "Sensor B Group W 594, -0EFI <Y < 026044 Y] Line + Symbo

w, [Step0l.dat]Step0! “Senso C Ungroup W« 896, 0<Y <0517 | Line + Symbao
|

Show Style Holders

Apply Range To Group
Apply Range To Layer

Apply Range To Page

11.3.3.5 Adding Data by Direct ASCII Import

You can import ASCII files directly into the active graph window using the the Import ASCI1 toolbar button.
Note that this method works only with files having a simple structure and it supports only the simplest of
graph types - Line, Scatter, Line + Symbol, Column and Bar charts.

13,
1. Click the Import ASCI1 B putton. This opens the Import ASCII dialog box.

2. Choose a file.

3. Click Open.

The file is imported and plotted in the active graph window.

11.3.3.6 Adding Data by Copying and Pasting a Plot

With many Basic 2D graphs (e.g. Scatter, Line, Line + Symbol, Bubble, etc.), you can copy a plot from an
existing graph layer and paste it to another layer in the same window or into a separate graph window. Prior to
Origin 2020, this would only produce a black line plot. Origin 2020 expanded copy-paste of plots to other plot
types, while preserving plot properties (symbol size, color, etc.).

1. Click on the plot to select it and press CTRL+C.
2. Click on the target graph and press CTRL+V.

You can also copy a plot by selecting the plot in the graph and clicking on the Copy Plot button on the Mini
Toolbar.

.. r -
2 o8 & o | ConyPlo
Then paste (Ctrl+V) into another layer as new plot
B e
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; Previous versions also allowed you to select and copy a simple plot (Line, Scatter, Line
+ Symbol, 2D Column/Bar) and paste underlying data into a worksheet. The default
settings no longer support this but you can reverse this by setting LabTalk system

variable @CPNP=1.

11.3.3.7 Removing or Hiding Plots with the Object Manager

The Object Manager is a dockable panel that allows for easy manipulation of graph layers and data plots.
See the section on The Object Manager in this Guide.

To hide or remove plots, right-click on a plot and choose from the shortcut menu:

[ Graph1CCA
Show Labels
NG| 320cm [ Show Plots with Same Name
A ——— 330cm Hide Plots with Same Name
— Jdcm
% Show Plots with Same Name Only
EIE Layer2 Show All Plots

=gl Hide All Plots
]l—1
E 110em Set as Group Begin
[+] 120cm 5et as Group End
[]—— 130cm Maove out of Group
@ 140em Move Up
1 ! I D

ove Down
[+] 160cm
EIE Layerd Fove Plot to 2nd ¥ Axis

=gl Mave Plot(s) to Other Layer...
Bmm
= U Remave

e  Show or hide plots of the same Long Name.
e  Show all plots.

e Remove a plot from the graph window (hidden plots can be quickly shown again; removed plots must be

added back using one of the above methods).

e |f the plot is part of a group, you can right-click on an individual plot and remove just that plot or you can

right-click on the group icon and remove the entire plot group.
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e  When you right-click on a plot, you can use Hide Plots with Same Name and Hide All Plots shortcut
menu items to quickly hide selected plots in the window without removing them entirely (restore plots by

enabling their display in the Object Manager or in Plot Details).

11.3.3.8 Removing or Hiding Data with Plot Details

In the left panel of the Plot Details dialog box (Format: Plot...), right-click on a plot and choose Remove or
Hide from the context menu. Remove will delete the data plot from the graph so if you just want to
temporarily hide a plot, choose Hide. Neither of them will delete data from worksheet or matrix.

4 [ Layer2
[ [datatiledepta]Sheet!! “--"(X), "100cm"[¥) [1*:122*]
-] [datatiledepta]Sheet]! *--“(X), "110cm"[¥) [1%:122*]
...'.,r| [datawﬂ'ﬂﬂ‘]
[V [datay | REMOVE [1%122°]
] [data Remove All Special Points [1%122%]
¥ [data Hide [1%122*]
V] [datatiledeptA]Sheet!! "—*(X), "160cm"(Y) [1%:106*]

11.3.3.9 Deleting Plots using the Delete Key

Click on a data plot (either in the graph window or Object Manager) and press the Delete key. If the selected
plot is part of a group, the entire group is deleted.

Note that this is more sweeping than the Remove shortcut menu command in that it will remove an entire
plot group from the graph window. This action does not delete worksheet or matrix data.

To restore the deleted plots, choose Edit: Undo Remove Plot from the main menu.

11.3.3.10 Editing Plot Range

Once a graph is made, you can edit the plot display range, specifying only a portion of the plotted data:

e Right-click on the plot and choose the Edit Range... shortcut menu command. Edit the From and To
values.

. In the right panel of the Layer Contents dialog box (Graph: Layer Contents), turn on the Range column
by right-clicking on the column headings and choosing Range. Click on a plot's range values, then click
the ... button that appears to the right side of that column.

e In the bottom panel of Plot Setup (Graph: Plot Setup), click on the plot range in the Range column and
click the ... button that appears to the right side of that column.

Choose Graph: Rescale to Show All to rescale the graph after editing the plot range.
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11.3.4Grouping Data Plots

When you make multiple range or column selections, then create a graph, Origin groups the resulting data
plots in the graph layer. This applies to most 1D (statistical) and 2D graphs, plus 3D XYY (XYY 3D bar, 3D
ribbon, 3D wall, and 3D waterfall plots) and 3D XYZ (3D scatter, 3D bar) graphs.

Grouping provides for quick creation of presentation-ready graphs because each plot in the group is assigned a
differentiating set of plot attributes (line color = black, red, green...; symbol shape = square, circle, triangle...;
etc.). Assignments are made by cycling through a pre-determined (user-modifiable) increment list of styles.

For instance, the first plot of a grouped line plots might be denoted by a black line; the second plot might be
denoted by a red line (the second color in the color list), the third plot by a green line (the third color in the
color list), and so on.

Tutorial: Creating a simple grouped data plot

12
1. Open a fresh worksheet and click the Import Single ASCI1 button ﬂon the
Standard toolbar.
2. Browse to the Samples\Graphing subfolder in the Origin software folder and Open
GROUP.DAT.
3. Select B(Y), C(Y), and D(Y) columns

4. Click the Line & Symbol button ')} on the 2D Graphs toolbar. Note that line and

symbol color and symbol type are automatically differentiated for each plot.

Tutorial: Grouping (or ungrouping) plots manually

e Via the Layer Contents dialog box

1. To open the Layer Contents dialog box, double-click on the layer n icon in
upper-left corner of the graph window.

2. To create a group, select the desired data sets from the Layer Contents list (use
CTRL + select, SHIFT + select, or simply drag the mouse to select multiple data
sets).

3. Click Group. Note that each plot in Layer Contents is now preceded by a gn (for
"groupl”, "group2"”, etc.).

4. To ungroup, click on one of the grouped data plots in the Layer Contents list and

click Ungroup.

e Via the Plot Setup dialog box

1. To open the Plot Setup dialog box, ALT + double-click on the layer n icon in
upper-left corner of the graph window.

2. To create a group, select the desired plots from the Plot List (use the CTRL or
SHIFT keys to select multiple data sets).

3. Right-click and select Group. Note that a Group icon now precedes the selected
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plots in the Plot List.
4. To ungroup, right-click on the Group icon and choose Ungroup from the shortcut

menu.

11.3.5Speed Mode

With Speed Mode, you can control the number of data points displayed in a graph layer. This option is most
used when working with large data sets, though note that there have been improvements in this area and
Origin now has Density Dots and Color Dots graph templates specifically for creating scatter plots of large
datasets.

Speed Mode can be turned on for any 2D or 3D graph. When Speed Mode is enabled, the layer icon displays in
red and a Speed Mode is On banner appears in the layer. The banner is not included when printing, copying,
or exporting the graph.

Color Scale Title

343

318

Reminder Message

To speed up your work this graph will be displayed in “speed mode.' Therefore,
some data may not be visible. To turn off speed mode select Format:Layer from the
SPEEd Mode mienu and select the Size/Speed tab.

Y Axis Tile

X OAXIs Title

Do not show this message in the future

0K

To adjust Speed Mode settings:

With your graph active, select Format: Layer... from the Origin menu.
Select the Display/Speed tab.
For plots created from worksheet data, Select the Worksheet Data, Maximum Points Per Curve check
box to enable Speed Mode for all the data plots in the layer that are created from worksheet data. Type
the desired value (n) in the associated text box. If the number of data points in a data plot exceeds n,
Origin displays a subset of the data plot containing n points, drawn by extracting values at regular
intervals from the data set.

4. For 3D data plots created from a matrix or for contour data in the layer, Select the Matrix Data,
Maximum Points Per Dimension check box to enable Speed Mode. Type the desired value (n, m) in the

X and Y text boxes. If the number of data points in a data plot exceeds n or m, Origin displays a subset of
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the data plot composed of -- at maximum -- n by m points. This subset is drawn by extracting values at
regular intervals from the matrix columns (X) and rows (Y).

For broad control, you can select Speed Mode from the Graph menu. This opens the speedmode X-Function
dialog. The dialog lets you specify which windows the settings should apply to ( Target ) and also, offers
several levels of data plot thinning from Off to High, plus Custom.

Click the Enable/Disable Speed Mode 1’"’ button on the Graph toolbar, to toggle
Speed Mode on/off for all layers in the graph window.

To turn off the Speed Mode is On banner for all graphs:

1. Select Preferences: Options to open the Options dialog box.

2. Select the Graph tab and clear the Speed Mode Show Watermark check box and refresh the graph, if

needed. Note that this only disables the banner across the graph; it does not disable Speed Mode.

Origin 2022b adds a page-level Mini Toolbar button to toggle the Speed Mode Banner
at the individual graph level.

3D Surface Plot from Virtual Matrix * = | =l ||t

i 83 @ EE

Z

% 4 Z

o
&

Th

[ B

11.3.5.1 Notes on Speed Mode

e  Skip Points and Speed Mode plot the last data point, by default, but this is controlled by system

variable @QSMEP.

e The Speed Mode controls on the Display/Speed tab of the layer's Plot Details only apply to what you see

on screen. They do not apply to graphs that are printed or exported, by default.
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e |If you wish to skip points in printouts, use controls in the Print dialog. See the discussion of the Skip

Points feature as it applies to some graph windows in the Origin Help file.

e |If you wish to apply Speed Mode settings to graphic export, please see this discussion of Performance
Group controls on the Miscellaneous tab of the Plot Details dialog box or use controls under the Export
Settings node in the Graph Export dialog.

e Speed Mode settings are saved with the graph template. If you make changes to Speed Mode settings for

a particular graph type, you will have to resave the graph template to make those changes permanent.

e  Always exercise judgement when using Speed Mode. Since Speed Mode systematically weeds out a
portion of your data points, any graph in which Speed Mode is turned on, may -- or may not -- accurately
represent your data, to your satisfaction. Always familiarize yourself with your data and adjust and

compare Speed Mode settings to ensure that trends in your data are accurately depicted.

11.4Publishing Your Graph: Copy/Paste, Image Export, Slide Shows and
Printing

There are a number of ways to present your finished graph.

e Copy a graph page and paste it in other applications such as Word, Powerpoint, etc.
e  Export the graph page as an image file (raster or vector).

e Send Graphs to PowerPoint.

e  Printout.

®  Slideshow within Origin.

(] Create Movies.

Please read details in the Publishing and Export chapter of this User Guide and the "Topics for Further Reading"
there.

11.50rigin Graph Types

Origin supports over 100 plot types. Origin's 2D graphs are plotted from Worksheet data. Origin's 3D graph
are plotted from Worksheet data (XYY, XYZ), a worksheet arrangement we refer to as a Virtual Matrix or
from Matrix data.

Origin Graph Samples of most 2D and 3D graph types are included with your Origin
software. To view graphs, supporting data and guidelines for making the graphs,
choose Help: Learning Center(F11).

The tables below list all Origin graph types, grouped by Plot menu category:

@

File Edit View | Plot || Column Worksheet Ar
[
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e The Plot menu icon for each graph type precedes the graph name.

e The Notes column provides basic information on data requirements. For more specific data

requirements, click on the graph name beside the Plot menu icon.

11.5.1Plot Menu Graphs by Category
P Plot menu templates display basic data requirements on hover.

IR

o Oweerl.., Half Box  Bar Overlap Bar Mormal Scatter Doub

& 4|+
+*E

Box Mormal

Select at least one column to create box chart with data points and

normal distribution curve on right side,
1

ulti-Panel  Distribution  Distribution  Histogram Stacked Population  Marg
stogram + Rug with Labels Histograms  Pyramid  Histoc

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.
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11.5.1.1 Basic 2D

Graph Types

Notes

- Scatter

L] Scatter Central

) Column Scatter

Y Error

Hi
FI_' XY Error

Error Band

1 .\catter + Ru

Bubble

Color Mapped

Bubble + Color Mapped

Start with a Worksheet.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

Line

Horizontal Step

Vertical Step

Spline

Start with a Worksheet.

Select one or more Y columns or at least a portion
of one Y column.

Multiple Y columns are grouped in layer.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.
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Graph Types

Notes

Line + Symbol

(E

Line Series

L
T
b e
LY
s dn

Before and After Graph

2 Point Segment

3 Point Segment

Spline Connected

Start with a Worksheet.

Select one or more Y columns or at least a portion
of one Y column.

Multiple Y columns are grouped in the graph layer
(except Line Series).

For Line Series graph, select 2 or 3 Y columns.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

Lollipop Plot

Vertical Drop Line

Start with a Worksheet.

For Bar, Column or Column + Label, select one or
more Y columns (multiple Y columns are grouped
in layer).

For Floating Bar/Column, select two Y columns.
For Stack graphs and Lollipop plots, select two or
more Y columns.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

Density Dots

Color Dots

Start with a Worksheet.

Select one Y (Density Dots) or two Y (Color Dots)
columns.

For more information, follow links in the Graph

Types column.
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Graph Types Notes

i e  Start with a Worksheet.

| . .
. . [ )
Colormapped Line Series If there is an associated X column, X column

\\_ supplies X values; otherwise, Y sampling interval
:./'\;_d_ Stacked Lines by Y or row number is used.
Offsets

e  For specific data requirements, follow links in the

Graph Types column.

Row-wise

11.5.1.2 Bar, Pie, Area

Graph Types Notes

B

Column

LK1
=]

Column + Label e  Start with a Worksheet.

e  For Bar, Column or Column + Label, select one or

Bar more Y columns (multiple Y columns are grouped

in layer).
Stacked Column

For Floating Bar/Column, select two Y columns.

For Stack graphs and Lollipop plots, select two or
Stacked Bar

more Y columns.

100% Stacked Column (] If there is an associated X column, X column

supplies X values; otherwise, Y sampling interval

TETERE

100% Stacked Bar or row number is used.

For specific data requirements, follow links in the

Floating Column Graph Types column.
[
[ |
H Floating Bar
il

Kite Diagram
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Graph Types Notes

3D Color Pie Chart

2D Color Pie Chart

e  Start with a Worksheet.
Doughnut Plot °

Select exactly one Y column or a range from one Y

N

>
j

@« column.
N

&)

J

2

0

Pi i . ;
le of Pie . If there is an associated X column, the X data are
used in the graph legend; otherwise row number is

Bar of Pie

used.

. e  For specific data requirements, follow links in the
Doughnut of Pie

Graph Types column.

Doughnut with Total

Pie with Different Radius At Origin 2022b New Graph

L
w Type: Bar Map
Doughnut with Different
-?:5'
¥ Pie Ma|

Wi
Bar Map
WArea e  Start with a Worksheet.
i\ 'r'k,-"-.-. e If there is an associated X column, X column

e  For specific data requirements, follow links in the

Fill Area Graph Types column.

. supplies X values; otherwise, Y sampling interval
i or row number is used.

100% Stacked Area
S

A “JFill 2 colors
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11.5.1.3 Multi-Panel/Axis

Graph Types

Notes

mDouble—Y Column Graph

. .

L]

‘.'
.

s Double-Y

2Ys, Column-
Line&Symbol

Start with a Worksheet.

Select two Y columns.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

=+ 13YsY-YY

b, {

« 1+ |3ys v-Y-Y
-

21/4Ys Y-YYY

= 1AYS YY-YY

Multiple Y Axes...

Start with a Worksheet.

Select one Y column for each Y axis.

Multiple Y Axes opens interactive dialog. Choose
plot type, number of axes, plots per layer, axis
color to match plot, etc.

For specific data requirements, follow links in the

Graph Types column.

l——
|£Vertical 2 Panel

|£ LHorizontal 2 Panel

[ et

Eli4 Panel

=l

P Pl

=== 9 panel
Al
sl IStack...

7l nSY

|.|£ Multiple Panels by
Label...

Start with a Worksheet.

Select one Y column (or range) per panel.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.
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Graph Types

Notes

& |Zoom

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow the link in

the Graph Types column.
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11.5.1.4 Statistical

Box Cha

i,

Beeswar

m Plot

Graph Types Notes
Box Chart Start with a Worksheet.
E Select at least one Y column or a range from at least one Y column.
Interval
Plot For specific data requirements, follow the link in the Graph Types
T | L column.
|_| Bar Chart
E I_'{E Box chart enhancements for Origin 2022b
= Box
Overlap
_"g -l-;_ e An Edge Thickness control is added to the Plot Details
lgl_:*lﬁ_.'? Box Percentile tab of box plots.
N?rma}l e The Connect Lines tab now supports a choice of
E.:.-'_ ;‘ connection types (e.g. Akima Spline) in addition to
= = |Half Box .
T =0 straight.
il
M Group Pattern Spacing Panel | Box Distribution  Percentile Label  Lines  Connect Lines
Overlap
-1 _|_ 5 B4 Connect Mean — = [] Connect within Subgroup
: %
|_l.'l'| I r‘ Bar [ Connect Median @ = Shaléhl to Symbal
== BB Straight o Fror
Normial Connect Data Points LineStyle |- 2 Point Segment Hie inront.
.. —- 3Point Segment | Line Behind
—'I— _E_ B4 Connect Percentiles Line G o B-Spline
i ne Color |« J Spline
Scatter _T Step Horz
— Percemties (%) Line Width .I: zep \.:g t
ep enter
¥ Step V Center
i ransparency «) Modified Bezie
I\/Lar inal ~ Alima spuﬂe' i
rts
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Graph Types

Notes

[ l”ﬂ} =[Histogra
m

I Histogra
m _+ Rug

-l'.-..-. Histogra
m + Probabilities

Hinszall
| el T murti-

Panel Histograms

Distributi

o

Dommmn | pistributi
on + Rug

o

]
.5| "
1 |_| Histogra
m with Labels

H Stacked

Histograms

Populatio
n Pyramid
sl

Marginal
Histograms

o, Ty [l

Marginal
Plots (Grouped
Marginal
Histogram)

Start with a Worksheet.
Select at least one Y column or a range from at least one Y column.

For specific data requirements, follow links in the Graph Types column.

7|7 ‘I HScatter
Matrix

Start with a Worksheet.
Select two Y columns or a range from two Y columns.

For specific data requirements, follow the link in the Graph Types

column.
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http://www.originlab.com/doc/Origin-Help/Histogram-Graph
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Graph Types

Notes

& &

Plot

é ol

with Box

& W

with Point

& S

with Quartile

&4

with Stick

* * Split Plot

Violin

Half

Violin
}Ridgeline

Start with a Worksheet.

Select at least one Y column (or a range from at least one Y column).
Split violin requires exactly 2 data columns, plus a third grouping
column.

For data requirements and other information on plot variations, see

Violin Plot.

For data requirements and other information on Ridgeline Charts, follow the
link in the Graph Types column.

i_,H
} Pareto

Chart - Binned
Data

r -
Ema.l.l_Pareto

Chart - Raw Data

¥

Start with a Worksheet.
Select one Y columns or a range from one Y column (Raw), or a 'Y
column of Binned results.
For specific data requirements, follow the link in the Graph Types

column.

|rt',';
-]

QC (X-bar
R) Chart

Start with a Worksheet.
Select at least one Y column or a range from at least one Y column.

For specific data requirements, follow the link in the Graph Types

column.
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Graphing

Graph Types

Notes

] Bridge
Chat}
n
I_JI!I *
L Stacked .

Stacked
idge

Horiz-
Bridge Chart

Start with a Worksheet.

Select one or more Y columns (or a range of one or more Y columns). If
there is an X column to the left of the Y column(s), this X column is
treated as categorical data; otherwise, the worksheet's row indices will

be used.

Origin Bridge Charts are variants of one basic chart type. For more

information, see Bridge Charts.

Altman Plot

0090 gy
; iDouble Y
Box
e  Start with a Worksheet.
- ] Probabilit e Select one Y column or a range from one Y column.
Plo e  For specific data requirements, follow the link in the Graph Types
- column.
Q-0 Plot
————— e  Start with a Worksheet.
""" Bland- e Select two Method columns and one Subject column (optional).

11.5.1.5 Contour

Graph Types

Notes

Labels
& ]

Gray Scale Map

-
e IContour - Cateqorical Z

e  Contour Color Fill, B/W Lines + Labels, Gray Scale
Map, Contour Profiles: XYZ, Virtual Matrix,
Matrix.

e  Contour - Categorical Z: XYZ, Virtual Matrix.

®  For specific data requirements, follow links in the

Graph Types column.
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Graph Types

Notes

EHeatmaQ
EHeatma with Labels

wee. |Split Heatmap

Heatmap and Heatmap with Labels start with a
Worksheet (XY, XYZ), Virtual Matrix or Matrix.

Split Heatmap starts from a Worksheet.

For specific data requirements, follow links in the

Graph Types column.

e
@ mContour Profiles
E=—]

@mlmage Profiles

Start with a Worksheet, Virtual Matrix or
Matrix (Image Profiles, Matrix only).
For specific data requirements, follow links in the

Graph Types column.

it -"J'§ Polar Contour theta(X)

r¢y)

fr.th# polar Contour r(X),
theta(Y)

Start with a Worksheet or Matrix.

For data requirements and other information on
polar contour graphs from worksheet data, see

Polar Contour from XYZ Data.

For data requirements and other information on
polar contour graphs from matrix data, see Polar

Contour from Matrix Data.

Ternary Contour

Start with a Worksheet.
Columns should be designated as XYZZ.

For specific data requirements, follow the link in

the Graph Types column.

2D Kernel Density

Start with a Worksheet.

Select at least one Y column or a range from at
least one Y column.

For specific data requirements, follow the link in

the Graph Types column.
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Graphing

Graph Types Notes

e  Start with a Matrix.

® Z values are from an imported raster image.

Elmage Plot For Origin 2022b, a

Transparency control is
added to the Plot Details
Colormap tab of Image Plots.

11.5.1.6 Specialized

Graph Types Notes

e  Start with a Worksheet.

e  For XYAM Vector, select three Y columns (or a

A range of the three Y columns).
R T Vector XYAM ®  For XYXY Vector, select two X columns and 2 Y
\;:/‘ columns (or a range of two X and two Y columns).
Vector XYXY e For specific data requirements, follow links in the

Graph Types column.

e  Start with a Matrixsheet with two matrix objects.

=+ e  The two matrix objects are the derivatives of the

- _Istreamline Vector Plot plotted curve in the (X,y) directions, respectively.
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Graph Types

Notes

Ternary, Line+Symbol

A\
A’l
e

Right-Triangle Ternary

Schoeller

A
O
c
=
(o]
<

Start with a Worksheet.

For specific data requirements, follow links in the

Graph Types column.

Origin 2022b New Graph

L
1§

“MEW Type: Right-Triangle
W Ternary

Y
)
Q
)
=

Line Fill

Start with a Worksheet.

Select at least one Y column (or a range from at
least one Y column). The X column displays as the
title of the radial axis around the chart. If there is
an associated X column, X column supplies X
values; otherwise, Y sampling interval or row
number is used.

Radar Charts are also known as "Spider Plots".

For more information, see Radar Chart (Spider
Plot).
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Graphing

Graph Types Notes

A
=S =

0.1 polar theta(x) r(Y)

)

(r.0% polar r(X) theta(y)

.rl Bar theta, r

i@ e  Start with a Worksheet.

(.7 Bar r, theta e Select one or more Y columns or a range from one
iﬁ@ or more Y columns. If there is an associated X
e Line + Symbol theta, r column, X column supplies X values; otherwise, Y
@ sampling interval or row number is used.

fr.92 Line + Symbol r, theta e  For data requirements and other information on

polar graphs, see Polar Graph.

FETTETTETITRNTIRTIRTIIT
==

fhr) Symbol theta, r

EERNERTNT NN

r 12 symbol r, theta

(A

Sin Wind Rose - Binned Data
i A
Fi Wind Rose - Raw Data
e  Start with a Worksheet.
P ® Select at least one Y column of values (or a range

oy | from at least one column). If there is an
-/ Stacked Radial

associated X column, X column supplies X values;
ﬁ otherwise, Y sampling interval or row number is
Radial Bar Plot
used.

e  For more information, see Radial Bar and Radial
Stacked Bar Plot

Radial Stacked Bar

(] Start with a Worksheet.

e For Compass, Select at least one Y column of

Pamnt values (or a range from at least one column). If

.} H

|t K | there is an associated X column, X column supplies
—/ Polar Vector 0r er] ) .

rx"\l X values; otherwise, Y sampling interval or row

[‘\ ] number is used.

- Compass Plot
e For Polar Vector Or Or, select two pairs of XY

columns in the order 6r or.
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Graph Types

Notes

@ Smith Chart

Start with a Worksheet.

Select at least one Y column of values (or a range
from at least one column). If there is an
associated X column, X column supplies X values;
otherwise, Y sampling interval or row number is
used.

For more information, follow the link in the Graph

Types column.

High-Low-Close

Japanese Candlestick

I -I‘ OHLC Bar Chart

[l 8w BloHLC-Volume

5
D

Start with a Worksheet.

For specific data requirements, follow links in the

Graph Types column.

E
Bullet Chart
MVertical Bullet Chart
L]
ENormalized Bullet Chart

Start with a Worksheet.
Select one X column and at least two Y columns.

For more information, see Bullet Chart.
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http://www.originlab.com/doc/Origin-Help/High-Low-Close-Graph
http://www.originlab.com/doc/Origin-Help/Japanese-Candlestick
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11.5.1.7 Categorical

Graphing

Graph Types

Notes

L]
- .

w
-
;e
-
]
5 .

£ s *|Grouped Scatter -
Indexed Data

Start with a Worksheet.

Select at least one Y column as input data.

One or more column(s) of categorical data provide
grouping information.

For more information, see the link in the Graph

Types column.

Color Mapped

Bubble + Color Mapped

Start with a Worksheet.

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For specific data requirements, follow links in the

Graph Types column.

-|I|Grou ped Columns -

Indexed Data

Grouped Floating Bar

Start with a Worksheet.

Select at least one Y column (Grouped Columns)
or two Y columns (Grouped Floating Bar).

If there is an associated X column, X column
supplies X values; otherwise, Y sampling interval
or row number is used.

For Grouped Columns - Indexed Data, an
additional column supplies the Group information.
For Grouped Floating Bar Graphs, subgroup by

size (i.e. number of columns) or by column label.
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Graph Types

Notes

.'na‘chl Grouped Box Charts -
Indexed Data

Fgur EI Grouped Box Charts -
Raw Data

: ¢ Grouped Column Scatter -
Indexed Data

by 3t

Grouped Interval Plot -
Indexed Data

1'-
|.J Grouped Mean Bar -
Indexed Data

;
| &

Grouped Violin - Indexed

Hs. 'iy:.‘
L Grouped Half Violin -
Indexed Data

i Grouped Half Box -
Indexed Data

Start with a Worksheet.

Select at least one Y column (or a range from at
least one Y column), plus a second column with
grouping information. If there is an associated X
column, X column supplies X values; otherwise, Y
sampling interval or row number is used.

Plots of Indexed Data are all style variations of

the Grouped Box.

For more information, follow the links in the

Graph Types column.

* [ITrellis Plot

Start with a Worksheet.

Select at least one Y column as input data.
Optionally, you can have an additional associated
Y error column for each Y column. Other column(s)
generally contain grouping information.

For more information, see the link in the Graph

Types column.

Double Y Trellis Plot

Start with a Worksheet.

Select two Y columns as input data. Optionally,
you can have an additional associated Y error
column for each Y column. Other column(s)
generally contain grouping information.

For more information, see the link in the Graph

Types column.
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Graphing

Graph Types

Notes

LY [T
il.lL 1|.|.L Cluster Plot

Start with a Worksheet.

You need at least two Y columns, one of which

should contain grouping information.

Grouping columns can be used to create separate
panels in the horizontal and/or vertical directions
and/or to modify plotted points (color, scatter

point size, scatter point shape, etc.).

~lparallel Plot

Parallel Sets

Parallel Index

Start with a Worksheet.

Select at least one (ideally, two or more)
column(s) or a range from one or more columns.
Column designation does not matter. Each column
will be treated as data on a single variable.
Variables may be numeric (Parallel Plot or Parallel
Index) or they may be categorical (Parallel Sets).
Parallel Sets plots have a "curvature" option that is
sometimes seen in plots termed "Alluvial
Diagrams" (see next).

For more information, follow links in the Graph

Types column.

_! I[sankey Diagrams

<Alluvial Diagrams

Start with a Worksheet.

For Sankey Diagrams, select exactly two columns
of categorical data + 1 column of numeric data.

Column designation is ignored

For Alluvial Diagrams, select two or more columns

of categorical data. Column designation is ignored.

For more information, follow links in the Graph

Types column.

For Origin 2022b, an effort
was made to improve
responsiveness when
highlighting or dragging
(moving) nodes in Sankey
Diagrams.
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Graph Types

Notes

@

Layout

Chord Diagram

Chord Diagram with Ratio

Start with a Worksheet or Virtual Matrix.

Select at least three columns of values
(worksheet) or a block of values (virtual matrix)
from at least three columns.

The first column will be treated as X and should be

monotonic.

For more information, see Chord Diagram and

Chord Diagram with Ratio Layout.

'y

4

A

-1
I

~ERibbon

lfl 100% Ribbon

Start with a Worksheet.

Select at least two Y columns of values (or a range
from at least two columns).

If there is an associated X column, X column
supplies X values; otherwise, sampling interval of

the Y column or row number is used.

“w Network

Start with a Worksheet.

The plot requires one of three data arrangements:
Adjacency matrix, Incidence Matrix or Edge List.

A dialog box is used to specify input and analysis
parameters.

Regardless of data arrangement, an intermediary
worksheet will be created to tabulate node and link

information.

ii_,/ Sunburst Plot

Circular Packing Graph

Start with a Worksheet.

Select multiple categorical X columns and one Y

column.

Origin 2022b New Graph

’ .-':: g Type: Circular Packing

Graph

200



http://www.originlab.com/doc/Origin-Help/Chord-Diagram
http://www.originlab.com/doc/Origin-Help/Chord-Diagram
http://www.originlab.com/doc/Origin-Help/Ribbon-Chart
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11.5.1.8 3D

Graphing

Graph Types

Notes

)
8

3D Scatter

3D Scatter + Error Bar

RRER

3D Line

i

and

%

3D Trajectory

Data requirements vary by plot type. See links in

the Graph Types column.

3D Vector XYZ XYZ
o

3D Vector XYZ dXdYdz

Start with a Worksheet.

Select 6 worksheet columns, designated as XYZ
XYZ.

For more information, see links in the Graph

Types column.

3D Bar Graph

@JSD Stacked Bars Graph

3D 100% Stacked Bar

Start with a Worksheet (XYZ) or a Virtual
Matrix or Matrix of Z values.
For specific data requirements, follow links in the

Graph Types column.
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Graph Types

Notes

Color Fill Surface

Ak

X Constant with Base

2]
c
=
—
Q
(2}
(0]

Y Constant with Base

Color Map Surface

&

Color Map Surface with

T

rojection

Wire Frame

Start with a Worksheet or Matrix.

For specific data requirements, follow links in the

Graph Types column.

ﬁ 3D Ternary Colormap

Surface

" .. 3D Ternary Symbol

Start with a Worksheet.

Select two Z columns (XYZZ) or a range of data
from two Z columns (Z columns may be multiples
of 2).

For more information, follow links in the Graph

Types column.

;
3D Tetrahedral

Start with a Worksheet.

Select two Z columns (XYZZ) or a range of data
from two Z columns (Z columns may be multiples
of 2).

For more information, follow links in the Graph

Types column.
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Graphing

Graph Types Notes
e  Start with a Worksheet.
@ ® Select at least one Y column (or a range from at
Waterfall
least one Y column). Ideally, select at least two Y
| z Waterfall v Color columns (or a range of at least two Y columns). If

there is an associated X column, X column supplies

X values; otherwise, Y sampling interval or row

Waterfall: Z Color number is used.
Mappin . . . .
e  For more information, see the links in the Graph
Types column.
3D Waterfall
4 " 3p waterfall: Y Color

Waterfall, Waterfall: Y
Color Mapping and
Waterfall: Z Color Mapping,
are only available from the 2D

Graphs toolbar.

3D Waterfall: Z Color

(] Start with a Worksheet.

@ ® Select at least one Y column (or a range from at
XYY 3D Bars

least one Y column). Ideally, select at least two Y

.!I columns (or a range of at least two Y columns). If
XYY 3D Side by Side Bars : :

there is an associated X column, X column supplies

@J X values; otherwise, Y sampling interval or row
XYY 3D Stacked Bars :

e

number is used.

e  For more information, see the links in the Graph
XYY 3D 100% Stacked

Types column.

e  Start with a Worksheet.
® Select at least one Y column (or a range from at
least one Y column). Ideally, select at least two Y
columns (or a range of at least two Y columns). If
@ there is an associated X column, X column supplies
3D Ribbons X values; otherwise, Y sampling interval or row
number is used.

e  For more information, see the link in the Graph

Types column.
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Graph Types Notes

e  Start with a Worksheet.

® Select at least one Y column (or a range from at
@ least one Y column). Ideally, select at least two Y
3D Wall Graph columns (or a range of at least two Y columns). If

l L there is an associated X column, X column supplies
< —* 3D Stacked Wall Graph

- X values; otherwise, Y sampling interval or row
@ number is used.
3D 100% Stacked Wall . i .
Graph e  For more information, see the link in the Graph

Types column.

For an overview of Origin's 3D graph types and their source data requirements, see these topics:

e Creating 3D Graphs

(] 3D and Contour Graphing

(] Creating Contour Graphs

® Creating 3D and Contour Graphs from Virtual Matrix

11.5.1.9 Browser Graph

Select Al « Wotwall Waterfall*
Unigeliect All i
Select every Sth 2600 E
Select every 108h Long Hleme: = 2000 E
Select every 580 o 1500 E
Select every 100th o 1000 E
Select evry Hih... 606
500 F
£08
[#] suta Rescate - Hare 0

Autn Bescale - ¥ Oaly 612 - 200
Alita Rcale - All
Resave Unislacted

Browser _graphs are useful for selectively plotting data from worksheets containing many columns (and rows),
into a single graph layer:

e Select a single plot or every Nth column for plotting.

e  Easily change column selection.

e  Stretch the window in either dimension to obtain the best view.

e  Specify automatic rescale and/or common display range for all plots.
e  Works with other Origin tools including Gadgets.

®  Plots can be further customized via Plot Details dialog box.
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Graphing

The page-level Mini Toolbar includes an Add Browser button so that you can add a
Browser panel to a regular 2D line plot.

Browser Graph

Graph Types

Notes

K

Black Lines

X
>

IColor Lines
ﬂﬂ Histogram

Stack

Starts with a Worksheet.

Plot selected Y columns, plot every nth column or
plot all columns.

For more information on use and configuration of

Browser Graphs, see Graph with Browser Panel

11.5.1.10 Function Plot

Graph Types

Notes

N/

X ==

New 2D Plot

R~

New 2D Parametric Plot

Function plots are not created from physical data.
Once a function plot is created, you can obtain the
derived dataset.

For more information on function plots, follow links

in the Graph Types column.

New 3D Plot

New 3D Parametric Plot

Function plots are not created from physical data.
When a 3D Function is plotted, a matrix of Z
values is simultaneously generated.

For more information on function plots, follow links

in the Graph Types column.
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11.5.1.11 My Templates

Dialog Box

Notes

j My Templates

This Category lists and gives direct access to the

custom templates in your User Files Folder.

11.5.1.12 Other Graphing Tools

App

Notes

if'lll

Graph Maker App

The Graph Maker app is pre-installed in your

Origin software.

Launch the App from the Plot menu or from the
Graph Maker app icon in the Apps Gallery to the

right side of your Origin workspace.

Use the Graph Maker app with Preview pane, to

interactively plot grouped data.

Choose from line, scatter, line+symbol, column,
box and histogram chart types.

Supports fitting for scatter plots.

Drag-and-drop worksheet columns to set up the
graph.

Graph settings are saved and can be re-loaded.

ﬂj Template Library

Use this dialog to organize your custom graphing

templates.

11.6Topics for Further Reading
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Graphing

Zooming In or Out on the Graph Page

Creating Multi Layered Graphs

Adding Data Plots to the Graph Layer

The Layer Contents Dialog Box

The Object Manager

Graph Layers

Linking Layers
3D and Contour Graphing

Graph with Data Slicer

Plotting Mathematical Functions

Batch Plotting

Appendix 2 - Complete Listing of Origin Graph Types
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12 Customizing Graphs
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12.1 Introduction

Double-click an
Legend to
Customize

Legend

Show Contour Labels l

This chapter introduces you to various aspects of graph customization. All Origin graphs start from a graph
template. If the graph you are making is fairly standard for its type, the options that were stored in the graph

template may be entirely adequate to produce a polished-looking graph. The business of basic graph creation
was covered in the last chapter, Graphing.

Sooner or later, however, you are going to want to add annotations, modify axis scales, or change plot colors.
Hence, the purpose of this chapter is to introduce you to some key Origin graph customization tools and

techniques, as well as to point you toward resources that will help you manage more complex graph
customization tasks.

We begin with a discussion of the graph customization-related toolbars, as these toolbars have tools that are

commonly used for quick modifications of graph elements.
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12.2 Dockable Toolbars

Toolbar buttons useful for graph customization tasks, include the following:

L Toolbar
DS (default configuration)

Format toolbar buttons:

e Creating and
customizing text

objects.

Style toolbar buttons:

e  Editing colors, line

thickness, fill patterns.

Tools toolbar buttons:

e  Add text objects,

lines, curves, arrows, b & A+ @I THA-w-m- M & - O @

rectangles/circles/poly

gons.

Graph toolbar buttons:

e Add graph layers incl.
inset graphs, merging

or extracting graphs;

E. 2 B4 B3 [ f%

exchanging axes;
anti-aliasing and
Speed Mode.

210


http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars
http://www.originlab.com/doc/User-Guide/Toolbars

Customizing Graphs

Description

Toolbar
(default configuration)

Add Object to Graph toolbar
buttons:

e Add legends/color
scales/bubble scales;
date & time and
project path stamps;
XY scale; table

objects.

=@M~ H @0

Object Edit toolbar buttons:

e Arranging and aligning
objects and layers on

the page.

2 S 0000 2 e Zoooes % oocm N

12.3Menus, Dialogs and Buttons Used in Graph Customization

Many quick graph customizations can be done using Origin's graphing Mini Toolbars. More complex
customization options can be accessed from commands on the Format or Graph menus. The following table
lists key menu commands and dialog boxes plus a few toolbar buttons, used in customizing graphs.

Task

Dialog Name Method

Customize the graph

Plot

e Double-click on Page, Layer or Data
Plot

® Format: Page... menu
® Format: Layer... menu

e Format: Plot... menu

See, Customizing Page, Layer and Data
Plots
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Task

Dialog Name

Method

Double-click on axes or tick labels
Format: Axes... menu

Format: Axis Tick Labels... menu

Customize Axes Axis Dialog
e Format: Axis Titles... menu
See, Customizing Graph Axes
® Click the Reconstruct Legend
B
(CTRL+L) ™%l putton on the Add
Object to Graph toolbar
® Right-click on the legend object and
f‘dd ac?efault choose Legend: Reconstruct
egen N/A
(most 2D Legend
graphs)

Choose Graph: Legend:
Reconstruct Legend from the main

menu

See, Graph Legends

Customize the

Legend

(Text Object -)
Legend dialog

Ctrl + double-click on the legend

object text

See, The (Text Object Properties) Text tab

Update Legend
dialog

Right-click legend and choose
Legend: Update Legend or choose

Graph: Legend: Update Legend...

See, The legendupdate Dialog Box

Legends/Titles tab
at Page level of Plot
Details dialog

Double-click in the white area just
inside graph window frame (but

outside of the data plot), then click on

the Legends/Titles tab

Choose Format: Page and click on

the Legends/Titles tab

See, The (Plot Details) Legends/Titles tab
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Task

Dialog Name

Method

Add a Color Scale

Click the Add Color Scale ™=/ putton
on the Add Object to Graph toolbar

N/A
(color-mapped plots)
See, Color Scales
® Click the Add Bubble Scale @
Add a Bubble Scale button on the Add Object to Graph
(symbol-size mapped N/A toolbar
plots)
See Bubble Scale
® Graph: Merge Graph Windows...
Merge multiple graph _ menu
windows into one Merge Graphs dialog
graph window See, Merge and Arrange Graphs (tutorial)
and The Merge Graph Dialog Box.

Adjust multi-layer
graphs:

resize, move, swap,
align, or add layers

Layer Management
dialog

Graph: Layer Management... menu

Right-click on the layer icon.

See, Layer Management-Quick Start
Simple adjustment of e Graph: Arrange Layers... menu
multi-layer graphs: Arrange Layers . ) )
arrange and/or resize dialog e Right-click on the layer icon.
layers
e File: Save Template As... menu
e  Right-click graph window title and
i S T late A
Save settings as d_a\lle emplate As choose Save Template As...
graph template 1alog
See, Graph Template Basics
¢ Plot > Template Library menu
Manage graph ) (worksheet or matrixsheet is active)
templates, Template Library
plot to a template
See, The Graph Template Library
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Task Dialog Name Method

e  Right-click and choose Save Format

as Theme... context menu (graph is
Save settings as Save Format as active)
graph Theme Theme dialog

See, Saving Formats to a Theme

e Preferences: Theme Organizer.. >

Manage Gre}ph Graph tab.
Themes: edit, Theme Organizer
combine, apply dialog ® F7 hotkey.

Theme, set as

System Theme .
See, Theme Organizer

12.4 Quick Editing: Mini Toolbars and Object Manager

While the dialog boxes listed in the previous section will provide full access to plot properties, settings are
sometimes buried and hard to find. Often, the most convenient way to carry out common graph editing tasks
is to use Mini Toolbar buttons or Object Manager short-cut menu commands -- or a combination of the two.

12.4.1Mini Toolbars for Graph Editing

Most Origin graphs support a set of "quick editing" tools for interactively modifying common graph object
properties. Tools are context-sensitive so that -- (1) depending on where you click inside the graph window, (2)
what the selected object is and (3) whether you have selected an individual plot or a plot group -- you will

have a different set of tools available to edit your selection.

@ T £ F 3t 2 | Hide Locks
Clickon... c [FP ey el
03
1
an empty iJO 6
spot on the @! ¥ | Layer Frame
graph page " c ) Hide Show Layer Frame
| O .
... an empty :
spot inside the EEL s
graph layer .
0.3
]
0a b I, . onadata |«
plot
B ... 1o edit
__| e e ...onatextor common
o—El—e—LEl—w—FL> i
_ES e 6 e Flepg) | Or@WNODleCt properties of
h v vl I Vi I v v v v I 8 I W I v10 I vil I\_IJ._I__'-I______S__'T'-___D these Objecrs

Font Size | [Times1 |18 - |[A7] A” ona
; graph axis
ABOOG I or tick label

e  Workspace display of Mini Toolbars is controlled via View: Mini Toolbars.
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e There are five levels -- i.e. five groupings of graph properties -- that can be edited with Mini Toolbars:
page, layer, plot, text or drawn objects and graph axes.
e When editing grouped plots, a single click will select a single plot. The Mini Toolbar displays two tabs --

one for the customizing the group, the other for customizing the single plot.

aroup —  single
tab _—" tab

®  Most Mini Toolbars have a "properties” : button that opens a related Origin dialog box where you will

find the full range of available controls.

Unless you have changed your selection, you can do a one-time restore of a Mini
Toolbar after it has faded by pressing the SHIFT key.

Prior to Origin 2022b, the View: Mini Toolbars setting was not remembered across
! sessions (i.e. if turned off in the current session, they would be restored on Origin
mimddal restart). Now, this setting is remembered across sessions (alternately, you can control
I:-Té' Mini Toolbar display by setting system variable @DMT (ON=0; OFF=1)).

12.4.1.1 Controlling Buttons that Increment

Some Mini Toolbar buttons will increase or decrease some property by some increment, each time you click
the button (e.g. font size, rotation angle, layer grid spacing). In such cases, you can modify that increment by
manipulating the value of a LabTalk system variable.

u
g{;ILarger Gap, increment=5, change increment by setting @IMNC5G to other value, I

For information on these LabTalk system variables, see this Appendix in Origin Help.
12.4.2Manipulating Graphs with the Object Manager

The Object Manager is general tool for managing Origin windows but it is especially useful for manipulating
graph windows. When a graph window is active, the Object Manager offers alternate views -- toggled by right-
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clicking in an empty portion of the Object Manager and choosing Show Plots or Show Graph
Objects(Ctrl+Shift+S):
e Show Plots: a collapsible, hierarchical list of plots by layer, plot group, etc.

e Show Graph Objects: a collapsible, hierarchical list of window objects (legends, text objects, images,

etc.) by layer.

Object Manager Tips:

e  Whether in Show Plots or Show Graph Objects view, right-clicking on an element will open a shortcut
menu of relevant actions (ungrouping a set of plots or designating a plot as the first plot in a plot group,
for instance).

e Common to both views is a check box beside each element; when checked, the element displays in the
graph window, when cleared, the element is hidden.

e  Additional shortcuts give quick access to source data, to Plot Details, allow you to rearrange plot or object

order and to other relevant tasks such as opening an inserted image in an Image window for further
editing.

12.4.3Editing Graphs Using Object Manager and Mini Toolbars

When a graph is active and you select graph elements in the Object Manager, a Mini Toolbar will show (make
sure the Mini Toolbars option is checked in the Show Plots/Show Graph Objects shortcut menu as shown
in the image above).

With the available buttons, you can make quick customizations to common plot properties such as line color,
line thickness, display of labels, etc.

New in Origin 2022b: In Object Manager Show Graph Objects view, a new Select
All with Same Name shortcut menu entry. Use in combination with Mini Toolbar
buttons (e.g. Font Size) to make quick graph changes.

12.5Customizing Page, Layer and Data Plots

A graph window is a collection of objects, organized in a hierarchical structure. As we shall see, there are
editable properties at the Page, Layer, Data Plot and Data Point levels.

Quick formatting of many plot properties can be done using Mini Toolbar or dockable toolbar buttons, as
mentioned above. However, more comprehensive access to plot properties is available from each graph's Plot
Details dialog box.

To open Plot Details:

e  Double-click on your plot.
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e Click the Format menu, then choose Page..., Layer... or Plot..., to open Plot Details at the

corresponding level.

The figure below shows an example of the Plot Details dialog box:

e  The left panel depicts the Page > Layer > Plot hierarchy as an expandable/collapsible tree.

e  The right panel contains controls, organized by tabs, that pertain to the object that is currently selected in

the left panel.

e To customize an object, select it in left panel and modify the corresponding properties that appear on

the various tabs in the right panel.
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Selected Left Panel
Object

Right Panel, Controls for...

Layer

Settings that are specific to the graph layer -- Layer background colors, layer size
and speed mode settings, layer display settings, stack settings for applicable plot
types. Some plot types will include extra tabs/controls specific to the plot type.

Plot

Plot-specific properties. The tabs and controls vary by plot type (e.g. Scatter plots
have a Symbol tab with controls pertaining to scatter symbols, Line plots a Line tab
with controls pertaining to line plots). Anything to do with a particular data plot --
color, fill patterns, colormapping, labeling -- will be found at this level in Plot Details.

Data Point

Properties that apply to user-specified "special points". Available for any plot for
which plots discrete points (scatter, line + symbol, column/bar, etc.). The tabs and
controls are generally similar to those available at the Plot level but any property that
you set at the level of a special point, will apply only to that point.

8 ' Plot Details - Plot Properties

sl

clear check mark to hide object
{layer, plot, point)

—
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of dialog box

click to return to source worksheet
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Prevent text and label objects from scaling when resizing layer, by going to the Size
tab of Plot Details (Layer level) and setting Fixed Factor to 1.

12.5.1Customizing Grouped Plots

Beginning with Origin 2020, there was a change in selection behavior that affects
grouped plots. Now, a single-click on a plot selects the plot. A second click (or
CTRL+click) selects a single point. SHIFT+click selects the entire group. Note that when
using the new mini toolbars, a single click on a plot group displays tools for editing the
plot group or the single, selected plot. To revert to the old plot selection behavior, set

@GSM=0.
group — . single
tab _—" tab

"___,--'

When you select and plot multiple data ranges to a single graph layer, the plots are grouped in the layer.
Generally speaking, plots within a group are automatically differentiated by assigning styles built from one or
more customizable "increment lists", one for each plot property (symbol shape, symbol color, line style, etc.).

By default, some properties are configured to increment "by one" (e.g. line color is assigned according to the
"Candy" color list and each successive plot is assigned the next color in the list) and some will be configured
not to increment (e.g. line style is solid for every plot), though this is ultimately controlled by the user. In any
case, the increment lists for each property are saved with the graph template (.oggu) or Theme file (.oth) so
that you can easily use them later to create graphs with the same look.

G |Line | Symbol | Panel | Drop Lines | Label | Offset

i - Sl Line Color, Symbol Type, and Symbol Edge
color increment By One Between Subgroups

Shap
ol 7 | Line Style and Symbol Interior do not increment
Sepll_ L (Line Style and Symbol Interior are "Solid")
Shepl
Sl
v
[ B | ez | oo | e | fee) | oom | Hom | wem | s | wow | o |-
Long Marme | Sensod Ax SensofAy SensorBx SensorBy SensorCax SensorCy  SensorDix | SensorDy SensorEx | SensorEy | SensorFx B
e By Sze |__concdd conchd coned concl2 £oncdd ooncl3 concld concdd concds oonchs concls
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FL=
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219


http://www.originlab.com/doc/User-Guide/Customizing-Graphs
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Quick-Help/permanent-change-system-variable-value
http://www.originlab.com/doc/Origin-Help/PD-Dialog-ColorList-Tab

UserGuide_2022b

The above image shows the Plot Details Group tab settings for a line + symbol plot in the upper-left. On this
Group tab, the first column lists Line Color, Symbol Type, Line Style Symbol Edge Color and Symbol
Interior. Properties of Line Color, Symbol Type and Symbol Edge Color are set to increment By One and
Between Subgroups (subgrouping occurs using the column Comments), while Line Style and Symbol
Interior are set to increment by None (they do not vary).

As previously mentioned, this arrangement is completely customizable and you can save customizations with

the graph template:

e To find out more about customizing of grouped and subgrouped plots, see The Plot Details Group Tab

Controls.

e To find out more about saving graphs as templates, see Graph Template Basics.

12.5.1.1 Using Object Manager with Grouped Plots

e To highlight a single plot and dim others (grouped or ungrouped) in the layer, click once on the plot in

Object Manager. Conversely, clicking once on a plot in the Object Manager, highlights the plot in the graph

window, while dimming others.
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e To reorder plots in the layer, drag a plot icon within the group; or right-click on the plot (in Object

Manager) and choose Move Up or Move Down.

Object Manager

* 0 X

- i Graph®3
1A Layer
-:Elg'l

[ —e—E1
—e—E2

Object Manager

* 0 X

(=1L Grapht3
=1 A Layer1
=1k gl

e To group or ungroup data plots in the layer, right-click on the group icon ("gN") and choose Ungroup. To

group plots in the layer, right-click on a plot and choose Set as Group Begin.
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e To move a plot from one group to another, drag the plot to the other group.

e To move a series of plots out of the group, right-click the last plot that you want to keep in the group and

choose Set as Group End.
e Toremove a plot from the layer (and the graph), right-click on the plot and choose Remove.

e To move a plot to a second Y axis, or move the plot to another layer, right-click on the plot in Object

Manager and choose Move Plot to Second Y Axis or Move Plot(s) to Other Layer ....

12.5.2Customizing Multi-layer Graphs

The graph layer is a fundamental concept in Origin and it is a primary building-block of most complex Origin
graphs (e.g. a graph with both left and right Y axes is constructed by overlaying one layer on another, and
sharing a common X axis between the two layers). While the graph layer is, fundamentally, a self-contained
unit it is, at times, desirable to create dependencies between layers:

e  One type of dependency is what we call "linking" of layers, which involves establishing spatial relationships

or relationships between axis scale values. You can read more about linking graph layers, below.

e  Another type of dependency is based on what we call "common display" and this is most useful in a
situation where we have multiple similar panels in a graph and we want to do something like change the

background color of each graph, or perhaps the change plot colors used in each layer.

For Origin 2022b, a new Add Label for Layers button is added to the page-level Mini
Toolbar (hint: click outside of graph layers to show).

At the graph page level in Plot Details, you will find a Layers tab that has controls that affect all layers within
a given graph page. The Common Display controls can be used to enable simultaneous editing of layer, plot
and axis properties of multi-layer graphs. For instance, in the following example, we have a two-layer trellis
plot -- the two layers being necessitated by there being a left-Y axis and a right-Y axis with two completely
different scales -- and as a simple illustration, we have used the Common Display controls to simultaneously
add a background color to both layers. We could have accomplished the same thing without using the Common
Display controls but this would have required twice the work -- set the background color of layer 1, then set
the background color of layer 2.
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This was a simple illustration but we can use the Common Display controls for application of more complex mix
of layer, plot and axis properties. Some of Origin's built-in multi-layer graph templates have Common Display
elements turned on by default. When working with multi-panel graphs, you may want to choose Format:
Page, click the Layers tab in Plot Details, and check the Common Display settings. See Common Display
for more information.

. The Common Display Apply to control supports including or excluding certain layers

¥ ' from common display customizations. For instance, you might have a 4 panel graph,
each with an inset layer and using this control, you could apply a common background
color to the inset layers without applying the same background color to the 4 primary
layers (panels). See Common Display for more information.

12.5.3Special Points: Customizing a Single Data Point

You can customize line style within a single data plot (e.g. between data points in a line
+ symbol plot). For Origin 2022b, you can assign line style according to a custom
increment list.

1. Double-click on the plot to open Plot Details, then click the Line tab.
2. Set Style = Increment, adding a Line Style List tab.

3. Enable custom increment list and customize the list as needed.
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For some plot types such as scatter, column or pie, you can modify the display properties of a single data point.

To edit a single point:

1. Click twice (slowly) or press CTRL + click on a data point to select it. Use the Mini Toolbars to edit

properties of the data point; or click available buttons on the Style or Format toolbars.

2. For access to a wider range of customization options, (a) double-click on the selected point or (b) CTRL +

double-click on an unselected data point. This opens the Plot Details dialog box with the focus set to edit

the data point (identified in the left-panel of Plot Details by its row index number). Then use controls on

the tabs in the right panel to modify the appearance of the data point, add drop lines, data label, etc.

Changes you make to the special point will not affect the appearance of other points in the same plot.

a {Zr Graph2
# [ Layerl
%] [Group DAT]Growp! A[X), B(Y) [1%:5°]
[+ [Group DAT]Group! A, CY) [1*:6%]
4 [ [Growp DAT)Group! A(X), D(Y) [1%:67]
B3]

Single data point
selected for editing.

When this box is cleared,
you can select a custom
symbaol shape from the
Symbol Gallery

Plot Details - Plot Properties

Symbol  Drop Lines | Label

Preview Size Auto v
b, A )
A = ciickfor Symbol Gallery )
Edge Thickness | Auto W
Symibol Colar W uto v

[+] Aute Transparent

| Custom Construction
& Geometn.

Sangle Alphabetic L7 4 Do nTnangle
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Note:: When the Custom Construction box is checked, you can use these controls to customize the

plot symbol of the selected point. Custom Construction can be applied to any plot symbol -- not

simply those that are designated as special points.

[#] Custorn Construction
(@ Geometric

(0 single Alphabetic Shape | &\ 3UpTriangle v
() Incremental Alphabetics

() Row Murmber Numerics Interiar B solid "

() User Defined Symbols

Origin supports adding your own plot symbols. For more information, see User
Defined Symbols Grid.

To remove customizations made to a single data point:

e  Right-click the single point in the left panel of the Plot Details dialog and choose Delete.

. In the graph window, click on the single point to select it, then press DELETE on the keyboard.

The point itself is not deleted; only the custom style is removed, with the point reverting to the style of the
containing data plot.

i Adding a special point at the beginning or end of a plot is not always easy, but there is a
/ simple, foolproof technique:

1. Select a special point anywhere on the plot, then double-click on the point to open Plot

Details.

2. In the left-hand panel of Plot Details, click once on on the point index number and

wait until the index number becomes editable.
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3. To add the special point to the first point in the plot, type Begin; to add to the last
point type End. If you know the index number of the first or last point, you can type
that instead.

4. Click outside the edit box. Make other special point customizations as needed, the click
Apply or click OK to close Plot Details. The special point will be added to the beginning
or end of your plot.

12.6 Customizing Graph Axes

Many common edits to axis properties can be done quickly from Mini Toolbar buttons. Click on an element
to edit.

L GER
RUS | Eurcpe
DNE
EEEEE ”
|5E9':'"='-" v” 14 v|A. A Open Properties Dialog
2 =2 e
ABQOO@- '151')
| | LN
18- 17 17 - 20 20- 24 2627

For more complex edits of axis properties, open the Axis Dialog:

e from the Axis Mini Toolbar > Open Properties Dialog.

e from the Origin menu > Format: Axes.

12.6.1Customizing Axes with Mini Toolbars

For quick adjustments to axis properties, you can use Origin‘s axis Mini Toolbars. As with all Mini Toolbars,
available tools will vary by plot type and selected object. For instance, note that clicking on a graph axis line
brings up a different set of buttons than clicking on the axis tick labels.
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Note that clicking the "gear" button on the axis line Mini Toolbar produces a popup menu with simplified "Mini
Dialogs" for axis line elements. For access to all axis settings, click Axes Dialog on either toolbar.

12.6.2Customizing Axes with the Axes Dialog Box

All graph axis customizations can be made in the Axes Dialog box. Click on the Mini Toolbar "gear" button
and choose Axes Dialog; or double-click on the graph axis or tick labels. This will open the Axis Dialog -
Layer N dialog box.

This image shows the tab-based axis dialog used by most 2D and 3D graphs.

87 X fugs - Layer 1 T x
Scale Ticklabels Title Grids Lineand Ticks Special Ticks Reference Lines Breaks Rug

i e ey ee——— :
; From L

Horizontal To 180

M Type !E Linear o

Rescale Nnrm.al w

Vertical

Rescale Margin(%) 8

Reverse N
B Major Ticks
Type “B}r.lm:r:maeni v|
Value 20
Firt Tick | |
El Minor Ticks v

Select multiple axes to customize together,

Apply To.. Cancel Apply

In the left panel, you can select one or more icons (hold the CTRL key to select multiple icons) to specify the
axis or axes to be customized, then select the desired tab and choose your options.
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Tab Controls for
Scale Scale range of values, scale type, rescale mode and margin, reverse scale, major and
minor ticks.
Display and Format options for major and minor tick labels, including custom labeling using
LabTalk substitution or mathematical expression. For information on custom formatting of
numeric data including display of percentages, fractions, pi, and geographic (Lat/Lon)
formats, see Origin Custom Formats.
Tick Label additions to Origin 2022b:
..'-_' .*.:.L' ®  Previously, users had to set page.longminus=1 to use a
Tick Labels Unicode (long) minus sign in tick labels. Now, all graphs
created from system templates will automatically use the
"long minus" (to roll back this change, set @TNA=2 or
=3).

e Axis dialog Display tab controls for displaying scientific
notation (base + exponent) at a single location along the
axis, rather than appending it to each significand.

. Axis title (often set using variable notation) and font options. Note that you can directly edit
Title L S
by double-clicking the text object in the graph.
Grids Control display and properties of grid lines at major and minor ticks.
Line and - . . .
Ticks Global axis line and tick display options for all axes.
Spemal Placement of special tick labels.
Ticks
Reference lines are optional lines that you add to your graph, either for emphasis or to
mark some key statistic. Additionally, they can be paired to add fill color to some portion of
your graph (e.g. "recession bars" in plots of financial data).
Reference
Lines \
You can use named ranges to place Reference Lines on a
graph.
Breaks Enable line breaks and configure each break.
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Click the Apply To... button to apply the axis format settings of the currently selected
axis to another axis.

Origin 2022b supports wrapping of tick labels for languages which typically do not use
space between characters (e.g. Japanese or Chinese). Controls are found at Format:

',--.1'- .“-'I." N
r')f :..i | f Axes > Tick Labels > Format > Wrap Text.

Note: For more information on axis customization and for axis controls for specialized graph types (e.g.
polar, ternary, radar chart.etc), refer to:

Help: Origin: Origin Help > Graphing > Graph Axes

12.7 Customizing Data Plot Colors

Origin ships with a number of installed color lists or palettes. If you prefer to create your own color lists or you
have a standard set of palettes and want to port them over to Origin, there are a number of tools available in
the software for doing that. See the next section, Color Manager, for more information.

12.7.1Color Manager

Use the Color Manager for importing, creating and organizing the color lists and palettes that you use in
Origin:

To open the Color Manager:

1. Choose Tools: Color Manager.

8 Color Manager ? X
Type @ColorLirﬁ@OPaleﬁa@ @
Available Import from ImportTfom Files W Selected for GUI ﬂ ﬂ
Color Name Category |* Name |c°|m A
Calor List Qualit ative 1| BueQrange _:_
saenta 2] Boi [ I
[Cree—— .. sens [ [T [ 5 E—w m
O 2 G (- | NN N
I:_ iridis Sequential |:| SltoloMBa | |
1 el Qe 7{comtne 5 D .
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The following list numbers correspond to controls shown in the image above:

Click these radio buttons to display installed Color Lists or Palettes.

2. Click Import from Web to open a dialog where you can specify a URL to install palettes. Support for
Scribus (.xml), Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch
Exchange (.ase) and JASC PaintShopPro (.pal).

3. Click to install locally-stored palettes. Support for Scribus (.xml), Office Color Table (.soc), Adobe Color
(.aco), Adobe Color Table (.act), Adobe Swatch Exchange (.ase) and JASC PaintShopPro (.pal).

4. Click to open the Build Colors dialog where you can build a color using a number of tools: using standard

color controls, direct entry of HTML codes or use an eye-dropper tool to pick onscreen colors. You can read

more about the Build Colors dialog in the Origin Help file.
5. Right-click on the Available list to Delete or Rename lists (you can also rename by clicking directly on
the name). Lists that are dimmed have already been Selected for GUI. Those that are Selected for GUI

appear from drop-down lists throughout the user-interface -- in Plot Details, from the Fill Color button

on the Style toolbar and from the Mini Toolbar Fill Color button when a plot or special point is
selected.
Use the list control to set Category = Undefined, Sequential, Diverging or Qualitative.
Use these controls to add or remove color lists and palettes from the user-interface (GUI).

Use these controls to move a selected list or palette up or down in the various GUI color lists.

© ® N o

Click Set Default Plot Colors to open the Theme Organizer's System Increment Lists tab, where you

can set default colors for use in your plots.

10. Drag list-number icons to rearrange GUI color list order.

12.7.2Applying Color to Your Graphs

There are many options for applying color to your graphs. We will try and cover the basics here, pointing you
to other resources for more in-depth discussion.

List of key topics on the subject of plot color:

(] The Color Manager

e  Customizing Data Plot Colors

(] Using a Dataset to Control Plot Color

(] The Plot Details Color Map/Contours Tab Controls for 3D and Contour Plots

12.7.2.1 Applying Colors Singly

Picking and applying a single custom color has been made easier with the addition of
the "eyedropper" tool to the Single tab of the Color Chooser. Previously, the
eyedropper tool was buried in the Build Colors dialog.

Applying colors singly simply means applying a single color to a plot as opposed to applying color from a color
list to a series of plots. It is the most basic way to apply color to a single plot or special point. Simply select a
color well from anywhere on the Single tab -- from the LabTalk colors at the top, from a selected color list, or
from a custom or recently used color.
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e Select a plot (e.g. scatter plot) and click the Fill Color button on the Mini Toolbar that appears.

e Select a plot and click the Fill Color button on the Style toolbar.

e  Double-click on a plot to open the Plot Details dialog box where you can click on a tab to the right side
(e.g. Symbol tab for a scatter plot) and set color for the element.

To create a special point -- i.e. to assign special characteristics to one data point in your plot -- press

Ctrl+click to select the point, then use the Mini Toolbar, Style toolbar or Plot Details controls to

customize color for that point.

12.7.2.2 Applying Colors By Points

Applying colors By Points generally means applying a color to each point in a plot by one of several schemes.
The simplest involves picking an Increment From color from a predefined color list and assigning colors, in
sequence, to each point in the plot.
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Color List: Bold2

| |

Color Options
() Indexing
() Direct RGB
() Color Mapping
() ¥ Value: Plus- Mmus

(® Increment from v
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As in the case of applying a single color, you can apply these settings using controls in Plot Details; or by
selecting the plot and using the Fill Color buttons on the floating Mini Toolbar or Style toolbar docked to the
top of your workspace.

Other schemes typically make use of a column of values to assign color to points:

o Indexing assigns point color by associating an integer or text string (categorical value) to different colors

in a list.
e Direct RGB assigns color using a value derived from columns of RGB values.

®  Color Mapping -- used for 2D, Contour and 3D plots -- assigns colors in a list or palette, to values across

the range of the plot's Y or Z values.

There are several other schemes which are specific to a certain plot type (or family of plots), but the list above
covers most of what you will use. For more information see Using a Dataset to Control Plot Color.

12.7.2.3 Applying Colors By Plots

You apply color By Plots when you want to assign differentiating colors to a series of plots. Typically, this
series of plots comprises a "plot group." In a plot group, plot attributes including color, are assigned to each
plot by incrementing through a style list -- color, line-style, symbol shape, etc.

Single By Pointsl__By Plots

Increment list: Bold2
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12.7.2.4 Applying Colormaps to 2D, 3D and Contour Plots

While you can use a color list with a contour or 3D plot, it is probably more common that you will use a color
palette. This allows a wider range of color variation and can add realism to to 3D surfaces and 3D function
plots.
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You can add new color palettes to Origin by drag-and-drop. Support for Scribus (.xml),
Office Color Table (.soc), Adobe Color (.aco), Adobe Color Table (.act), Adobe Swatch
Exchange (.ase) and JASC PaintShopPro (.pal).

Colormapping can also be applied to 2D plots. This allows you apply a greater range of color variation to data
points than would be possible with incrementing or indexing. A good example of applying a color map to a
scatter plot would be Origin's Density Dots plot in which, typically, thousands of scatter points are plotted
and an algorithm is used to calculate point density and assign color to ranges of point densities.
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Applying a colormap to a 3D or contour plot is much the same as applying color singly, by points or by plots.
You select a plot -- then using the Palette button on the floating Mini Toolbar or the Style toolbar. You pick

a palette.
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You can also use the controls on the Colormap/Contours tab of Plot Details. This tab gives many more
options beyond simply picking and applying a colormap.
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For more information on applying color to colormapped plots, including contour and 3D surfaces,
see these topics:

e The Plot Details Colormap/Contours Tab

(] Tutorial: Contour Plots and Color Mapping

(] Surface Graph

e  Symbol Plot with Size and Colormap from Other Columns

e Parametric Surface with Colormap from Data

12.8Graph Legends

12.8.1How the Default Legend is Created

A graph legend is automatically created when you plot data. For most 2D and some 3D graph templates, the
default legend combines (A) plot style information stored with the graph template, with (B) dataset
information stored in the worksheet column label rows, and places the resulting legend object on the
graph page.

E: AGX) B(Y) | cwm | om
Long Mame Time _ | Delta Temperature | Magnetic Field | Position
Units | (sec) [134] (Oe) (mm])
Comments | S15-12503 51592503 31502503 81512503
Fix)=
Sparklines . Y
: !_,—""J \_\__ ‘_’,ﬂ- . Delta Temperature (K)
—ve=e 24 = 2.1% —— Magnetic Field (Oe)
Mo, of points 1000 1000 1000 100 45 —— Position (mm)
Sample fBCO milled YBCO milled YECO milled YBCOn
Measurad o |1 1 ! 12/01/2004 1 . 104 1 13 - \ - -'_'__rlllrﬁ.;l
!
€ v i \

Note that the default legend object is not created with literal text and plot symbols but instead is created from
LabTalk script.

e  This allows the legend object to be dynamically linked to plotted data and worksheet metadata, so that
the legend can be updated when data or plot metadata change.

®  Because construction of the legend object relies on scripting rather than literal information, you can save
customizations to a graph template and recreate the graph with its accompanying legend object using new

data, as often as is needed.

The legend script relies on "substitution notation" to convert variable values to readable symbols and text. You
can see this notation when you double-click inside of the legend object (as if to edit it).
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m Calcium{pg/ml) m 0%(1)
®  bMagnesium{pgiml) ® 05(2)

Fotassium(pa/ml) ’ 06(3)
¥ Sodiumipgiml) v %(4)

®  You control which dataset metadata are used in constructing the default legend text by setting the the

Translation mode of % (1), %(2) list in the Legends/Titles tab of the Plot Details dialog box

(Format: Page...).

e Custom strings can be constructed using LabTalk substitution. Customizations can be saved to the graph

template for repeat use.

Origin has a Eit Layers to Page tool that is useful for arranging a graph and a large,
text-wrapped legend on the page.

12.8.2Adding and Updating the Default Legend

The table below lists tasks associated with adding or updating the graph legend, and where to find editing
controls for each legend type. Before proceeding, we should point out that there are two legend refresh modes:

e Updating a legend will preserve any customizations that you might have made to the existing legend,
including size and position adjustments and legend symbol and text customizations.
® Reconstructing a legend will overwrite any customizations. When you add or reconstruct the legend, you

are creating a copy of the legend that is stored in the graph template.

In addition, the graph template stores a Legend Update Mode setting that determines how the legend is
refreshed when adding or removing data plots from the graph. See Controlling Legend Update, below.

Task Method (graph is active)

® Graph: Legend: Reconstruct Legend menu.

—E
e Reconstruct Legend button (Add Object to Graph toolbar).

e CTRL+L.
Add or reconstruct
legend

Legend customizations not saved with the template,
will be lost when you reconstruct.
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Task

Method (graph is active)

Update legend

Open the legendupdate dialog box:

e Graph: Legend: Update Legend menu.

e Right-click on legend and select Legend: Update Legend.

Note: "Updating"” a legend does not overwrite legend customizations.

Customizing
special legends

Right-clicking on these special legends opens a dialog box with customization
options specific to each legend type:

(] Categorical legends.

(] Box chart legends.

e  Point-by-point legends.

Add color scale

Only available for color-mapped plots (e.g Contour Plots).

e Click the Add Color Scale button == (Add Object to Graph toolbar).
e  Right-click in the layer and select New Color Scale.
. Insert: Color Scale menu.

e When you have multiple color-mapped plots in a single graph window, you

can click on each plot to select it, then add a corresponding color scale.

Control color scale

Available when a color scale object has been added to a graph. To open the Color
Scale Control dialog:

e  Double-click on the color scale object.

®  Right-click on the color scale object and choose Properties.
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Task

Method (graph is active)

Add bubble scale

Available for bubble plot, or when symbol size is controlled by a dataset.

e Select Insert: Bubble Scale.

e  Right-click in the layer and select New Bubble Scale.

e Click the Add Bubble Scale button @ in the Add Object to Graph
toolbar.

e  Right-click the legend to select Add Bubble Scale from the context

menu.

Control bubble
scale

Available when bubble scale object has been added to a graph. To open the
Bubble Scale Control dialog:

e  Double-click on the bubble scale object.

e  Right-click on the bubble scale object and choose Properties.

The legendupdate dialog box and the Legend/Titles tab at page level of Plot
Details both have an Auto Legend Translation Mode drop-down that determines
which worksheet metadata (e.g. column Long Name, Comments, etc.) is used to
generate the legend text. For a list of Custom options, see Legend Substitution
Notation.

Note: For more information on creating and customizing graph legends, see:

Help: Origin: Origin Help > Graphing > Graph Legends and Color Scales

12.8.3Controlling Legend Update

When a data plot is added or removed from a graph layer, the default behavior is to update the legend. The

Legend/Titles tab

at the graph page level in the Plot Details provides a Legend Update Mode drop-down

to control this behavior.

The default setting Update when Adding only affects the legend display of data plots that are added or
removed. Previous legend customizations to existing plots, such as literal text entered manually, will be

maintained.

Tutorial: Customize legend and add data plots

Start with a new project in Origin.

2. Open Windows Explorer and navigate to the subfolder <Origin EXE
folder=\Samples\Import and Export\

3. Shift-select the files S15-125-03.dat, S21-235-07.dat, S32-014-04.dat and
then drag-and-drop the files onto an empty Origin workbook. The three files will be

imported into three separate workbooks.
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Click on one of the workbooks, select the column B, and create a line plot.
Right-click on the legend and select Legend: Update Legend... to open the
legendupdate dialog.

6. Change the Auto Legend Translation Mode drop-down to Custom, and in the

edit box that appears below, enter the string:

@WSs, @LD3

and then press OK to close the dialog box. The legend updates, displaying the
sheet name and the third user parameter.

7. Click on the second workbook, select column B, move the mouse over the right-

kg |
edge of the column until it changes to , and then drag-and-drop this data
onto the graph to create a 2nd data plot.

8. Repeat the procedure with column B from the third workbook. The graph will now
display three data plots, and the legend will automatically update to display the
identifier for all three plots.

9. Click on each individual curve and use the Style toolbar to set a different line color
for each. The legend will automatically update and display the new line color.

gﬁnphl [r= = ]

—— Tral Run 1, YBCO milled
45 - —— Tral Run 2, YBCO milled
—— Trial Run 3, YBCO milled-square

Delta Temperature (K)

Time {sec)

12.8.4Special Legend Types

As mentioned, Origin supports these specialized legends for use with specific graph types. These legends can
be customized and updated similarly to the Data Plot legend used by most 2D graph types.
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Legend Type Menu to Create Used in situations where ...

At least one plot attribute (e.g. color, symbol

Legend for Graph:Legend:Categorical shape.etc) is controlled by data indexing.

Categorical values

Values See the Legend for Categorical Values help
page.
The plot symbol style is controlled by data
indexing, an increment list, or color mapping.
See the Point by Point Legend help page.

Point by Point Graph:Legend:Point by

Legend Point

Origin 2022b
d adds a Show
bl Unique Entries
T Only option.

The graph is a box chart, or a grouped box
Legend for Box chart.
Chart

Components

Graph:Legend:Box Chart

Components See the Legend for Box Chart Components help

page.

12.8.5Tips for Quick Legend Edits

Origin 2022b adds support for quick editing of multiple legend objects on the same
page using Mini Toolbars:

. a ® In the graph window, press Ctrl and select multiple objects. Release Ctrl to display
the Mini Toolbar.

e Additionally, when the graph window is active, go to Object Manager and right-click
on a legend object and choose Select All with Same Name to display the Mini

Toolbar.

Many edits to the graph legend can be made from the legend's Mini Toolbars. The default legend for 2D graphs
has two Mini Toolbars:

e The Legend toolbar -- available when you select the legend object -- has general controls for font, legend

reconstruction, reversing order, etc. Click on the legend object to produce the blue selection handles.

You also gain quick access to more complex controls such as Data Plot Legend Translation Mode --

identifying the column label row metadata that you wish to use to create your graph legend.

239


http://www.originlab.com/doc/Origin-Help/Legend-CateData
http://www.originlab.com/doc/Origin-Help/pts-pts-legend
http://www.originlab.com/doc/Origin-Help/box-legend
http://www.originlab.com/doc/Origin-Help/Mini-Toolbar
http://www.originlab.com/doc/Origin-Help/PD-Dialog-LegendTitles-Tab

UserGuide_2022b

®

SEIEE Repc"-t Update Data Plots Legend: legendupdate ?

Dislog Theme | a5t useds = ﬂ
Update or reconstruct graph legend

Update Mode Update i
Auto Legend Translation Mode Custom ~
Legend Custom Format(@D,@LU etg) | SL0 Brand” @LC vl -

Combination of legend notations with any literal before. after and in
between Is allowed.

Additional Format (for @L, @V etc) |
Show Legend for Visible Piots Only  []
T T - Hide Legend for Fitted Curves O

A

0 T T
Feb Mar Apr May Jun Jul Au

g || indicate Active Dataset )
| Ferrari East I:IFemi.n Central [0 Ferrari Wes: [Arial -] 18 AT AT A Data Plat Legend Translation Mode
i: BMW East BMW Central JEBMW West ] | -y oo o4 25 m—w—r—ﬂé ;

e The Legend Symbol toolbar becomes available when you click on a legend symbol. Use it to change

symbol or pattern block height and width, line thickness, etc.

In addition to the Mini Toolbar for the default legend, there are toolbars specifically for Color Scales and
Bubble Scales.

To format your legend or scale using a Mini Toolbar:

¥ Title go-1 012,
O K-z o5% Arrangerment

1564 1187 78.95 39.25

79.86 -119.6

1. Select alegend or legend component (e.g. legend symbol). A Mini Toolbar with context-specific buttons
will show.

2. If the toolbar fades too quickly, restore it by pressing the Shift key.

Other legend editing tips:

e  Apart from the Mini Toolbar buttons, you can also right-click on the legend object, choose Legend and
open a shortcut menu with some useful commands such as Text Color Follows Plot, Reverse Order,
and Show Legend for Visible Plots Only. The same menu commands are available from Graph:
Legend.

e  Both the Mini Toolbar and the shortcut menu have an Arrange in Vertical/Horizontal button/command
for changing the legend aspect; or you can modify it interactively by selecting the legend object, then
pressing CTRL while dragging a selection handle (e.g. drag horizontally to create a legend that is all on

one line).
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ul'cCCE

Iceland

Press CTRL, grab a blue handle and pull or push the legend

< > ; Germany | Greece| !Icelancﬂ ﬂ]ar_d
o .

Denmark

®  You can modify the white space around legend entries in the default 2D legend, by clicking precisely on
the legend frame and dragging the selection handles.

e  While plot metadata stored in column label rows is an ideal source for legend text, you can simply

overwrite the existing legend text with literal text. Either double-click on the legend text to enter in-place
edit mode or if that proves to cumbersome, right-click on the legend and choose Properties (taking care
not to overwrite the "\I( )" notation that creates the plot symbol). CTRL + double-clicking on the legend
will also open the this dialog.

e  Double-click a legend symbol to open the Plot Details dialog box.

e Any changes that you make to the legend can be saved with the graph template (File: Save Template
As) If you do not want a legend object added to your graph each time you create the graph, delete the

legend object and re-save the graph template.

If you are adding symbols to the legend manually, there is a new simplified Symbol
Map dialog for Origin 2022b. Most-used symbols are arranged on tabs for easy
access. To access the full Symbol Map dialog, click the Advanced button.

Lx,

Ly
.

12.9 Annotating Your Graph

When we speak of "annotating” a graph, we are talking about adding text or drawing objects to the graph.
Generally, these "annotations" help to enhance the graph in some way -- add a page title, add an arrow to
draw attention to some graph feature, label data points, add a date-time stamp to note the time of graph
creation, etc.

Annotating a graph can be as simple as adding a static text object and formatting it with Mini Toolbar buttons.
Or you might add a more complex object that is dynamically linked to a variable value or to some LabTalk
script that is executed whenever some user-specified event occurs.

Origin 2022b supports "substituting” cell Notes in graph legend and text objects using
@WN (e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source
{14 worksheet).

The following table lists some common graph annotation tasks and available tools for accomplishing those
tasks:
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Task Method

® Choose Format: Plot ..., then click the Label tab and select Enable (not

available for all plot types).

=

® Select a plot and use the Mini Toolbar Show Data Labels button L_Ti to turn

on labels. Some label buttons may support formatting options for the data
labels (hint will be a downward pointing arrow as on the button shown here).

e To label a single data point, click twice on the point (hint: not a double-click but
a click, pause, click). When the single-point is selected, click the Show Data

Labels button on the Mini Toolbar.

Label Data ) o .

Points and Plots e For format options not supported by Mini Toolbars, you will generally use
controls on the Label tab of Plot Details. Note that labeling options will depend
on the plot type.

For Origin 2022b, the Label tab of Plot Details (Format:
Plot) adds a Font group Alignment control that applies to
HEWY multi-line data labels.
I | |
. T : i
e  Click the Text Tool button, then click on the graph to place the object.
e  Right-click on the graph and choose Add Text from the shortcut menu.
e Double-click on text to do rich text editing; or click on the object and use the
text object Mini Toolbar to change font color, bold, align, wrap text, etc.
For Origin 2022b, you can add images from a worksheet
Add Text cell or an Image window, to a text object on the graph
Objects  NENY page.

e Worksheet cell: Select a worksheet cell and Copy
(Ctrl + C); then while editing a text object on the
graph, right-click and Paste Link.

. Image window: While creating the text object, right-

click and choose Insert Graph/Image.
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Task

Method

Add Layer Title

® Right-click on graph and choose Add/Modify Layer Title from the shortcut

menu to add/modify layer title in active layer.

In Origin 2022b, add a label to multi-layer graphs with the
page-level Mini Toolbar Add Label for Layers button
WEWY (hint: click outside of graph layers to show).

a1 m

Add
Vertical/Horizont
al Line

e \With a 2D graph active, use the Insert: Straight Line... menu item. Note that
this tool allows use of a simple LabTalk expression in the At Value field (e.g.
"mean(plotdata(1,Y))" which translates to "mean of 1st plot's Y dataset™) for

positioning the line object. For information, see At Axis Value.

Annotate a Data
Point

e This is another another option for labeling individual data points. Click the

Annotation tool on the Tools toolbar. See The Annotation Tool.

Add Drawing
Objects

Use the corresponding toolbar buttons on Tools toolbar. Origin supports:

e  Arrow, Curved Arrow.
e Line, Polyline, Curve, Freehand Draw.

e Rectangle, Circle, Polygon, Region.

New for Origin 2022b: On the Tools toolbar "split-button”

with the Arrow and Curved Arrow tools, you'll now find a
g HEVY Distance Annotation button for drawing a scale-labeled,
"—ﬁ‘;"‘ double-headed arrow between two points on a 2D graph.
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Task Method

e Insert Equation button group on the Tools toolbar. For equations, note that you
can download a free App from the OriginLab File Exchange, for adding LaTeX
objects to worksheets and graphs.

New in Origin 2022b:

Insert Equation, b i

Word Object, w e Insert Object dialog now has a "Use

Excel Object, - "

Other OLE Current Selection as Default...." check

Object box to allow inserting a user-specified
object, without opening the dialog.

® You can override (i.e. open the dialog) by
pressing Shift while clicking the Insert

Object button.

e Right-click on the graph and choose Insert Images From Files. You will be
asked whether you want to insert your image as a background for the active
Insert Image graph layer. Answering yes will cause the image to be imported and placed

behind plots, graph legends, text objects, etc.

e Click the New Link Table B button on the Add Object to Graph toolbar and
then click on the graph.

® From the main menu, choose Insert: Table.

e To edit table content, double-click the table object.

e To format the table, select it and use the available Mini Toolbar.

::‘“’“ _ ""B""" Er—:ﬁﬁ@glz.s v:—‘—'i-:uufnrsandudkm

Weight o Weighting 0 v None

Add Table Al SRR  HAEEECTE AR
O G76E4 = 005682 | | u 'm

L
ual Sum of Squares 023102 Mere Colors: Bold »
@r TR EEEEEEEN
uare (COD) [EEEH
Adj R-Square 069564 I —T 1
Tegrees of F reedam 30

Custom: Bold2

EEEEENEN+
Recent colors
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Task Method
Insert Date & e Date & Time EE' button on the Add Object to Graph toolbar.
Time Stamp
Insert Project ® Project Path Ea' button on the Add Object to Graph toolbar.
Path

L3
e To indicate statistical groupings, click the Add Asterisk Bracket ™ Tputton on
the Add Object to Graph toolbar.

Add Bracket with e  Manually adjust the size and placement of brackets by dragging handles on the

Asterisk object.

e To format the bracket, click the bracket and use the Mini Toolbar buttons.

This is useful when using a nonlinear xy scale.

Add XY Scale e New XY Scale button E and click on a graph layer.

e Select Insert: XY Scaler.

12.9.1Tips for Editing Your Graph Annotations

Beginning with Origin 2021, use Alt+Enter when creating multi-line text objects. To
revert to using Ctrl+Enter to insert a line break, set @FCA=1.

e  Pressing CTRL when drawing with the Rectangle O or Circle © tools, will draw a square or circle (as
opposed to a rectangle or ellipse).

e Use Mini Toolbar buttons for quick edits to selected objects. For more complex edits, right-click an object
and choose Properties to edit object properties and set defaults.

e  For text objects, including the axis titles and graph legends, you can edit text objects directly in "In-place
Edit" mode. Double-click on a text object to edit. Use the Format toolbar buttons to add superscript,
subscript, and Greek characters.

e Note that manual editing of axis titles and legends may be the best "quick solution", in most cases, you

are better off using worksheet column metadata to automatically create axis title and legend text.

e Do NOT set font size while in "In-place Edit Mode" unless you need to mix font sizes within a single text

object. The correct way to change font size is to click the text object once so that the green selection
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handles appear, then select font size from the Format toolbar. If you set while in In-place Edit mode,
Origin will not indicate the proper font size when you hover on the text object.

e  When you are in In-place Edit mode, you can right-click and choose Symbol Map to insert special
characters into your text object.

For Origin 2022b, this opens a simplified, tabbed Symbol Map with quick access to
most-used symbols. To access the full dialog, click the Advanced button.

®  You can insert data from of a worksheet cell into a text object by copying and pasting the cell contents.
While in In-place Edit mode in the text object, right-click and choose Paste or Paste Link. Data added by
Paste is static; Paste Link is dynamic and thus, the text object will update if the data in the linked cell

changes.

e Also, when in In-place Edit mode, you can right-click and choose Insert Info. Variable... to insert

project variables into the text object. Since the pasted information is linked to a LabTalk variable value,

the inserted data updates if the variable value changes.

® You can insert variable values into a text object using the LabTalk %0, and $ substitution notation by
setting the Link to (26,%$), Substitution Level to 1 in the text object's Properties dialog box,

Programming tab. Right-click on the text object and choose Properties from the shortcut menu.
Alternately, you can use the Link to Substitution Mini Toolbar button, saving you

from having to open the Properties dialog.

®  You can use controls on the Programming tab of Properties to associate your LabTalk script with a text

or drawing object (for instance, see Linking Text Labels to Data and Variables). Enter your script in the

text box and specify a Script, Run After condition for running the script. Use the Apply to drop-down to

set the scope for the script.

® You can copy a range (of cells) from a workbook and paste it into a graph as a table object. Table content

is (a) edited by double-clicking on the object and (b) can be formatted using Mini Toolbar buttons.

[E :GFE*' [
DEETE 042145
D014
051633
e a2 ]
ERRE-]
OZF1E5
03124
[

@E@ z; — Table Style
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i You can add text formatting (e.g. super-/subscripting) to non-consecutive characters
; via the text object's Properties dialog:

Right-click on the text object and choose Properties.
2. On the Text tab, press CTRL and in the text box, highlight multiple characters by
dragging with your mouse.

3. Click the desired text formatting button above the text box and click OK to close.

12.9.2Grouping, Aligning and Arranging with the Object Edit Toolbar

Object Edit X
=4 000 & sf B0oof<s TPy s I

You can group text labels and drawn objects so that they move or resize as a unit:

1. To select objects, press SHIFT + click; or drag out a box around objects using the Pointer tool.

I

2. To group the selected objects, click the Group button on the Object Edit toolbar.

I

3. To ungroup objects, click the Ungroup button on the Object Edit toolbar.

You can align multiple text labels and/or drawn objects with one another using the tools on the same Object
Edit toolbar:

1. Select objects to be aligned by holding the SHIFT key while selecting (or drag out a selection box using

the Pointer [:E tool), then click one of the align objects buttons on the toolbar. Note that objects will be

aligned with respect to the first-selected object.

You can bring overlapping objects to the front or send them to the back:

1. Select the objects that you want to move to the front or the back.

T =

2. Click the Front button or the Back button on the Object Edit toolbar.

Note: For more information on graph annotations, see your Origin User Guide:

Help: Origin: Origin Help > Graphing > Adding Text and Drawing Objects

You can also use the Object Edit Toolbar to manipulate graph layers. Use buttons to
align and set a uniform size for multiple graph layers or to swap layer order.
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12.9.3Using Page or Layer Grids to Place Objects

For manually placing objects -- graph layers, text objects, legends, etc. -- you can turn on a non-printing, non-
exporting page or layer grid:

e With the graph active, choose View: Show: Page Grid/Layer Grid (displays only one at a time).

e  Alternately, you can turn on grids by clicking near the page margin and clicking the Mini Toolbar Show

Grids button. In addition, you'll find buttons for increasing or decreasing grid size by increments.

12.9.3.1 Control of the Grid

Grid display and related grid settings are found by clicking on the Show Grids button.

1. Click Show Grids, then click Page Grid Settings.

12.9.40bject Attachment and Scaling in Graphs

There are two settings that you should know something about, particularly if you subsequently modify axis
scales or resize the graph layer after adding annotations: One is the object's Attach to method, the other is
the layer's Scale Elements behavior.

12.9.4.1 Object Attachment

When you add a text or drawing object to an Origin graph window, the object becomes part of the active graph
layer. Thus, if you resize or delete that graph layer, you will resize or delete the added object.

In addition to being part of the graph layer that was active at the time of object creation, note also that
objects are attached to the graph in one of three ways, depending upon the type of object and where it is
created on the page.

To view the "Attach to" setting for any object:

1. Right-click on a text or drawing object and choose Properties....

2. Click on the Programming tab and note the object's Attach to setting.

Border | Fill | Dimentions | Programming

Mame Cirde Attach to | Layer Frame W

Visible Selectable [ ]real-Time | Editable

Script Run After | None
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Though objects remain a part of the layer that was active at the time of their creation, you can manage some
object behaviors by changing the object attachment method. An object is attached in one of three ways:

e Page. When attached to the page, objects are not affected by moving or resizing the graph layer, nor are
they affected by a change in axis scales. These objects are still associated with a particular graph layer
and they will be hidden or deleted if the layer is hidden or deleted.

e Layer Frame. Objects that are attached to the layer frame, are resized and moved with respect to the
layer frame. However, they are not tied to axis scales and are not affected by changes in the layer's axis
scale values. Objects are hidden or deleted if the associated layer is hidden or deleted.

e |Layer and Scales. Objects are linked to a particular range of axis scale values. If you resize the layer,
the object is resized accordingly. If you rescale the axes, the object moves in relation to the visible scale
and will disappear from view if the linked axis scale range is not displayed. These objects are hidden or

deleted if the associated layer is hidden or deleted.

To briefly illustrate why object attachment is important, let's look at the following graph. After the graph was
created, arrows and text objects that point to their respective data plots, were added to the graph. Both
arrows and text objects are attached to the graph Layer Frame.
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Now, consider what happens to these objects when we modify the graph's X axis scale (recall that objects
attached to the Layer Frame "are unaffected by changes in the layer's axis scale values"). Note that by
changing the axis scale display range, we have shifted the data plots but the text objects and arrows did not
move with them.
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Objects attached to Layer Frame

Objects attached to Layer and Scales

The remedy for this is to change the text and drawing objects' Attach to method to be Layer and Scales
because "if you rescale the axes, the object moves in relation to the visible scale."” Sometimes we may want an
object to move with scale changes; at other times we may not. You can force either behavior if you keep in
mind the Attach to setting.

12.9.4.2 Object Scaling

Object scaling often comes up when manually resizing the graph layer or when merging separate graphs into a
single multi-panel graph (Graph: Merge Graph Windows). By default, added objects are set to Scale with
Layer Frame -- that is, when the graph layer is resized, associated objects such as text objects, axis lines and
ticks, and axis titles -- will be scaled proportionally. In the case where you merge four single layer graphs into
a single, four layer multi-panel graph, these objects will be scaled down with the reduction in size of the layer

frame.
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However, this is another default behavior that you may want to change (e.g. you have set your font size to 10
pt. and you want to preserve that size), and you can do this using the Scale Elements control on the Size tab
(Layer level) of Plot Details. If our goal is to keep objects at their current size when merging graphs, for
instance, we can open the Plot Details dialog box and at the layer level (Format: Layer...), click on the Size

tab, choose the Fixed Factor radio button and set the scaling factor to 1.
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i If you have resized the graph layer, either by merging multiple graphs into a single

; graph or by manually resizing the layer, you will find that the font sizes do not display
at their "correct" size (i.e. if you select a text object, the Font Size list on the Format
toolbar shows the original font size). Further, if select a text object, the Status bar will
report two font size numbers -- "size" and "actual". You can reset font size so that they
are shown as actual size, not scaled size, by choosing Graph: Fix Scale Factors. For
more information, see FAQ-441 How do | export graphs with exact size and resolution
as specified by publishers?

Inserting Images to Graphs

There are two general approaches to adding images to graph windows:

12.10.

Insert the images as floating or background images.

Insert images within a text object.

1 Floating or Background Images

Images can be inserted to graphs from file or from Image Windows.
Images can be inserted as floating images or as a layer background.
Double-click on a graph image to open the image in an Image Window.

Once opened in the Image Window, define a region-of-interest (ROI) and Clip the image (graph image

clipped to ROI) or Crop the image (image is cropped in Image Window and graph).
Use the Image Window to Set (image) Scale or Set (image) Coordinates of the inserted image.

Images may be saved with the project or linked to an external file (Link File) to control project size.

Previously, images linked to an external file had to be manually reimported on project
open. Now, linked images are automatically reimported, including modified source
images. Disable or modify auto import with system variables @LFAU and @LFC.

12.10.1.1 Inserting Image from File

You can insert an insert an image into graph page, with the option of inserting it as a background image that is

linked

PN PR

to layer and scales.

With the graph layer active, choose Insert: Image from File. The image is inserted as a floating image.
To convert the image to a background image, double-click to open it in an Image Window.
Right-click on the Image Window image and choose Set as Layer Background.

Click the Close button on the Image Window.
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12.10.1.2 Inserting Image from Image Window

You can also insert images to graphs from an Image Window:

1. With the graph window active, choose Insert: Image from Image Window. The Insert from Image
Window dialog opens.

Set the Image Window drop-down to the desired image.

Optionally, choose to insert the image as Layer Background and to Rescale Layer using Image

Coordinates (Layer Background only).

12.10.1.3 Manipulating Images with the Image Window

12.10.1.3.1 Mini Toolbar

Clicking on an Image Window image produces a Mini Toolbar with buttons for simple image manipulations
(flip, rotate, convert to gray scale, etc.).

12.10.1.3.2 Region-of-Interest (ROI)
Placing an ROI object on the Image Window image allows you to perform certain image editing operations.
Add an ROI to the image by one of the following:

e  Click the Add ROI button on the Mini Toolbar.
e  Right-click on the image and choose Add ROI.

e Click the Rectangle Tool on the Tools toolbar.

Once added, the ROI can be resized (by dragging handles) or moved. Additionally, various operations can be
performed on the ROI, including:

e Clip graph image to ROI, Crop image to ROl or Copy ROI as image to graph.
e Copy Positions/Paste Positions for copying ROl dimensions to a second ROI on another Image Window.

e Export ROI or Import ROI to save or apply previously-saved ROl dimensions.

For more information on the Image Window, see the Origin Help File.
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12.10.2 Inserting Images into a Text Object

Starting with Origin 2022b, images can also be inserted as part (or the entirety) of a
text object. Source images can be from:

L e |ocal image file or Web image URL

e \Worksheet cell

12.10.2.1 Local Image or Web URL

When you insert an Image from File or Image from Web using the following
methods, the image is linked and not stored in the Origin project file. This helps control
project file size.

On the Tools toolbar, click the Text tool T and click once on the graph to enter "in-place" edit mode.
2. Enter text if needed and when ready to insert image, right-click and choose Insert: Image from File or
Image from Web:
O When inserting an image from file, browse to your local image file and click Open.
O When inserting an image from Web, you'll need a URL (hint: locate your Web image, then right-
click and copy the address (Copy Image Address, Copy Image Link, etc, depending upon

browser).

To examine (or modify) the syntax used for inserting an image, you can select the inserted object and choose
Properties. In the Text Object dialog, you should see something like these examples:

Examples:

\img(file://"C:/Program Files/OriginLab/Origin2022b/Samples/Image Processing and
Analysis/white camellia.jpg"”,w=200)

\img(https://www.originlab.com/images/header_logo.png, w=200)

... where option "w="is the default width in pixels, of the inserted image. Width is user-modifiable by editing
the "w=" value in Properties or -- if no width is specified -- by simply dragging the object's selection handles.

12.10.2.2 Worksheet Cell
You can also insert an image from a worksheet cell into a text object, but you'll need to make use of a special

syntax. The syntax is not complicated and combines a \cel 1 ( ) escape sequence with a cell reference --
either a range reference (e.g. [Book1l]Sheetl!col(C)[1] ) or a named range reference.
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1. On the Tools toolbar, click the Text tool T and click once on the graph to enter "in-place" edit mode; or
right-click and choose Add Text from the shortcut menu.
2. Enter your string into the text object using the examples below as a guide:
0 If you are copying and pasting a string (e.g. \cel 1 ([Book1]Sheet1!B[1])), click outside the
text object to leave edit mode. Your cell image should display in the text object.
O If you are typing directly into the text object in "in-place" mode, enter your syntax (e.g.
\cell([Book1l]Sheetl1!B[1])) and when finished, right-click on the object, choose
Properties and on the Text tab, remove one of the leading "\" characters from your cell
reference (Origin automatically "protects” "\" characters entered into text objects which is why

you'll need to remove one "\". See Escape Sequences).

O If you are typing directly into the Text Object (Properties) dialog, enter your syntax (e.g.
\cell([Book1l]Sheetl1l!B[1])) directly to display the cell image.

Examples:

\cell([Book1]1!col(C)[2]) // Bookl, Sheetl, col C, row2, size = current font height
\cell(alpha,200) // named range "alpha'", width=200 logical pixels

\cell(alpha,h=300) // named range "alpha', height=300 logical pixels

12.11Working with Map Data

You can overlay geopolitical boundaries on graphs or Image Plots of NetCDF data from the Insert menu.

. Insert: World Map will apply boundaries within the graphs current Lat and Lon ranges.
e Depending upon the graph's Lat and Lon ranges, other options may be available (e.g. Continental USA

Map, Map of China, etc.).

12.11.1 Importing Shapefiles

You can also import locally-stored shapefiles using Origin's Shapefile Connector:

1. With a workbook active, choose Data: Connect to File: Shapefile.

12.11.2 Map-related Apps

There are at least two add-on Apps for inserting geographic data:

e OriginLab's free Google Map Import App lets you place a Google Map as background on the graph page

using specified coordinates.
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e Maps Online is another free OriginLab App that lets you connect to one of several map databases.

You can find and install these Apps by pressing F10 and searching on maps. For information on App
installation, see Where Do | Find Apps?

12.12Arranging Graphs and Layers

Task Method

e Graph: Merge Graph Windows... menu command

or

EIL]

e Merge Graph Windows button on the Graph toolbar.

Merge
multiple
graph
windows
into a single

Sianialt
\%iggw L A Unit control is added for Origin 2022

Origin has two dialog boxes -- Eitting Layers to Page and Fit
Page to Layers -- that are useful for arranging multiple graph
panels on the page and for adjusting graph margins.

—
e  Extract to Layers button ==/ on the Graph toolbar.
Extract data
plots in one
layer to
multiple =
layers. Hint: to preserve your original graph, click the Duplicate button = | pefore extracting

to layers.

255


https://www.originlab.com/fileExchange/details.aspx?fid=240
http://www.originlab.com/doc/User-Guide/Apps
http://www.originlab.com/doc/Origin-Help/Fit-Page-Layer
http://www.originlab.com/doc/Origin-Help/Fit-Page-Layer

UserGuide_2022b

Task Method
e Graph: Extract to Graphs
or
Extract
multlplg e Click the Extract to Graphs button B®| on the Graph toolbar.
layers in a
single
graph to All layers are extracted to individual graph windows, even if a layer is linked to another
multiple layer.
graph . . -
windows By default, the layextract dialog box has Extracted Layers set to 1:0, which specifies
that all layers be extracted. To extract only certain layers, clear Auto and use the
layextract X-Function's comma/colon notation to control which layers are extracted. The
notation 1:0 means starting with layer 1, extract all layers to graphs (O denotes all).
Specifying 1,3:4, for example, tells Origin to extract only the first, third and the fourth
layer. Note that you can enable Keep Source Graph to preserve the original graph.
e Graph: Layer Management... menu.
e  Position selected layers using Object Edit toolbar buttons. Hold SHIFT + click to
select multiple layers and Align Left, Right, Top, Bottom, etc.
Add,
arrange,
resize, -
position, i R
swap, align, L A Unit control is added for Origin 2022
or link
layers
I You can use the Layer Management tool's Swap control (Graph:
' Layer Management,Size/Position tab) to physically swap
layer positions without reassigning layer numbers. Before doing
so, set each linked layer's Units to % of Page (Size/Speed
tab of Plot Details).
e Graph: Arrange Layers... menu.
e Row by column layer arrangement with control of page size and spacing between
layers.
Simple
arrangeme
nt of layers
":-1_. N New easy-to-use tool for Origin 2022
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Task Method
e Linked Axes Scales tab, layer level of Plot Details dialog box.
e Link tab of the Layer Management dialog box.
Link graph When linking layers, the child layer must have a higher layer number than the parent
layers layer.
Linked layers can be moved and resized together.
You can link layers' axis scale values to be Straight (1:1) or you can specify a Custom
mathematical relationship.
Reorder There are several ways to reorder graph layers (reassign Layer number for each Layer).
layers Learn more about reassigning layer numbers in the mini tutorial below this table.

Method 1: Open the Layer Management dialog and click the row header (shown in image

below) and drag it up or down to change the Layer order.

X Layer Management
Laver Selection Add
o
M 5

For more information, see the Layer Management tool.

Method 2: Enter the following LabTalk script in the Command Window

(Window:Command Window), then press Enter to execute.

page.reorder(n,m)

The command changes the nth Layer to the mth Layer.

Method 3: Use the Front and Back buttons on the Object Edit toolbar (these buttons work

on the active layer as indicated by the graph layer icon mJ) Alternately, right-click on
the graph layer icon and change layer order using shortcut menu commands (e.g. Bring to
Front).

|, When two layers are linked by a common X axis (e.g. Double-Y
graph), you can swap layer drawing order by right-clicking on the
"front" layer in Object Manager and choosing Push to Back. This will
not break layer linking.

Note: Reordering layers may break layer linking relationships.
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Task Method
Reorder
layers | A Note on Inset Graphs: In certain situations (see Tutorial, below),
, / the order in which the layers are drawn on the screen becomes an
(cont'd) issue. In this image, we have added an inset graph using the Add
Inset Graph with Data button (Graph toolbar). The problem is that
the data plot of the parent layer (red symbols) shows through the inset
layer (small, black symbols). To fix this, we do two things:
® Set the inset layer background Color = White -- by default, it is None
(Format: Layer, then Background tab).
e Set the layer Drawing order to Draw layer by layer (Format: Page
then Layers tab).
Inset e
Layer P
1.0 —
-
4
W o
] ]
L
Farent Layer Hnn ™
1 | 5 10 15 =0 25 30 35 1
Inset X \
ERS
" ]
=Y "
By default, an inset layer is added "on top of" the parent layer but if
needed, you can click on the inset layer to select it, right-click and
choose Bring to Front.
e Graph: Exchange X-Y Axes menu command
Exchange e
X-Y Axes (] Exchange Axes ™ button on the Graph toolbar.
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Task Method
(] Method 1: Open Plot Setup dialog(by selecting Graph:Plot Setup), expand the
bottom panel, select a plot and drag it from a layer to another layer.
e Method 2: Run laymplot -d; (e.g. open the Script Window, type the command
and press <Enter>) to open the Move Plot dialog to specify plot(s) to move and a
Move a target layer.
plot(s) to
another
layer

i You can move a plot by Copying (CTRL+C or Copy Range
/ context menu) and Pasting (CTRL+V or Paste context menu)
operations, between different layers or different graphs. Please
note, the pasted plot won't be associated with the source data of
the copied plot, but exists as a loose dataset.

In a multi-layer graph, layer order determines drawing order. The 1st layer is plotted and
then 2nd layer is plotted on top of it, and so on. The layer with higher number is drawn on
top of the layer with lower number. This is important when plots in one layer overlay plots
in another layer. When necessary, you can change layer order to change plot drawing
order.

This mini tutorial shows you how layer reassignment works. Use the preview window to
see how layer number reassignment affects your graph.

1. Click Help: Origin Central or press F11.

2.Click on the Graph Sample tab, set the Samples in drop-down list to Area Plots

and double-click on this graph:

3. Activate the graph Area Plot With Horizontal Color Gradient, then click the

Extract to Layers button =L/ on the Graph toolbar. Set both number of rows

and columns to 1, click OK, then, click OK again for the page spacing. The green
layer is on the top of the yellow layer in the figure. The purpose of this last step
was simply to create a two layer graph in which the data in one layer partially

hides the data in the other layer. What we will do now is to reorder the layers and
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set the yellow layer on the top, giving you a better view of the two plots.

-
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4. Choose Graph: Layer Management... menu, then drag the row header "1" of the
Layerl in the Layer Selection downward under the Layer2 (indicated by a blue
line), and click OK.

5.  You can see the yellow layer is on the top now.
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Alternate Method: You can use the Front T;‘l.' or Back toolbar buttons (located in
the Object Edit toolbar, or at the top of Layer Selection box in the Layer Management
dialog) to bring a layer forward or push it backwards. As happens when you rearrange
layer order with the Layer Management dialog, this method swaps layer numbers.

|, You can easily add an inset layer with data by clicking the Add Inset Graph With
S
Data button on the Graph toolbar or Insert: New Layer(Axes): Inset With
Data (Linked Dimension) .

o

You can copy a layer from one graph window to another graph window. Click to select
the layer first (a frame shows around the layer). Then press Ctrl+C or right-click and
choose Copy. Click on the target graph window, then right-click to Paste.

Note: For more information on merging graphs, see your Origin User Guide:

Help: Origin: Tutorials > Graphing > Layers > Merqging and Arranging Graph Layers

Help: Origin : Origin Help > Graphing > Reference > The Merge Graph Dialog Box
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12.13Templates and Themes

Origin's flexible Page > Layer > Plot hierarchy, plus an extensive list of editable object properties makes it
easy to customize and save your graph settings for repeat use. You can preserve your custom settings in a
couple of ways -- either with templates or with Themes. These concepts are introduced below.

Note: For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Graphing > Creating Graphs from Graph Templates

Help: Origin: Origin Help > Customizing Your Graph > Graph Formats and Themes

12.13.1 Templates

A new Origin installation lists close to 240 plot types, each one backed by an Origin graph template file (*.otp
or *.otpu). For most users, a Plot menu graph is the starting point for customizing and saving your own
custom graph templates. The basic process goes like this:

Plot your worksheet or matrixsheet data using the Plot menu (or equivalent graphing toolbar button).
Customize the graph's default settings.

Save the graph as a graph template file (*otp or *.otpu) by choosing File: Save Template As and filling

in the requisite information. By default, custom templates are saved to your User Files Folder (hint:

easily find this folder by clicking Help: Open Folder: User Files Folder).

A few things to note:
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The Plot menu is the definitive list of built-in plot types. At one time, a graphing toolbar button was
created for each new plot type but in recent versions, few toolbar buttons have been added as toolbar
space has become limited.

In a fresh Origin installation, each one of Origin's 240 built-in graph types uses a specific "system"

template when creating a particular graph type. When you click on a Plot menu graph or graphing toolbar

button (e.g. Area b ), one of these system templates is used to plot the selected data.

System templates are installed to the Origin Program Folder. They are completely customizable but as the

Program folder is write-protected, you cannot overwrite the original system template file (see next).

Instead, when you customize and save a system template, it is saved by default to your User Files Folder
(UFF). If you save the customized template to the same system template name, the customized template
replaces the system template as the template associated with the Plot menu command or corresponding
toolbar button used to create that plot type. Additionally, the customized template is added to the user's
Template Library.

To view your custom graph templates, click Plot (workbook or matrix should be active) and click Category
= MyTemplates.

You can save a graph template anywhere (and with any name) that you like -- it does not need to be

saved to your UFF. However, by saving customized templates to your UFF, they will be collected in one,
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easily-remembered place and they will be readily available when you upgrade your Origin software (since

Origin 2018, all Origin versions have shared a common User Files Folder).

e  For an overview of graph templates, see Graph Template Basics.

e  For information on the Template Library, see The Graph Template Library.

e  For information on “cloneable" templates, see Cloneable Templates.

12.13.1.1 The Template Library

B Template Library

3DCylinder

Chmate

‘tujjmmﬁ

Graph Samples_.

E

Scan User Files
Folder to Add
Templates

Browse to Select
and Add
Templates

List Cloneable
Templates

B Extended

User

; aﬂplmlibry
(5) « +

4
e

"Manage" Mode: *

elete/Show/Hide User Templates

——.

All Categories

List under
Plot: My Templates

B Extended
User

0 Bstack_Big
ExcelBridge
Master
BOXAZ?

gBox
HalfVicli
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3D
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Statistical
Contour/Heatmap

Specialized
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MeraeGrao‘=r
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Learning Center
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2/20/2019 11:37:14 User
2/20/2019 113317 User
2/20/2019 12:57:55 User
2/20/2019 132708 User
T/11/2019 15:44:32 User
v
2/20/2019 13:02:22 User
Create Prototype Plat Setup Plot Close

Summary of Features:

Model Data for
Cloneable Template

A\

Open the Plot Setup Dialog to
Manually Create a Plot

_ |

® Toggle between list and thumbnail view modes. Thumbnails images are automatically generated when you

save a template.

e In either mode, you can hover on the template to preview, read template location, comments, etc.

e In list mode you can sort; or opt to list a User or Extended template under Plot: My Templates.

e Templates are listed as System, Extended or User. System templates are Origin's default templates for

creating Plot menu graphs. They can be plotted to and customized but cannot be overwritten. Extended
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templates are add-on templates that are installed with Origin. User templates are those that you

specifically customize then save using File: Save Template As; or which you add using the Library's Add
or Scan functions. Note that User templates can include customized System templates that you have

saved to \User Files.

® To scan your User Files folder (UFF) for custom templates, click the Scan User Template icon. To browse

and add a template file to the Library, click the Add Template icon.

e Click the List Cloneable Templates icon to show only cloneable templates.

e Click the Manage Mode icon to delete, show or hide a given template. Hiding a template removes it from
My Templates but does not remove it from the Template Library (note that you can also remove a
template from My Templates simply by clearing Show in Menu). Deleting a template removes it from the

Library and moves the template to User Files\DeletedTemplates.

e Click the Template Center icon to open a dialog and search the OriginLab site for additional graph

templates.
Beginning with Origin 2022b, you can search for Template Center templates and
install them directly from the Start menu.
12.13.2 Themes and Copy/Paste Format

An Origin Theme is a file containing a set of object properties. There are four kinds of Theme files in Origin:
graph Themes, worksheet Themes, dialog Themes and function plot Themes.

Graph Themes are a collection of properties of different elements in a graph window. A graph Theme can be
very simple (e.g. graph axis major and minor tick direction settings) or it could be something more complex
(e.g. a combination of page dimensions, layer background, axis scales, and color palettes). Whether simple or
complex, the purpose of graph Themes is to allow you to quickly change one or more object properties in an
existing graph, or to apply a consistent set of properties to a selection of graph windows, without having to
recreate a suite of settings, or to apply those settings one-by-one to individual graph windows.

All graph objects have a customizable set of properties that are specific to the object type. Therefore, it follows
that the properties that can be saved as a Theme differ depending upon the selected object. You can (1) copy
a Theme from one object and "paste" it to another object of the same type or (2) you can save a Theme from
one object as a named Theme and apply that named Theme to other like objects at a later time.

1. Right-click on an object in a graph window (e.g. a plot) and choose Copy Format. Depending on what
you click on, there may be sub-menu items under the Copy Format shortcut menu, which give you the
option as to what exact format to copy.

O To apply the copied formats to a single object, right-click on your target graph and choose Paste
Format To. Again, this shortcut menu might has some sub-items that limit what to paste. In this
way, the formatting option(s) from your source object should be applied to your target object.

O To apply the copied formats to multiple windows in the project, keep the source graph window
active and select Edit:Paste Format(Advanced)... from the Origin menu. This opens the Apply
Formats dialog box. Here you have the option of editing or selectively applying formats to one or
more graph windows in the Origin Project.

264


http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/OFileType-Template
http://www.originlab.com/doc/Origin-Help/UserFilesFolder
http://www.originlab.com/doc/Origin-Help/Graph-Template-Basics

Customizing Graphs

If you would prefer to save formats to a named Theme file that you can re-apply at a later time, choose
the Save Format As a Theme... shortcut menu item, then use Preferences: Theme Organizer to

apply the Theme when needed.

12.13.2.1 Theme Organizer

Use the Theme Organizer (Preferences: Theme Organizer) to organize and apply Themes to graphs.
With this dialog box you can apply a graph Theme simultaneously to multiple graphs in the Origin project file.

To combine multiple Themes in the Theme Organizer dialog box:

Press the CTRL key while selecting multiple Themes, then right-click and choose Combine from the
shortcut menu. The shortcut menu in the tool provides an option for editing a Theme, allowing the user to

add/delete properties from an existing Theme.

| @ Theme Organizer » IEH
| A gystemn theme can be applied automatically when making new graphs

Current systemn theme: Light Grids

Right-click to set system theme or to choose other operations

Graph | System Increment Lists | Worksheet | Dialog | Function Apply Theme To

Name Size  Path Date A | Current Graph w

e e —

Physical Review Letters 17:53

Plot Group Simple Line + Symbol Edi. 7:53

Plot Group Simple Scatter Delate 1 7:53

profile_cline x1 1753

profile_cline_x2 Duplicate 17:53

profile_hline_x1 Combine 153

profile_hline_x2 [} 17:53

profile_sep_x Set as System Theme 7.53

profile_sep_x2 Clear System Theme 117:53

profile_viine_x1 — ) 17:53

profile_viine_x2 E} ShwToomip: 17:53

Speed Mode OFF 4 ysterm  B15/2017 1153

Speed Mode ON 5 Systern 501572017 17253

Wicksallin | 2dSstem [Sn520171753 |

Ticks All Cut 2 System 5152017 17:53 Apply Mow

Ticks YL XB Out YR XT In 8 System 51572017 17:53

Times New Rerman Font T System  5A152017 17253 ¥ ndo Appl
[+] Exclude increment lists [ Close

The Theme Organizer has separate tabs for managing graph, increment list, worksheet, dialog boxes and
plotted mathematical function Themes.

If you right-click on a graph Theme and save it as your System Theme, then each time you plot a new
graph, this System Theme will be applied regardless of the settings that were saved with the graph
templatet.

Use the System Increment Lists tab to manage increment lists and selectively apply them to project

graphs.
You can load a graph Theme in the Export Graph dialog and the Theme will be applied to the exported

image file.
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T If you don't want a System Theme to be applied automatically to the graph, save the
graph as a template (File: Save Template As) and clear the Apply System Theme
to Override check box.

12.14Topics for Further Reading

(] Plot Details: Customizing Graph Page Elements

®  Plot Details: Customizing Graph Layer Elements

®  Plot Details: Customizing Plot Elements

e The Preferences: Options: Axis tab Settings

(] The Preferences: Options: Graph tab Settings

(] Graph Axes

e Controlling the Graph Axis Display Range

e Graph Legends

®  Color Scales

e  Customizing Data Plot Colors

(] Using a Dataset to Control Plot Color

(] Using a Dataset to Control Plot Attributes

. Labeling Data Points

e Adding Text and Drawing Objects

e Adding Unicode and ANSI Characters in Text Labels

. Linking Text Labels to Data and Variables

®  Associating Script with an Object

(] Hiding Labels, Data and Layers

e  Working with Maps

e Graph Template Basics

e  Graph Template Library

e System Templates

(] System Themes
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13 Graphical Exploration of Data

Start with a data plot .. I

|
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a
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interactive analyses
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recalculation of resulis
choose
Gadgets
S i Click here for
= Gadget controls
=0 —-ll*:-“h! R - _|
L 5:: Gadgets for:
£ 133 Peak Finding
§ i Hm Integration
= £yl Differntiation
o] _J_ I_L LIl FFT
"‘3 P =0 Curve Fitting
[ Statistics
Curve Intersection
and more ...
T

[% Pointer
Ohbject selection mode

4

4

4

XU e B+ 0Py

@\ Scale In

Axes magnification, double-click to
restore, ctrl-drag to create zoom graph

4 Screen Reader

Read screen coordinates, click pointer
to restore

Ed Data Reader
‘EE’ Data Cursor
¥ Data Highlighter

¥ Data Selector

Select a range of data, click pointer to
restore

£ Selection on Active Plot
% Selection on All Plats

*o2 Mask Points on Active Plot
¥:& Mask Points on All Plots

},f; Unmask Points on Active Plot
ﬁ Unmask Points on All Plots

": Draw Data

Free-form drawing of data

4 Zoom-Panning Tool

Can also hold Ato entertool; Drag
pagefor arrow keys) to pan, mouse
wheel{or =,-] to zoom

/////\

i[",l[ Rescale Tool

Can also hold Z7% to enter tool;
ZiZoom, X:Pan: Shift=Z/% for ¥
otherwise X dir; Mouse wheel{or =,
or drag(or arrow keys): Space: taggle
panning mode (3 or minar, major
ticks).

Origin includes a number of tools for graphically exploring your data including those for zooming and panning
data plots, reading XY coordinate values and other data point metadata, or highlighting or masking selected

data points
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P With Origin 2016, OriginLab began releasing add-on tools called Apps. Many
' exploratory and analysis-related tools have been added to OriginLab's File Exchange
since that time. If you find you need some exploratory or analysis tool that is not a
standard part of Origin, you might check to see if the tool exists as an App. If it does
not, request it!.

13.1Plot Highlighting

While plot highlighting can be used to select a subset of data for more in-depth analysis, at a basic level it is
useful for quick visual comparisons.

Lo

W owld wll wll +1] w4 Wl vl vl ow

——— (e Object M A%
] Row-wise Line Sesies with Error Bars ™ [ [ (] | | 5] Row-wise Line Senes with Errer Bars * :'E _JG;;«
L 0.6 {‘/‘ A Layert
. A Hg
i ==y " Click once v E S
. —e—E2
5 g—. E—e—E3
Gl E I e — a5 ~J1Z = Es
| S - .,_-_l---: N " s
03| :i i 5 ’...! . | :_' s il & . Emg o _
s . SER T oy — i A7
. : =k Az W . o= F—s—Ez
Vs ~N : -
ipe L
i
1

To engage plot highlighting:

Click on one plot in the graph layer. Other plots in the layer and in linked layers sharing the same X axis,

will be dimmed.
Click on the plot in the Object Manager.

To highlight/dim plots on hover (without clicking), click the Highlight Plot when Mouse Over Mini

Toolbar button (page-level).

% % . I-i I-é Highlight Plot when Mouse Cver
" B B B (][ Aly5 1

Other Origin features useful for quick visual inspection of data plots:
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If you have many columns of Y data, plotting a Browser Graph, or adding a Browser panel to an existing
2D line plot, can be useful for quick visual inspection. Clicking the menu on the Browser panel, you can
plot every Nth column or Flip Through plots using a specified Move By factor.

For scatter data, use the customizable Data Point Tooltip to read coordinate values and column
metadata on mouseover.

You can also use Tools toolbar buttons to zoom or pan your graph, as you will see in the next section.
Origin has various other tools available for visually inspecting and recording information on your data plots

and those are covered in the remaining subsections of this chapter.
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Graphical Exploration of Data

13.2 Data Slicer

If you are plotting worksheet data where a data filter has been applied, you can enable a Data Slicer panel,
make quick changes to filter conditions and see the effect on your plot. The tool is intended for plotting and
comparing single categories.

A ‘%.rk_rg Data Slicer
Grpho v 5 6 o I < 0 [

Data Slicer x ® |1 Q

8000

.
Filters Make: Lincoln

TO0D -

Year: 1992,1993,1994,1995,1996,...

Lincoln e S0+ of

Acura
Buick
Chrysler
GMC
Honda
Infiniti
lsuzu
Kia ] ﬂog
Lexus 110060 -
Mazda [! 20 40 80 20 100 120 140 160 180
Mercedes Power (kw)

Missan
| Saab

E ngine Displacement {cc)
e [
g B
1 1

Saturn
Suzuki
Toyota
Vaolvo

Apply one or more filters to your worksheet data and create your plot.

2. Hover just inside the graph window but outside the layer and when you see the Mini Toolbar cursor, click
and look for the Data Slicer button.

3. Once the Data Slicer panel is enabled, you will want to right-click on the title bar of both the worksheet
and the graph and Duplicate the two windows. Duplicating the two will allow you to make side-by-side
comparisons.

4. In the left panel of the duplicated graph, click on the listed filter(s) and choose another category from the

drop-down list.

13.3Zooming, Panning and Rescaling

This section discusses the use of toolbar tools, and keyboard and menu commands that change the view of
your 2D graph. We have split these tools and commands into two groups:

® Page-level zoom and pan operations that do not change axis scales.

® Axis rescale operations which zoom and pan the graph by changing axis From and To values.
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P Page level zoom and pan do not alter the graph; they only determine which portion of
; the graph page is visible within the graph window. You can read the current zoom level
in the Zoom dropdown list of the Standard toolbar. Page-level zoom and pan will not

affect the printout or export of the graph. On the other hand, axis rescaling tools (e.g.

Q@ Q

=" land *“* ) do alter the graph and, thus, will affect the printout and export of the

graph.

gets  Tools ormat  Window

= A =

= © | Bp Default: Arial |0

13.3.1Page-level Zoom and Pan

Action Button Shortcut Key

Menu

Notes

A+
+/- keys
Zoom-Panning: Zoom @ (zoom)
and pan the graph page. or
arrow keys
(pan)

Click the toolbar button; or
with the Pointer tool

L

active, place the cursor on

the graph page and press "A",

then ...

Use +/- keys or
mouse wheel to
zoom in or out.

Use the arrow keys
to pan horizontally or

vertically.

Stepped Zoom-Pan':
Zoom graph in or out, by
increment.

CTRL +1
CTRL + M

5 5

View:Zoom
In and
View:Zoom
Out

Stepped zoom.
CTRL+I1 activates
zoom in; click on the
graph to establish
the focal point.
CTRL+M zooms out;
clicking on graph not

needed.
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Action Button Shortcut Key Menu Notes

(] Reset the view of the

page after using the

. View:
Whole Page: Show the E CTRL +W Whole Zoom-Panning tools,
whole graph page. P
age above.
e Can be used to
locate "lost" objects
Zoom All: All objects in View: Zoom . .
! - - [ tside th
the window are shown. All ying outside the

graph page.

"Notes: These are older tools and methods that have been deprecated. Toolbar buttons are not shown by
default. To add them to the workspace, use the Customize Toolbars dialog box (View: Toolbars > Graph
button group).

13.3.2Axis Rescaling

P New Hotkey support for Rescaling of 3D Graphs:

e D + mouse wheel: rescale in Z direction
e Z + mouse wheel: rescale in X direction
(] SHIFT + Z + mouse wheel: rescale in Y direction

e Enable clipping on Miscellaneous tab of Plot Details (layer level) hides plots

outside of frame.

Action Button Shortcut Key Menu Notes

e  Scroll mouse wheel

to rescale X.
e  SHIFT + scroll to
rescale Y.

e  Drag with the left

Rescale: Rescale and

mouse button to pan
pan the graph in both X A - - P
and Y dimensions. (will rescale both X
and Y).

e  Select the Pointer
tool to exit Rescale

mode.
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Action

Button

Shortcut Key

Menu

Notes

Z + scroll .
wheel Rescale the graph in
Rescale the graph in the B or 3 the X dimension
X dimension. Z + without limits.
+/-
keys
X + scroll
wheel Rescales X.
gi?et:seiogr:aph inthe X - or -- Does not rescale Y.
. X +
+/-
keys
Rescales (Resets) X
Resca_le X: Rescale the to full X range +
graph in the X L=, - - _
dimension. some padding factor.
SHIFT + Z +
scroll wheel Rescale the graph in
Rescale the graph in the _ or 3 the Y dimension
Y dimension. inlFI without limits.
+/-
keys
SHIFT + X
+ scroll
wheel Rescales Y.
giﬁetr:lseiognraph in the ¥ - or - Does not rescale X.
: SHIFT
+ X +
+/-
keys

Rescale Y: Rescale the
graph inthe Y
dimension.

Rescales (Resets) Y
to full Y range +

some padding factor.

Rescale XY: Rescale
the graph in both X and
Y dimensions.

Rescales (Resets) X
and Y to full range +

some padding factor.
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Action Button Shortcut Key Menu Notes
® Rescales (Resets) Z
Resca.le Z: Rescale the to full range + some
graph in the Z al -- -- .
dimension. padding factor.
® Select Scale In
button, then drag
out rectangle(s) to
define axis scale
range desired.
® Reset by clicking on
the Scale Out
Scale In/Scale Out: &, q
Rescale the graph in X an - - button (no need to
and Y dimensions. Q‘* drag) several times.
e Rescales both X and
Y.
® Press ESC (or select
another tool) to quit
magnifying mode.
® Rescales (Resets) all
axes to display all
Resca_le: Rescale the Graph: data in the layer (+
graph in the all TA CTRL+R Rescale to )
dimensions. Show All some padding

factor).

parent layer). With a graph active, press Ctrl then click the Scale In button

You can use the Scale In button Q‘

to copy an enlarged portion of your 2D graph to a
new window. This will also work on any graph that has multiple linked layers as long as
the layers are overlapped and share a common axis (%6 of Linked Layer has

Left/Top set to 0 and Width/Height set to 100, plus Straight (1 to 1) linking to the

=

(Tools

toolbar) and drag out a rectangle on your 2D graph. Note that this Enlarged graph is
dynamic. Move or resize the rectangle on your original graph and the Enlarged graph
is updated.

If you do not see a toolbar button, it may be turned off. To add or remove buttons from
a toolbar, see The Customize Toolbar Dialog Box.
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P To prevent an axis from rescaling when using one of the axis rescaling tools, set
; Rescale = Fixed. If both X and Y axes are set to Fixed and you pick one of these axis
rescaling tools, you are reminded that X and Y axes are in "Manual Rescale mode" and
are prompted to proceed. Answering Yes will allow you to override and manually
rescale in one or both dimensions. If you need to block such manual overrides of Fixed

axis scales, set @nrm = 1.

13.4Rotation of 3D openGL Graphs

This openGL toolbar that previously displayed when a 3D layer was selected, has been
replaced by layer-level Mini Toolbar buttons.

2,

When you click inside the layer of a 3D graph, the layer is selected and a Mini Toolbar appears. Click the
Rotate Mode button to enter rotation mode; then use one of the hotkey/mouse combinations listed below; or
drag the radial rotation handles in the graph with your mouse.

Hot Key Menu/Action Context

Rotate 3D graphs with the 3D floating buttons

Rotate the 3D graph around

X + Arrow key the X axis

Y + Arrow key f:\c:?(t;[:;: 3D graph around With graph layer active and with Rotate Mode
button selected in the 3D floating button group.

Rotate the 3D graph around

Z + Arrow key the 7 axis. P’,\‘:: 'S E @ Rotate Mode
D SpEAVAR o
Rotate the 3D graph in Doo

screen.

Q + Arrow key

Rotate the 3D graph around

W + Arrow key any axes

Rotate 3D graphs using R key

R + Mouse Drag to rotate the 3D graph Press "R" before pressing other keys.
in an arbitrary direction.
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Hot Key

Menu/Action

Context

R + Ctrl +
Mouse/Arrow key

Rotate the 3D graph around
the X axis.

R + Shift +
Mouse/Arrow key

Rotate the 3D graph around
the Y axis.

R + Ctrl + Shift +
Mouse/Arrow key

Rotate the 3D graph around
the Z axis.

Hovering on a 3D graph while pressing "R"

b

changes the Pointer tool

your keyboard.

toa

. Press Ctrl
and/or Shift as needed, and rotate by (a) dragging
with your mouse or (b) pressing the arrow keys on

13.5Reading Coordinate Values and Distances

Origin provides several tools to aid in labeling and graphical exploration of your data plots. Most of these tools
are available from the Tools toolbar (View: Toolbars). There is a related tool -- Vertical Cursor -- available
from the Gadgets menu.

13.5.1Data Point Tooltip

Most 2D plot types, 3D Scatter, XYY Bar and XYZ Bar plots support a floating, customizable tooltip that reads
data point values when you hover on a data point.

40 -
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Tooltip Shortcut Menu

For tooltip customization and other options, right-click directly on the data point tooltip.

Goto Sheet
Show Data Plot Tooltip
0 Pick Dvata Points...

Copy
Copy Coordinates

Row: Preferences...
Make: Infiniti %

Power: 38 4

0~60 mph:|12

Weight: 867

® Go to Sheet pops up the worksheet with source data highlighted.

e Show Data Plot Tooltip toggles display of a non-customizable data plot tooltip in place of the
customizable data point tooltip (see, below).

e Pick Data Points puts the cursor into data reading mode and opens a Pick Points dialog. Double-click
on points in the graph and when finished, click Done. This generates summary data (source, X-Y
coordinates, etc.) for your picked points.

e Copy copies data point tooltip information, including labels, to the Clipboard.

e Copy Coordinates copies only coordinate values. Right-click on a cell and Paste each value to a separate
cell within the row; or Paste (keep spaces) to paste values to the selected cell as a space-separated
string.

e Preferences opens the Data Point Tooltip dialog allowing you to customize tooltip content and

formatting. Use documentation of the Data Info window, below, as a guide to configuring your tooltips.

The Data Point Tooltip dialog is a slightly simpler version of the Data Info window's preferences dialog (Data
Info Report Settings). See The Data Info Window for help with customizing your Data Point Tooltip.

For Origin 2022b, the Data Point Tooltip dialog adds a Column Width control, giving
AT you better control over the width of tooltip column display. This is especially handy when

W tooltips include images.
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Report Title | Mone
(] Show Source as Column Header
+ X A T #
— .
Labels L‘@- )/alue Column Settings
Long Mame, Data
L J Type Value ~
2
2 Source | Data (Reader) w
5
Font
m- s
» Colurmnn Width Alignment | Auto
E 0K i Cancel

By default, the Data Point Tooltip displays with a moderate degree of transparency. You
can affect tooltip transparency by changing the value of LabTalk System Variable
@TDT. For information on changing the value of a LabTalk System Variable, see this

FAQ.

13.5.2Data Plot Tooltip

There is a second tooltip that can be displayed in place of the Data Point Tooltip and this we refer to as the
Data Plot Tooltip. This non-customizable tooltip displays the source book, worksheet and coordinate datasets,

on hover.
Go to Sheet Goto Sheet
Show Data Point Tooltip Show Data Plot Tooltip
40 L
Pick Data Points... Pick Data Points...
254 s ) 259 Copy
* &
‘gm' = sRdes! 0 e=a lomabile.dat ’g-’fﬂ- Copy Coardinates
£ b athan au_ome?lle ) E
2x] o ‘mems » LPower 25 Preferences...
g ? ﬁ F'Gas Mileage” 3
= | 2 QWB@MII @ =
& o Daﬂ I:to L] a 204
a PIRTRTTY L3 @ <] @
@ o WARR W e °
154 @ o ae 3 @ a 154 @ a
> -1~ a3
.0._.:=t.00 @ @ @ L]
104 @ : @ ‘n 104 a ‘n
T T T T T T T 1 T T T T T T T 1
20 40 5] 80 100 120 140 160 180 0 40 & 8 100 12 140 180 180
Power (kw) Power (kw)
Data Plot Tooltip Data Point Tooltip

The Data Point Tooltip displays by default. If you prefer to use the Data Plot Tooltip, right-click on the Data
Point Tooltip and choose to Show Data Plot Tooltip. Conversely, right-click on the Data Plot Tooltip and

choose Show Data Point Tooltip.
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13.5.3Managing Tooltip Display

You can turn off display of data tooltips by activating the graph window, clicking on the View menu and
clearing the check mark beside Data Tooltips.

There is a second way to control tooltip display that is more complicated but allows a greater degree of control.
This entails changing the value of LabTalk system variables @PT and @PTI.

@PT=0; //Disable both data plot and data point tooltips

@PT=1; //Enable data plot tooltips for 2D graph

@PT=2; //Enable data plot tooltips for 3D OpenGL graph (default)

@PT=3; //Enable data plot tooltips for both 2D graph and 3D OpenGL graph
@PTI=0; //Disable only data point tooltips

@PTI=1; //Enable data point tooltips (default)

13.5.4The Annotation Tool

Use the Annotation tool to label a data point. The tool works with Symbol/Line+Symbol and Column/Bar plots.
Choose from several standard data point labels or create your own custom label using LabTalk script.

To annotate a data point:

1. Click the Annotation button on the Tools toolbar and move the cursor to the desired data point. The

cursor and the Status Bar will display the current label form.

Cursor —_—

Eliéstum ,/,— Status Bar

| double click=add an annotation, TAB=toggle annotation label. current label :Custom {this point's x location is 5m]|

2. Use the TAB to toggle between the following standard annotation forms: (X coordinate value, Y coordinate
value); (X coordinate value, Y coordinate value)[index number]; X coordinate value; Y coordinate value;
index number (row number); or Custom (see Tutorial, next).

3. When you've selected your label form, double-click to add a label to the data point; or single-click on the

point and press Enter.

Tutorial: Customizing the Annotation String

The annotation string can be customized by combining literal characters with the X and
Y coordinate values:
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Start with a graph of your data.
2. Open the Script Window (Window:Script Window) and type the following

command, then press Enter:

system.annotation.customlabel$="X value: $(x,.2), Y value: $(y,*5)”

x}

several times to cycle through the annotation choices until the custom string

3. Click the Annotation button , hover on your graph, then press the Tab key
format specified above is displayed in the Status Bar. The cursor will display the
word "Custom".

4. Start double-clicking on data points (or single-click and press Enter) to add the
custom annotation string. The X values will be displayed with two decimal places
and the Y values will be displayed with 5 significant digits, as specified by your

script.

Adjustments using the Pointer Tool:

s

® To re-position overlapping labels, drag the label. A leader line is automatically added.

e To move a label to another data point, click the Pointer tool , press the ALT key and drag the label.

e To copy a label to another data point, press CTRL + SHIFT and drag the label to a new data point.

Note: Please view more information on string formatting in the Programming help file:

Help: Programming: LabTalk > Language Reference > Object Reference > Alphabetical
Listing of Objects > String

13.5.5The Screen Reader Tool

The Screen Reader uses the Data Display window to report the XY(Z) coordinates of the cursor on the
graph page. Note that the Screen Reader is not reading data point coordinates; rather it is reading page
coordinates relative to the graph axes.

The Data Display window opens automatically when you select the Screen Reader tool from the Tools toolbar
(by default, the Data Display window is docked at the bottom of your Origin workspace).
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Data Display
[Bookl]Sheetl!B[14]: X =14,% =14

You can alter basic properties of the Data Display window by right-clicking on the window title bar or by right-
clicking inside the window.

To use the Screen Reader:

Click the Screen Reader button on the Tools toolbar. This opens the Data Display tool.

2. Click on a location in the graph page to read its X,Y, and Z coordinates (ternary and contour only).

Coordinate values show in the Data Display window.

3. To increase cross-hair size, press the space bar.

e

4. Click the Pointer button on the Tools toolbar to exit screen reading mode.

13.5.6The Data Reader Tool

The Data Reader is used to read information associated with a data point in your plot. This could be
coordinate values or it could be more complex information including metadata or even images that relate to
the data point. The Data Reader works in concert with the customizable Data Info window.

The Data Reader tool is grouped with two related tools -- the Data Cursor and
the Data Highlighter J Only one of these toolbar buttons will show at any given

time. To select a hidden tool, click on the small arrow to the right of the button and
select a tool from the pop-up menu.

4
f.
&)
3 Data Reader

£ Data Cursor
{¥¥ Data Highlighter

T2 |

T

To use the Data Reader tool:

1. Click the Data Reader B button on the Tools toolbar. This opens the Data Info window.
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2. Click on a data point to read its X,Y (and Z, if they exist) coordinates. Coordinate values display in the
Data Info window (and Data Display window).

3. To move the cross-hair to the next data point along the data plot, use the LEFT and RIGHT arrow keys or
click on the data point using your mouse. If you have multiple plots in a layer, use the UP and DOWN
arrow keys to move to a data point on another plot or use your mouse to click on the point.

4. To change the vertical and horizontal cross-hair size, click on a point and press the spacebar.

5. Click the Pointer button on the Tools toolbar or Esc key to exit the Data Reader tool.

You can zoom into the graph while using the Data Reader. While the tool is active,
press CTRL and use your mouse wheel to zoom in or out on the page.

13.5.7The Data Cursor Tool

The Data Cursor tool -- grouped on the Tools toolbar with the Data Reader tool -- allows you to place one
or more cursors on a data plot and (using the Data Info window) read the cursor coordinates or measure the
X and Y distance between two cursors, or the distance between a cursor and a point selected with the Data
Reader.

Tutorial: Using the Cursor Tool to Measure Relative Distance
1. Import the file Samples\Spectroscopy\Sample Pulses.dat and create a line plot.

2. Click and select the Data Cursor button from the Tools toolbar.

o
Ed Data Reader

+

* EE:* Data Cursor
A

* .
& 7 I+ Data Highligh

+n.§v|

3. Double-click on one of the peaks or click once on a data point and press

ENTER, to add a cursor object.
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Repeat to place a second cursor object on another peak.

5. Double click in the Data Info. window to open the Data Info. Report Settings
dialog. If this window is not visible, select the View: Show Data Info menu item
to open the Data Info. window.

6. Switch to the Columns tab and then right-click in the gray area to the right of the
columns and choose Add Column.

7. In the new column that is added, click on the source row of new column, and select
Relative (Cursor2 - Cursorl) from the drop-down, and then press OK to close
the dialog.

8. Now you can drag and move the cursor objects and the third column in the Data

Info window will display the X and Y distances between the two cursors.
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13.5.8Distance Annotation Tool

New for Origin 2022b: On the Tools toolbar "split-button™ with the Arrow and

.""_‘i: _* Curved Arrow tools, you'll now find a Distance Annotation button %- for drawing a
w scale-labeled, double-headed arrow between two points on a 2D graph.

- 30

= 20

T, =200~

- 10

. . :
t,=197.4 t, =9822 t;=1526.4 'O

1. Click the Distance Annotation button @ on the Tools toolbars.
2. On a graph, place the crosshair on the starting point and drag with your mouse. Press Shift to force the

double-headed arrow to the horizontal or vertical
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To fine-tune arrow placement, right-click on the drawn arrow and choose Properties.
Use Dimensions tab settings to control exact placement of object.

13.5.9The Data Highlighter Tool

The Data Highlighter is grouped on the Tools toolbar with the Data Reader and Data Cursor tools. Use the
Data Highlighter to pick one or more points in the your graph and simultaneously highlight the corresponding
data row in the worksheet. Unselected points are dimmed in the graph and the worksheet.
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= g‘ wd & 1995
[ E @ 1996
= - & 1007
) + g = E A | Born | cor) ooz | Evm | Fen | GiY2)
:I' = Long Name Year WMake Power  0-60 mph  Weighl Gas Mileage Engine Displacement
o - 204 Unis low S8 kg meg e
5 3 | Comments
+ Ed Data Reader w54 75,:”;';2; - " .m m _,/-‘"" M
= :‘:a 5 Data Cursor 1 _ 1 t”
K |-@- Data Highlighter |
L & 8
]_ EES) 2004 Infnit E"] 12 867 38 14915

While in Data Highlighter mode ...

e CTRL+click to select multiple points in the graph.

e Drag out a rectangle/freehand object on the graph to select multiple points.

e Use SPACE to toggle between rectangle and freehand selection modes.

e  Use left/right arrow keys to highlight individual points in sequence by row index.

. In the worksheet (still in Highlight mode), CTRL+click multiple rows or SHIFT+select blocks of rows, and
highlight corresponding points in the graph.

® Press ESC to exit Highlight mode in the graph while keeping highlighted rows selected in the worksheet.

13.5.9.1 Collect Data from Multiple Sheets

When the Data Highlighter is active, a Mini Toolbar displays at the upper-right corner of the graph or
worksheet window. The toolbar has buttons to Create Subset Sheet, Delete Points, Mask/Unmask
Highlighted Points or Dimmed Points; plus a Highlighter Properties for configuring how to pick and
collate data from multiple worksheets.
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How to Pick Points Plotted from Multiple Sheets

A new method is added for picking a subset of points from a graph of plots from
multiple worksheets and adding them to a single sheet:

Ly |

1. Pick the Data Highlighter tool ﬂ then CTRL+click to select multiple points
from a SINGLE plot; or drag out a rectangle/freehand object on the graph to select
multiple points (hint: press spacebar for ROl shape).

2.  When finished, click the Create Subset Sheet button m‘ on the Highlighter Mini
Toolbar.

3. Click the Open Properties Dialog button -E} on the Mini Toolbar and set Add
Data Mode = Append or Append with Gap.

4. Continue to pick points from other plots (worksheets) as in step 1, clicking the
Create Subset Sheet button each time you finish picking points from one of the
plots.

5.  When you have finished, pick the Pointer tool Di‘ .

13.5.10 The Data Info Window

=}

Data Cursor tools . When you click on a plotted data point with one of these tools, the Data Info window
displays information about this particular data point.

H
The Data Info window opens when you choose either the Data Reader , the Annotation or the
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[SamplePulses]"Sample Pulses"[51]

X 51
¥ 0.243015229

In its default configuration, the Data Info window reports only a column short name, plot designation (e.g.
"X") and the XY coordinate values of a data point. However, the window is capable of displaying any of the
worksheet-contained information that is associated with a data point including metadata and images.

Data Info - [Book1]Sheet1!{A"Name",D"Mass")[1]

Name Ethane Ethane is a chemical compound with chemical formula
Mass 2007 H C2HG. It is the only two-carbon alkane that is an aliphatic
H... . hydrocarbon. At standard temperature and pressure
CAS number | 74-84-0 R yaroca pe P
108,40 2m -~ ethane is a colorless, odorless gas.

Formula C2HB /C—C

i
Appearance | Colorless gas H™ [ssomy Ethane is isolated on an industrial scala from natural gas,
Melting point -181.76 H and as a byproduct of petroleum refining. ts chief use is as
Boiling point -39 petrochemical feedstock for ethylene production

To customize the Data Info window:

1. Double-click on the Data Info window; or right-click and choose Preferences....

2. Use the controls in the Data Info Report Settings dialog box to customize the display of the Data Info

window:
LR mem-mtmmﬂ'm X
| X Y Z % Report Title | Mone w Window Title | Auto w
K Dlats ¥Dists ZData [ Show Source as Column Header + X A T i
Short Mame | Long Mame - Short Name | Labels & |Value &~ Preview
A MName | < XData> Long Mame Data (Reader)
Namg
B CAS number 4 <YData> Mazs
! Formula B R oo | 122228
D Mass 4 c e R ek
fEtiirds
E Appearance E aing point
G Meiting point G Boling poire | 8
H Boiling point v H v
< > < >
» & H 4 oK Cancel

The Data Info window can report any information in the source data worksheet. You are not limited to
displaying plotted data.

e The window can display anything that can be inserted into the worksheet cell, including inserted graphs
and images.

e  The window can be customized with a Window Title and Report Title.

Window configurations can be saved as Themes, including Save to <Graph>, Save to <Layer> and
Save to <DataPlot>. This allows, for instance, all graph windows in your project or all graph layers in

your multi-panel graph to have a unique Data Info window. Saved Themes can loaded and applied to the
current Data Info window.

286



Data Info - [automobilelautomobile! (C*Power ™ F.. X
Mileaoe vi. Power

Graphical Exploration of Data
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If you save your Data Info Theme settings in the graph, then save the graph window
as a standalone graph window file (OGG, OGGU), know that the OGG/OGGU file travels
only with the data that are plotted in the graph. Therefore, if your Data Info Theme
uses data in other columns in your worksheet, the Data Info display will be incomplete
if, for instance, you reopen the window file in a new project.

F

£

< @

OK

Cancel

Save to < Graph=
Save to < Llayer>

Save to < DataPlot=

Save as < default>
Save

Save As...

For more information on customizing the Data Info window, see:

e The Data Info Window.

e  Tutorial: The Data Reader Tool (discussion on customizing the Data Info window).

13.5.11 Gadgets

Origin provides several Gadgets for data exploration and analysis. These gadgets are accessible from the
Gadgets menu when a graph window is active. Three gadgets in particular are suitable for data exploration:

e Vertical Cursor
(] Statistics

e Cluster (OriginPro)

The Vertical Cursor gadget is especially useful for reading XY coordinate values for data points in stacked
panel plots or multi-plot graphs, where plots share a common X scale.
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To open the Vertical Cursor:

1. With a graph window active, choose Gadgets: Vertical Cursor... from the main menu. This opens the

Vertical Cursor dialog box.

Using the controls in this Gadget's dialog box, you can add data labels to the graph, increase or decrease label
font size, hide labels, etc.

-
=]
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L

Decay 3(a.u)
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4

u B Vertical Curser - X Based on Layer!

_ x
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=

:; Cursor [ Snap Cursor to Mearest X
= a2}
E\ o Y Mame | Graph Status
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B 00e 0.5 7004  Decay? Graph3 =]
=
Sy 05 10978 Decayl *Graph3 ¥

2

Decay 1 (au)
2

132 e E
&6 L . .
0.0 & 1.0
Time (sec)
ol When labeling plots with the Vertical Cursor, you can opt to combine separate data labels
¥ 9 into a single label by clicking the gadget's Show All Info in One Label button.
s | .
f — Show All Info in One Label
04 vE T 5 g -
EB8: 03518317 Y
* il I .
B D 8 Jesossirall [ (B[] A £ NS¢
03 |- ¢ II,".-- _":-_‘;-.i-___ E6: 0329380 Cimar £ Snap Cursor to Mesrest X
| A "_.1 0.28828
P/.__.-' - | ] E2: 0 2B828 X | W ] Marne | &'ﬂlh |
i I/ ] E1: 0.27506] || »6 027508 El *Graph
- / NeT: 026435 || w6 028328 E2 Graph
3: 021384 v6 021384 E3 Graph!
01 wi 028828 E4 Graph!
1 - 1 i
o—El-o—E ;J_' 3 pqllv6 039174 ES  Grapht
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The Statistics gadget returns basic statistics on data points falling inside a rectangular region-of-interest (ROI)
on the graph.

e Display basic statistics for data inside the ROI.

288



Graphical Exploration of Data

e Display mean and nth Standard Deviation lines inside the ROI.

e  Update results dynamically as ROI is moved or resized.

M = 4650 Mean = 9350 §5559 W= 3201 Mean = 145601 7954

50 = 3551 93483 5D = 3493.9107
x> X | »
27000 +
+3 8D
25041.91203
I +3 SD
O - 20506.36108
= 18000 |-
4]
=
.
= L
]
=
@ 9000
=
)
5]
m -
= 4078.44786
0 -3 5D
-805.24791
Fhaszel Fhase |l Fhase Il

The Cluster gadget (available in OriginPro) provides the following features:

e Display basic statistics for data inside a region of interest (ROI).
e  Switch between rectangular or elliptical ROI.

e View statistics for points inside and outside of the ROI.

e  Edit, copy, mask, delete or group data points.

e  Update results dynamically as ROI is moved/re-sized.

e  OQOutput results to a worksheet.
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can apply a differentiating color to points within the ROI.

n’ Cluster Gadget: Editing Inner Points - All Plots =
Edit Dats Srﬂlngs

B| 5| m| _|i|_|_|_|_|E

When you use the Cluster gadget to define a category (points within a ROl on a plot), you

Inener Points lﬂmerl"mnls
Mawve the RO box to start r_nmptutmn.

= || Ef
0 Plot Recovery
Calar Drug
454 Ilong s .
| .l:u'ugEl .
20 4 Flacebo L]
Shape Gender - -
O Wale
IS q O Femalke I:ID
E-. 1
£ ap "gﬂ
8
=]
¥ 25 4
L ]
L]
20 - "
"
15 o (& Cluster Gadget: Editing Inner Points - All Plots E= ")
11:: 2 Edit Dasta Settings
o - E LI E L T ek
Inner Pants | Quter Pairits |
IrputLegend |N |Sum |Mean  Medan SO Mmnmum | M
Recovery 6 193 3216657 315 278587 b
&l Plats 6 193 L1667 315 278567 29
4 L] | 3

Note: To learn more about these gadgets, see:

Help: Origin: Origin Help > Gadgets
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13.6 Drawing Data Points on the Graph

This section discusses methods of graphically creating and modifying data plots.

This collection of tools and menu-driven operations is helpful in exploring certain "what if* scenarios, or to
quickly generate some data for purposes such as testing a fitting function. These procedures work only with 2D
scatter plots.

13.6.1Drawing a Data Point
1. Activate the graph window.
2. Click on the Draw Data Tool

3. A small dialog opens and displays the graph window short name.

B [Graph1 e

-

Curent Count: 0 Total Count: O

Start

4. Click the Start button, then hover on the graph and double-click to set a data point. Continue clicking to

set as many data points as you need.

5. Points drawn on a new graph window will be added to a new sheet in the GAData book. Click the

Worksheet button to pop-up this new Workbook.

% GAData - Graph Annotator Data ™ EI@
B [Graph1]1 x
Ay | Bwm | co | A
Long Mame Picked Paints Label . .
3 705027 | 2233022 "\ Curent Count: 3 Total Count: &
2| 1106874 2541808
3| 161987 2816638 \
4 = . Warkshaet Finish Cancel
5 21.1833 7718549
G| 23.39774| 9.95756
7| 27.55301 | 1442487
]
9
10
11 Bl
[ NGrapht1 {Gaprzt 7| <1 |
6. Click Finish to end the point series.
O Each time you click Finish, a "--" separator is added to the worksheet columns to delineate a

group of XY coordinates (drawn points).
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O Points drawn on a new graph window will be added to a new sheet in the GAData book. Each
graph window will have its own sheet in the workbook.
7. To label data points, go to the new Worksheet and enter label information in the Label column. Note that
Label column info can also be used to create plot groups by opening Plot Details and editing controls on

the Symbol tab (e.g. Symbol Color is indexed, by points, using the Label column data).

51 Plet Details - Plot Properties ? *
<:@:I Panel  Drop Limes  Label Centroid [Pre]  Shape List
reEw Size |8 ~| Z| Graph1 * E_lil—n
v Se Unit Point w 1 -
. Edge Thickness | Defautt | [ Scale by § 10 +DeD ac
Symbel Color Index:Col{C): "La... w vD « gD o n A U'H&
aC
Transparency 9 LR +D =A B
aC
[ Overlapped Paints Offset Plotting
. *D A
1 al =B
[+ Custarn Construction o *D
(®) Geometric D A .B
() Single Alphabetic/Unicode Shape 3 Colick "Label” 49 D
) Incremental Alphabetics - AC LI vB#B
() Ravw Mumber Numerics Inteior | [ Sad | 2 vD -k eB D
() User Defined Symbols
aCwD l“\H *B *D
i «ABB By ) *D
Hint: To skip points, you need to use the "Drop Lines” tab M é d'_ é 1'5 1ID
Waorkbook oK Cancel Apy Picked Foints

13.6.2Moving or Deleting Data Points in the Graph

13.6.2.1 Moving a Data Point

You can move individual data points in the graph. Understand that when you do this, you are changing the plot
and the underlying data:

Select Data: Move Data Points (you'll be warned that you are about to change your data).
2. Click on the point you want to move (change X and Y coordinates). Place crosshairs on the point and drag;

or use the arrow keys.

e

3. Click the Pointer button on the Tools toolbar or press ESC to exit the Move Data Points mode.

The data point is moved in the plot and the X and Y coordinates are changed in the worksheet cell.

13.6.2.2 Deleting a Data Point

You can delete individual data points from your graph:

1. Select Data: Remove Bad Data Points.
2. Double-click on the data point, or click to select the data point and press ENTER key.

3. Click Arrow button on Tools toolbar or press ESC key to exit the Remove Bad Data Points mode.
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The data point is deleted from both the data plot and the worksheet cell. In the worksheet, only the data cell
for the Y value will be cleared and shown as missing value.

13.7 Topics for Further Reading

e  Gadgets

(] The Data Analysis chapter of this User Guide

(] The Cluster Gadget (OriginPro)

e The Vertical Cursor Gadget

(] The Digitizer
e The Statistics Gadget

. Masking Data
(] Data Filtering

(] Drawing or Deleting Data Points in the Graph

(] List of Origin Built-in Toolbars and Buttons
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14 Gadgets

Gadgets provide a quick and easy way to perform exploratory analysis on plotted data. The concept is simple:
While each Gadget has a specific purpose, each is built around applying a set of customizable analysis
operations to a range of plotted data defined by a movable, resizable, region-of-interest (ROI) object.

You can drag to modify the ROI at any time, then change your analysis options and recalculate results by
clicking the arrow button in the upper-right corner of the ROl and choosing one of the menu options. For
general access to Gadget formatting and analysis options, choose Preferences at the bottom of the context
menu. Use the Preferences Dialog Theme box to save a group of Gadget settings to a Theme file.

Multiple Gadgets are supported on a graph. You can distinguish ROIs by giving each a different color. Click on
an ROI object to bring it forward. When an ROI is selected, you can use the TAB key to switch the ROI.

//_ Gadgets perform some \

mathematical or statistical operation
on data within

Click for contextual menu

lew Output (0]

Mew Qutput for Entire Curve

] a moveable, resizeable,
N Region of Interest (RO)
£00 - b peakisifound
/¥
450 4
§E5E
400 4 §c 8
5
B =2
E 350 -
[ab]
g‘ T o=
3 zo0 § EE
= = RE
= H ER
250 A A
2 2R
200 A »L [ LI
150 4

H MNew Output for All Curves [N)
Mew Qutput for All Layers (L)
Subtract Baseline

Click to hide Tag Peaks

or show ROI Fit Peaks v
box({es) for _
analySi S or Switch to Peak Analyzer...

graphic export J update output

Go to Report Worksheet

Change Data b
Expand to Full Plot(s) Range
Fioe ROI Position

Save Theme...

! Save a5 <default>

34.0 35.0 35.5
Time {SEE]I Load Themea »
Preferences...
I L e
(" Click the ROl to add Click the ' Click to adjust
selection handles for to close the Gadget format
_ moving or resizing Gadget and output

|, Origin 2016 introduced add-on tools called Apps. Since being introduced, many new
exploratory and analysis-related tools have been added to OriginLab's File Exchange
and more tools are being released all the time. Please visit the File Exchange to review

available tools.

14.10rigin Gadgets

The Gadgets main menu is available when a graph window is active. There are 14 gadgets available in Origin.
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Cluster Gadget

View statistics on points inside or outside of a graphically-defined region-of-interest
(rectangular, circular/elliptical or arbitrarily-shaped).

Differentiate Gadget

Calculate and plot the nth-order derivative of selected data.

FFT Gadget

View FFT spectrum of selected data.

Integration Gadget

Calculate the area under a curve, or between two curves.

2D Integration
Gadget

Calculate the 2D integration for a contour or image graph created from matrix or
XYZ worksheet data.

Interpolate Gadget

Perform linear, spline, b-spline or Akima spline interpolation of selected data.

Intersect Gadget

Calculate the intersection points of two or more data plots.

Quick Fit Gadget

Perform linear, polynomial, or nonlinear fitting of selected data.

With Origin 2022b the Quick Fit Gadget supports
custom labeling of the ROl Box .

Quick Peaks Gadget

Locate peaks, and compute area and other peak properties.

Quick Sigmoidal Fit
Gadget

Perform Sigmoidal fit of selected data.

Rise Time Gadget

Analyzes rise/fall time for the step-like signal.

Statistics Gadget

Compute and display simple descriptive statistics of selected data on the graph.

Vertical Cursor

Read coordinate values and label data plots across multiple graph layers that share

Gadget the same X axis.
Image/Contour . . .
Profile Analyze the image or contour from matrix data and generate profiles.
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Curve Translate
Gadget

Drag a curve in the vertical or horizontal direction, adjusting source data in the
process.

Note: To learn more about these gadgets, see:
Help: Origin: Origin Help > Gadgets

Help: Origin: Origin Help >Matrixbooks Matrixsheets and Matrix Objects > Viewing and
Profiling Matrix Data

Tutorial: Using the Integrate Gadget to Output Results to a Worksheet

10.

With a new workbook active, import the file Peaks on Exponential Baseline.dat
located in the Samples\Spectroscopy subfolder under the Origin installation folder.
Create a line plot of the data in column B.

With the graph active, go to the main menu and click Gadgets: Integrate....

In the dialog box that opens, click the Baseline tab and select Straight Line from
the Mode drop-down list.

Click the Output tab, and under the Output Quantities to node, select Append to
Worksheet and clear the other check boxes.

Expand the Quantities node, select None from the Dataset Identifier drop-down
list and enable Beginning X and Ending X.

Press OK to close the dialog box. The Region-of-Interest (ROI) rectangle object is
added to the graph.

Resize and move the ROI object to cover just the first peak in the data plot, then

press the arrow button E] located at the top-right of the ROI and select New
Output; or press "O" on your keyboard. This will write the parameters for the first
peak to a worksheet.

Drag and move the ROI to cover the second peak, and repeat the steps above to

generate output for the second peak.

Press the arrow button E] again and this time select Go to Report Worksheet. A

worksheet with the integration results will open.
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Click the flyout menu button E] (top right of the ROI) and output results for all curves
in the current layer (New Output for all Curves (N)) or for all layers of the graph
page (New Output for All Layers (L)) or press the corresponding N or L hotkey. This
allows for batch analysis of multiple curves in a graph.



Gadgets

14.1.1Custom Label for ROl Box

Origin 2022b supports custom labeling of the ROI Box for the Quick Fit and
Statistics gadgets.

liny)

Maximum (max)

Count =10
Mean u =0.4204 LD LT
SD o =0.2347
XatyY =40 Custom Label
XatY =20 Count = 5(n)

Mean \g(m] = S(mean, 4}
SD\gis) = S(sd, 4

(X at Y\-[min}= Skminy, *2)
% at ¥\-[max)=8{xmaxy, *2)

Related Apps aK Can

][>
10
08

14.1.1.1 Quick Fit Gadget

1. Choose a gadget from the Gadgets: Quick Fit menu.

2. Open the gadget dialog (hint: if the ROl is already added, click the menu button E]and choose
Preferences).
Click the ROI Box tab and enable Custom Label.

4. Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or

superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label Custom Variable Example
Reduced Chi-Sqr chisgr Chi-Square \g(c)\+(2) = $(chisqr, .2)
R-Square cod R-Squared n+(2) = $(cod, .2)
Pearson's r r r=9$(r, .2)

Y Intercept intercept Y Intercept = $(intercept, .2)
Slope slope Slope = $(slope, .2)
X Intercept xintercept X Intercept = $(xintercept, .2)
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14.1.1.2 Statistics Gadget

1. Choose Gadgets: Statistics: Open Dialog (hint: if the ROI is already added, click the menu button

E]and choose Preferences).
Click the Show on Center-Top of ROI Box tab and enable Custom Label.

Build your custom label using a mix of (a) literal text (b) escape sequences (e.g. Greek symbols or

superscripts) and (c) custom variables. Specify decimal places, etc. using Origin custom formats.

Dialog Label Custom Variable Example
N n Count = $(n)
Mean mean \g(m) = $(mean, *4)
Minimum min Min = $(min, .2)
X at Minimum xminy X Min = $(xminy, .2)
Maximum max Max = $(max, .2)
X at Maximum Xmaxy X max = $(xmaxy), .2)
Sum sum Sum = $(sum, .2)

14.2 Topics for Further Reading

e  Gadgets

e The Image/Contour Profile tool

(] Tutorial: Using Multiple Gadgets

(] Tutorials for Individual Gadgets

(] Peak Analyzer
. Digitizer
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15 Data Analysis

15.1 Introduction

Origin contains powerful tools for all of your data analysis needs, including curve fitting, statistics, peak
analysis and signal processing. Most of Origin's analysis tools can make use of a stored collection of settings --
something known as a Dialog Theme -- that makes repeat analyses a snap. Furthermore, the output from
one operation can become the input for another operation, thus allowing you to set up a chain of operations,
with results that update whenever there are changes to source data, as would happen when importing a series
of data files.

The following sections cover (1) selecting the data that you wish to analyze and (2) the Origin and OriginPro
tools available for analyzing that data. Please refer to the How to Handle Repetitive Tasks chapter of this User
Guide for more information on Analysis Templates, Dialog Themes and other time-saving features.

Apps are add-on tools that extend Origin's graphing and analysis capabilities. Many
analysis-related tools are available free-of-charge from OriginLab's File Exchange. To
find out more about Apps in Origin, see the Apps for Origin chapter of this User Guide.

15.2 Data Input

Origin's analysis tools will work with workbook, matrix and/or graph data, depending upon the tool. By default,
analyses will be on done on selected data (note that in the case of matrix data, "selected data" will the the
matrix sheet or matrix object, depending on the analysis). When working with worksheet or graph data, you
may want to restrict your analysis to a subset of the data -- say, a certain range of rows or columns in a
worksheet or a certain X range in a graph.

Data selections can be made before or after opening an analysis dialog. Most of Origin's X-Function based
analysis tools have a Input branch with a range selection control that you can use to interactively select your
data (as explained below).

15.2.1Selecting Data in the Worksheet

When you highlight a range of worksheet data, then open one of X-Function based dialog boxes -- that would
include nearly all of those that open from the Analysis or Statistics menus -- you will see your range
selection already entered into the dialog box Input branch. Most will find that selecting worksheet data prior
to opening an Analysis or Statistics dialog box, is the easiest way to specify which data you wish to analyze.
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I Signal Processing: smooth

Dialog Theme ﬂ
Description  Perfarm smoothing to iregular and noisy data.
M
Recalculate :
H Input ||[.-’-'-.verageSunspu:u]".-i‘-.\-'erage Sunzpot”l[& ear', B Mumber'] Ij‘ilLl
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by ||[.-'1‘-.verageS unzpo]“Average Sunzpot 1B Mumber” Ij"EILl
Fows All W
“
[ &wuto Preview [ Fresie ] [ k. l [ Cancel ] ﬂ

If you open one of the X-Function dialog boxes without pre-selecting your data, the first thing you should do
upon opening the dialog is to select data in Input branch:

Click to go to
worksheet data
selection mode

Multi-D ata Fit Mode
Input Data
= Range 1
*
Y
" Error

Rows

|ndependent Fit - Conzalidated Repart

All -

1. Click the range selection control next to Input (or Input Data). The dialog box will roll up.

2. Go to worksheet and highlight your worksheet data, then click the EI button at the right end of the

rolled up dialog box. The Input branch will now show the selected range.

Note that you do not have to select entire datasets (columns). You can select a portion of your worksheet data
and analyses will be confined to that selected subset of your data. Also if the analysis supports multiple
datasets, you could support multiple ranges such as multiple Y columns or Y ranges. If the analysis only
supports one dataset, you may be able to select multiple ranges in the worksheet, but only the 1st range will

be picked in the analysis.
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The Input Data branch has a hierarchical structure. If the analysis supports multiple datasets, you can
add multiple ranges under Input Data and they will show as Range 1, Range 2, etc., each with its

corresponding X, Y, Error and Row controls.

Mousing over each level will show a tooltip indicating where the data on that level is from (i.e. book, sheet

and column).

A Rows control under each range node lets you set range by row index or X value. If you want to apply
the same row range to all ranges under Input Data, click the arrow button to the right of the range node
and choose Apply Row Range to All.

Depending on where you are in the Input Data hierarchy, the range selection button may have some
limitations ( e.g. if you click range selection control next to Y, though you could select multiple columns in
a worksheet, only the 1st column is accepted).

Clicking the arrow button to the right of the range selection control will show more selection options,
including individual worksheet columns that can be quickly added to your data selection.

Depending on which level you are in, the selection options when clicking the arrow button may vary. For
instance, clicking the "arrow" button next to Input Data and clicking the Select Columns... menu item,

will open the Column Browser allowing you to select multiple columns from different worksheets.
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Click for data selection options

Independent Fit - Conzolidated R epaort

BEY]) : Decay 1
) : Decay 2
DY) : Decay 3

| 3 E] Add

All Columns

r Reset
-
Select from Warksheet

‘ Select Columns... j

1. Use the List Datasets drop-down list to filter which sheets you want to pick from. The top panel list can

be sorted by clicking any of the column headings, making it easy to select, for example, all columns that
share the same LName or Comments.

Then click the Add button to add the column to your selection list in bottom panel.

To modify the data input range of any dataset, click the range button to the right of any dataset added to

the bottom panel and edit the From and To values.

15.2.2Selecting Data in the Graph

When a graph window is active and you select one of the Analysis menu tools, the default behavior is for the
analysis dialog box to open showing the selected range of the active dataset as your Input Data (note that
analysis dialogs include an Input Data node that allows adjustments -- adding more datasets with the
interactive range selector button, changing a data range, etc.).

15.2.2.1 The Data List and the Active Data Plot

The active data plot is the one that shows in the data list (bottom of the Data menu) with a check mark next
to it. If the active graph layer contains a plot group, the default behavior is to make the first plot in the group
the active data plot (note the "gl1" beside each range in the following image, indicating that all are members of
plot group 1). You can activate a different plot by clicking on another of the data plots listed at the bottom of
the Data menu. Subsequently, when you open an analysis dialog box, this newly-selected plot will be listed as
your input data.
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Data | Analysis Gadgets Tools  Format  Window  Help

Set Display Range

Reset to Full Range

M| Mark Data Range Ctrl+ Al -+
Analysis Markers »
Lock Position r

Mask Data Points
Mowe Data Points

Rernove Bad Data Points

1 g1 [Waterfall2 dat Jwaterfall2! &0, By [1*:1000%]
2 gl [Waterfallz2 . dat Jwaterfall2! A, COv) [1%:1000*] %
3 gl [Waterfall2 dat Jwaterfall2! A0, D) [1*:1000%]

However, for most purposes, you can ignore the data list and select your plot data directly in the graph
window or using the Object Manager:

e |f your data plots are part of a plot group, select the entire group by pressing SHIFT + clicking on a plot.
Alternately, click on the group icon in the Object Manager. Either will set Input Range to all plots in the
group.

e To select just a single plot -- whether it be an independent plot or part of a group -- click once on the plot.
Alternately, click on the plot icon in the Object Manager. Either will set Input Range to only the selected

plot.

Object Manager 3 X Object Manager w 3 X

== Graph2 = Graph2
= =] Layerl =l [+ Layerl
=k gl

KIRIE]
(XN |
0O m

Select Plot Group Select Single Plot
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P You can also indicate the active dataset by placing a red box around the plot's legend
' entry. In the case of grouped plots, the red box shows on the first plot in the group.

To turn this feature on or off:

e  Click on your graph window, select Format: Page..., click on the Legends/Titles

tab and enable or clear the Indicate Active Dataset box.

e  Select the graph legend, then right-click on it and choose Legend, then

select/deselect the Indicate Active Dataset menu entry.

e  Select the graph legend, then right-click on it and choose Legend: Update

Legend and enable or clear the Indicate Active Dataset box.

15.2.2.2 Customizing X scale range using Analysis Dialog "Rows" controls

You can adjust data range using the Rows controls under the Input Data branch of most analysis dialogs. If
you have an analysis dialog box open:

1. Click on Input Data branch to expand.

2. Change the Rows drop-down list to By Row or By X and enter your From and To values. Note that each

Range N will have its own Rows controls.

Multi-Data Fit Mode |Independent Fit - Consolidated Report -

El Input Data | [Graph2]1!(1"B"[10:201,2"C",3"D") BAC
| B Range 1 | [Graph2]1!1"B"[10:20] |=,é ,
X | [Book1]Sheet1!A EIC
¥ | [Book1]Sheet1!B FIC
vEror 4| =
H Rows | By Row )

From | 10

To |20
| @ Range2|  [[Graph2]12"c” G
| @ Range3|  [[Graph2]113'D" BIC

15.2.2.3 Customizing X scale range using Axis Scale Mini Dialog

Before opening an analysis dialog...

1. Click on an axis then click the Mini Toolbar Axis Scale button to open the Axis Scale dialog box.
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Adjust the X axis scale to your desired range.

Now open your analysis dialog (e.g. Linear Fit) and click the arrow button beside the Input Data box and

select Use X Scale Range from the context menu:
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As you can see, the customized scale range of X axis on the graph has been used to specify the input data
range for your analysis (Rows = By X).

15.2.2.4 Selecting data graphically using The Regional Data Selector

You can graphically select a range of data using the Regional Data Selector tool:
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+*
1. With a graph window active, click and hold on the Regional Data Selector button e on the Tools

toolbar, and then choose either the Selection on Active Plot or Selection on All Plots button.

2. Drag out a rectangle or freehand object to select an area of the plot(s). Note that you can press Space to

+

2
toggle between rectangle and freehand modes .

5| £ Selection on Active Plot
+
p-3 fﬁ Selection on All Plats

When you make your selection, Data Markers are placed on the graph to mark the selected range(s). You can
now use Origin's analysis tools (e.g., Linear Fit) to perform an analysis on the selection, but note that some
analysis dialog boxes do not work on multiple data ranges. The smoothing dialog box, for example, (Analysis:
Signal Processing: Smooth...) will only smooth data in the active dataset or a single, selected plot.

| There is a new Mini Toolbar for controlling X scale range when using Data Markers.
; Click on a Data Marker and use the buttons to Set Display Range or Reset to Full

Range.
|
|::‘ "I I" Reset To Full Range
== :!
_iw
!ﬂ@uﬁ
%&mu“

Tutorial: Linear Regression on Partial X Range

1. Import the file \Samples\Curve Fitting\Exponential Decay.dat into a new

workbook.
Select all Y columns and create a line plot.

3. Click and hold the Regional Data Selector button on the Tools toolbar, and then

- %
choose the Selection on All Plots button .
4. Drag out a rectangle to select the tail-end of the three curves between values of
approximately 0.6 and 1.0 along the X axis.
Use the Analysis:Fitting:Linear Fit menu to open the Linear Fit dialog.
Input Data branch is filled with three ranges. Mouse over Input Data branch will
show tooltip which shows 1X,1Y, ...3X and 3Y.

7. If you want to change the data selection, click the arrow button in Input Data
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and choose Reselect All Data from Graph. The dialog will roll up. Drag out a

rectangle in graph again to make your selection and then click the EI button at
the right end of the rolled up dialog box. The new data selection will show in Input
Data branch.

8. Accept default Linear Fit settings and press OK to close the dialog. Linear fitting

will be performed on all three curves over the selected range.
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In addition to the data selection and data masking methods discussed in this

section, Origin offers data filtering and data reduction tools. Please visit the linked
pages for details.

15.2.2.5 Editing a Data Marker

To edit a Data Marker:

To modify a data range, right-click a data marker and choose Edit; or double-click on the data marker.
The red marker changes to a dark color with arrows on both ends and the cursor changes into a cross-hair.
Drag the beginning or ending marker to a new position or use one of the keyboard shortcuts listed below

and modify the data range. To escape edit mode, double-click on the marker or press the Enter key.

There are other options when right-clicking the data marker such as Delete Marker, Delete Data, etc..
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Edit %
Move to Begin/End
Move to Begin

Mowve to End
Delete Data

Delete Marker Delete

Note: If you use the Regional Data Selector to place markers on multiple plots (Selection on All
Plots), be aware that moving markers will affect the data range of the active plot only; the ranges of other

selected plots will not follow that of the active plot. This is a limitation of the Regional Data Selector.

Alternately, you can use these keyboard shortcuts to select and edit data markers:

1. Select data markers using these keys ...

Hot Key Action
S Select the first pair of data markers on the graph (those marked with "1").
Tab Select the next pair of data markers (not in edit mode) or the other data

marker of the pair (in marker edit mode).

Home Return to the first data marker.
End Go to the last data marker.
2. ... then activate and edit the data marker using these key combinations:
Hot Key Action
Enter Activate thg selected data marker for editing. (Press Enter again to exit
data selection mode.)
Arrow Move the active data marker exactly one data point.
Ctrl/Shift + Arrow Move the active data marker multiple data points.
Delete Delete the the active data marker.
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15.2.2.6 Difference between Data Markers and Analysis Markers

e Data Markers define a sub-range that you select using the Data Selector tool.

If you want to remove the data markers from a graph, you can select Data: Clear Data Markers from

[

the main menu, or click the Clear Data Markers button on the Markers and Locks toolbar.
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e When the analysis routine is completed, Data Markers are replaced with Analysis Markers. By default,
Analysis Markers will not show if the analysis is done on the entire dataset. If performed on a subrange,
Analysis Markers will show at the beginning and end of that subrange. To modify the data range and rerun
your analysis, you must right-click an analysis marker and choose Change Parameters.... Change the

Input Data range and rerun the analysis.
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Note:

1. If you set Recalculate to None in the analysis dialog box, then no analysis markers are

generated.

Data markers and analysis markers are not exported when you choose File: Export Graphs.
To select the exact same range again for another analysis, click the green lock and choose Plot
Input Data with Data Markers to create a new graph and do analysis on it.

4. There is a Markers and Locks toolbar to control analysis markers and locks, such as Marker

=
Hide Show to toggle analysis markers on or off, etc. There is also an Analysis Markers
submenu, available from the Data menu; or when you right-click on an analysis marker or green

lock and choose Analysis Markers.

15.2.2.7 The Pick Points Tool

You can also pick the data points in the graph using the Pick Data Points tool. This works best for scatter or
line + symbol plots of smaller datasets.

1. Select Data: Pick Data Points. The Pick Points dialog will pop up.

2. With the square cross-hair, you can read the coordinate of current data points in the Pick Points dialog
(also the Data Source). Double-click on the point you want to pick until the cross-hair cursor became

round, the actual X&Y values will be recorded and the total number of picked points will be counted up.
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7 Pick Points 2
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e Cone Cancel

3. Once you finished the picking, click the Done button to output the results to a new workbook.

15.2.2.8 The Data Highlighter

In some cases, the Data Highlighter on the Tools toolbar, can be useful for selecting some portion of your
data for further analysis. For instance, you have a 2D scatter plot and you are interested in data points in a
particular region of the graph.

Click the the Data Highlighter button ﬂon the Tools toolbar.

2. Highlight the desired group of data points. Note that you can toggle between rectangular and freehand
selection modes by pressing the spacebar while the Highlighter is active. Selection points in the graph
simultaneously highlights selected rows in the source worksheet.

3. Go the source worksheet, right-click on it and choose Create Subset Sheet.

You now have a secondary worksheet named as wcopyN, that contains only the data points that you selected
in the graph.

For more information, see The Data Highlighter Tool.

15.3Data Output

Origin's analysis tools typically have an Output branch (the exact name varies by tool), in which you can
specify the output that you wish to generate and where you would like that output to go. This happens to be
the output branch of the Integration tool.

|| [+ Inpy_t fl sad-Ul4-U4H A Time”, L IMagnetic Field”) I_; F |
Output Quantities
Bl [ Integral Curve Data || [<input>,<new>) | % | »
= Range 1 || (=input> <new>) | | b
X [ <input> B
¥ [ <new> EE
Integration Result " [<input>]<new: | B3 [<input>]<input>: Input Book, Input Sheet
Plot Integral Curve None v <news>: New Sheet
[=new=>]<new:>: Mew Book
Related Apps | oK | Cancel Custom... [:}

Output can be directed to various places -- a range of worksheet cells or columns, or possibly to a worksheet,
a workbook, a matrixsheet, or a graph layer. Output options depend upon the target object as well as the type
of window that was active when the tool was opened. You can determine your output target by:
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e  Typing directly in the associated text box, using a standard range notation

®  Selecting data with the interactive range control.

e  Type or select your target using a set of predefined range strings.

This being an introductory manual, we will stick with the simplest to use -- using predefined range strings.
For information on other options, follow the links above.

15.3.1Specifying Output Using Range Strings

Referring to the image above, note that range strings are enclosed by < > characters. Valid strings will differ
from dialog to dialog (e.g. <source> is available from the Book list under the Output Fitted Values To
branch of the Fit Linear dialog, but it is not used to specify Output in the Smooth dialog).

The most common strings:

® <none>: Generate no output.
e <new=>: Create a new Origin object -- a column, a worksheet, a graph, etc.

e <input>: Use the input object for output.

You can type these strings directly into the edit box but the easiest thing to do is to just select them from the
flyout menu (options will vary by tool). Alternately, you can click the Custom button and open the Range
String Builder. Despite the intimidating name, it is just a way to step through the process of specifying your
output target. For more information on range strings and Range String Builder, see Qutput Results in the
Origin Help file.

15.4 Data Masking

Masking is another technique that you can use when you want to analyze only a subset of your data, or
when you have spurious data points that you do not want included in your analysis. Masking or unmasking
data will trigger recalculation of linked operations.

®  You can mask data points in both worksheets and graphs.

e When data exist in both the worksheet and the graph, masking data in one will mask (and mark) the

corresponding data in the other.
e  Mask toolbar buttons work on both graphs and worksheets.
e Tools toolbar buttons work on graphs.
® When data are selected in the worksheet, a Mini Toolbar Mask Data button becomes available.

e  Additionally, you can mask worksheet data by mathematical condition.

The active worksheet's Masked and/or Unmasked Data Count can be reported to the
Status Bar.
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15.4.1Masking with the Mask Toolbar (worksheet, graph)

These toolbar buttons are used to mask and manipulate masking of selected data. Note that this includes
graphs, once data have been selected (see the next section on Tools toolbar buttons for graph selection).

Toolbar

Button Shortcut Command Notes

Action

Mask the selected data range.
Masked data will display in the mask
color.

Mask data El Mask: Range

Unmask the selected data range.
Unmasked points are included in
analysis operations and plot
"normally".

Unmask data m Mask: Clear Range

Swap masked and unmasked points
in the active dataset.

Swap mask I Mask: Swap

Change mask x| Change the mask color of the

Mask: Change Color

color

masked data range.

Hide/Show
masked points

Mask:

Hide

Toggle display of masked points ON
and OFF on-screen, and in printed
and exported graphs.

Disable masking

=]

Mask:

Disable Masking

Toggle the mask ON or OFF for all
masked data in the worksheet.
When toggled OFF, all data points
are analyzed and included in printed
and exported graphs.

15.4.2Masking with the Tools Toolbar (graph)

There was a change made to the default masking mode, starting with Origin 2021:

e Default is changed from mask by row index number to mask by

rectangular region.

e  Otherwise, behavior remains as before: toggle between masking modes

(see next) by pressing Spacebar.

e Use system variable @MTI=1 (persistent) to revert to mask by row

index as default.
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To mask points, click on the graph window to activate it:

1. Choose Data: Mask Data Points from the main menu or click the Mask Points on Active Plot button or
Mask Points on All Plots button on the Tools toolbar, then hover on the graph.

2. To mask a single point, double click on the point. To mask a region of points, press the Space bar to
toggle among masking by row index number, by rectangular region or by freehand region (differences
explained below), then drag out a region.

3. Once data are masked in the graph, you can use the Mask toolbar buttons, described above.

Mask Points Mask Points on All

. Plots of Active Purpose
on Active Plot Layer
e s Mask data points by rectangular region. Only the data points inside
the rectangle that you drag out, will be masked.
h‘ } Mask data points by freehand region. Only the data points inside
the region that you drag out, will be masked.
Mask data points by row index number. All data points between the
%@| EE]’E lowest and highest selected index numbers are masked regardless

of whether they lie inside your rectangle.

To remove the mask from data points in the graph window:

.* o
1. Choose either the Unmask Points on the Active Plot ﬂ tool or the Unmask Points on All Plots of

-
Active Layer “é‘ tool on the Tools toolbar.

2. Use the space bar, as needed, to choose points by index, rectangular region or by freehand region, then

b

drag to unmask your data points. The tool will be active until press ESC or click the Pointer tool.

15.4.3Mask Mini Toolbar Button (worksheet)

When worksheet data are selected -- cells or entire columns -- A Mini Toolbar Mask Data button
becomes available. The button works as a toggle to mask or unmask data within the selection.

15.4.4Mask Cells by Condition (worksheet)

There is a tool for masking worksheet data values by condition (e.g. <= 0).

1. With the data selected (cells or one or more columns), choose Column: Mask Cells by Condition. This
opens the colmask dialog.

2. Choose your Condition and Value, plus other options as needed and click OK.
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15.5 Mathematics

Data Analysis

Origin provides a number of mathematics tools to perform basic calculations, interpolation, and area or volume

calculations.

15.5.1Basic Math

New Analysis: Mathematics: Normalize Columns options:

i sll, e Normalize Methods = Normalize to [X,y] to normalize columns to a user-

specified range of values.

(] For Normalize Methods = Use Reference Column, a new Normalize to =

Range option.

Tool Name

Description

Menu Entry

e  Simple Column
Math/Simple Curve
Math

e Normalize
Columns/Curves

e  Average Multiple
Curves

[ Differentiate

Perform basic calculations
on worksheet columns or

XY data plots

Analysis:Mathematics
(workbook, graph)

e  Simple Math

Perform element-wise

arithmetic on two matrices.

Analysis:Mathematics
(matrix)

(] Subtract Reference

Data

Subtract one dataset from

another

Analysis:Data Manipulation
(workbook, graph)

e  Subtract Straight

Line

Subtract a straight line
defined graphically by
clicking in the graph.

Analysis:Data Manipulation
(graph)

e  Subtract

Subtract matrices in sheet

by another matrix.

Analysis:Mathematics
(matrix)
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Tool Name

Description

Menu Entry

e  Vertical Translate

. Horizontal Translate

Use a Gadget to
graphically translate
curve(s) in vertical or

horizontal.

Analysis:Data Manipulation
(graph)

e Differentiate Gadget

Perform differentiation
over a region of interest in

a graph

Gadgets:Differentiate...
(graph)

e Intersect Gadget

Calculate the intersection
points of two or more data

plots.

Gadgets:Intersect... (graph)

e  Vertical Cursor

Read and tag X, Y
coordinate values for data
plots across multiple
graphs that share the

same X axis.

Gadgets:Vertical Cursor...
(graph)

e  Set Column Values

Use formulae to
set/transform worksheet

column values

Analysis:Mathematics
(workbook)

(] Inverse

Generate pseudo inverse of

a matrix

Analysis:Mathematics
(matrix)

(] Median Filter
e  Special Filter

(] Custom Filter

Apply
median/special/custom

filter to a matrix

Analysis:Mathematics
(matrix)
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15.5.2Interpolation

Data Analysis

Tool Name

Description

Menu Entry

e Interpolate Gadget

Perform interpolation
over a region of

interest

Gadgets:Interpolate...
(graph)

e Interpolate/Extrapolate

e XYZ Trace Interpolation(3D
Graph)

e Trace Interpolation(2D
Graph)

Perform
interpolation/extrapola
tion on a group of XY
data.

Perform periodic
interpolation on XYZ

worksheet data
Perform interpolation

on cycle or periodic

curves

Analysis:Mathematics
(workbook, graph)

. Interpolate/Extrapolate Y

from X

e 3D Interpolation

Perform
interpolation/extrapola
tion on a group of XY
data to find Y at given
X values.

Perform 2D
interpolation on a
group of XYZ data to
find Z at given XY
values w/ choice of 8
methods.

Perform interpolation
with a 3D function on

XYZ dataset.

Analysis:Mathematics
(workbook)

e 2D Interpolate/Extrapolate

Perform 2D
interpolation/extrapola

tion for a matrix

Analysis:Mathematics
(matrix, graph from
matrix)
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15.5.3Area/Volume Calculation

Tool Name Description Menu Entry

e Perform integration over a

e Integrate Gadget region of interest in a 2D
Gadgets:Integrate... (graph)
Graph

e  Calculate max height,
volume, FWHM (X,Y) for a

e 2D Integrate Gadget contour or image graph
Gadgets:2D Integrate...

created from matrix or XYZ
(graph)

worksheet data (OriginPro
Only).

o . .
e Integrate(2D Graph) Perform integration on

input data
e  Polygon Area(2D
e  Calculate the area of
Graph) : Analysis:Mathematics
enclosed plot regions :

e  XYZ Surface Area (workbook, graph)

e Calculate the area of the

(3D Graph) XYZ surface
e 2D Volume Integrate * Calculate the volume Analysis:Mathematics: 2D
beneath the matrix surface Volume Integrate (matrix, 3D
from zero plane graph from matrix)
e  Matrix Surface Area or
e  Calculate the area of the Analysis:Mathematics:
matrix surface Matrix Surface Area (matrix,

3D graph from matrix)

15.6Curve Fitting

I A number of free Apps designed for various curve-fitting operations are available from
' the OriginLab File Exchange. To find and install these Apps click Analysis: Fitting:
Find Apps. The App Center will open, displaying only fitting-related Apps. Browse

available Apps and click the Download and Install button to install an App.
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Data Analysis

Curve fitting improvements in Origin 2022b:

Use named range values as fitting function parameters, X "From" and "To" values,

lower and upper bounds and initial parameter values in the nonlinear curve fitter
(NLFit).

Better auto initialization of parameters that are not assigned a specific value.

For User Defined functions, support EMF or SVG image of Formula (Equation) to

display in lower panel of NLFit or Fitting Function Organizer.

8 MLFit (ExphssocMOD (User))
Dialeg Theme

Recalculate Manual ~

Settings Cede  Parameters Bounds

Data Selection Category User Defined -
Fitted Curves [Function ExpAssocMOD (User] e
Find X New Add ;4!“!1
Advanced : s
Heration Algarithm | Levenirerg Marquardt o

Output
T h | istion equation

P

[File Mame{.FDF) C:\Users\mike\ Do cuments\ OriginLab User Files\fitfunc ExpAssecMOD fdf

Ble@le] val pols]ale]  [E o ] G

Fit Curve  Residual IFnrmuIa ISﬂmnIeELlrn Messages  Function File  Hints

3£ X

y=vo+Ai1(l—¢ )+ Ay(l — ¢ )

To add an EMF or SVG image to your user-defined function:

Create the EMF/SVG using an equation editor (hint: Origin's LaTeX App can convert a
user-defined fitting function into a LaTeX equation object).
Name the EMG/SVG image just as you named the user-defined fitting function (e.g.

MyFunction.SVG) and place in \User Files\fitfunc.
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15.6.1Linear and Polynomial Fit

Most curve fitting and peak finding analyses add an optional Result Table with equation,
weighting, slope, intercept, etc., to the active graph. Origin 2022b adds a Mini Toolbar
v button for adjusting displayed digits in the Result Table.

e L
v g

Equafion =a+ b == PO

: FEELMEL[es |- ) bgis.

Weight No Weighting a v RF]

Intercept Some oo |(Default ~ A A —.A.‘ﬁ_|

L 5
A

95 lope 0.9608T + 002279 4
Residusl Sum of Squarss 003706
Pearson’sr 099167
R-Square {COD) 0.5834
Adj. R-Square _ 058285

b

Linear and polynomial fitting can be performed on worksheet data or data plots in a graph. Linear Fit on
Matrix Stack is performed on a series of matrix objects.

Tool Name Menu Entry

e Linear Fit Analysis:Fitting:Linear Fit
or
Gadgets:Quick Fit (graph)

e Fit Linear with X Error . L o .
Analysis:Fitting:Fit Linear with X Error

®  Multiple Linear Regression o . ) .
Analysis:Fitting:Multiple Linear Regression

e Polynomial Regression Analysis:Fitting:Polynomial Fit
or
Gadgets:Quick Fit (graph)

e  Perform a linear fit on a series of

matrix objects for each pair of XY ) ) ) . )
. Analysis: Linear Fit on Matrix Stack (matrix)
coordinates.

15.6.2Nonlinear Curve Fit

You can perform nonlinear curve fitting using one of many built-in fitting functions, or you can create a user-
defined fitting function. OriginPro supports implicit function fitting, surface fitting, and fit comparison. Some
tools are available only in OriginPro.

The table below summarizes available nonlinear curve fitting tools:
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Tool Name

Features

Menu Entry

Quick Fit Gadget

Fit a region of interest in a
graph interactively

Fit with built-in or user-
defined fitting functions

Fit one or multiple datasets
Choose from a number of
pre-defined analyses (incl.
Linear, Cubic, Peak and

Sigmoidal).

Gadgets:Quick Fit (graph)
or

Gadgets:Quick Sigmoidal
Fit (graph)

Nonlinear Curve

Fitting

Fit with built-in or user-

defined fitting functions
Fit one or multiple datasets

Compare fit, multiple

parameter sets

Global fit with parameter

sharing

Global fit, parameter
sharing with multiple
functions

Fit with replicas

Advanced options including
bounds, constraints, fit

control

Analysis:Fitting:Nonlinear
Curve Fit (workbook, graph)

Implicit Curve Fitting

Fit with implicit functions

Orthogonal Distance
Regression (ODR)

algorithm

Analysis:Fitting:Nonlinear
Implicit Curve Fit (workbook,
graph)

Surface Fit

Fit data from a matrix or

worksheet XYZ columns

Analysis:Fitting:Nonlinear
Surface Fit (workbook, graph)
or

Analysis:Nonlinear Matrix
Fit (matrix)
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Tool Name

Features

Menu Entry

e  Fitting Function

Builder

Create or edit user-defined

fitting functions

Tools:Fitting Function
Builder

e  Fitting Function

Organizer

Manage fitting functions by
categories
Move or share functions

between categories

Tools:Fitting Function
Organizer

e  Fitting Function

Library App

Download fitting functions
from originlab.com
Request or Share a

Function with OriginLab

Click the Fitting Function
Library icon in the Apps
Gallery

e Simulate

Simulate a curve from a

given function

Simulate a surface from a

given function

Analysis:Fitting:Simulate
Curve

or
Analysis:Fitting:Simulate
Surface

e Fit Comparison

Compare fit results from
two datasets using one
function function
Compare fitting results for
one dataset using two

fitting functions

Analysis:Fitting:Compare
Datasets

or
Analysis:Fitting:Compare
Models (workbook, graph)

(] Fit and Rank

Functions

Compatre fit results of two
or more functions for a

single dataset

Analysis:Fitting:Rank
Models (workbook, graph)

15.7 Peak Analysis

Origin provides several tools for peak analysis. With these tools, you can define and subtract baselines, find
peaks, integrate peaks, and fit peaks. Some tools are available only in OriginPro.
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Note that a number of free Apps designed for peak analysis are available from the OriginLab File Exchange. To
find and install these Apps click Analysis: Peaks and Baseline: Find Apps. The App Center will open,
displaying only peak-fitting related Apps. Browse available Apps and click the Download and Install button

to install an App.

The table below summarizes various built-in tools available for peak analysis:

Tool Name Features Menu Entry

e  Perform peak analysis over

a region of interest
e Create baseline
®  Quick Peaks Gadget ®  Subtract baseline
Gadget:Quick Peaks (graph)
®  Find peaks
e Integrate peaks

e Fit peaks

®  Pick multiple peaks .
e Multiple Peak Fit Analysis:Peaks and

®  Fit peaks Baseline:Multiple Peak Fit
(graph, workbook)

® Create baseline

®  Subtract baseline
e  Find peaks

. Integrate peaks

® Fit multi-peak datasets ]
e  Peak Analyzer Analysis:Peaks and

Baseline:Peak Analyzer
raph, workbook

e Fit baseline (grap )

e  Find hidden peaks

e Compute many peak

characteristics

. Use a theme file created

using Peak Analyzer tool )
) Analysis:Peaks and

(] Batch Peak Analysis e  Perform batch peak Baseline:Batch Peak
analysis on multiple Analysis Using Theme

h kbook
datasets (graph, workbook)
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15.8Signal Processing

Origin provides signal processing tools for many tasks, including producing signal transforms,
smoothing/filtering, and correlation on 1D and 2D signals. Advanced tools are available in OriginPro.

You may refer to the tables below for the signal processing tools and their menu entry.

15.8.1Signal Transforms

Tools Menu Entry

e FFT Gadget
Gadgets:FFT... (graph)

e  Fast Fourier Transform (FFT)

® Inverse Fast Fourier Transform Analysis:Signal Processing:FFT
(IFFT) (workbook, graph)
e 2DFFT
e 2D IFFT Analysis:Signal Processing:FFT (matrix)

e  Short-time Fourier Transform

Analysis:Signal Processing:STFT
(STFT) (workbook)

® Hilbert Transform Analysis:Signal Processing:Hilbert
Transform (workbook, graph)

e Image Profiling Plot>2D:Profile:image Profile (matrix,
worksheet, XYZ data)

15.8.2Filtering

Tools Menu Entry

* FFT Filter Analysis:Signal Processing:FFT Filters

(workbook, graph)
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Menu Entry

e 2D FFT Filter

Analysis:Signal Processing:2D FFT
Filters (matrix)

. IR Filter Design

Analysis:Signal Processing:IlIR Filter
(workbook, graph)

15.8.3Smoothing

Tools

Menu Entry

e  Smooth

Analysis:Signal Processing:Smooth
(workbook, graph, matrix)

15.8.4Correlation

Tools

Menu Entry

e  Correlation

Analysis:Signal Processing:Correlation
(workbook, graph)

(] 2D Correlation

Analysis:Signal Processing:2D
Correlation (matrix)

15.8.5Convolution

Tools

Menu Entry

(] Convolution

Analysis:Signal
Processing:Convolution (workbook,
graph)

Data Analysis
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15.8.6Wavelet Analysis (Pro Only)

Tools Menu Entry

®  Continuous Wavelet Transform

. Discrete Wavelet Transform
(Decomposition)

® Inverse Discrete Wavelet

Transform (Reconstruction) Analysis:Signal Processing:Wavelet
e  Multi-Scale Wavelet Analysis (workbook, graph)

Decomposition
e  Smoothing

(] Noise Removal

e 2D Wavelet Decomposition
Analysis:Signal Processing:Wavelet

° i . .
2D Wavelet Reconstruction Analysis (matrix)

15.8.70ther Advanced Tools (Pro Only)

Tools Menu Entry

e Rise Time Gadget ) )
Gadget:Rise Time (graph)

* Decimation Analysis:Signal Processing:Decimation
(workbook, graph)

® Coherence Analysis:Signal Processing:Coherence
(workbook, graph)

* Envelope Curves Analysis:Signal Processing:Envelope
(workbook, graph)

15.9 Image Processing

Origin provides a collection of tools for basic image processing. These tools are accessible from the Image

menu when a matrixbook is active. Some tools are only.
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The tools are organized in the following sub-menus:

. Image:Adjustments

. Image:Arithmetic Transforms
L] Image:Conversion

° Image:Geometric Transforms
. Image:Spatial Filters

15.10Topics for Further Reading

®  Analysis Dialog Boxes: Specifying Your Input Data

e  Qutputting Analysis Results

(] Recalculation of Analysis Results

®  Generating Analysis Report Sheets

e Performing Math Operations on Datasets

(] Linear/Polynomial Regression

(] Nonlinear Curve Fitting

e Peak Analysis using Origin

e  Signal Processing

. Image Processing and Analysis
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16 Statistics

16.1.1Apps for Statistics

Origin 2016 introduced add-on tools called Apps. Since being introduced, a number of statistics-related
graphing and analysis Apps have been added to OriginLab's File Exchange and more tools are being released

all the time.

A few Apps are installed with your Origin software. Note that as of the fall of 2019, all Apps are available at no
extra cost and they are easily added to Origin. Click Statistics: Find Apps. This opens the App Center to

£ 3

show only statistics-related Apps. Browse available Apps and click the Download and Install button to

install an App.

Origin includes a pre-installed App called Stats Advisor. This App uses an interactive "wizard" interface to
help you choose appropriate statistical tests and to tell you where to find them in your Origin software, or -- if
the test is available from another add-on App -- where to find it on the OriginLab File Exchange.

Look for this App in the | Stats Adviser

Apps Gallery, located
to the right side of your

Origin workspace

Stats Advisor

>> What do you want to do?

O Summarize, describe, or present
data with basic statistics

O Compare means/medians,
variance, proportion in groups
and datasets

® Examine distribution of data or
find cormelation of data

O Perform regression on predictors
and responses

O Reduce number of variables
(O Classify data into groups

O Miscelianeous Multivariate
Analysis

O Perform DOE, determine power
and sample size

O Parform survival analysis or
ROC curve

O Analyze time series data
O Piot advanced statistics graph

> 1. Which kind of data do you have?

® Have columns of numerkc data and
want to examine or calculate
disiribution

O Have numeric data and want to find
comelations between columns

O Have two categorical data columns for
cross tabulation analysis

O Have no data but want to cakulate 3
distribution

O Have no data but want to generate or
simulate random data
>> 2. Is your data in individual columns or
paired XY columns?
® Individual columns
O Paired XY columns

O Muttiple columns

>> Suggested feature(s)

Please answer all questions in the left panel first
You may need fo scroll down o view ail
questions.

QO MNormality Test

O Distribution Fit

© Randomness Tests @D

O Rank Data @D

QO Probability Piot €I

QO o-c Pt M

© Histogram I

O Gaussian Micture Models QI

Open Help Open Dialog
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16.2 Basic Statistics

Many of Origin's advanced statistical tests are available only in OriginPro. Users of
standard Origin will see these Pro-only tests marked as (Pro) in the main menu. If you
own the standard version of Origin but find that you need features of OriginPro, you can
upgrade by contacting your Origin representative.

If you wish to continue using standard Origin without seeing (Pro) menu commands, click
Preferences: System Variables and enter the following in the Set System Variables
dialog box and click OK (Comment is optional):

B Set System Variables ? *
Variable Value | Comment 2
RPM 1 Turns off menu display of (Pro) features
W
System Variables List
Ok Cancel
16.2.1Basic Statistics on Worksheet
Descriptive Statistics Menu entry with worksheet active

Statistics on Columns

Statistics on Rows Statistics:Descriptive Statistics

No menu access. To open the dialog box:

Statistics on Y by X Bin 1. Click Window: Script Windowv.
2. At the cursor, type statsxy -d and press

Enter.

Cross Tabulation and Chi-Square

Statistics:Descriptive Statistics
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Statistics

Discrete Frequency
Frequency Counts

2D Frequency Counts/Binning

Distribution Fit m

Normality Test

Correlation Coefficient ﬁ@

Partial Correlation Coefficient @

Grubbs Test

Dixon's Q-test

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics

Statistics:Descriptive Statistics

You can apply Conditional Formatting to a worksheet by applying mathematical
expressions or statistics to cell values. For more information, see Conditional

Formatting.

ilefsie]

g e

peesotl
imig itees

IifREEE
Aafei Ry

333


http://www.originlab.com/doc/Origin-Help/conditional-format
http://www.originlab.com/doc/Origin-Help/conditional-format

UserGuide_2022b

16.2.2Descriptive Statistics on Graph

Origin provides a couple of gadgets to explore and summarize data plotted in graphs.

Descriptive Statistics Menu entry with graph active

®  Cluster Gadget

Gadgets:Cluster...

Gadgets:Statistics...

e  Statistics Gadget

With Origin 2022b the Statistics Gadget
Lkl supports custom labeling of the ROI Box.

16.2.3Descriptive Statistics on Matrix

Descriptive Statistics Menu entry with matrix active

e  Qutput descriptive statistics (mean, sd,
min, max, etc.) on the matrix stack

(series of matrix objects), for each pair Analysis: Descriptive Statistics
of XY coordinates.

16.2.4Statistics on Selected Range

Origin provides some quick ways to obtain basic statistics on a selected range of worksheet cells, or data plot(s)
in a graph.

16.2.4.1 Status Bar
Select a range of cells in a worksheet. Note that the selection can include cells from one or more columns, and
you can use the CTRL key to select non-contiguous groups of cells.

Basic statistics (average, sum, count, min, max) for your selected data will be displayed in the status bar.
Right click on the status bar to customize what quantities to display.
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16.2.4.2 Command or Script Window

Statistics, Report to Script/Command Window

1. Select a range of cells in a worksheet, or click and select a group of data plots or an individual data plot in
a graph.
2. Open the Command Window or the Script Window from the Windows menu, and type one of these

commands, then press ENTER:

stats

moments

quantiles

With the Command Window, the results are typed out below the command line. With the Script Window, you
will need to issue an additional command to return your results:

stats;
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stats.=;

Note: For more information, please refer to the:

Help: X-Function > X-Function Reference > Statistics

16.3 Statistical Graphs

Origin provides numerous statistical graph types. All graphs can be easily customized and saved as a template
for repeat use. View the Graphing and Customizing Graphs chapters of this guide for more information.

Plot Menu
raph T
Elzel Tz Category
Box Charts: Box, Interval Plot, Bar Charts, Box Overlap, Box Normal, Half
Box, Bar Overlap, Bar Normal, Scatter Interval, Double-Y Box, Marginal Box Statistical

Charts.

Box Charts, Violin Plots, etc., Grouped: Grouped Scatter - Indexed Data,
Grouped Box Charts - Indexed Data, Grouped Box Charts - Raw Data, Grouped
Column Scatter - Indexed Data, Grouped Interval Plot - Indexed Data,
Grouped Mean Bar - Indexed Data, Grouped Violin - Indexed Data, Grouped
Half Violin - Indexed Data, Grouped Half Box - Indexed Data.

Categorical

Violin Plots: Violin Plot, Violin with Box, Violin with Point, Violin with Quartile,

Violin with Stick, Split Violin, Half Violin. Statistical
Histograms: Histogram, Histogram + Rug, Histogram + Probabilities, Multi-

Panel Histogram, Distribution, Distribution + Rug, Histogram with Labels, Statistical
Stacked Histograms, Marginal Histograms.

Population Pyramid Statistical
2D Kernel Density Contour
Heatmap: Heatmap, Heatmap with Labels, Split Heatmap Contour
Contour - Categorical Z Contour

Cluster Plots

Categorical

Probability: Probability Plot, Q-Q Plot.

Statistical
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Statistics

Plot Menu
Graph Type Category
Pareto and QC Chart: Pareto Chart - Binned Data, Pareto Chart - Raw Data, Statistical
QC (X-bar R) Chart.
Bland-Altman Plot (Tukey mean-difference) Statistical
Scatter Matrix Statistical
Trellis Plot: Trellis Plot, Double-Y Trellis Plot, Double-Y Trellis Plot Categorical
Parallel Plot: Parallel Plot, Parallel Sets, Parallel Index. Categorical

The following statistical graphs are only available within the Plots branch of the statistical analysis dialogs.

Graph Type Menu Entry

° Means Plot

. Statistics: ANOVA: One-Way ANOVA, Two-Way ANOVA
e Means Comparison

Plot Statistics: ANOVA: One-Way Repeated Measure ANOVA

(] Survival Curve

®  One Minus Survival

Curve

Statistics: Survival Analysis: Kaplan-Meier Estimator
e Hazard Curve

®  Log Survival Curve

e  Scree Plot

e Component Plot Statistics: Multivariate Analysis: Principal Component Analysis

e Dendrogram
Statistics: Multivariate Analysis: Hierarchical Cluster Analysis
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Graph Type

Menu Entry

Classification
Summary Plot
Classification Fit
Plot

Canonical Score

Plot

Statistics: Multivariate Analysis: Discriminant Analysis

ROC Curve

Statistics: ROC Curve

16.4Comparing One, Two or More Groups

Origin provides parametric and non-parametric tests to compare one, two, three or more groups.

16.4.1Parametric Hypothesis Tests

Feature

Menu Entry

One-Sample t-Test
Two-Sample t-Test
Pair-Sample t-Test
One-Sample Test for
Variance

Two-Sample Test for

Variance

Statistics: Hypothesis Testing

One-Sample Proportion

Test

Two-Sample Proportion

Test

Statistics: Hypothesis Testing

Two-Sample t-Test on

Rows

Pair-Sample t-Test on

Rows

Statistics: Hypothesis Testing
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16.4.2ANOVA

Feature Menu Entry

e  One-Way ANOVA
e Two-Way ANOVA

e  Three-Way ANOVA
e One-Way Repeated-Measures ANOVA Statistics: ANOVA

e Two-Way Repeated-Measures ANOVA

(Supports both Balanced and Unbalanced data)

16.4.3Non-parametric Tests

Feature Menu Entry

®  One-Sample Wilcoxon Signed Rank Test

®  Paired-Sample Wilcoxon Signed Rank Test
e  Paired-Sample Sign Test

(] Mann-Whitney Test

e  Two-Sample Kolmogorov-Smirnov Test Statistics:Nonparametric Tests
e  Kruskal-Wallis ANOVA
® Moods Median Test

(] Friedman ANOVA

Notes:

Multiple nonparametric tests can be run simultaneously. (Accessible from the

Statistics:Nonparametric Tests menu ) Available options are:

e (NPH) K Independent Samples: Kruskal-Wallis ANOVA and Mood's Median Test
e (NPH) Paired Samples: Paired-Sample Wilcoxon Signed Rank Test and Paired-Sample Sign Test

e (NPH) Two Independent Samples: Mann-Whitney Test and Two-Sample Kolmogorov-Smirnov

Test
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16.5 Advanced Statistics

Several additional tools are available in OriginPro.

16.5.1Multivariate Analysis

Origin offers several multivariate analysis methods to help you simplify, classify, or make predictions from
your data.

Feature Menu Entry

e  Principal Component Analysis
e K-Means Cluster

e Hierarchical Cluster

e Discriminant Analysis Statistics:Multivariate Analysis
e  Canonical Discriminant Analysis

e  Partial Least Squares

Notes: Canonical Discriminant Analysis is integrated with Discriminant Analysis. It is accessible from the
Statistics:Multivariate Analysis:Discriminant Analysis: Canonical Discriminant Analysis(System)

menu.

16.5.2Survival Analysis

OriginPro includes widely used survival tests to quantify survivorship in a population.

Feature Menu Entry

(] Kaplan-Meier Product-limit Estimator
e  Comparing Survival Curves
e  Cox Proportional Hazards Model Statistics:Survival Analysis

e  Weibull Fit Model

Notes: Comparing Survival Curves is accessible in the Kaplan-Meier Product-limit Estimator

feature.

16.5.3Power and Sample Size

Statistics, Power and Sample Size Origin provides eight types of power and sample size analysis, useful in
designing experiments. Origin can compute the power of the experiment for a given sample size and can also
compute the required sample size for given power values.
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®  One-Variance Test
(] Two-Variance Test

e  One-Way ANOVA

Feature Menu Entry
®  One-Proportion Test
®  Two-Proportion Test
®  One-Sample t-Test
e Two-Sample t-Test
e  Paired-Sample t-Test Statistics: Power and Sample Size

16.5.4ROC Curve

ROC Curve analysis is useful in determining if an incident has occurred, or in comparing the accuracy of two

methods that are used to discriminate between diseased and healthy cases.

Feature

Menu Entry

(] ROC Curve

Statistics: ROC Curve

16.6 Topics for Further Reading

e  Statistics on Worksheet Columns

e  Statistics on Worksheet Rows

. Descriptive Statistics

(] Statistics Charts, General

e  Appendix 2 - Origin Graph Types

e  Appendix: Statistical Graph Types by Template

(] Normality Testing
. Distribution Fit

e  Parametric Hypothesis Testing

e ANOVA

(] Nonparametric Tests

° Multivariate Analysis

(] Survival Analysis
(] ROC Curves

e  Power and Sample Size Tests

(] LabTalk Supported X-Functions: Statistics
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17 How to Handle Repetitive Tasks

17.1 Analysis Report Sheets
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Analysis operations, such as those performed with the tools listed in the Analysis chapter or in the Statistics
chapter, create detailed Analysis Report Sheets.

®  Analysis Report Sheets contain tables that are organized in a tree structure.

e Expand or collapse each branch to show or hide table contents.

e Tables are not static reports. They are constructed using placeholders linked to particular analysis results

and thus, results can be recalculated with changes to input or analysis parameters.

®  You can add comments to the sheet or copy tables and paste or paste-link them to other windows in your

project.

e  Analysis Report Sheets often contain embedded graphs such as fit curves or residual plots. To customize

these plots, double-click on them. This opens the embedded graph in a separate window where -- as with

any Origin graph -- you can customize it using Mini Toolbar buttons or Plot Details controls. When you are

done customizing, click the Close button and re-insert the customized graph back into the report

sheet.
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For more information on Analysis Report Sheets, see the Origin Help File.

17.2 Recalculation

All Analysis and most data processing dialog boxes in Origin include a Recalculate control. This control
allows you to tie output operations to the source data. When Recalculate is set to Auto or Manual, changes to
the source data will trigger an update of the output (pending, in the case of Manual). This allows you to
analyze multiple datasets by, for instance, serial import of a new data file to replace existing data. This feature
is also the basis for creating Analysis Templates. The Analysis Template concept is explained below.

Linear Fit l ? -5 -
Dialog Theme ﬂ

Description  |Perfarm Linear Fitting

Mone I
Input Fitcmttities|F‘.esidua|Ana|y‘sis Cutput | Fitted Curves Plot | Find X/ | Residual Plots
P &kl

Errors as Weight | Fgtrumental
Fix Intercept =

Fix Intercept at 0

Fix Slope =l

Fix Slope at 1

Usze Reduced Chi-Sqr
Apparent Fit

[ Ok ] [ Cancel ]

The Recalculate control has three modes:

e No lock is displayed in the output.

None e Changes to the input data will not result in an update of the output.

e An auto green lock @a displays on the output columns and graphs of the output data.
The main operation lock displays on the left-most column as ﬁ. while any related
operations columns to right of the main operation display the "+" icon &,

Auto e  The output will be automatically updated when input data is changed.

®  You can also click on a lock icon and open the dialog to make changes to the analysis

settings, including changing the Recalculate mode.
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¢ A manual green lock @. is displayed in up-to-date output columns, and graphs that
contain plots of the output data. Any related operations columns to right of the main
operation display the "+" icon 3.

e Avyellow lock |T_ﬁ:. indicates that input data have changed and recalculation operations
are pending. You can trigger updates individually by clicking on a yellow lock and

Manual selecting Recalculate from the shortcut menu; or you can update all pending

operations by clicking the yellow Recalculate button '5’7% on the Standard toolbar.

®  You can also click on a lock icon and open the dialog to make changes to the analysis

settings, including changing the Recalculate mode.

Tips for Managing Recalculation Operations

e A left-click on the lock displays a menu that provides multiple options including changing analysis
parameters, opening source data sheet, switching to result sheets, and controlling the status of the

operation such as switching from manual update to auto update.
e The Standard toolbar displays a Recalculate button that shows green 5’% when all project operations

are up-to-date and yellow '@ when there are recalculation operations pending. If you have opened a
project and you see that the Recalculate button is yellow, understand that calculations are pending and

that the data and data plots you see in the project may not be up-to-date.

. If a lock icon appears dark gray in color ﬂ this indicates that the associated operation was performed in
OriginPro and the window or project has been opened in standard Origin. The operation is not supported
by standard Origin and to modify or re-run the analysis, you will need to locate a computer with an

OriginPro license.

2L
. If a lock icon appears red li.‘ something has occurred which makes recalculation operations impossible.
Such conditions are rare but would occur if, for instance, you passed a project file that included a user-

defined curve fitting operation to a colleague but failed to pass along your user-defined fitting function.

e Having many recalculation operations in your project file can slow down your work. You can block
recalculation -- both Manual and Auto recalculation -- by clicking on a lock icon and choosing Block

Recalculation from the popup menu. Placing a block on pending recalculations places a yellow "block"

icon |@ on each associated operation in the chain. Placing a block on up-to-date calculations places a
T

green "block™ icon |E‘ on each operation in the chain. To remove the block, click on the "block" icon and

clear the check mark (Note that clicking the yellow Recalculate button gg on the Standard toolbar does

not update blocked operations).

e To suspend all recalculation, press Ctrl+0, choose Analysis: Pause Auto Recalculate (worksheet only)

or click the Pause Auto Recalculate button j on the Standard toolbar.

®  You can hide the lock icons on your graph window by clicking on the graph and, from the main menu,
choosing View: Show and clearing the check mark beside Lock Icons. This does not remove associated

operations from the graph window. To re-display the icons, repeat the procedure.
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17.3Dialog Themes

Pause Auto Recalculate using hotkey Ctrl+0. Menu command also added to the
Analysis menu when a worksheet is active.

Settings in analysis dialogs and most other data processing dialogs can be saved as a Dialog Theme file.
Once saved, these Theme files containing your custom settings can be recalled as needed. Multiple theme files
can be saved from a dialog, allowing for easy repeat analysis of datasets that may each require different

settings.

Last used dialog box settings are automatically saved as a <last used> Theme. Origin also allows you to save
your custom settings as the <default> Theme. The default Theme, last used Theme, and any named Theme
that you have saved, can all be accessed from the Dialog Theme fly-out menu that opens from the dialog box.
The same Themes are also available from the main menu item associated with the analysis dialog box.

Statistics
Bathematics

Data Manipulation
Fitting

Signal Processing
Peaks and Baselime

1 Linear Fit: <Llast useds> ..

I Linear Fit: «default» ..

3 Smooth: <last used»_.

4 Smooth; <defaults ..

5 Simvgle Peak Fit: «Last used>...
G Single Peak Fit: < default>...

| Anaipsis | Gadgets Tools Farmat Window Help

100%

=
sk

\ A W = 3L
Linear Fit

Fit Linear with ¥ Error...
Polynomaal Fit...

- w wl . w w w

Manlinear Curve Fit...
Homnbinear Imiplicit Curve Fit...
Hanbinear Surface Fit-..

Chri=¥

Simulate Curve...
Simulate Surface..,

Exponential Fit...
Single Peak Fit._.
Sigmoidal Fit..,

Compare Datasets_.,
Compare Models...

named Theme

= 1
s 2 e
PR ' p—— | =3 -|fo < .
1 < defauts>
2 «last useds
3 Zero Intercept [:} g
Open Dialog... |— Linear Fil of Linear Fit B
g
/.ﬁ
8 ;
_ o
L - "
" /
4 f/f/.'
A m
74 [ ]
/.
o - : . T -
2] 2 4 [ L] 1w 12

Dialog Themes are managed with the Theme Organizer tool, available from the Tools menu.
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Tutorial: Saving and Re-using a Dialog Theme

Import the file Linear Fit.dat from the Samples\Curve Fitting\ subfolder.

Highlight column B and select Analysis: Fitting: Linear Fit...

In the Linear Fit dialog that opens, check the Fix Intercept checkbox (under Fit

Options) and set the Fix Intercept at edit box to O.

Click the ﬂ button next to the Dialog Theme control and select Save as .... In




How to Handle Repetitive Tasks

the Theme Name box, enter Zero Intercept and press OK. Press OK again to
close the Linear Fit dialog box and perform the analysis. FitLinearl and
FitLinearCurvel result sheets are added to the workbook.

5. Return to the source data and highlight column C. Select Analysis: Fitting:
Linear Fit from the menu. You will see a fly-out menu with multiple Theme options
including the Zero Intercept Theme you saved in the previous step.

6. Select your saved Theme. The analysis is automatically performed on Column C

using the settings saved in the Theme. Note that the dialog box does not open.

I Tips for Working with Themes:

e Hold the SHIFT key while clicking on your Theme in the main menu and the
associated dialog box will open with settings from the selected Theme loaded into
the dialog box.

e  The default Theme Origin shipped for an analysis is called System Default. Click
the fly-out menu in the analysis dialog and choose System Default to load it.

®  Click the fly-out menu in the analysis dialog and choose Delete to delete Themes
you have created, including any customized <default> Theme.

® The customized <default> Themes for all analysis dialogs are saved in

Defaults.xml in the User Files Folder. Deleting this file restores system default

settings of all analysis dialogs.

17.4Workbook and Project Templates

There are a number of reasons for saving a single workbook or an entire project, as a "template" file. Here
are a few typical scenarios.

e  You might import data files that always have a fixed number of columns with a repeating pattern of
column designations (e.g. XYyError, XYyError, etc.) so you create a custom workbook just for importing
these files (File: Save Template As).

®  You regularly import data files of similar structure and you perform some routine graphing and analysis

operations on the data, then generate a report using a worksheet or a workbook embedded Notes window.

This would be a typical example of an Analysis Template (File: Save Workbook As Analysis Template).
®  You perform some operations similar to those described in the previous example but you can't save your
workbook as an Analysis Template because all data are cleared from the workbook on saving and that
would destroy a sheet of reference values that you rely on for your analysis. Instead, you could opt to
clear only the imported data and save your workbook as a window file (File: Save Window As). This
preserves the sheet of reference data and like the Analysis Template, saves analysis and graphing

operations with the workbook.

®  You routinely import data, do some analysis and generate a report and would like to make use of the
Analysis Template concept (as in the second bullet point), but you have multiple windows in your project,

including Layout windows that cannot be embedded in the workbook. So, a single workbook Analysis
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Template won't do the job. In this case, you could save the project without data by "cloning" it (File:

Clone current Project).

17.4.1The Workbook as Template

The workbook can contain worksheets with data, metadata, floating or embedded graphs, embedded matrices
and notes, plus scripts, variables and other supporting data.

You can save a workbook as a template for repetitive graphing and/or analysis tasks. Depending on your
needs, there are three options for saving your workbooks -- as a workbook (OGWU), as a template (OTWU)
or as an Analysis Template (OGWU):

e Workbook (OGWU): Choosing File: Save Window As saves all workbook content.

e Analysis Template (OGWU): Choosing File: Save Workbook as Analysis Template clears all data
columns that are used in analysis operations in the workbook before saving. Operations are preserved as
are data that are not associated with analysis operations.

e Template (OTWU): Choosing File: Save Template As saves the structure of the workbook, plus any
analysis operations that exist in the workbook, but all data including data that are not associated with

these analysis operations, are cleared.

The New Book dialog is a template library for managing workbook, matrixbook and
Analysis Templates. See Workbooks for an overview of dialog box features.

Tutorial: Creating an Analysis Template

1. Start with a new workbook and import the file Samples\Curve
Fitting\Sensor0O1l.dat.

2. Select column B and use the Analysis: Fitting: Linear Fit and open the Linear
Fit dialog.

Change the Recalculate drop-down to Auto.

Click the Fit Control tab, check the Fix Intercept check box and enter O in the
Fix Intercept at edit box.

Click OK to close the dialog and perform the linear regression.

Answer "Yes" to the prompt and switch to the FitLinearl report sheet to view
results including plots of the best-fit line and residuals.

7. Now switch back to the original data sheet and import the file Samples\Curve
Fitting\Sensor02.dat. The analysis results will be automatically updated with this
new data. Note that you could continue to use this workbook for importing other
data; or you could right-click the workbook window title and choose Duplicate
without Data to create a new workbook with the linear fitting operation saved
into it. This allows you to import new data into the new workbook and thus save a
project with multiple such workbooks, if desired.

8. With the workbook active, select the menu File: Save Workbook as Analysis

Template..., and in the dialog that opens, give a name such as Linear Fit of
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Sensor Data and click Save.

9. Choose File: Recent Books and select the template that was saved in the
previous step. The workbook will open and the data sheet will be empty.

10. Import the file Samples\Curve Fitting\Sensor3.dat into the empty data sheet

(1st sheet). The analysis results will be automatically generated upon data import.

Analysis Templates can include summary sheets and custom report sheets (worksheet-based or HTML),
making them an ideal medium for importing, analyzing, plotting and reporting the results of your routine
analyses. When used in combination with the the Batch Processing tool, you can repeat a set of analyses
and graphing operations for any number of data files and create a PDF summary report for each one, as itis
processed. View the Batch Plotting and Batch Analysis sections of this chapter for examples of using the
workbook as a template for handling repetitive tasks.

|, Notes windows now support HTML. Notes windows can be added to the workbook
(right-click on sheet tab and Add Notes as Sheet) making it easy to incorporate HTML
reports into your Analysis Templates. For more information, see HTML Reports
From Notes Windows.

17.4.2The Project as Template

The Origin project file can also be used as a "template" for carrying out repetitive graphing and analysis tasks
-- particularly when your analyses and graphing tasks can't be resolved within a single workbook.

The basis steps of creating a "project template" are as follows:
1. Create the desired graphs and/or analysis results from data in your workbook(s) and save the project.

2. After saving the project, choose File: Clone current Project. A small dialog opens for configuring

your cloned project:

Data Manipulation: clrAllData 4 x

Dialog Theme .| aot yeeds LJ

Clear data to make Analysis Template Project

Add Data Connectors |
Clear Data (W) Clear Al
i) Clear Imported Data and Delete Calculations

E\Project_Data\Origin 20196\Project Data\simple_fit_results.opju

O Add Data Connectors: Check this box to add Data Connectors from the cloned project to your
saved project. Each cloned worksheet will have a connection to the original worksheet in the
saved project. If you plan to import data from other similar files in your cloned project, you
should CLEAR this box.

O Clear All: Clear imported data only. Analysis operations are preserved in the cloned project.

O Clear Imported Data and Delete Calculations: Clears imported data and analysis operations.
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3. Click OK to create your cloned project. Selected data are cleared and the cloned project named UNTITLED
is added to the workspace.
4. Name and save the cloned project and when you are ready to process more data files, you can open it and
import new data:
O If your analysis and graphing operations are linked to a particular set of data files that are
periodically updated, you don't necessarily need to use Connectors. You can simply re-import the

files (Data: Re-import... or Re-import Directly).

O If your operations are linked using Data Connectors, click the Connector icon % and from the
popup menu choose Import (this Connector only) or Import All (all Connectors in the book).

O One possible scenario is that you store all of your data in a single Origin project file. If you have
added Data Connectors from your cloned project, to your original project then you can selectively
import just the data that you need to perform your graphing and analysis operations. When you

have finished, you can save the file to a new name, preserving your cloned project for re-use.

17.5Batch Plotting

Origin provides several methods for batch plotting of graphs from multiple datasets or files. The following two
sections outline how to create multiple graphs from (1) data that is already in worksheets, or (2) multiple data
files. In addition to these two procedures, batch plotting can also be performed programmatically using
LabTalk script or Origin C.

A new Match X by Offset check box is added to the Set Column Offset dialog, for
handling batch plotting of graphs that use multiple X columns (e.g. Sunburst plot).

17.5.1Duplicating Graphs with Data from Other Books/Sheets/Columns

If you have several workbooks, worksheets or columns with similar data structure as you the data used to plot
the graph, you can have Origin clone that graph via Window: Duplicate (Batch Plotting) menu with new
data. There are two cases:

e |If you have plotted a graph with a single dataset and customized it, and want to clone the graph with
other data in the same worksheet: Choose Window: Duplicate (Batch Plotting): Duplicate with New
Columns. Pick other data (columns) that you want to plot. Each column will be plotted as a new graph.

. If you have plotted a graph with data in one worksheet or workbook and customized the graph, and you
want to clone the graph with other worksheets or workbooks with a similar data structure: Choose
Window: Duplicate (Batch Plotting): Duplicate with New Sheets/Duplicate with New Books.
Origin will list all worksheets or workbooks with a similar data structure. Pick the worksheet or workbook

you want to plot from. Each worksheet or workbook will be plotted as a new graph.

Tutorial: Duplicating a graph with data from other books/sheets

1. Press the New Project D button on the Standard toolbar.
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5
Press the Import Wizard @ button on the same toolbar. This opens the Import
Wizard dialog box.

Click the browse button E] to the right of the File box. Browse to the Import
and Export folder and select the files S15-125-03.dat, S21-235-07.dat, and
S32-014-04.dat. Click Add File(s), then press OK. In the Import Wizard dialog
box, press Finish. The files are imported into three separate workbooks.

Drag and select all three Y columns in one of the workbooks, then select the menu
item Plot>2D: Multi-Y: 3Ys Y-YY to create a graph with multiple Y axes and one
shared X axis. Make any desired customizations to the graph.

Right-click on the title bar of the graph window then select Duplicate (Batch
Plotting) shortcut menu.

In the dialog box that opens, press Ctrl and select the other two
workbooks/worksheets then press OK. Two more graphs are created with data

from the other two workbooks/worksheets.

17.5.2The Workbook as a Template for Processing Multiple Files

If you want to plot graphs from many data files but don't want to import all files to workbooks before plotting,
you can import one file, create the desired graph(s) based on that data, then add the graph(s) to your
workbook and save the workbook as a template. Using this template you can process multiple files, creating a
workbook for each file and its corresponding graph.

Tutorial: Creating graphs from multiple data files

1.

With a new workbook active, choose Data: Import From File: Single ASCII and
import the file SensorO1.dat from the Samples\Curve Fitting subfolder of the
Origin installation folder.

Highlight column B and create a line+symbol graph of the data.

Double click on the X axis to open the Axis dialog. Make sure Scale tab is active.
Select both Horizontal and Vertical on the left panel and set Rescale to be Auto
and click OK. This will ensure that the graph scale will update automatically on
data change.

In the workbook, right-click on the worksheet tab and select Add Graph as
Sheet, then select the graph created above and click Done. This will add a new
workbook sheet containing an embedded graph.

Switch to the data sheet, double-click on the tab rename the sheet as Data.
Select the Worksheet: Clear Worksheet menu item to clear the data in this
sheet. Note that this step is optional. Clearing the data will reduce the size of the
template saved in the next step.

Select the File: Save Window As... menu item, assign a name such as Sensor
Data and Graph and press Save.

Now we can use this template to process multiple files. Select the File: Batch
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10.

11.
12.

Processing... menu item.

In the dialog box that opens set the Batch Processing Mode to Load Analysis

Template, then set the Analysis Template control to point to your saved

template.

Set Data Source to Import from Files and select the three files SensorO1l1.dat,

Sensor02.dat, and Sensor0O3.dat from the Samples\Curve Fitting subfolder.

Set the Data Sheet(s) to Data and set Result Sheet to <none>.

Press OK to close the dialog box. You should get three workbooks with the data

imported into the first sheet and the graphs updated in the 2nd sheet. To further

edit any of the graphs, double-click on the graph to pop up an editable page.

If processing of your data requires some custom import settings, those settings will be
saved to the data sheet by default. Settings thus saved to the sheet will be used for
import when batch processing of multiple files using the workbook as a template.

17.6Batch Analysis

Origin provides several ways to perform batch analysis of multiple files, data columns, or data plots.

17.6.1Analyzing Multiple Datasets in Dialogs

Some analysis dialog boxes, for instance Linear Fit and Nonlinear Fit, support analysis of multiple datasets.
Report sheets created by these dialog boxes include a summary table listing the parameter values for each
dataset and other pertinent results such as goodness-of-fit indicators. The summary table can be copied to an
external sheet for further processing.
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Tutorial: Fitting Multiple Datasets

1. Open a new workbook and import the file Samples\Curve Fitting\Multiple

Gaussians.dat from the Origin installation folder.

Set the Long Names of the four Y columns as Peak 1, Peak 2, Peak 3 and Peak 4.

3. Select all four Y columns, and use the Analysis: Fitting: Nonlinear Curve Fit...

menu item to open the NLFit dialog box.

4. Select Gauss from the Function drop-down list, then press the Fit button to perform

fitting and close the dialog box.

5. Switch to the FitNL1 report sheet. You will see a table named Summary which lists

the fit parameters and fit statistics for each dataset.

T Sumnmary x|
v Ho v A siima  PAHM  Height Statistics
\\ Walue Efror Walis Error Walue Efror Walie =T Walus Poaiiiced Chi-Sor Kdi P
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Peak2 4954 0087 20046 0144 BEN 0,325 43 182 1229 4311 10161 4852 0028
Peakd 0147 006 24973 0.247 | 12393 0.620 11116 DE43  BAO7 145082 OTI6 0.004
Peak 4 2,033 no4e W0ms 00832 4 611 011z 81 452 11488 1305 5429 2A03 0.0s7
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|, In the NLFit report sheet, click on the downward-pointing arrow button ﬂnext to the
table named Summary and select Create Copy as New Sheet. This will create a copy
of the table in which all cells are linked to the report. Any updates/changes to the fit
will automatically update the values in this copied sheet. This sheet can then be used to
plot or to perform secondary analysis on the fit parameters.

I When enumerating something like a column Long Name, as you did in step 2 above,
/ enter the string in the first cell (e.g. "Peak 1"), select the cell and hover over the lower-
right corner. When the cursor becomes a "+", drag across the other cells and the
contents of the first cell will be extended to those cells.

17.6.2Using Gadgets for Analyzing Multiple Curves

Origin includes several gadgets for performing interactive analysis on plotted data. Gadgets allow selecting a
data range of interest, switching from one dataset to another, and setting various preferences specific to the
analysis being carried out.

Most gadgets offer an option to perform the analysis on all data plots in the current layer, or all data plots in
the graph page. This allows for performing repetitive analysis on multiple datasets using the same settings,
and generating a table of results across all datasets.

Tutorial: Using the Integrate Gadget to Integrate Multiple Curves

Open the project "Samples\Spectroscopy\Absorbance Spectra.opj".
With the graph window active, choose Gadgets: Integrate from the main menu.
In the dialog that opens, click the Baseline tab and set the Mode drop-down to
Straight Line.

4. Click the Output tab, expand the Output Quantities to node, and check Append to
Worksheet. Press OK to close the dialog box.

5. A region of interest (ROI) object is placed on the graph. If necessary, click on the ROI
and resize this object to cover the entire data range plotted in the graph. The integrated

area will be displayed as a shaded region.

6. Click the arrow button E] at the top right of the ROI object, then choose Change Data
from the context menu and switch to another plot in the layer. Check that the current

baseline setting works for other curves in the layer.

7. Click the arrow button E] select New Output for All Curves (N) or simply press the

"N" key. Integration is performed on all curves.

8. Click the arrow button E] again and select Go to Report Worksheet. Expand the
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report worksheet to view the integration results from all curves.
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17.6.3Batch Analysis Using an Analysis Template

The Batch Processing tool allows you to process multiple files or datasets using an Analysis Template.
Simply perform the analysis on one of the files, include all desired results and report sheets in one workbook,
and save that workbook as an Analysis Template. The Batch Processing tool then uses the Analysis Template
to process multiple files/datasets. You have the option to retain one workbook for each file/dataset, and
additionally, to create a summary table with select analysis parameters and other metadata that you have pre-
configured in your analysis template.

These Batch Processing improvements are added for Origin 2022b:

“lalakil e  When setting Batch Processing Mode = Repeatedly Import into
Active Analysis Template Window, there is a new Result Sheet =
<none> option.

. If the Analysis Template is set up to import multiple files into the same

sheet, Batch Processing will now import all selected files to new columns
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when Use Import Settings in Workbook is checked.

Tutorial: Batch Analysis of Multiple Files using an Analysis Template

1. From the main menu, choose File: Batch Processing.... This opens the Batch
Processing dialog box.

2. Set Batch Processing Mode to Load Analysis Template.

3. Press the browse button B to the right of the Analysis Template box and
browse to and select the file <Origin Program Folder>\Samples\Batch
Processing\Sensor Analysis.OGW. This Analysis Template contains multiple

sheets set up for linear regression analysis, reporting, and summary tables.

4. Set Data Source = Import From Files, then click the browse button B to the
right of the File List and from the Samples\Curve Fitting folder, select files
Sensor01l.dat, SensorO2.dat and SensorO3.dat .

5. Set Dataset ldentifier to File Name, Data Sheet(s) to Data, and Result Sheet
to Result. Note that these are the names of existing sheets in the Analysis
Template.

Uncheck Delete Intermediate Workbook.

Click OK to close the dialog box and process the three files (you can answer "No"
to the prompt). You will obtain three books with the data, analysis results, and
report for each file, and a fourth book containing the summary table of analysis

results from all files.
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2| Sensor02.dat -0.858 0.362 2627 0.056 0.991 0.996
3[Sensord3.dat 0.460 0.436 4.437 0.068 0.996 0.998 |
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i Saving the initial workbook as an Analysis Template is optional. You can simply save
; the Origin project (.opj) and next time replace the data in your workbook to update all
results and graphs. The Batch Processing tool also has an option to repeatedly import
files into the active window, allowing you to simply re-use an existing book within a
project (which contains all desired analysis and graphs) as an on-the-fly template for
the batch analysis.

|, You can batch generate analysis reports using a custom MS Word template, with the
' option of outputting a PDF and/or an MS Word file for each report. Additionally, you
can opt to combine reports into a single file. For information on Batch Processing
with a Word Template for Reporting, see this tutorial.

17.7 Repeating Analysis on Other Datasets or Data Plots

For some analysis operations, you can perform the analysis on one dataset or data plot and then repeat the
analysis for all other data. This feature is available via a special shortcut menu entry, when you click on the
lock associated with the operation.

. In worksheet columns or reports, clicking the lock will show the menu command Repeat this for All Y

columns. Selecting this will repeat the analysis on all other Y columns in the source data sheet.

. In a graph, clicking the lock will show the menu command Repeat this for All Plots. Selecting this will

repeat the analysis for all other data plots in the graph page, even if the plots are in different layers.

This is particularly useful for such analysis dialog boxes as smoothing or interpolation that support input of
only one dataset. As long as the data are contained in one worksheet or plotted in one graph, the analysis can
be repeated on all other datasets.

Tutorial: Smoothing Multiple Columns in a Worksheet

1. Import the file Samples\Curve Fitting\Multiple Gaussians.dat into an empty
workbook.

2. Select column B and click Analysis: Signal Processing: Smooth to open the
smooth dialog box.

3. Accept the defaults and press OK to perform smoothing. A new column will be
added with the smoothed data.

4. Click on the lock @.in the output column and select Repeat this for All Y
columns. Three more columns of smoothed data with same settings will be

generated from the data in columns C thru E.

17.8Duplicate this Operation

Output produced by the Origin's analysis operations is linked to its source data by a particular analysis and a
particular set of analysis parameters. This linkage is signified by the placement of an "operations lock" on
analysis output and -- unless the user turns off recalculation for a particular operation -- such results are
generally "locked" to editing. You can find out more by reading about Analysis Report Sheets and Recalculation,
in the introductory sections of this chapter.
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The lock icon placed on analysis output can be clicked on to open a menu, giving you post-analysis access to
operation parameters and other information. This includes the dialog box and parameter-set used to produce
the analysis output, opened by clicking Change Parameters.

Towards the bottom of this menu, you will see a Duplicate this Operation entry.

E] Graph1 * BN HoB =)

™

H:'-| i B .:. L
Recalc

Change Parameters... i
Delete
Go to Source

o to Results

Amalysis Markers L3

Flot Input Data with Data Markers

[ ] Recalcutate Mode: Manual
Recaloulate Mode: Auto A 19

Recaloulate Mode: None

— Block Recalculation l

Ignore Hidden Fows L3

Show Info [FitLinear)

Sawe Theme AS..,

Copy Operation
] Duplicate this Operation »]
Repeat this Tar G1E

One possible use of the feature goes like this:

1. The user performs an analysis operation on a data plot, say, a fitting operation using the nonlinear curve
fitter (NLFit).

2. The user is not sure which fitting function best models her data so she tries a fit using one potential
function.
The user clicks the resulting operations lock and chooses Duplicate this Operation.
A duplicate analysis is run and a second operations lock is added to the graph window.
The user clicks the second operations lock, chooses Change Parameters and when the NLFit dialog
opens, chooses her alternate fitting function and performs a new fit operation. The new fit operation
results in new output which can now be compared to the output generated by a fit of the first fitting

function.
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17.9Repeating Analysis Using Data Filters

Large multi-column datasets can be quickly reduced by applying filter conditions to one or more columns. This
Data Filter feature can also be used in conjunction with the colcopy (column copy) X-Function to produce
multiple graphs from the same source data using different filtering conditions. The filtered data can also be
analyzed, allowing you to compare graphs and analysis results across multiple filter conditions.

Selected columns from the source data sheet can be copied to create child sheets where the filter condition
stays synchronized with the parent sheet, or is locked to the child sheet. When the source data sheet is
updated, all child sheets, associated graphs and analysis results will automatically update using their
respective filter conditions. Additionally, the filter condition of a particular child sheet can be pushed back to
the parent sheet at any time.

The image below displays the source workbook with data for several makes of automobiles. Two books were
created with a subset of columns and a data filter to restrict the data to a particular make of automobile.
Linear regression analysis of the filtered data was performed, allowing comparison of the results across the
two filters.
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Tutorial: Locking a Filter Condition on Copied Columns

1. Import the file Samples\Statistics\Automobile.dat

i

2. Click on the Make column, then click the Add/Remove Data Filter button on
the Worksheet Data toolbar.

3. Click on the filter icon g that was added to the column, and uncheck all makes
but Honda (Hint: Clear the check mark beside Select All, then check Honda and
click OK).

4. Hold down the CTRL key and click and select the Make, Power and Engine
Displacement columns. Next, right-click and select Copy Columns to... from the
shortcut menu.

5. In the dialog that opens, expand Copy Labels and place a check mark beside
Long Name and Units, then click OK. A new worksheet will be added to the
workbook and it will contain only the Honda data, for Power and Engine
Displacement.

6. Click and hold the tab of the new worksheet and drag it to an empty spot in the
Origin workspace to create a separate workbook.

7. Click on any of the locks in the columns of this copied sheet, and select
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10.

11.

12.

Worksheet Filters: Lock. The filter conditions will be locked to this sheet. If you
change the filter condition in the original data sheet, this copied sheet will not be
affected.

You can now return to the original automobile book, click the filter icon and
change the filter condition to Toyota, then use Copy Columns to to create another
worksheet.

Highlight column B in your Honda workbook,then right-click and choose Set As: X.

Do the same for the Toyota book.

Highlight column C in your Honda workbook and click the Scatter button ﬂon
the 2D Graphs toolbar. Do the same for the Toyota book. This gives you two plots
of Power vs Engine Displacement, one for Honda, one for Toyota.

Click on the Honda graph and choose Analysis: Fitting: Linear Fit. Accept the
dialog defaults and click OK. Do the same for the Toyota graph. A linear fit is
performed for both datasets and an Analysis Report Sheet is generated for each.

Compare the fitting results for the two automobile makes.

By default, when there is a data filter on a column that is input for an analysis
operation, filtered data (hidden rows) are ignored in the analysis. To include hidden
rows, click on an analysis lock icon and set lgnore Hidden Rows = No.
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17.10Automating Tasks Using Programming

In addition to the above mentioned methods for automating tasks using the interface, graphing and analysis
features can also be accessed programmatically from the LabTalk scripting language, from Origin C or from
Python (internal or external). Access to Graph Themes and templates, and Analysis Templates can be
programmed. You can set up some of the procedures manually by first creating templates (graph templates,
Analysis Templates™, etc.) using the graphical user interface, and then write your code to call the templates
as needed.

You can get a broad look at what programming options are available in Origin by browsing the Programming
Chapter of this User Guide. More in-depth programming-related information is linked to from that chapter.

17.11Topics for Further Reading

. Recalculation of Analysis Results on Data or Parameter Change

e  Saving Analysis Dialog Settings as a Theme

(] The Theme Organizer, Dialog Themes

®  Analysis Templates

(] Batch Processing and Analysis Templates

e Copy and Paste Operations

. Using Data Filters to Obtain Different Views of Your Data

e  Analysis Report Sheets and Columns

(] Tutorials: Batch Processing

e Video: Batch Processing

e  Tutorial: Combine Quick Peaks Gadget with Peak Analyzer
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18.1 The Master Page

The Master Page feature is used to add one or more common objects to exported or printed graphs. Use
the master page to add a set of properties and objects -- a custom background, a company logo, text labels,
images, etc. -- to selected graph windows in your project.
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To make use of this feature, you must first create your Master Page. The Master Page should contain only the
properties and objects that you want to display on your selected graph windows:

From the menu, choose File: New: Master Page. If you are not in the project root folder when selecting
this menu item, you will be asked to switch to the project root folder.

Customize the Master Template. Note that the comments that show beneath the Save Master Template
button are "hidden" and will not be applied to your graph windows.

Click the Save Master Template button. When you save, the Master Template will be saved to the
User Files Folder as "name of active window".otpu (e.g. "C:\Users\YourName\Documents\OriginLab\User

Files\Master.otpu").

Things to know about the Master Page:
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Master items will only show in graphs pages of the same dimensions as the template. Apply Dimension
to All Graphs applies Master Template page dimensions to all graphs of the same aspect ratio.

If you create a graph and modify page size, then choose File: New: Master Page and load a Master
Template into the workspace, the Master Template will be loaded with the page dimensions of your
modified graph page.

The Rotate button swaps the Master Template page dimensions (toggles orientation between landscape
and portrait).

When you click Apply Dimension to All Graphs you are prompted to apply dimensions only to graphs of

the same aspect ratio, or to all graphs of the same orientation (portrait or landscape).


http://www.originlab.com/doc/Origin-Help/UserFilesFolder

Publishing and Export

®  Master Page items on a graph with portrait orientation will not show on a graph with landscape orientation
and vice versa.

e  When NOT using Master Items, Edit: Copy Page (CTRL + J) will place an OLE-editable Origin graph
object on the Clipboard. When using Master Items, Edit: Copy Page will place an image on the Clipboard;
the Copy Graph as Image dialog will open asking you to accept or adjust image settings before clicking
Copy.

o If a graph uses Master Items, Send Graphs to PowerPoint does not support Insert Graphs as

Embedded Object. Instead, use Insert Graphs as Picture which does support Master Items.

e There is a mechanism for selectively excluding Master Items in your exported or printed page. Any object
that you do not want to appear in the exported or printed page should begin with "NoExport" (e.g. open
an arrow object's Properties dialog and on the Programming tab, rename "Arrow" to
"NoExport_Arrow").

e When you customize and save your Master Page to the User Files Folder, the next time you choose File:
New: Master Page, you load your customized template.

. If you don't want to show Master Items in the workspace, click View: Show: Master Items and remove
the check mark. The exported graph will still contain the Master Items (they just won't show in the
workspace).

. If you want to remove Master Items from a graph in both the workspace and exported images, click

Format: Page..., Display tab and clear the Use Master Items check box.

I You could use the Text tool to add project and system information to your Master
' Template as static text objects, but since the idea is to build a template for re-use,
consider "soft-coding" information in your text labels. To learn more, see these topics:

®  Substituting Variable Values in Text Labels]

(] LabTalk String Registers

18.2The Export Margin Offsets Dialog Box

By default, the margins of your copied or exported graph are determined by the Margin Control in Copy
Page Settings group of Preferences: Options (Copy actions) or the Export Settings branch of Export
Graphs (Export actions). You can interactively modify the default margins using the Export Margin Offsets
Dialog Box.
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1. Click on the graph window (to activate) and choose Edit: Set Export Margins. This opens the Export
Margin Offsets dialog.
2. Drag the blue selection handles that appear at the page margins; or enter values into the dialog edit

boxes and click Apply.

18.3Fit Page to Layer and Layer to Page

There are two small dialog boxes that are also helpful for removing white space or placing a margin around
your graph before exporting:

e Fit Page to Layers: Choose Graph: Fit Page to Layers to open the pfit2l dialog box.

e Fit Layers to Page: Choose Graph: Fit Layers to Page to open the gfitp dialog box.

366



Publishing and Export
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Both dialogs can be used to remove white space. Both can perform resizing, with or without changing graph
aspect ratio. You can view the documentation for both to decide which might work best for you but basically it
boils down to whether you need to keep a particular page size. If so, you'll likely want Fit Layers to Page; if
not, either one may work for you.

18.4Copying and Pasting Graphs to Other Applications

There are two ways you can include Origin graphs in another application's files (e.g. Microsoft Word .docx
files):
e As animage

e As an editable OLE graph object

When you paste as an image, you are pasting a static object. In MS Word, for instance, you may be able to
modify the image using Word's picture-editing tools, but you cannot make edits to the graph in Origin and
have it update the graph in Word (short of deleting the existing image and replacing it with a new one).

By contrast, when you paste an editable OLE graph object you can later double-click on the object in the host
application to launch a new instance of Origin. The graph and any associated data sheets will be available for
editing. After editing, use Origin's File: Exit and Return to... menu item to update the embedded object,
close Origin and return to the host application.

18.4.1Copy Graph as Image
1. Click on your Origin graph to activate it, then ...

2. Choose Edit: Copy Graph as Image (CTRL+ALT+J). Alternately, click on the graph window near the

page margin and click the Copy Graph as Image button on the Mini Toolbar.
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3.
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Y

In your host application choose Paste or press CTRL+V.

Copy Graph as Image...

"¢ BB b5 B SR A

When copying the graph as an image (CTRL+ALT+J), you have a choice of image formats (PNG, EMF, DIB,
HTML, JPG). Additionally, you can make quick size adjustments and specify background transparency (PNG).
The Copy Graph as Image (copyimg) dialog includes a Dialog Theme control which allows repeating <Last
used=> settings, saving current settings as default Save as <default> or saving settings to a named Theme

(Save As...).
Copy Graph as Image: copyimg ? >
Dialog Theme < | act yseds * 3

18.4.2Copy Graph as Editable OLE Graph Object

1.
2.
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Copy to clipboard without using OLE

Image Format PMNG e

Graph Size 10.72 x 3.21 (inch)
DPI 300 et

Size Factor (%) 100 et
Image Size:

10.72 x 8.21 (inch), 3216 x 2462 pixels

You can cpen Preferences = Options = Page
to set Ctrl+C etc.

There is a Copy control on the Preferences: Options: Page tab that lets you assign
the CTRL+C hotkey combination to either Copy Graph as Image <last used> or
Copy Page (CTRL+J) (i.e. "editable OLE graph object™). This allows you to bypass the
Copy Graph as Image dialog and speed up placing a standardized image on the

Clipboard using CTRL+C.

Choose Edit: Copy Page (CTRL+J).

In your host application choose Paste or press CTRL+V.
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Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Pasting or Embedding Graphs
in Other Applications

18.50rganizing Your Graphs for Presentation or Export

If your Origin project file contains a large number of graphs that you plan to export or use in an Origin slide
show, you can make things easier by adding shortcuts to your graphs to a Project Explorer Favorites folder
and arranging them there:

e  Right-click on a window and choose Add Shortcuts to Favorites. This will add a shortcut to each graph
window, to a new Favorites subfolder (visible in Project Explorer).
e  When sending graphs to PowerPoint or creating an Origin slideshow, you can (1) set slide order in the

corresponding dialog box or (2) set slide order following this procedure.

If you are preparing a manuscript for publication, you may want to see FAQ-441 How
do | export graphs with exact size and resolution as specified by publishers?

18.6 The Layout Page

Origin 2022b supports export of layout pages to .SVG files. When adding graphs to
the layout, choose Add Graph from the layout shortcut menu and elements of your
SVG file (e.g. text) will be editable in applications such as Inkscape or Adobe

L lllustrator.

A layout page, as the name implies, is a window useful for laying out different elements for publication or
export. Use it to assemble graphs, result tables, text objects, etc. onto a single panel.
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Typically, you start by creating a blank panel:

Click the New Layout button on the Standard toolbar.

2. Right-click on the blank layout to paste Clipboard content, add text, insert images from files, add graphs,
tables, etc.

3. When inserting an image from file, right-click in the area where you want to insert. When adding graphs
or worksheets, pick a window in the Browser and drag out an area on the layout with your mouse. Note
that added objects can be moved or resized by dragging with your mouse.

O You can make edits to inserted images, by double-clicking on the image. This opens the image in
the Image Window.

O You can make edits to the graph by double-clicking on the inserted graph object. This opens the
source graph for editing. Edits to the source graph will update the graph on the layout page.

O Inserted tables can be edited by double-clicking on the table object. Style adjustments can be
made by selecting a table object and using available Mini Toolbar buttons.

4. Note that selected elements on the layout page can be aligned using Object Edit toolbar buttons.

&S D00o & e8 'S 0hol<S Ty oocm I

For more on the layout page, see Using the Layout Page Window in the Origin Help file.
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18.6.1Merge Graphs to Layout

As an alternative to manually creating layouts, Origin offers a tool that will merge select graphs into a single
layout page of equal spacing. In this case, merged graphs are images and, therefore, not editable using the
procedure described in step #3 of the previous section. However, if further graph edits are not needed, you

can use this method to quickly produce a nice-looking layout.

Dialeg Theme

Blitute ol

Add selected graphs and arrange them in a new

All in Active Folder [Opf

| Graphl10
Graphs Graph313
Graph18
Number of Columns |2 |
Number of Rows 2 I

[l spacing (in % of Page Dimension)

Horizontal Gap

Vertical Gap

Left/Right Margin

Top/Bottom Margin

To merge graph images into a single layout:

1. With a graph window active, click Graph: Merge Graph to Layout: Open Dialog.
2. Use the Selection drop-down to specify how to select graphs. To choose individual graphs, choose

Specified and use the browse button beside Graphs to open the Graph Browser and pick graphs.

Origin 2022b adds a Fit Page to Objects menu command (Format: Fit Page to

“REW Objects), allowing you to apply a uniform margin to the active Layout page. This works
W the same as the aforementioned Eit Page to Layers does for graph windows.

18.7 Exporting Graphs and Layout Pages to an Image File

Origin 2021b added a simplified graph export routine to complement the existing graph export routine:

e File: Export Graph: If you simply want to export one or two graphs to one of several common image
format (PNG, BMP, JPEG, TIFF, EMF) and need only minimal control of image size, this routine is quick and
easy.

e File: Export Graphs (Advanced): If you want to batch export graphs (e.g. All in Active Folder, All in
Project, etc.), or export to vector types such as PDF or EPS, use this routine. The dialog supports
outputting to a specified path, auto naming, application of Speed Mode settings to exported graphs, plus

margin control, image size and other filetype-specific settings.
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Origin 2022b supports export of graphs and layout pages to .SVG files. Before
~ NEW ] exporting, confirm that @SVGTC = 1 and text objects (e.g. axis titles and tick labels)
W will be more-easily editable in applications such as Inkscape or Adobe lllustrator.

18.7.1File: Export Graph

File: Export Graph (X-Function = expG2img) is a simplified routine for exporting the active graph page to
one of the following formats: PNG, BMP, JPEG, TIFF, or EMF. It does not offer the level of control or flexibility
as File: Export Graphs (Advanced) (next section) but it works well for simple export of individual graph
pages.

To export using expG2img:

When a graph window is active, choose File: Export Graph.
2. For EMF images, set a size factor relative to the Image Size reported at the bottom of the dialog. For
raster formats, choose an output DPI setting. Alternately, clear the Auto check box and specify a Width

in Pixels.

umq-fwcm-_ E=RIE-] :E ‘
1

x

A" Export Graph: expG2img 7

Dialog Theme < a5t ysed> [ |

Export graph with a simple dialog

Image Type WG -
PHG

File Mame BME b | —
IFEG . — —

File Path TIEE F'-Documents-.ongmLal:-'-.User Files, v | —
EMF

Graph Size nch)

Sire Factor (3) | 100 b

File will be saved as:
CAUsers'wniatDocuments’\OnginLab\User Files\phatPhile.svg

Image Size:

1067 x 8.00 (inch)

18.7.2File: Export Graphs (Advanced)

File: Export Graphs (Advanced) (X-Function = expGraph) is Origin's primary tool for exporting graphs and
layout pages. It supports raster or vector output, flexible multi-page export (e.g. All in Active Folder), DPI
and Speed Mode control and more.

To export a graph or a layout page as an image file:

1. Select the menu File:Export Graphs (Advanced).
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The expGraph routine exports graphs to one of 15 file formats:

Raster Formats

BMP, GIF, JPG, PCX, PNG, TGA, PSD, TIF;

Vector Formats

CGM, DXF, EPS, EMF, PDF, SVG, WMF

18.7.2.1 Saving Export Settings to a Theme

As is the case with many other Origin dialog boxes, you can save your graph export settings as a Dialog

Theme for repeat use.

B ' Export Graphs: expGraph 7 x
Dialog Theme = Graph= ﬂJ
Export graphs as raster or vector files
. ~1

Once you have determined your export settings:

Click the flyout button to the right of Dialog Theme and choose one of the Theme save options.

Using any group of custom settings creates a temporary default Theme called <Last used>. This Theme

then becomes available for loading your last used settings and you can access it from the expG2img or

"expGraph dialog boxes or from the File: Recent Exports menu.
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expGraph dialog box File: Recent Exports menu

p | Saveto<Graphs Recent Exports » 1 expGraph: <Llast used=>

Save as < default=
Save

Save As..

System Default
Delete...

Compare...
Generate Script

<Last used=>

Since Origin 2021, expGraph dialog box settings are saved to the graph automatically on export.

e To save current settings withtout exporting, choose Save to <Graph>.

e To restore saved settings after you've modified them in the export dialog, choose <Graph=>

B Export Graphs: expGraph 7 >
Dialog Theme <Graph> > | Save to<Graph= IE‘
- SAVE 4% < derauns
Export graphs as raster or vector files
Save
|
N Save As...

System Default
Delete...

Compare...

Generate Script

<Graph>

<last used>

Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Exporting Your Graph or

Layout Page to an Image File
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You can export multiple graphs, such as all graphs in a folder or all graphs in a project file,
to a single, multi-page PDF file. Choose File: Export Graphs and open the Export Graphs
dialog box. Set Image Type to Portable Document Format (*.pdf) and Select
Graph(s) to one of the following options and you will see a checkbox for Export as multi-
page PDF file.

| Portable Document Format (*.pdf)

All in Project e

Active Page
All in Active Folder
All in Active Folder [Recursive) h

All in Active Folder [Open] I
All in Active Folder [Include Embedded)
Allin Project

[Specified I]

Export as multi-page PDF file

18.8Exporting Images to a Raster File

Image window content can be exported to several raster formats: BMP, GIF, JPG, PNG, TIF.

Dialeg Theme  + b

Export the active Image as file

File Type PNG v
DPI | 60D |

File Name | <auto> |
File Path | C:\Users\ %\ Documents\OriginLab\L| |

Width in Pixels 300
Height in Pixels 373

File will be saved as:
ChlUsers\y 0 wDocumentstOriginLabhUser
FileshCar.bmp.png

QK Cancel
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For Origin 2022b, you can set a DP1 for your exported image.

L

18.9Send Graphs to PowerPoint

You can send a group of Origin graphs to MS PowerPoint as pictures or as embedded objects (see limitations
of embedded objects and Master Items, explained above). Graphs inserted as embedded objects can be
further edited in your Origin software. Double-click on the graph in PowerPoint to open the graph in an OLE
instance of Origin.

To Send Graphs to PowerPoint:

B

1. Click the Send Graphs to PowerPoint button . on the Standard toolbar.
or...

i
1. Click the Send Graphs to PowerPoint icon ™F in the Apps Gallery, docked to the right-side or your
Origin workspace (if you do not see the Apps Gallery, click View: Apps or press ALT + 9).

or...

1. Right-click in the lower-pane of Project Explorer and choose Send Graphs to PowerPoint.

Tutorial: Send Graphs to PowerPoint

1. Run Origin and open the sample file <Origin EXE

Folder=>\Samples\Graphing\Column and Bar.opju.

Click the Send Graphs to PowerPoint button on the Standard toolbar.
3. Click the Select Graphs button and choose Specified.
Select all except Graph5B in the left panel and move them to the right panel by

clicking the in the middle of the dialog box. Click OK. A scrollable list of
graphs is added to the left panel in the App.

Set Insert Graph as = Picture.

Set the Slide Margin top dimension as 8% and leave the others as 0.

Set Title Line = Top of Slide, and Title = Window Long Name.

Set Starting Slide Index = 3 and Slide Mode = Start New.

© © N o O

Use the browse button beside Load File/Template (optional) to load the file
<Origin EXE Folder>\Samples\Import and
Export\Column_Plots_in_Sample_OPJ.pptx.
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10. Specify a Save File as (optional) output path for the resulting PPTX file.

There is also a Send Graphs to Word App that is pre-installed with your Origin
software. This App is particularly useful for batch export of graphs to a book-marked
MS Word document.

18.10Slide Show of Graphs

Origin has a built-in slideshow utility for viewing or presenting your graphs while running Origin. The slide
show can be started in two ways:

®  Right-click on any folder in Project Explorer and select Slide Show of Graphs...

or

e  Click the Slide Show of Graphs button .IE- on the Standard toolbar.

A dialog box opens offering options to set slide order, slide cycle time, whether to include graphs in sub folders,
etc. The dialog also lists shortcut keys for use during the slide show (e.g. G = go to the actual graph window
of the currently displayed slide).

Tutorial: Slide Show of Graphs

1. Use the File: Open Sample Projects: 2D and Contour Graphs menu to open
the sample project.
Click on the Slide Show of Graphs button in the Standard Toolbar.
Accept default settings in the dialog that opens, and press OK to start the slide
show.

4. You can use the up/down arrow keys or the mouse wheel to flip thru the slides.

18.11Creating Movies

Origin provides a Video Builder tool, accessible from the Open Video Builder button EEE on the
Standard Toolbar. This tool can be used to manually capture a series of graph windows, and write one frame
at a time to a video (.AVI) file.

Videos can be created using LabTalk script or Origin C code, by programmatically computing or updating data
and then writing out the graph as a frame in the video, at each step during the computation.

Note: For more information, please refer to the:

Help: Origin: Origin Help > Exporting and Publishing Graphs > Creating Graph Animation
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For specific examples of programmatically created movies, including Origin Projects and
code, please visit www.originlab.com/animation.

18.12Notes Windows for Reporting

NEW For Origin 2022b, the Notes window gets Rich Text support.

Over time, Origin's Notes window has morphed from a plain-text window for jotting down your research notes,
into a flexible medium for collating a variety of research-related materials.

Because the Notes window can contain linked objects -- graphs, images, worksheet cell values, etc. -- it can

be useful to add a Notes window to an Analysis Template™ for purposes of summarizing analysis results.
Alternately, you can save your Notes window as a PDF by clicking File: Print and choosing a PDF driver.

18.12.1 Notes Window Syntax

Origin's Notes window supports four syntaxes: Text, Origin Rich Text (default), HTML, and Markdown.

1. To switch syntaxes, choose Notes: Syntax: Text.

2. Once you have selected Text, you can freely choose other syntaxes from the Notes menu.

18.12.2 Rich Text

With Rich Text, the Notes window has two modes -- raw text mode and Render mode. Toggle between these
modes using Notes: Render Mode or shortcut key combination CTRL + M.

To add text to the Notes window, you need to be in raw text mode. To style added text, use the Format
toolbar and/or apply pre-defined paragraph styles.

T Segoe Ul - 1 - E F U= x, SSap Al 8 =-1- A~
o ‘ o g
: q . »
jﬁig::gﬂ::zii * Number of Points: 2 Meore Colors: System Color List
"-:l:){{style;Bulletec * Degrees of Freedom: 18 EEERNFEEEEEEn
\pi{styleBulleted « Residual Sum of Squares: 9.54378 50 5 5 [
\p{{style:Bulleteg P s 1 0.99587 ERECOOCONEONEEN
\piistyle:Bulleted °* "carsonsr-G. EEREE(IOEENEEEE
« R-Square (COD): 0.99175 EEENSNEEEEEEE
AEEEEEEEEEEEN
+ Adj. R-Square: 0.99129 Custorm +
+ *
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18.12.2.1 Adding Content to Your Notes

Objects that you can Insert by right-clicking in the Notes window:

‘imo(lmage1, w=300) ~
¥} Undo Ctrl+Z
\p{{style:Heading 1}}({% Redo =¥ 117, Wit
Insert r Graph/image: Image2]
s {%{[EDDkE].pa.ge.mfm. Paragraph Styles R Worksheet Cell...
$([Book2]'page.info.File Info Variable...
Fl + ¥
k| Cut chrl=x Mew Table...
\pi{style:Heading Left}}(|=2 Loy Lt
[ Ppaste Ctrl=V S
\pf{style:Bulleted List}}(} Paste Link Ctri=Alt+V Sl e
\p{{style:Bulleted List}} (4 Delete Delete Hink...
{_{St}f!e:Bu!!eted L!st}}{{ Select Al Ctrlen Image from File...
{{St:x’ e:Bulleted L st H_r COTSOTT 5 T, LS P L Image from Web...
st =ted List}}({R-Square (COD): (o(0.95 e
Object Comments
Opens the Graph/Image Browser where you can pick project graphs and images.
Graph/image Note that you can Show Embedded Graph (see the first row of this table for a

definition of "embedded graph") and Project Explorer "Favorites" folder shortcuts
(Include Shortcut Page).

Worksheet Cell...

Opens the interactive range selector. Use this to pick a cell value in a worksheet or
report sheet. Click Done to insert a linked cell value.

Opens the Insert Variables dialog for inserting project variables stored on data

Info Variable... .

import.

Opens the New Table dialog for configuring a basic table. Clicking OK closes the
New Table dialog and opens a basic workbook containing a single worksheet. Customize the

worksheet, add data, etc., then use Notes window Render Mode to view the resulting
table.
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Object Comments

Opens a simplified Symbol Map with characters sorted by tab. Click Advanced to
go to the full Symbol Map.

Symbol Map

Opens the LaTeX Equation Editor App (if you've not already installed this free App,

LaTeX Equation you are prompted to do so). You can click the Equation button fiy to open a list of
Origin's fitting functions (incl. your user-defined functions). Pick a function (or enter a
function into the top box) and click Preview to see your equation rendered.

Opens a dialog box for entering Text to display and a Link. The link can be a URL
or it can be a link to such things as a worksheet data range (e.g.
range://[bookl1]sheetl!col(1)[100]). Additionally, you can run simple LabTalk
commands using a "labtalk://" tag (e.qg. labtalk://newsheet).

Link

Opens a dialog to browse for image files. Note that the inserted image is linked to an

Image from File external file and is not saved with the project.

Opens a dialog to specify a Image Link for a web image (hint: In your browser,

Image form Web right-click on an image and Copy Image Address, Copy Image Link, etc).

Add your content using raw text mode.

2. When you are ready to view your content, turn on (place a check mark beside) Notes: Render Mode or
73% |+
press CTRL + M. Note that you can use the Zoom combo box on the Standard toolbar to

zoom in or out on the page (CTRL + mouse wheel also works).
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18.12.2.2 Text Styles Manager

In addition to styling text with the Format toolbar, you can apply a simple set of

paragraph styles on a line-by-line basis. Manage styles with the Text Styles Manager
dialog box.

1. With a worksheet active, choose Tools: Text Styles Manager.
2. Select a Style to Modify and Apply or Close.
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B Modify Text Style 7 x
Style to Modify Body Text w
Font Face T Default: Anal vl
Size Factor (3%) 100 v
Color B Aute -

[ Justification
= Font Style
Bald O
ltalic |
Underline |:]
= spacing
Extra Line Spacing (%) o V|
Before Paragraph [pts) | O v|
after Paragraph (pts) 3 W |
[# Indentation (3% of font size)
List None w
Delete Apply Close

Note that you can add styles by selecting <new> from the Styles to Modify drop-down list; or select a style
and Delete.

To apply a paragraph style to Notes window text:

Open the cell note in a Notes window.

2. With Render Mode off (CTRL + M, to toggle), click on a line of text then right-click, choose Paragraph
Styles and choose a style from the popup menu.

3. To check results, press CTRL + M (Render Mode).

To see a list of built-in paragraph styles, open a fresh Notes window, then from the
menu choose Notes: Load Samples: Built-in Styles.txt.
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18.12.2.3 Adding Rich Text Content to Layout or Graph

Insert Rich Text content of a Notes window to a text object on a Layout or graph page.

This s linked o he new ted Bbelin 2 greph or layout.
You can replsce this 12 with your own and then press FE
in the layout'graph io updsie.

Frommin menu choose Notes > Load Samples
Right-click on text to apply styles.
Right-click to insert images, links, or enustions.

Use CTRL+M i topgie betwesn edt and render modes

This is linked to the new text label in a graph or layout.

You can replace this text with your own and then press
F5

in the layout/graph to update.

From main menu choose Notes > Load Samples
Right-click on text to apply styles.

Right-click to insert images, links, or equations,

Use CTRL+M to toggle between edit and render modes. .

To add the content of an existing Note (Layout or Graph):

1. Select the Text tool ﬂ then click on the Layout/Graph and enter "@@@NotesN" (i.e. the Notes
window Short Name).

2. Click off the text object to insert Notes content.

To add content by creating a new Note (Layout only):

1. Right-click on the Layout and choose Insert Notes Text.

2. See Adding Content to Your Notes.
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18.12.2.4 Print or Export to PDF

You can output Rich Text content to a physical printer; or print to PDF using a third-party driver such as
Microsoft Print to PDF.

To create nice-looking output, you'll need to pay attention to these settings:

® Paper Size: This is set in File: Page Setup or in the Advanced options for your printer driver.

(] Margins: These are set in File: Page Setup.

e Notes Display Margin: By default, the Notes display margin = 5 (units = points). Thus, you will note
that in Render Mode (CTRL + M), there is a slight margin to the left side of the Notes page. This display
margin is controlled by setting system variable @NDM.

e Notes Window Page Width: Page width is controlled by the property note.width (units = in/cm, etc).
Default = 0, which corresponds to an uncontrolled width. For best printing results, you will need to set

notes.width.

Paper Size - Margins - Notes Display Margin = Width of the printed area (paper or PDF).

So, for example, an 8.5 inch wide page with 1 inch margins to the left and right; and a display margin of O
points, should "print out" as 6.5 inches wide. Therefore, for best results, set page .width = 6.5 before

printing.

18.12.3 HTML and Markdown

You can also use Notes windows to create HTML or Markdown reports. Similar to Rich Text, you can build your
HTML report using placeholders that link to report sheet elements such as metadata, statistical results or
graphs. The resulting HTML report can be printed or exported; or it can be incorporated into your Analysis
Template. If Markdown syntax is used, optional HTML syntax can be also included for advanced customization.

To use this feature, the user should have some basic familiarity with HTML or Markdown, and as with most
things, the more proficient the user is, the easier it will be to create professional-looking output. However, the
skill needed to generate a basic report can be easily mastered. See this OriginLab blog post for guidance.

Fee HTML Report - |

|@  Analysis Report Sheet Linear Fit Report e_: reienl rela
L3 L] Iall L

jops 125833 010007 1258005 2 35151E-1

Origin Project: O\ Usersimike | Downdoads |HTML -Bleg-Analysis-Report| HTML Biog Anatysis Repert.opju

Flle Informatio
=l Placeholder Sheet et
I Iy | ] |

Lang MName PLacencioens

Commants

File Mame: Linear Fit.dat
File Dater 12/12/2018 161847

Thase ae the piacenciders
n e HTML S0UTce

e

Fitting Information

User Chris
1047 Equation TR B -
Weight Mo Weighting
o Intercept 024317

Slope 12
Residual Sum of Squares 29
Pearsen’s r 0.94756
R-Square (COD) 080
Adj. R-Square 089

= Filled Curves Piot -

0D ™7 —

18.12.3.1 Adding Content to Your HTML Report

The basic steps of creating reports using an Origin Notes window, are as follows:
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Create your project to include graphing and analysis results.
E

From the menu, choose Notes: Syntax, then choose HTML or Markdown (Hint: You can toggle

Click the New Notes button to add a Notes window.

between text/view and markup modes by pressing CTRL+M and you can choose the default syntax by
setting LabTalk System Variable @NPS).

You can write your code in the Notes window's markup mode or you can use a text editor such as
Notepad++, then copy and paste it to your Notes window. If you have no experience with HTML or
Markdown, you may want to load samples by activating your Notes window and clicking Notes: Load
Samples (HTML = ".html", Markdown = ".md").

You will likely want to incorporate graphing and analysis results from the current project, into your report.
The simplest way to do this is to insert "placeholders" for each Origin object that you intend to include in
your report, into your code. These placeholders can be named using any string that makes sense to you
and they should be enclosed in double-curly braces (e.g. {{MyR-SquareValue}}).

Right-click on the Notes window title bar and choose Edit Placeholders. Placeholders that you have
incorporated into your code will be picked up and added to a Placeholders worksheet in the workbook.
The sheet will list, in column A, all of the placeholders found in your code. A second column -- Column B --
is blank and is reserved for adding the associated Origin objects (i.e. the variables, analysis and graphing
results, etc.) that you want to include in your report.

For each placeholder in column A, find the associated Origin object and copy it to the Clipboard (e.g. if it is
a numeric quantity in a sheet resulting from some statistical analysis, select the cell quantity, right-click
and choose Copy, or press CTRL+C on your keyboard).

Return to the Placeholders sheet, right-click in column B, beside the associated placeholder and choose
Paste-Link. This associates your placeholder with the intended Origin object.

If you intend to include your HTML report in an Analysis Template, you can right-click on a workbook tab
in your Analysis Template and choose Add Notes as Sheet. This inserts your Notes window into

workbook and you can now choose File: Save Workbook as Analysis Template.

I When a Notes window is active, you can click the Notes menu and load a sample HTML
; file into the Notes window.

Motes | Tools  Preferences Connectivity Window  Social Help

Load 5amples 4 Combo and Button.html
Load... Hella Warld,html
Add Links 4 Linear Fit Report with Placeholders.html
Export to Webpage... Linear Fit Report.html
Peak Fit Report with Placeholders.html
Render Mode Ctrl=M +

Edit Placehaolders... Peak Fit Repart.htm|

Useful String Registers.html
Syntax 4 S

Display Line Numbers Hello World.md

Linear Fit Report.md
Useful String Registers.md
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18.12.3.2 Using Your HTML Report

As you fill in your Placeholders sheet, you should see your HTML report take shape in the Notes window. Once
completed, you can do various things with your HTML report, including:

e  Print to hard-copy or to PDF (File: Print).

e  Export the window as a webpage (Notes: Export to Webpage).

® Click the embed button in the upper-right corner of the Notes window to embed the content into your

workbook, then save the workbook as an Analysis Template (File: Save Workbook As Analysis

Template).

18.13Exporting Worksheets and Matrices

18.13.1 Exporting Worksheets
With a worksheet active, the File: Export menu item provides the following options:

e ASCII, NI TDM (TDM, TDMS), and Sound (WAV)

This option is available only for sheets containing data columns, and is not available when report sheets
such as those created by the Nonlinear Fitting tool are active. The exported file will contain only data

from the worksheet columns. Floating or embedded graphs placed in the worksheet will be ignored.

e Excel

Export books of worksheet columns with text and numeric data to an MS Excel file (XLS, XSLX, XSLM).
Note that analysis report sheets with their hierarchical tables, and things such as embedded graphs and
images, are not exported to the Excel file. Analysis results that are output to regular Origin worksheets

are exported.

For information on copying analysis report sheets and pasting to MS Office applications,
see FAQ-815 How do | copy report sheet tables and paste them into Word, Excel or
PowerPoint?

e SQLite
This option exports the active worksheet(s) as an SQLite file. Specify a file extension of .sqlite, .sqlite3
or .db (note that file structure is identical). Options to skip hidden columns or rows. Limited to export of

data in worksheet columns.

e As Multipage PDF File
This option is available only on sheets with data columns, and not for report sheets. Use the View:
Page Break Preview Lines menu item to view the vertical and horizontal page break lines that
determine which columns and rows will be included in each page of the export. Floating or embedded

graphs placed in the worksheet will be included in the exported image.
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e As Image File

This option is available on both data and report sheets. In the dialog that opens, you can select whether
to export the entire sheet, visible area, or selection. Image file formats including PDF are supported.

Floating or embedded graphs placed in the worksheet will be included in the exported image.

e As PDF Filet

This option is available for both data and report sheets. In the dialog that opens, you can opt for
exporting the entire sheet, the visible area, or a selection. Floating or embedded graphs are included in

the exported PDF.

When creating a custom report from a worksheet that combines data, numeric results
and graphs, the best option is to export the entire sheet as a PDF file, or export the
sheet as a multi-page PDF file.

18.13.2 Exporting a Matrix
Origin matrix data can be exported in these two formats:

e ASCII

This will create an ASCII file of the data contained in the active matrix object.

e Image

This option will export the image view of the active matrix object, as a raster file.

Note: For more information, please refer to the:

Help: Origin: Origin Help > Importing and Exporting Data > Exporting Worksheets and

Matrices

18.14Topics for Further Reading

e The Preferences: Options Page Settings

e  Pasting or Embedding Graphs in Other Applications

(] Exporting Your Graph or Layout Page to an Image File

e  Which Image Format Should | Choose?

e The Export Graph Dialog Box

e Send Graphs to PowerPoint

e Send Graphs to PowerPoint Dialog Box Settings

e View Graphs as a Slide Show

(] The Slide Show of Graphs Dialog Box Settings
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Creating Graph Animations

Printing Graphs, Layout Pages and Analytical Results

The Print Dialog Box

The Print Options Dialog Box

Copying and Pasting Graphs inside Origin

Inserting Graphs and Images into Worksheet Cells

Tutorial: Creating a Custom Report Sheet

Using the Layout Page Window

Creating a Master Page Layout for Graphs
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19 Apps for Origin

Origin 2016 introduced Origin Apps -- tools that you could easily add to your Origin installation by dropping
them onto your Origin workspace. This ever-expanding collection of add-on tools is extending Origin's already-
powerful graphing and analysis capabilities.

Because an App is a self-contained, easily-distributed tool aimed at solving a particular problem, it can be
developed and deployed quickly, sidestepping the need to wait for a new Origin product release. In addition,
an App can be developed by anyone with a basic knowledge of programming in Origin, making it attractive as
a means to create and distribute tools for your company or user-community.

At present, all Apps can be downloaded for free. Note that some Apps require OriginPro; these are denoted in
the App description by the symbol.

19.1Where Do | Find Apps?

Apps are listed on the OriginLab File Exchange. While you can download Apps from the File Exchange using
your web browser, it easier to obtain and manage your Apps using the App Center.

The App Center provides "one stop" App installation and maintenance: Browse and download new and
popular Apps, search for Apps, update existing Apps, request an App or submit an App via the OriginLab
website.

Search for Apps and install them directly from the Start menu.

To open the App Center, click the Add Apps button that appears on all tabs of the Apps Gallery.

App Center - B

Spectral Broadening m Allan Variance
A k3 LV .4
Min. Version: OrignPro 2017 M. Viersiore CriamPyo 207

Maps Cnline [E3 Import Files from a Folder
A o - s
What to look for in the App Center:
e Installed Apps with an Up-to-date Version icon v beside them are up-to-date.
e  Apps with a clickable Download and Install icon beside them are not installed. Click

this icon to install.

Ty
e  Apps with an Update icon ~ beside them have an available update that you can install.

Click this icon to update.

e Click the New and Popular tab for a quick look at what's available. Download and update
Apps.

®  Click the Search tab to find Apps by Category and Minimum Version. Download and

update Apps.
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e The Updates tab will display a red circle icon when there is an update to one or more

installed Apps. Improvements and bug fixes are listed for each.

New Apps and App updates are continually made available to Origin and OriginPro
users. Be sure to open your App Center occasionally (press F10) and if it displays the
red Download Now button, click to get the latest list of available Apps.

New App
Information
Is Available

Download
MNow

19.1.1Finding Apps from Analysis and Statistics Menus
You can find Apps for these specific applications by clicking Find Apps... from Origin's main menu:
e  Analysis: Fitting

e Analysis: Peaks and Baseline

e  Statistics

These menu commands open the App Center Search tab to show only relevant Apps that are currently

available from OriginLab's File Exchange. Click the Download and Install button
install the App.

beside an App, to

57 App Center m}

Category All

Min. Version | Al

 Uipdated (Newest - Cldest)

E Onget for Peaks
OrriginLab

@ =
Min. Version: OnginPro 2019b SRO
Downloads(30 days): 29

Wk o e o ()

Pulse Integration [
Crigintab

Min. Version: Origin 2018b SRD
Dowmicads{S0 days): 622

* e o (0)

+ B

J-_AK Align Peaks
—1= OngnLab

Min. Version: Ongin 2019 SRO

390

Global Peak Fit
Cnginlab

Min. Version: Ong




Apps for Origin

19.2How Do I Install Apps?

If you install your Apps using the Download and Install button in the App Center dialog, you don't
need to do anything else. The App is automatically downloaded and installed. When App updates become

-

available, you can use the Update button e to update an installed App.

If your workstation does not have internet access:

If your workstation does not have internet access, you will need to find a computer that does (does not need
to have Origin installed), download the App from the OriginLab File Exchange to a thumb-drive and bring it
back to your workstation.

1.

On the internet-connected computer, open a browser window and browse to
originlab.com/fileExchange.

Browse the list of Apps, go to the App's description and download page, then click the Download File
button and copy the file to your thumb-drive.

Return to your Origin workstation, plug in your thumb-drive and run Origin. Open Windows Explorer,
browse to your thumb-drive and once you locate the App (it will have a .opx file extension), drag the App
file to an empty portion of the Origin workspace. Make sure you are not running Origin as administrator or
drag-and-drop operations will fail. The App will be installed and the App icon will appear in the Apps
Gallery, docked to the right side of your Origin workspace.

If you have questions, click the How to Install link below the Download File button on the File Exchange
App description and download page.

File Exchange > DataAnalysis = Seque

Download File

How to Insial

19.3How Do | Run an App?

Upon installation, an App icon is placed in the Apps Gallery, docked to the right side of the Origin
workspace.

App operations may be window-specific. If the App is dimmed (grayed out), the active window cannot be
operated on by the App. Check the required window type (hover on the dimmed App icon in the Apps
Gallery).

If the Origin window type (worksheet, graph, etc.) is matched to the App, you can launch the App by
double-clicking on it in the Apps Gallery.

If you prefer to launch the App from a toolbar button, open the Customize (Toolbars) dialog box (View:
Toolbars), click the Button Groups tab, locate the App's toolbar button and drag the button to the
OriginLab workspace or to an existing toolbar. Close the dialog box.

Specific usage information is available on the description and download page for each App.
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19.4Managing Your Apps

You can use the App Center in combination with the Apps Gallery, to manage your Apps:

e Use the App Center (discussed above) to add and update Apps, search for Apps, request an App or

submit a review of an App.

. To launch the App Center, click the Add Apps button in the Apps Gallery.

—

App Center

L]
L

ﬂ Spectral Broadening
Ongnlab

Min. Versionc OngnPro 20107 SR0

e  QOrganize your Apps by adding tabs to the Gallery. Right-click in an empty portion of the Gallery and

choose New Tab, then double-click on the default tab name and give the tab a meaningful name.

Show All
Uninstall All...
Refresh
=3
— NewTab =

Femove Tab

Sort Apps :hrnmatngraphﬂ |
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Additional higher-level actions available from the shortcut menu:

Apps for Origin

Adjust icon spacing using an Apps Icon Spacing slider control. LabTalk

system variable support for @APPS (horizontal) and @APPV (vertical)

spacing.

Apps lcon Spacing... I}

Uninstall All...
Refresh
Mew Tab

Show Connector Apps

Show Apps from Other Tabs
Sort Apps

B Apps lcon Spacing

s

oK

Cancel

Apps lcon Spacing ...
Uninstall All ...
Refresh

New Tab

Show Connector Apps

Show Apps from Other Tabs

Sort Apps (Alphabetically, Newest Install, Recently Used).
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e A number of App-specific actions can be performed by right-clicking directly on the App icon in the Gallery

and choosing from the shortcut menu.

Apps x

Add Apps

1S

H

3

ED

= send Graphs

= toWord

L

7| e

K -

= | 5end Graphs Show in Folder
S | to PowerP. .

E\ Uninstall

Open File Exchange Page

Send Feedback...

Show All
Refresh

Tab Views

-

[

ol

=

=y

i 5'

=
v

e Show in Folder: Opens the user's \AppData\Local\OriginLab\Apps\ folder to the App

installation folder.

e Uninstall: Uninstalls the selected App.

e Open the File Exchange Page: Opens the App's description and download page on the
OriginLab File Exchange.

e Send Feedback...: Opens a Rate App dialog box to provide feedback.

e  Show All (user-added tabs only): Shows Apps from all Gallery tabs on the active tab.

e Refresh: Refreshes the tab view.

e Tab Views: Place or remove the check mark beside the App to determine on which Gallery

tab(s) the App shows.
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19.4.1Docking the Gallery

By default, the Gallery is docked to the right side of the workspace.

w 0 X
& 28
Add Apps Peak
Deconvolut...

Speedy Fit  Maps Online

§

Rank Models Chromaticity
Diagram

(&

Google Map Graph
Import Annotator

IlI!L|5!|E|I"|d'}r" bLJ!L{dEJE)'}-"bLJ!uH'}r"SJDJJBUUDj

Beginning with Origin 2022b, you can dock the Gallery to the top of the workspace, just
below the toolbars.

1. To dock the Gallery at the top of the workspace, drag the title bar toward the top of the workspace. Guide
it to and drop it on he workspace docking button that appears (shown outlined in magenta).

2. Once docked, drag the bottom edge of the Gallery to adjust width, as needed.

Add Apps Speedy Fit  Maps Online Rank Models Chromaticity Goor

Deconvelut
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19.5Will I be Notified When Updates are Available?

Several things will indicate when an App update is available:

e A red dot appears in the upper-right corner of the Add Apps icon in your Apps Gallery (docked to

the right side of your workspace). Additionally, the red dot shows on individual Apps when an update

is available.
v
Add Apps Simple Fit

e In the App Center, the App will appear with a clickable "update" icon beside it.

_-:ﬁi‘ Maps Online [IE3
" OriginLab
Min. Version: Orign 2017 SR2

**** _ Updﬂte

e The App Center Updates tab will show a red dot with a number indicating how many App updates are

available. The tab will list updated Apps and allow you to apply updates for individual Apps or all Apps.

Updatezo

To update an App:

e Click the Update icon that appears next to the App in the App Center.

e Right-click on the App in the Apps Gallery and choose Download and Install Update

e Click the Update All Compatible button that appears on the Updates tab in the App Center; or click the
"update" icon beside each App.

e  Right-click on the Add Apps icon in the Apps Gallery and choose Update All.

Apps
x | — -
- [ P . |
*| Add2  Show in Folder 1
= 1 i
= Update All P
() |
B Refresh I
= - -
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You can verify the version of an installed App by hovering on the App in your Apps
Gallery.

19.6How Do | Uninstall an App?

Uninstalling an App is easy. Right-click on the App icon in the Apps Gallery and choose Uninstall from the
shortcut menu.

Apps w 0 X
Multiple R... ~
Show in Folder
Tangent Uninstall

Open File Exchange Page

E 5end Feedback...

=

= oA

= Monte Ca Refresh

ix_ Simulatio Tab Views .
3

o T =
= o

2 s K

o Log Principal Enzyme

19.7How Do | Give Feedback on an App?

OriginLab relies heavily on customer input to improve our software products. We encourage you to give
feedback on Apps by right-clicking on the App icon in the Apps Gallery and choosing Send Feedback.... It

takes just a few seconds!
[ 87 Aain App
B Simple Fit

Uise this farm o rate and review he app. Pleada da mal use d 10 rapo bugs nor regues fBabinas

Rate this app (optional):

1 2 3 4 5

1 = Mot useful, 5 = Very useful

Clear Rating
Wirite & review for this app (optional):

Lober, cot-poress isterface For Gol
STTEC WAy To g0 curve CiTTing for

fais app prowices o omec

carve CATE TETRL:

¥ou are mot 4 curve FLEtisg eupert.

rtaistien iz the Fit paraceters are ceported ssch tRat tRay
£ otha data |WBich Ly oot tha default iz tRe Cregalar” carvefittis

Subrmnit Cancel
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19.8Can I Request an App?

As previously mentioned, Apps can be developed by anyone with Origin programming knowledge. However, if
you do not program but you find that you need some particular functionality that is not currently a part of the

Origin product, you can request an App through the OriginLab website. OriginLab is continually building and
posting new Apps to the File Exchange.

To request an App, open the App Center and click the Request App button in the lower-left corner of the
dialog box. This opens a web page on www.originlab.com.

Verify that the Your Reason for Contacting Us drop down is set to Request an App.

Fill out the remaining required fields and click the Submit Inquiry button at the bottom of the form.
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20 Programming in Origin

Origin Application I
Origin GUI:
Warkbooks, Matrices, Graphs,
Client Graph Templates
Applications: Analysis Templates __.
Excel VBA
LabVIEW
MATLAB
Python
R . LabTalk Python R
Visual C++ Origin C Scriotin origi ) (R Console,
Visual Basic ping onginpro RServe)
more...

NAG
Mumerical
Library

As you gain experience with Origin, you may want to access Origin features programmatically, add your own
custom routines and tools, or communicate with Origin from other applications. This chapter outlines basic
programming options available in Origin. For more detailed information, see the following Origin programming-
related resources:

e  Programming documentation including guides, language references, and examples are available from the

Help menu in the product.
e  Online programming documentation is available at www.originlab.com/doc.

®  You can typically locate online programming pages by performing a web search from your browser using

phrases such as: labtalk importing , originc interpolate, or labview origin send data.
e  An Origin Programming Forum can be found at www.originlab.com/forum.

e  Sample files for LabTalk, Python, COM Server and Client, etc. can be found in the \Samples folder of your

Origin software.
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20.1 LabTalk

LabTalk is a scripting language that provides access to most of Origin's functionality. With LabTalk you can
access and change properties of Origin objects such as worksheets, columns, graph layers, and data plots.
LabTalk script can include calls to X-Functions to perform advanced data processing and analysis.

There are many options for executing your LabTalk scripts. Multiple lines of script can be organized as sections
in a file, and those individual sections can be executed from the user-interface at the command prompt in the
Script Window or Command Window; from buttons added to worksheets and graphs; from included or
custom-made toolbar buttons; or from custom menu commands.

Origin 2022b improvements to LabTalk:

e  Support for "substituting” cell Notes in graph legend and text objects using @WN
(e.g. %(1, @WN, B, 3) for Note in col(B), 3rd cell of 1st plot's source worksheet).

e  Control display of sparklines with new LabTalk System Variable @SPK (0 =
(default) no change, 1 = display only existing, 2 = can add, but load with none, 3
= no add, load with none).

® Improve text editing in Notes window: support moving cursor to matching

brace/parenthesis using CTRL+K, CTRL+B.

e lLayer object support for changing XY mapping of the matrix object.

The following "mini-tutorial™ will demonstrate adding a button object to a worksheet,
associating a short LabTalk script with the button, then using the button to execute the
script and perform a basic statistical calculation while writing the results to the
worksheet.

3

1. Run Origin and start a new project by clicking the New Project button on the
Standard toolbar.

2. Click Data: Import from File: Single ASCII and browse to the file
\Samples\Graphing\Box Chart.dat. Select the file and click Open. The file is
imported into the active worksheet window.

3. With the worksheet window active, click Format: Worksheet. In the Worksheet
Properties dialog, click the Size tab and set Gap from Top to 25, then click OK.
A gap is added to worksheet window.

4. Click the Text Tool on the Tools toolbar. Click inside the gap that you just added
and type "Add Mean Label Row" into the text object. Click outside the text object
to exit edit mode.

5. Right-click on the text label and select Properties.... Choose Programming
Control tab, set Script Run After to Button Up. Copy and paste the following

script into the text box:
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wks.userParaml = 1;

wks.userParaml$ = "Mean'';

for (int i1 = 2; 11 <= wks.ncols; ii++)

range rr = $(ii);

Col($(i1))[D1]$ = $(mean(rr),.2%);

6. Click OK to apply settings and close the Text Object dialog box. Note that your
text object now looks like a button.

7. Click the button. Note that a new header row labelled "Mean" is added to the
worksheet and the mean value of each column of data is written to the Mean row

cell above the corresponding column.

Note: For more information on LabTalk, Origin's built-in scripting language, please consult your

product documentation at Help: Programming: LabTalk.

Sample files can be found in the \Samples\LabTalk Script Examples folder of your Origin software.

20.2Python

Origin provides an embedded Python environment so that you can run Python in Origin. Origin supports
command line execution of Python code from the Python Console or Origin's Code Builder IDE. As of
September 2021, the embedded Python version is version 3.8.3.

Python support improvements in Origin 2022b:

4 -2 e Added a function evaluate_FDF(strFFname, indepvars, parameters) to
call a fitting function from Python.
e  Added package version checking to pip -chk and pip -chkl (e.g. pip -chk
emd==0.4.0; // install emd version 0.4.0 only).
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Note: For more information on integrated usage of Origin and Python, see these topics in the Python

documentation:

(] Introduction to Python in Origin

. Embedded Python

e Sample Projects with attached Python Code.

There is an API for calling Origin from Python. See note under Automation Server,
below.

20.3R

Origin supports running R commands in the Origin environment. You can issue R commands in the Script
Window or from the built-in R Console, or you can run .R files. All releases of R are supported up through

version 3.6.

From Origin, you can connect with R in two ways:

e R. Installed on your local computer.

(] Rserve. Installed on a remote PC.

Note: For more information on integrating Origin and R, refer to the Origin Help file (R_Console and
Rserve Console) and the LabTalk Scripting Guide (Running R in Origin, R Objects, Rserve

Objects).

Sample files can be found in the \Samples\R folder of your Origin software.

20.4MATLAB

The MATLAB Console allows Origin users to issue MATLAB commands from Origin, and to transfer data
between the two applications either using a graphical interface or using a command line.

e The Console requires both Origin and MATLAB be installed on the same computer.

e  Origin also supports importing MATLAB (MAT) files from disk. There are two import routines, the older

Data: Import from File and the new Connector-based Data : Connect to File: MATLAB. Importing

MAT files does not require that MATLAB be installed.

Note: For more information on the MATLAB Console, refer to the Origin Help file (MATLAB Console.

The <Origin Program Folder>\Samples\COM Server and Client\MATLAB subfolder contains an example
(CreatePlotIinOrigin.m, CreatePlotinOrigin.OPJ) that illustrates how to connect to an Origin COM server

from a MATLAB client (requires MATLAB).
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20.50rigin C

Origin C is a full-featured high-level programming language based on the ANSI C programming language
syntax. Origin C also supports a number of C++ features and a few C# features. Origin C provides access to
all aspects of Origin including data import, data handling, graphing, analysis, and exporting. You can access
Origin C functions from interface controls such as buttons, toolbars, and menu items, using LabTalk script.

Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled
to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and
manageability for developing and debugging code of greater scope and complexity.

Origin C also provides access to the NAG Numerical Library functions included in your Origin installation.
NAG functions provide you with a large selection of algorithms for performing computations ranging from
simple statistics and Fourier transforms to linear algebra and multivariate analysis. Origin currently supports
NAG Library Version Mark 26.1.

Origin C improvements for 2022b:

Add function to matrixbase class for importing ASCII strings; with support for

LF/CRLF, specify token separator and missing value.
e Add global function to get data range from name.
e  Add function Worksheet class to get list of cells with Notes.

e  Support for getting Notes embedded in worksheet.

Note: For more information on Origin C, please refer to the Origin C documentation:
Help: Programming: Origin C
There you will find usage information, a language reference, developer notes, examples, etc.

Sample files can be found in the \Samples\Origin C Examples folder of your Origin software.

20.6 X-Function

An X-Function is a self-contained XML file that can be loaded in Origin as a special type of global function.
Origin C is the language used to create X-Functions. X-Functions provide a way to expand the functionality of
Origin by adding custom data processing features. Many of the built-in tools in Origin are based on X-Functions.
Once an X-Function has been created, it can be accessed from anywhere in the interface that allows for script
execution, such as the script window, toolbar buttons, or custom menu items.

Note: For more information on X-Functions, please refer to your product documentation that is

installed with your software:
Help: Programming: X-Functions

There, you will find information on creating and using X-Functions, a language reference, and tutorials.

20.7 Automation Server

Origin can be used as an Automation Server. Client applications such as National Instruments™
LabVIEW™, Microsoft Excel, Python, or custom VB/VC/C# applications can exchange data with Origin, and
can also send commands to be executed within Origin.
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Note: For more information on Origin's Automation Server functionality, refer to the product

documentation installed with your Origin software:

Help: Programming: Automation Server.

There you will find examples and language reference information. Sample files can be found in the

\Samples\COM Server and Client folder of your Origin software.

20.8LabVIEW

National Instruments™ LabVIEW™ is widely used for data collection. For example, many instrument and
sensor vendors provide LabVIEW drivers for acquiring data. Once the data is collected, the end user will need
to graph and analyze the data, and create reports for presentation. Origin provides powerful data analysis and
graphing tools, including the Analysis Template feature, which allows for repeat analysis on newly acquired
data. The ability to communicate between LabVIEW and Origin can thus greatly improve the efficiency of post-
acquisition analysis and presentation.

Origin ships with a collection of LabVIEW sub-Vls. LabVIEW users can simply incorporate these custom sub-Vis
in their main LabVIEW application to communicate seamlessly with Origin.

For Origin 2022b, the "Close References" application control is added to all
"NE! Samples\COM Server and Client\LabVIEW .vi files. Copy these samples to LabVIEW
e j b using the Origin menu Tools: Copy Origin Sub-VI LabVIEW vi.lib\addons.

Note: For more information on Origin-LabVIEW connectivity, see the product documentation installed

with your Origin software:
Help: LabVIEW VI

Examples and tutorials are provided.

20.90rglab

Orglab is a freely distributed component DLL for directly creating or reading Origin Project (.opj) and other
Origin file types (.ogg, .ogw and .ogm). It is available as a free download. An Origin license is not required to
use Orglab. Typical use of Orglab is for instrument manufacturers and other third-party vendors to allow their
frontend software to output data as Origin files.

The Orglab module is available for 64-bit systems. To find out more about Orglab and to download the

Orglab module, go to the Products > Orglab page of www.originlab.com.
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21 Customizing Origin

21.1 Customizing Default Settings

21.1.1Setting Preferences with the Options Dialog Box

The multi-tabbed Options dialog box has controls for Origin global settings pertaining to numeric display,
file and system paths, text fonts, Origin program opening and closing behaviors, etc.

To open the Options dialog box:

e Choose Preferences: Options (any Origin window is active)

e |f you opened an Excel file inside Origin, choose Window: Origin Options (Excel workbook is active)

Controls For
e  Max number of ticks for numeric and date/time scales
e Distances from the tick labels to tick marks, axis titles
e Display of zeros and scientific notation in tick labels, units display in axis title
Two zero control check boxes were added and turned on by
. default for Origin 2020b:
Axis Tab 9
e Zerois'0O'
e No Trailing Zero
Beginning with Origin 2021, these options are turned OFF
by default.
e Use of default plot assignments
e  Scan datasets for legend text
Excel Tab
e  Prompt before opening Excel files by drag-and-drop or saving Excel workbooks
e  Set file paths to track last opened, last saved, last exported file
Eile Locations e  Set default path and file extension for importing different file types
Tab e Define applicable file types for ASCII import dialogs

405


http://www.originlab.com/doc/Origin-Help/Options-Dialog-Axis-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-Excel-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab
http://www.originlab.com/doc/Origin-Help/Options-Dialog-FileLocation-Tab

UserGuide_2022b

Controls For

Dash lines definitions, line to symbol gap, user-defined symbols, etc.

e 2D graph anti-aliasing

Enable in-place editing of linked and embedded graphs in another application

e  Speed mode reminder watermark

Origin 2022 improves support for user-defined symbols,
removing some long-time restrictions and making it easier
=1 to apply custom symbols to your graph:

User Defined Symbols

@SS € |7

Graph Tab

[ 1Monochrome

e  Support for Clipboard, .bmp or .svg formats.

e  Support B&W or color symbols.

e Add symbols via the Options dialog or via Plot Details
Add from Clipboard button (Symbol tab > Custom
Construction check box > User Defined Symbols

radio button).

®  Proxy server configuration
e  Default templates for ASCII import

(] Custom date/time formats

Enable collapsible menus

. Use of dataset names in the Origin workspace
Miscellaneous

Tab

Origin's Python Packages dialog for managing installation

of Python packages used with Origin, now supports package
P installation via proxy server. Open Preferences: Options,
= m go to the Miscellaneous tab, choose Use HTTP Proxy
Server and enter the proxy address.
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Controls For
e  Thresholds for displaying numbers in scientific notation
. Defaults for displayed digits in data and report sheets
Numeric . .
Fmb e Radians, degrees or gradians
e  Separators for decimal places
e Default window closing behaviors
Open/Close ®  Project startup, backup and autosave options
Tab e  Options dialog save options
e Default percent of page size of OLE graphs copied to Clipboard, graph margin
and CTRL+C hotkey controls.
Page Tab
Until 2021b, the Size Factor (26) (formerly, Ratio) was
set to 40. The default is now 100.
e Default fonts for text objects
e WYSIWYG and in-place editing mode behaviors
® Size and positioning of superscripts/subscripts
e  Footnote size, analysis report sheets
Text Fonts
Tab
|
For information on controlling fonts used in the Origin
interface, see LabTalk's system.font(object).
e View/Change the location of the User Files, Autosave, Backup, Unsaved and
System Path Group folders
System Fatn
Tab e View locations of system folders (Program, License and Application Data)

21.1.2System Variables Dialog

System variables are internal Origin settings that allow for the fine-tuning of a wide range of Origin behaviors.
Origin's Set Systems Variables dialog box (Preferences: System Variables...) can be used to view and set
system variable values. In the dialog, there is a link named System Variables List which opens a web page
with a list of all system variables, the default value, and description.
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To customize a particular system variable:

1. Type the system variable name in the first column of Set System Variables, without the @ symbol. For
example, if you wanted to make a global change to the Recalculate mode of analysis dialog boxes, type:
DAM

2. Click on the 2nd column to view the current value, and type in a new value. For example, with DAM, to set
Recalculate to Auto, type the value: 1.

3. Add optional comments in the third column and click OK to close dialog.

This modified value will be remembered and applied in every Origin session.

You can quickly read or set the value of a writable system variable in the Script Window (Window: Script
Window) by typing @systemVariable= as, for example ...

@DAM=

... then pressing ENTER. When setting the value of a system variable in this way, note that that typing in the
Script Window sets the variable value for the current session only.

21.1.33D OpenGL Settings Dialog

Origin uses OpenGL (Open Graphics Library) for rendering of 3D graphs. OpenGL provides enhanced
performance including fast drawing, fast rotation and zoom, transparency, and lighting support.

For optimum performance, your card should support OpenGL version 3.0 or higher. To check your hardware's
support for OpenGL, run Origin and choose Preferences: 3D Open GL Settings.... Look under OpenGL Info
for information on graphics hardware and the supported version of OpenGL.

If your graphics hardware is older, you may experience compatibility issues with things such as transparency
settings and anti-aliasing. The controls under the Settings node in this dialog allow you do such things as
disabling transparency. The dialog box also provides information on disabling OpenGL.

For more information on OpenGL in Origin, see the links under "Topics for Further Reading" at the end of this
chapter.

21.2Customizing Menus

21.2.1Collapsible Menus

Like many software products, Origin uses an auto-expanding "collapsible" menu feature that shows only a
partial list of menu commands when opening longer menus. If you want to show all commands upon opening,
click Preferences: Options, click the Miscellaneous tab and clear the Enable Collapsible Menus check box.

[ ] Enable Collapsible Menus
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21.2.2Custom Menu Organizer

If you have scripts that are frequently run, you can add them to the menu for quick access. With the Custom
Menu Organizer you can...

e Create up to 3 main menus and corresponding sub-menus
® Assign LabTalk scripts and X-Functions to a menu item
® Restrict menu item access to specific window types

(] Hide unused built-in menu items, streamlining your Origin workspace

To open the Custom Menu Organizer, choose Preferences: Custom Menu Organizer... from the main menu.

-
Then press F1 or click the button —I in the upper-right hand corner of the dialog box for instructions.

Once you create and save a new menu configuration (.omc) file, you can then select that configuration from
the Preferences: Menu fly-out menu. Multiple configuration files can be created, allowing you to easily switch
from one configuration to another. A Default configuration is also available in the fly-out, to revert to default
menu settings. Configuration files can be shared among colleagues so that you use a common set of menu
commands.

21.2.3Displaying Bitmaps in Menus

You'll note that form some menu commands, a bitmap is displayed to the left of the menu entry. The bitmap
indicates that there is an equivalent toolbar button.

On some systems such as VirtualPC or Terminal Servers, such bitmaps may cause a long delay when opening
menus. To turn off the display of menu command bitmaps:

1. Select Preferences: Options to open the Options dialog box.

2. Select the Miscellaneous tab, clear Display Bitmaps in Menus, and click OK.

You can modify the size of the Plot menu icons using the LabTalk system variable
@PPS. To find out how to change the value of a system variable, see Customizing
Origin Using System Variables.

21.3Customizing Toolbars and Buttons

In addition to the standard Windows OS toolbar customizations, Origin provides some clever and easy-to-use
tools for creating, programming and distributing custom toolbar buttons. If you or your staff are performing
complex but repetitive Origin routines, you'll want to explore creating and sharing custom toolbars.

21.3.1Displaying, Hiding or Moving Toolbar buttons

®  Click the small down arrow at the end of any toolbar and select the Add or Remove Buttons context
menu. Then select desired sub menu and check/uncheck to show/hide buttons. A Reset option is also

available.
e Press ALT key and drag a button to any new toolbar location.
® Press ALT key and drag a button to blank Origin workspace to create a new toolbar.

® Press ALT key and drag a button to any window till X shows, then release to delete the toolbar.
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21.3.2Customizing Toolbar Button Appearance

Use controls on the Options tab (View:Toolbars) to:

Show toolbar screen tips and shortcut keys on hover
Increase toolbar and toolbar button size

Toggle between "flat" or 3D toolbar buttons

21.3.3Displaying or Hiding a Toolbar

Double click the left/top end of any docked toolbar to undock. Double-click on title of floating toolbar to
dock.

In floating mode, click X button to hide the toolbar. Drag it to any new location to reposition. Drag it to

edge of the Origin workspace to dock.
In docked mode, drag the left/top end of a toolbar to reposition.

To show/hide multiple toolbars together, choose View: Toolbars... from the main menu. Use the check
boxes on Toolbars tab to show/hide toolbars. Click the New button to add a new toolbar, then drag

buttons from the Button Groups tab to add buttons on the new toolbar.

Use the Reset, Reset All buttons to reset toolbars.

21.3.4Creating New Toolbars with New Bitmap Images

Origin supports creating new toolbar buttons with Labtalk script, both built-in or user-defined script to run
when click it. Choose View: Toolbars... and create new button group on Button Group tab.

Origin ships with three button groups starting with User Defined... with a bunch of bitmap images.
Click any button and click Settings... button to link .ogs (Script) file section with the button.

Drag the button to Origin workspace to create toolbar button.

If you are feeling really creative, Origin allows you to define a new button group that uses your own 16
color, 16 x 16 pixel bitmaps.

Export the button group as an .OPX file and share it with others. The person who gets the OPX can drag

and drop the OPX file onto Origin workspace to install the toolbar.

Note: To learn more about creating and exporting user-defined toolbars, see:

Help: Origin: Origin Help > Customization and Automation > Customizing Toolbars

21.3.5Add a Custom Button to the Window Title Bar

Origin supports adding a system button to the left of the minimize button on the window title bar. A custom
LabTalk script can then be associated with this button.
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Note: Please view the -tbb option of the LabTalk Page command in the Programming help file:

Help: Programming: LabTalk > Language Reference > Command Reference > Alphabetical

Listing of Commands > Page

21.4Customizing the Status Bar

Origin uses the Status bar at the bottom of the Origin workspace to report software hints, statistics and other
useful information depending upon current action, selection, window, etc.

®  Right-click on Status Bar to customize the display.

® Press ALT and drag items along the Status Bar to reorder.

21.5Customizing the Origin Workspace

Origin also supports customizing dockable windows such as the Project Explorer, Quick Help and Messages
Log windows.

e  Right click on the window title bar to specify dock, hide, auto hide, and other settings.

e  When auto-hide is unchecked, double click to float the window.

e Drag the window title to move or dock to a new location.

® Arrange dockable windows as multiple tabs along the edge of the workspace to save screen space.

® Choose View: Toolbars... from main menu. On the Toolbar tab:
O The Reinitialize button resets menu, toolbar and dockable windows to default settings.
O The Export button exports the current menu, toolbar and dockable window settings to an .OPX
file. Drag and drop the OPX file onto another Origin installation to configure the workspace to

match your customized settings.

I Occasionally, an Origin workspace component goes "missing” -- The Data Display
' window, one of the panels in Project Explorer, etc. When this happens, you can reset
your workspace by choosing View: Toolbars: Reinitialize. The downside has been
that this also resets workspace customizations and toolbar configurations. Beginning
with Origin 2018, clicking the Reinitialize button produces an attention message
asking if you want to restore the workspace settings from your previous version or use
the 2018 system defaults.

21.6 Templates and Themes

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to
the creation of custom settings for repeat use. You can save your custom settings either as templates or
themes, described briefly in the following sections.
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Note: For detailed information please refer to Origin Help file, see:

Help: Origin: Origin Help > Origin Basics > Origin Template Files (OTW, OTP, OTM)

21.6.1Templates

The Origin template concept applies to graphs, workbooks, matrixbooks, and Analysis Templates™. Templates
allow you to choose a set of properties or operations and save those for repeat use.

21.6.1.1 Template Center

Both the New Book (File: New: Workbook/Matrix: Browse...) and Template Library (Plot: Template

Library) dialogs include an Open Template Center button

downloading additional templates.

To open the Template Center directly, choose Tools:

or Book.
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Beginning with Origin 2022b, you can search for additional templates and install them
directly from the Start menu.

Worksheet top left corner with sheet selected->Con
Templates
[l Triangle Heatmap
Il Heatmap with Significant Mark

Find |heatmap]| x {3

a << Start Menu [F1)

21.6.1.2 Workbook Templates and Analysis Templates

You can save workbook or matrixbook settings, such as the number of columns and sheets, column plot
designations, fonts, colors, display formats, custom header rows, scripts associated with the sheet, or
dimension and coordinate settings, to OTWU (workbook template) or OTMU (matrix template) files.

When the workbook or matrix window is active and you choose File: Save Template As, you save any
window customizations, minus any data that might exist in the window at the time of saving, to a template file.
The template file can then be used to create new windows, as needed, for storing and analyzing your data.

You can use the New Book dialog box for managing your workbook, matrixbook and Analysis templates. The
New Book dialog is re-designed for Origin 2021b and is covered in the Workbooks chapter of this User Guide.

Use the same New Book dialog to manage your Analysis Templates™. An Analysis Template starts from a
workbook but differs in that when you save it as an Analysis Template (File: Save Workbook as Analysis
Template), it is saved with whatever analysis operations and dependent graphing operations, exist in the
workbook at the time of saving. Analysis Templates are discussed briefly in the Batch Analysis section of
How to Handle Repetitive Tasks chapter of this guide.

For a more in-depth discussion of Analysis Templates, see these topics:

®  Analysis Templates.

e Creating and Using Analysis Templates (tutorial).

(] Batch Processing with Word Template for Reporting (tutorial).

21.6.1.3 Graph Templates

As mentioned in the Customizing Graphs chapter, Origin ships with about 240 built-in graph templates that are
used to create Origin’s many science and engineering graph types. Using one of these as a starting point, you
can create your own graph, adding more layers, setting scale or dimensional relationships between layers,
modifying data plot properties, etc., and then save your customizations as a user-defined graph template
(.OTP) file by clicking File: Save Template as.... See the "Templates and Themes" section of the Customizing
Graphs chapter for a general discussion of graph templates.

One important subset of graph templates are what are called “cloneable” templates. A cloneable template
requires a very specific data arrangement in your worksheet or matrix; the idea being that if you have once
created a complex arrangement between worksheet datasets, matrix objects, etc. and, for instance, layers or
panels in your graph, then you shouldn't need to recreate this arrangement every time you want to recreate
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such a graph. Cloneable templates are identifiable in the Template Library by the presence of a “sheep” icon
next to the template name or thumbnail image.

MergeGrap 3/22/2021 17:26:41 UserDefined User

BUX"@" 3/23/2021 15:31:40 UserDefined Uzer v

For more information, see the section on cloneable templates in Graph Template Basics in your Origin Help
file.

21.6.2Themes

An Origin Theme is a file containing a set of object properties or dialog settings. Thus for example, the
customized settings of a graph window can be saved as a Theme, or the customized settings in an analysis
dialog can be saved as a Theme. If you were to open the Theme Organizer (see below), you would see that
there are tabs for Graph, Worksheet, Dialog, Function and System Increment Lists.

Themes allow you to quickly apply a new set of properties to an object, such as a graph. For example, you
might apply a black-and-white Theme to a color graph in order to prepare it for publication. Or you might take
the object properties of one graph and apply them to all the other graphs in the same project.

Right-click on plot, layer, object, etc. in graph -- or right click with nothing selected in graph -- and choose
Copy Format context menu to copy format. Depending where you right click, the corresponding selection's
format can be copied. Then right-click on corresponding selection or right click in target graph and click Paste
Format to apply the copied settings to the target selection or graph. You can also choose Edit: Paste
Format... to paste the Format to multiple target graphs.
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Customizing Origin

The Theme Organizer dialog box is opened from the Preferences menu. Use this dialog to organize your
graph, worksheet, and dialog themes.

With this dialog you can apply a graph theme to multiple graphs to have consistent look. To combine multiple
graph themes in the Theme Organizer dialog, hold down Ctrl while selecting the Themes, and then right-click
to access the Combine context menu. The context menu in the tool provides an option to edit a Theme,
allowing the user to add/delete properties to an existing theme. Setting a Theme as a System Theme means
that it will be applied to new graphs automatically, if the graph template allows a System Theme to override
template settings (see the Allow System Theme & System Increment Lists to Override check box).

' Theme Organizer ? n :
A systern theme can be applied automatically when making new graphs

Current system theme: Light Grids

Right-click to set system theme or to choose cther operations

Graph | System Increment Lists | Worksheet | Dialog | Function Apply Theme To

Name Size | Path Date * | Current Graph w
Opposite Lines Add New

Physical Review Letters 17:33

Piot Group Simple Line + Symbol Edit. 17:53

Plot Group Simple Scatter Delate 17:53

profile_cline_x1 1753

profile_cline_x2 Duplizate 117:53

profile_hline_x1 Combine 1753

profile_hline_x2 [} 1753

profile_sep_x] Set as System Theme 753

profile_sep_x2 Clear 5ystem Theme T:53

profile_vline_x1 17:53

profile_wiine_x2 T! ShiwTaoMes 1753

Speed Mode OFF 4 Systemn  15/20017 17253

Speed Mode ON 5 Systern  5015/2017 17:53
TicksAilln | _ 2Sstem |sisa0i7irss |

Ticks All Qut 2 System 3152017 17253 Apply Neow
Ticks YL XB Out YR XT In 8 System 152017 153

Times New Rorman Font 1 System 511572017 17:53 W ndo Apply

[+ Exclude increment lists | Close

The Theme concept extends to dialog box settings, as well. For instance, you can choose a particular suite of
settings in the Linear Fit dialog box (Analysis:Fitting:Linear Fitting), and then save those settings to disk
as a named Theme file. You can save multiple Theme files for a given dialog box and then load them into the
dialog, as needed, using the dialog box's Dialog Theme drop-down list. Saving multiple Themes for a dialog
box allows you to customize your analysis routines from different experiments, when each requires using a
specific (and unique) group of settings.
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-
Lingar Fit

Dizdog Themea
Description  Pesform Linear Fitting
—

Recalculate | paryal

Input | Fit Options | Quantities | Residual Analysis = Output  Fitted Curves Plot  Find X7 | Residual Plots

Save as < default>

Save

Save As...
Theme Setting...

[

System Default
Delete..

Compare...

<Last used>

=)

My Limear Fit with Fixed Intercept

Emors as Weight restrumental
Fiz Intercept ™
Fiz Intercept at ]
Fix Slope [
Fiz Slope at 1 [ 1 " Theme Save as.-
Lol T R ] Please specily a theme name
Apparent Fit
Theme Mame
E Theme Setting
h Save X/How Range

[ ot || cance |

Dialog themes are explained in more detail in the How to Handle Repetitive Tasks chapter of this guide.

21.7 Topics for Further Reading

(] The 3D openGL Settings Dialog Box

Creating Custom Menus

The Custom Menu Organizer

Analysis Themes

How to Manage Multiple Menu Configuration (.OMC) Files

Managing Collapsible Menus

The User Files Folder
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22 Sharing Origin Files
e e . Free Origin Viewer

{ h--__;_--'-F),

Send Origin Files as
Attachments and
Recipient can Drop onto
Origin Workspace

Package your — : Share Files
Tools as OPX files with
and Recipient can : : . i non-users
Drop onto Origin R with the
Workspace. 3! | oy Free Viewer

To Share Files...
One User, Multiple Machines = User Files Folder is Shared or on Flash Drive
Multiple Users, Multiple Machines = Group Folder

You may want to customize some aspect of your Origin installation and then share your customizations with
other Origin users. Custom settings can be saved in many file types including graph templates (.otpu) and
themes (.oth), analysis templates (.ogwu or .opju), dialog themes, curve fitting functions, import wizard filters,
LabTalk script files (.ogs), and X-Functions.

22.1Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The
recipient can then drag and drop the file into the Origin workspace.

Drag-and-drop is supported for most Origin file types. Origin project (.opju) and graph template (.otpu) files
automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in
the User Files Folder (UFF). For example, when you drop a fitting function (.fdf) file into the workspace, a
dialog opens asking how you want to categorize the new fitting function.

Beginning with Origin 2022b, you can use a small dialog to remove formulas and links
from the current selection, the active sheet, the active book or the entire project. This

E - converts formulas and links to raw numbers. Removing formulas and links can make it
easier to share project data with colleagues without having to share such things as
externally-linked (DDE) Excel files; or to significantly reduce project size before
archiving data.
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22.2Sharing Files with Multiple Machines for Single Users

If you are a single user and have installed Origin on multiple machines, you can share your custom settings
across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive,
or even a USB flash drive, and use the same UFF path with each installation.

Note: For information on changing the UFF path, see:

Help: Origin: Origin Help > Customization and Automation > Setting Your Preferences > The
User Files Folder

22.3Sharing Files with Other Users in a Network

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each
group can have some power user(s) set as the group leader. The group leader can use the Group Folder
Manager tool to publish custom files for sharing with other group members. When a group member launches
Origin, the published files will be copied to their Origin automatically and made ready for use.

| Origin supports setting multiple group folders, making it possible to share different files
\ between groups. A leader machine can set up multiple groups and publish different files
to different groups. A member machine can belong to multiple groups and thus receive

all files published by group leaders.

Note: For information on group folders, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Sharing Files with
Multiple Clients > Setting a Group Folder Location

22.4Packaging Files

Origin provides a Package Manager tool for packing multiple files into a single Origin Package (.opx) file.
This is a convenient way to distribute custom applications that may contain multiple Origin files, such as
templates, X-Functions, and LabTalk script files. The Package Manager includes options for running LabTalk
scripts before and after installation.

To access the Package Manager, click Tools, and then click Package Manager...

To install the contents of an .opx file, simply drag and drop into the Origin workspace.

Note: For information on packaging files, see:

Help: Origin: Origin Help > Sharing Your Origin Files with Others > Packaqing Multiple Files
as OPX

22.5The Origin Viewer

The Origin Viewer is a freely distributed, standalone application that allows viewing and copying of
information contained in Origin project files and window (graph, worksheet, matrix) files on computers that do
not have Origin installed.
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Sharing Origin Files

e The Origin Viewer is distributed as a single EXE file - no installation needed.

® Available as a 64-bit Windows application, or as a native Mac application (Mac version not compatible with
11.0.1, Big Sur).

®  Project Explorer-like folder view with graph previews on hover, icon or details views, X-large icon view
option.

® Open a graph in a pop-up window for better viewing.

®  Supports viewing and rotating Origin's OpenGL 3D graphs.

|, Origin 2018 introduced a new Unicode-compliant project file type (OPJU). Origin Viewer
versions 9.6.5 or later allow anyone to save the Unicode-compliant OPJU project files
to the pre-2018 OPJ format for sharing of projects with users of older versions of
Origin.

If you have Origin graphs or data that you wish to share with colleagues who are not currently using Origin,
you might direct them to the Origin Viewer page (www.originlab.com/viewer) where they can find out more
and download the free EXE.

22.6Topics for Further Reading

(] The User Files Folder

e  Attaching Files to the Origin Project

e  Package Manager

e  Setting Up a Group Folder

(] Exporting Custom Button Groups

(] Exporting Toolbar Settings

e  Apps for Origin
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23 Origin Toolbars

This is a list of Origin toolbars, and buttons by button group. Toolbars are shown in their default configurations.
You will note that some buttons are missing from default toolbar configurations. This may be because a button
has been deprecated, because it is duplicated on another toolbar, or simply because it is a lesser-used button.

To add or remove buttons from a toolbar:

1. Click View: Toolbars to open the Customize dialog box.

2. Click on the Button Groups tab and drag desired buttons to a toolbar or to an empty portion of the
workspace.

3. To remove a button/toolbar, drag it from the toolbar back to the Buttons list or click the small "x" in the

upper right-corner of the toolbar (removes entire toolbar from the workspace).

Note also that some toolbar buttons have a small downward pointing arrow next to them. Clicking the tool
displayed on these "split buttons™ carries out the action associated with the displayed tool. Clicking the arrow
beside it opens a menu, allowing you to pick another tool. A split button displays the tool that was last used.

Finally, toolbar buttons will be inaccessible (dimmed) if the object that they act on is not active. For instance,
the 3D-Rotation Toolbar is only available when a 3D graph is active.

In addition to these dockable toolbars, Origin has context-sensitive Mini Toolbars for
variety of common editing tasks. These toolbars are discussed in The Origin Interface
chapter of this Guide. For a complete list of those toolbars, see the Origin Help File.

23.1Standard

Standard -
NEBRRRBR:- Bl soEB £ 95
e - BERIE PEE & aABEE e +E

Button Description Hotkey Button Description Hotkey

D New Project E New Folder

New Workbook New Graph
New Matrix fU New 2D (Function) Plot
re) New 2D Parametric Plot = New 3D (Function) Plot
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Button Description Hotkey Button Description Hotkey
@ New 3D Parametric Plot New Layout
New Notes Eﬁ Digitize Image
@ New Image g Open Ctg *
@ Open From Cloud E Save Project Ctg *
B | seeTempe R | S e
% Updai)(?/l;{s:cgléhciation H Zoor;elpcggfa;)éj ty
=7 Print Ctg * =) Slide Show of Graphs
Se;gw%:g%?:tto R Open Video Builder
E] Refresh F5 g Duplicate
2 Custom Routine al Project Explorer Ali *
@ Object Manager Alé * Results Log Al; *
i Command Window AI; * [EH Code Builder AIZ *

Add New Columns
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23.2 Import

EEme 2Eae B 0%

Origin Toolbars

Button Description Hotkey Button Description Hotkey
e Import Wizard = Import Single ASCII
1@!@ Import Multiple ASCII ﬁ Import Excel
% Re-import no Dialog Ct‘rll * ﬁi Re-import with Dialog
mﬁ Clone Import % Batch Processing
i"" Connectvt\?elzata from @ Connect Multiple Files
i;__, Import All Connected

Data
23.3Edit

Button Description Hotkey Button Description Hotkey
& Cut Ctrl+X By Copy Ctrl+C
F N Paste Ctrl+V ) Undo Ctrl+zZ
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23.4Graph

=Ll CEEEH- LT U0k

Button Description Hotkey Button Description Hotkey
=== Enabl%ﬁ)éss?%e Anti- H Rescale Ctrl+R
H Rescale X H Rescale Y
H Rescale XY g Rescale Z

u Exchange the X and .

XY Y axes 1% Enable/Disable Speed Mode
Extract to Layers Extract to Graphs
Merge Duplicate with New

Columns/Sheets/Books

=

Add Bottom-X Left-Y
Layer

n

Add Top-X Layer

&

Add Right-Y Layer

=

Add Top-X Right-Y Layer

E

Add Inset Graph

Iz

Add Inset Graph With Data

B

Zoom In

®»

Zoom Out

|m

Whole Page
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Origin Toolbars

23.52D Graphs

y y Note that only common plot types have a toolbar button. Complete access to Origin plot
types is found on the Plot menu.

AR MEA RS ™ig GARY Rgv!

Button Description Button Description

ﬂ Line I Horizontal Step

Vertical Step Spline Connected

=
[

Scatter Grouped Scatter - Indexed Data

Scatter Central Column Scatter

[£2]

T'I Y Error ﬂ XY Error

@ Vertical Drop Line 3'*0% Bubble

Color Mapped 3-3':'1 Bubble + Color Mapped
ﬂ Line + Symbol % Line Series

2 Point Segment 3 Point Segment

S
kel

L

Row-wise Column

el

Column + Label il Grouped Column-Indexed Data
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Button Description Button Description
l Bar . Stacked Column
l Stacked Bar . 100% Stacked Column
= | 100% Stacked Bar [ Floating Column
= Floating Bar [a 3D Color Pie Chart
B 2D B&W Pie Chart EA Double Y Axis
= 3Ys Y-YY £ 3Ys Y-Y-Y
2|l 4Ys Y-YYY 5] 4Ys YY-YY
||E|| Multiple Y Axes = Stacked Lines By Y Offsets

iy Colormapped Line Series (P Waterfall

@ Waterfall Y: Color Mapping @ Waterfall Z: Color Mapping
@ 3D Waterfall @ 3D Waterfall Y: Color Mapping
@ 3D Waterfall Z: Color Mapping = Vertical 2 Panel

b Horizontal 2 Panel e 4 Panel
@ 9 Panel % Stack
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Button Description Button Description
e Multiple Panels by Label za! Trellis Plot
EE Cluster Plot B Box Chart

|

Violin with Box

Grouped Box Charts-Indexed
Data

g%

Grouped Box Charts-Raw Data

=

Interval Plot

Histogram

Histogram + Probabilities

l& Multi-Panel Histogram E Marginal Histograms
28 Marginal Boxes o Distribution + Rug
2D Kernel Density l_.. QC(X-bar R) Chart
['.: Pareto Chart-Binned Data [:': Pareto Chart-Raw Data

P

Scatter Matrix

Probability Plot

v Q-Q Plot H Parallel Plot
ad Area ak Stacked Area
~ Fill Area 5 Zoom

Polar theta(X) r(Y)

Polar r(X) theta(Y)
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Button Description Button Description
@ Wind Rose-Binned Data @ Wind Rose-Raw Data
Ternary i, Piper
@ Smith Chart @ Radar
o Vector XYAM ﬂ Vector XYXY

-

}rrt

High-Low-Close

=

Japanese Candlestick

=

OHLC Bar Chart

B

OHLC-Volume

i

Line (Stock)

=

Bridge Chart

ig]

Template Library

23.6 Add Object to Graph

—QFE~AE &G =

Button Description Hotkey Button Description Hotkey
; Add Color Scale Reconstruct Legend Ctrl+L
= Add Asterisk Bracket H Add XY Scale

Date & Time

Project Path

New Link Table

Add Bubble Scale
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23.7 3D and Contour Graph

Origin Toolbars

Description

Button

Description

3D Scatter Plot

B

3D Trajectory

B

3D Scatter + Error Bar

®

3D Vector XYZ XYZ

®

3D Vector XYZ dXdYdz

I3

3D Tetrahedral

2

3D Bars

E)

3D Stacked Bars

2

3D 100% Stacked Bars

=

XYY 3D Bars

=

XYY 3D Stacked Bars

El

XYY 3D 100% Stacked Bars

L)

3D Ribbons

Aa)

3D Walls

L)

3D Waterfall

3D Waterfall Y: Color Mapping

3D Waterfall Z: Color Mapping

L

3D Color Fill Surface

w® | ®

Multiple Color Fill Surfaces

®

3D X Constant with Base

il

3D Y Constant with Base

LS]

3D Colormap Surface

@

Multiple Colormap Surfaces

®

3D Color Fill Surface with Error
Bar

B

3D Colormap Surface with Error
Bar

®

3D Wire Frame
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Button

Description

Button

Description

3D Wire Surface

3D Colormap Surface with
Projection

3D Ternary Colormap Surface

5

Contour - Color fill

Contour - B/W Lines + Labels

14

Gray Scale Map

EE

Contour Profiles

(5]

Polar Contour theta(X) r(Y)

&

Polar Contour r(X) theta(Y)

B

Ternary Contour

@

Image Plot

B

Image Profiles

Heatmap

B2

Heatmap with Labels

23.83D Rotation

PRV NATFLPX s @ 0

Button

Description

Button

Description

*|

Rotate counterclockwise

Rotate clockwise

1\ Tilt left ¥ Tilt right
F 3 Tilt down Tilt up

Increase perspective

Decrease perspective

&
x

Fit frame to layer

w

Reset Rotation
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Button

Description

Button

Description

L

Reset

Rotate on any direction

BN

Rotation Angle

23.9Worksheet Data

BHL A R dilbf YTXB

Button Description Hotkey Button Description Hotkey
EE Statistics on Column(s) mEm Statistics on Row(s)
ng Sort “’E Set Column Values Ctrl+Q
ﬁfj Set All Column Values Ctrl+F5 ,dﬂ] Row number

&

Uniform random
numbers

Normal random
numbers

Add/Remove Data

Enable/Disable Data

W Filter X Filter
% Reapply Data Filter
23.10Column
H, X Y Z b oo [¢ ¢ 9 9
Button Description Button Description
ol Set as X h i SetasY
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Button Description Button Description
pra SetasZ i Set as Y Error Bars
HE Set as Labels HOHE Set as Disregard

Set as Grouping

)

Set as Subject

Move to First

|

Move Left

Move Right

£3

Move to Last

Swap Columns

E3

Add Sparkline

23.11Layout

ElE & =l=

sl

Button Description Button Description
+L] Add Graph +EH Add Worksheet
23.12Mask

Button

Description

Button

Description

B

Mask Range

Unmask Range

Change mask color

Hide/Show masked points
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Button

Description

Button

Description

|

Swap mask

=]

Disable/Enable masking

23.13Tools

&S+ @ - It wTHE A-w-0O-ME-E- 54

Button Description Hotkey Button Description Hotkey
[:‘;? Pointer @\ Scale In
Q Scale Out + Screen Reader

&

Data Highlighter

]

Data Reader

®

Data Cursor

Ii

Data Selector

L

Selection on Active
Plot

B

Selection on All
Plots

'fr‘j Ma:,(l:(tisé)igfzton :ﬁ; Mask PPoIi(;]ttss on All
T-F';' Unnlas_k Points on ﬁ Unmask Points on
ta ctive Plot *a All Plots
J Draw Data ﬂ Text Tool
@ Annotation ﬂ Arrow Tool

2

Curved Arrow Tool

&

Distance Annotation
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Button Description Hotkey Button Description Hotkey
v Line Tool A Polyline Tool
ﬂ Curve Tool ﬂ Freehand Draw
Tool
O Rectangle Tool o | Circle Tool
N Polygon Tool 2 | Region Tool
ﬂ Zoom-Panning Tool Hzld @ Insert Equation
@ Insert Word Object Insert Excel Object
@ Insert Object Insert Graph
r Hold "Z": Zoom;
Insert Worksheet ‘@'_]f Rescale Tool Hold "X": Pan
%) Rotate Tool Hgld
23.140bject Edit
B S8 0o & e Floole= ThEy ooce IO
Button Description Button Description
= Left = Right
0d Top 0o Bottom
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Button Description Button Description
& Vertical a4 Horizontal
e Uniform Width [y Uniform Height
E Group I{_’_“I Ungroup

Distribute Selected Layers/Graphic
Objects
Evenly in Vertical Dimension

2

Distribute Selected Layers/Graphic
Objects
Evenly in Horizontal Dimension

E Front E Back
E Forward E Backward
ﬂ Front(data) ﬂ Back(data)
23.15Arrow
= ST S
Button Description Button Description

Horizontal Alignment

Vertical Alignment

Widen Head

Narrow Head

Lengthen Head

Shorten Head
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23.16Style

R A e = 05 @ [z 0 >
Button Description Hotkey Button Description Hotkey
ﬂ Fill Color g Line/Border Color
i Lighting Control Dialog @ Palette
EB Line/Border Style H Line/Border Width
Fill Pattern Fill Pattern Width
Z Pattern Color Clear Borders
Left Border Top Border
Right Border B Bottom Border
Frame Borders = Insidgoljgéiéontal
Inside Vertical Borders Inside g(c))rr(ijze?snd vert
= All Horizontal Borders [ All Vertical Borders
@ All Borders EE Merge cells Ctrl+R
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23.17Format

T Default: Arial

<Sap A £ E M, A-

Origin Toolbars

Button Descrzlptlo Hotkey Button Description Hotkey
| T Default: Arial b Font H Font size
B | Bold Ctrl+"B" I Italic Ctrli+"I"
i) | Und:rlln Ctrl+"U" x? Superscript Ctrl+"+"
x, | Subtscrlp Ctrl+"=" x2 Super;ubscn Ctrl+"-"
Ctrl+">" Ctrl+"<"
A Increase . ' Decrease .
Eont Ctrl+Shift+ Font Ctrl+Shift+
(i Greek Ctrl+"G" == Left
o Center .
= Horizont = Right
al
It m Center
I Top i v
Il Bottom ﬁ| Font Color
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23.18Auto Update

‘o

Button

Description

]

Pause Auto Update/Recalculations

23.19Database Access

]
B EE &K

Button Description Button Description
@’ Open SQL Editor @} Open Query Builder
= Load ODQ File 2 Preview Import

@ Import data @( Remove SQL
23.20Markers & Locks
M [+ += @

Button Description Hotkey Button Description Hotkey
M| Add Data Markers Ctrl+Alt+M || Clear Data Markers Ctrl+Alt+N
+4 Marker Size $~¢‘| Marker Hide Show
(=] Lock Positions
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Column Label Rows, Worksheet ......................... 97
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Columns, NamMiNg . ..cvviieiiii i 83
Command WIiNndow .........c.oiiiiiiiiiiiiiiiiiieieaens 45
Concurrent NetWOrK.........ooiviiiiiiiiiiiiii et 5
CONSUITING .. e 9
(0701917701 [ 5] 1]o] o F PP 327
Coordinate Values, Reading/Annotating............. 295
Coordinates, Reading/Labeling......................... 287
Copy/Paste Graphs.......ccooiiiiiiiii i 367
Curve Fit, Linear and Polynomial...................... 322
Curve Fit, Nonlinear.........ccooevviiiiiiiiiiiiiiianennn, 322
Curve Fitting ...oooveiieii e 295
Custom Menu Organizer ........ccooveeeviiiieiaianeannnns 409
Customizing Origin, Global Settings.................. 405
Customizing Toolbars and Buttons.................... 409
D
I 70
Data Cursor TOOl.........cccooiviiiiiiiiiiiiiieee 281
Data DiSplay....coeeeeeie e 280
Data Info Window ..., 285
Data Markers.........coooiiiiiiiiiiiie 309, 311
Data Reader............cocoiiiiiiiiiie 280
Data Reduction, Graphs.........cccvviiiiiiiiinnnnnn 178
Data Reduction, Worksheets ........................... 123
Datasets, Creating.......cooooeeiiiiiiiiiiiii e 104
D e 70
Deactivate License...........ccoooiiiiiiiiiiiiiiiieans 7
Derivatives, Plot.........coooiiiiiiii e 295
Descriptive StatisStiCs ........covviiiiiiiiiiiiiiiiaees 295
Dialog BOX TheMEeS.....coiiiiiiiiiiiie e 346
Differentiation ... 295
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Digitizing Scatter PIots ........ccoiiiiiiiiiiiiiiieens 76
Drag and Drop Plotting.....cccvveviiviiiiiiieeannns 172
Drag-and-Drop Origin File Sharing ................... 418
Drag-and-Drop, Importing by ...t 71
DX e 70
DX e 70
E
EarthProbe...... ..o 70
EDF 70
Embed Graphs, 3rd Party Applications............... 367
Embed Graphs, Origin Templates ..................... 348
E P A 70
ETAS INCA . e 70
EXCel.cnii 42, 66, 403, 405
Exporting a MatriX.......ccooieiiiiiiiiiiii i 387
Exporting Graphs/Layout Pages ....................... 371
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